AMERICAN ASSOCIATION orF
STATE HIGHWAY aAnD
TRANSPORTATION OFFICIALS

AASHTOW':lre ﬁvﬁngml;lRIAQ
Project

SiteManage

User Reference Manual

AASHTOWare Project SiteManager™ 3.16a

September 2015

Last Updated
June 2015

O InfoTec

INNOVATION AT WORK

5700 SW 34th Street, Suite 1235, Gainesville, Florida 32608-5371 «
Phone: (352) 381-4400 « Fax: (352) 381-4444 - info@infotechfl.com « www.infotechfl.com



AMERICAN ASSOCIATION orF
STATE HIGHWAY anD
TRANSPORTATION OFFICIALS

AASH

THE VDICE OF TRANSPORBATION

AASHTOWare is a registered trademark and service mark of AASHTO.

The AASHTOWare logo, Trnseport Estimator, the Trnseport Estimator logo, Trnseport Expedite, the Trnseport
Expedite logo, AASHTO Trnseport, the AASHTO Trnseport logo, CES, the Trns*port CES logo, CAS, the Trns*port
CAS logo, PES, the Trnseport PES logo, LAS, the Trns*port LAS logo, BAMS/DSS, the Trnseport BAMS/DSS
logo, Trnseport SiteManager, the Trnseport SiteManager logo, SiteManager, Trnseport SiteXchange, the Trnseport
SiteXchange logo, Trnseport FieldManager, the Trnseport FieldManager logo, Trnseport FieldBook, the Trnseport
FieldBook logo, Trnseport FieldBuilder, the Trnseport FieldBuilder logo, Trns*port Preconstruction, the Trnseport
Preconstruction logo, Trnssport CRLMS, the Trnssport CRLMS logo, AASHTOWare Project logo and
AASHTOWare Project BAMS/DSS logo are registered trademarks of AASHTO.

AASHTOWare Project Bids, AASHTOWare Project Bids logo, AASHTOWare Project Civil Rights & Labor,
AASHTOWare Project Civil Rights & Labor logo, AASHTOWare Project Construction Administration,
AASHTOWare Project Construction Administration logo, AASHTOWare Project Construction & Materials,
AASHTOWare Project Construction & Materials logo, AASHTOWare Project Decision Support, AASHTOWare
Project Decision Support logo, AASHTOWare Project Estimation, AASHTOWare Project Estimation logo,
AASHTOWare Project Estimator, AASHTOWare Project Estimator logo, AASHTOWare Project Expedite,
AASHTOWare Project Expedite logo, AASHTOWare Project FieldBook, AASHTOWare Project FieldBook logo,
AASHTOWare Project FieldBuilder, AASHTOWare Project FieldBuilder logo, AASHTOWare Project
FieldManager, AASHTOWare Project FieldManager logo, AASHTOWare Project FieldNet, AASHTOWare Project
FieldNet logo, AASHTOWare Project, AASHTOWare Project logo, AASHTOWare Project Preconstruction,
AASHTOWare Project Preconstruction logo, AASHTOWare Project Worksheet, AASHTOWare Project Worksheet
logo, AASHTOWare Project SiteManager, AASHTOWare Project SiteManager logo, AASHTOWare Project
SiteXchange, AASHTOWare Project SiteXchange logo, AASHTOWare Project TRACER, and AASHTOWare
Project TRACER logo are trademarks of AASHTO.

AASHTO Trnseport, Trnseport CES, Trnseport PES, Trnseport Expedite, Trnseport LAS, Trnseport CAS, Trnseport
SiteManager, Trnseport BAMS/DSS, Trnseport SiteXchange, Trnseport SitePad, Trnseport Preconstruction,
Trnseport CRLMS, AASHTOWare Project BAMS/DSS, AASHTOWare, AASHTOWare Project Bids,
AASHTOWare Project Civil Rights, AASHTOWare Project Cost Estimation, AASHTOWare Project Decision
Support, AASHTOWare Project Estimation, AASHTOWare Project Expedite, AASHTOWare Project
Preconstruction, AASHTOWare Project, AASHTOWare Project SiteManager, and AASHTOWare Project
SiteXchange are proprietary software products of AASHTO.

Other product names are trademarks or registered trademarks of their respective owners.

FieldManager, FieldBook, and FieldBuilder represent one or more proprietary products jointly owned by Info Tech,
Inc., and the State of Michigan.

FieldNet represents a proprietary product of Info Tech, Inc.
© Copyright 2015 by the American Association of State Highway and Transportation Officials, Inc. All rights

reserved. This document or parts thereof may not be reproduced in any form without written permission of the
publisher. Printed in the United States of America.



Contents

Lo INEFOTUCTION ...ttt 1-1
1.1 DOCUMENT STFUCTUIE ...ttt 1-2

1.2 ODJECLIVES ...ttt ettt te et e et et e e et e nn e ne e ne e 1-5

1.3 PrOCEAUIES .....viitieiieiieieie sttt sttt bbbt ne e s 1-5

2. GEUING STANTEU ....ecuiciicieiee ettt e e 2-1
2.1 Understanding the General WOrkflow............cccocoiiiiiiiiinineeee, 2-2
2.1.1 AASHTOWare Project SiteManager Software............ccocooevvrivrvnnnnnnn 2-2

2.2 Starting and EXiting SIEMaNAJET..........cceriiriiiniiiseeeeee e 2-2
2.2.1 Starting SIEMaNAGET .........coiviiiieieeie st 2-2

2.2.2 End-User Security — Changing Your Password .............c.ccoceevvrveninennn 2-3

2.2.3 EXItiNg SItEMANAGET.......ciuiiiiiieieriesee e 2-5

2.3 SiteManager Main Panel ..o 2-5
2.3.1 Security and the SiteManager COMPONENTS ..........cccoererererinienieeieennn 2-6

2.3.2 The SiteManager Status Bar...........c.ccovviiiiniieiiieie e 2-6

Panel Icons - SiteManager Functional Areas ............ccooeoeienenenenesiseees 2-6

2.3.3 Navigating in SiteManager Using the Main Panel.............cc.ccocveeneee. 2-10

2.4 AACCESSOTIES ...ttt ettt b bbbt b et e e nb e bbb 2-10
2.4.1 IN-BOX CONCEPLS.....cviiiieiieiieiiesieese ettt 2-11

2.4.2 DIStIDULION LIST ....oviiiiiiiiiiiiee e 2-17

2.4.3 Process Status WINCOW .........cccooiririiiinininieieeee e 2-18

2.4.4 System AtAChMENTS........ccviiiiiie e 2-20

2.4.5 REPOITS ..ot 2-22

3. GENEIAl CONCEPTS ...ttt bbb bbbt 3-1
3L IMIBIUS .ttt b e 3-2

3.2 Using SiteManager Menus and TooIbar............cccoeevieiii i 3-3
3.2.1 Accessing SiteManager Menus With the Keyboard...............ccccovvenin. 3-4

3.2.2 TOOIDAr BULLONS.....ccueiiiieiiieie st e 3-4

3.3 Frame IMBNUS ...ttt 3-6

3.4 WINAOW MENUS ...ttt ettt sttt nne s 3-7




G 0t R 1 [N 1Y/ =T 1 TR 3-7

342 EQIEIMENU. ..ot 3-14
3.4.3 SEIVICES MENU....oviiniiiiieiiieie ettt et 3-17

3. 4.4 WINAOW MENU....cviiiiiiiiiiieiieie ettt e 3-22
345 HEIP IMENU. ...t 3-25

3.5 ODJECE MEBNU ...t 3-29
351 SBAICN ...t 3-31
35,2 FHIEI oo e 3-32
3.5.3 FING 1o 3-33
3514 SN e 3-34
3.5.5 ShOW FILEI/SOI ... e 3-35

3.6 DOCUMENLALION SUPPOIT......cvivieirieiiieiieeie e 3-35
BT REPOITS ..t 3-37
3.7.1 RePOIt OPLIONS ...c.viviiiiiiieiieieie et 3-38
3.7.2 Saving, Opening, and Exporting Simple Reports ...........ccocvevvvviennnn. 3-38

3.8 Plug-In, URL, and OLE AttaChments..........cccceiverrniiniiene e 3-40
3.8.1 URL, Plug-In and OLE Attachment ICONS .........cccevvvveiiverenrieseennn, 3-41
3.8.2 AtaChMENt USAGE .......eiviiiiiiiieeierese e 3-42

4. Contract Administration - Reference Tables ... 4-1
4.1 Reference Tables (Contract AdMINIStration)...........cccovvevveveiievie s 4-3
4.1.1 Interface Load MESSAQES .......ccveiveeiiiieiieeie st e e ste e s sre e 4-4
4.1.2 Default Liquidated Damage Rates .........cccceeveeiieviiiieiicce e 4-6
4.1.3 Default CritiCal DAtes........cccouvieieriirieiesieseseeeeee e 4-8
4.1.4 Default KeY DAtesS ......ccccccveiieiireieiieiie e 4-10
4.1.5 Default Checklist EVENTS........cccooiiiiiiiiiiicieee e 4-12
4.1.6 FUNAING SOUICES.....ccueeitieieitieite e steeste et ste e sre et sre e reeere e 4-15
A.1.7 M MASTEL ... 4-18
4.1.8 VENUOIS ....oeiiieiieieie ittt sttt bbbt ene e 4-19
4.1.9 AdMINIStrative OFffiCES .......coviiiriiiiese e 4-45

4.2 System Operational Parameters for Contracts..........cccccevveveiveieevecce e, 4-50
4.3 Tab-Level Security for CONtracts ..........ccccvveveiiieiicci e 4-52
5. Contract Administration - New CONtracts .........c.ccoceviviininieinnese e 5-1
5.1 AdAING NEW CONTIACES ....c.ooiviviiiniiiiieiieieie sttt 5-2
5.1.1 From Preconstruction SYStemS...........cccooiiiiiciiiiiiieinceee s 5-2
5.1.2 Entry Directly Into SIteManager ..........cccovvririeieieiese e 5-2
5.1.3 General Procedure for Adding New CONtracts..........ccocooevvenirenenennnn, 5-3

5.2 Contract Status Validation.............ccooiieiiiiieiiiesieie e 5-6
5.3 CONLraCt RECOIS .....vveveeieiieiieesie et ste et esreeneeaneenreas 5-9
SR O] 11 - Vo £ TP SURTRPRP 5-10
5.4.1 CoNtract DESCHIPLION ...ccuvvviiiiiiiieiierie st 5-12
5.4.2 CONLraCt LOCALION ......ccveivieiieieiiesieeie et 5-19
5.4.3 Contract Payment Data...........ccooveiirienieiieieseesieee e 5-21
5.4.4 Contract Critical DateS..........cccevvereeiieiieiierie e 5-26
5.4.5 Contract Primary Personnel ..., 5-31




5.4.6 Prime Contractor, Contacts, and ASSOCIALES .........ueueeeeeeeeeeeeeeeeennns 5-34

5.4.7 DBE COMMITMENTS ...ccvviitieiieiesieeiiesie st s 5-39
5.4.8 TrainiNg Plan ........oooi i e 5-41
5.4.9 CUSEOM RECOIS ....oovviivieiiieiieie ettt 5-43

5.5 CoNtraCt IMIlESIONES ......cceeiieiiiie e 5-46
5.6 PIOJECES ...ttt e 5-51
5.6.1 Project DeSCIIPLION.......cueiiiiieierieiterie st 5-52
5.6.2 Project COUNLIES .......cceiiiieiiieieesiet et 5-57
5.6.3 Project Price Adjustment INAICES ...........coviriiiierencieic e, 5-59

ST A O 1 (=T (o] 4 - TSRO U RS UROP 5-61
5.8 IHBIMIS <t e e beenree s 5-67
5.9 CoNtraCt FUNAING ......ooiiiiieiiiiereee e 5-73
5.9.1 Related Item COUES .......cccveiieieiieceeie e 5-73
5.10 Contract Group AULNOIITY ........cccoiiiiieieere e 5-78
5.10.1 Window ACCESS RIGNES .......cveiiiiiiiiiieee e, 5-78
5.10.2 Office-Wide CONraCt ACCESS......ceerurreerireriraiesreeieaseesreeseeeseesseeneens 5-78
5.10.3 Contract Authority EXamples..........ccccoviiiiiiiiiiieeeeee, 5-79
5.10.4 ContraCt AULNOIILY........coiviiiieieierese e 5-81
5.11 Key Dates and CheckIiSt EVENES........c.coviiiiriniiiiieeeee e 5-84
5.12 Progress SCNEAUIE..........cciiiiiiieiecee s 5-84
TN R T =T 00 | £ USSR 5-87
5.14 Stockpiled MaterialS...........cociiiriiiiiiieee s 5-89
5.14.1 Before AddiNg Data .........cccevveiiiiiiiiiiisieeeeee e 5-93
5.15 Construction CONTEIENCES........ueiieeiiiieiieie e ens 5-97
5.16 SUDCONTIACES ....eoveeieeiieie ettt nne s 5-100
5.16.1 Subcontract DeSCIIPLIONS ..........coeierireiieieiene s 5-101
5.16.2 SUDCONTIACT ILEMS.....c.veiieeiiecieee e 5-109

6. Contract Administration - MaintenancCe............ccoovvereiiierieeresiese e 6-1
6.1 COorreSPONUENCE LOQ.....ccviiieiiieie ettt 6-2
6.2 FOICE ACCOUNES ...ttt ettt ettt 6-5
6.2.1 Force Account EQUIPMENT.........ccociiiieiieiecicee e 6-9
6.2.2 FOrce AcCOUNt LabOr........cccoviieiiiiiiiesc s 6-11
6.2.3 Force Account MaterialS .........ccccoveveiiiieninieieee e 6-13
6.2.4 FOrce ACCOUNT SUMIMAIY ......ccuiiiiiieiiieeiieeesieeesieessinee e s nieeessee e 6-14

6.3 Design EVAlUALION..........cccoiiiiic e 6-17
6.4 Plan DISCIEPANCY ......veeiuiieiieiie ettt ve e sre e e s aeesree s 6-18
6.5 DISPULE/CIAIM ....cviiiiic e 6-21
6.5.1 Dispute/Claim DeSCHPLIONS ........ccivvieiiiiiiieiie e 6-22
6.5.2 Dispute/Claim RECIPIENTS ........ccoveiieiiieiie s 6-27
6.5.3 Dispute/Claim Related ReCOrds.........cccevviveiiiiiieiie e 6-29

6.6 Contractor PayrOllS..........ccviiiiiiie i 6-30
6.6.1 Payroll INformation ...........cccccoveiiiiii i 6-32
6.6.2 Employee INformation............ccccooveiieiiii i 6-34
6.6.3 Employee Daily INnformation...........cccccoeiviiiiiiiiiiic e 6-37

6.7 Contractor Payroll LOAd ...........cocveiviiiieiiieie et 6-41




6.7.1 Contractor Payrolls Text File Format..........cccoocovoviininiinncieseen, 6-41

6.8 DOCUMENT SUDMISSION .....cuviiiiiiiieiiee e s 6-46
6.8.1 Checklist EVent DOCUMENTS ........ccooviiiiiiiiieieiee e 6-47

6.9 Document SUDMISSION REVIEW........cciiiieiiiiiiiiiesiieeeeee e 6-50
6.10 Contractor EVAlUALION...........ccoiiiiiiiieeec e 6-52
6.11 Contract COMPIELION .....ovieiiiiieecieee e 6-54
6.11.1 Contract Items Complete Date RequUIrements..........c.coovvvvvrveiennen. 6-54
6.11.2 Final Estimate REQUIFEMENTS .........cocviiiiriiiciee e 6-55
6.11.3 Complete Status REQUIrEMENTS .........cccviieiiieieieereee e 6-56

6.12 DSS CONLIACES ...ttt 6-57
6.13 Reports (Contract AAMINISIIAtIoN) .......cccvevvvrieiiiieiie e 6-59
6.13.1 Contract Status REPOIT .........c.ooeeiiiiiiieiie e 6-60
6.13.2 Contract Dispute/Claim RepOIt.........ccccoiriiiiieieieic e, 6-66
6.13.3 Item Quantity REPOI........ccveiveiirieiieiisiesie e 6-68
6.13.4 1tem WOrK REPOIT .....oviiiiiiiieieee e 6-71
6.13.5 Required DOCUMENES REPOIT......c.oiviiiiiiiiieieee e 6-73
6.13.6 Contractor Behind Schedule Report...........ccooeveiiiiiiiiniiiiicee, 6-75
6.13.7 Past HiStOry REPOIS........ccviieiirieiieiesiesie et 6-76
6.13.8 Contractor Current Status REPOIt..........cccoeviiiiiiniiiie e 6-79
6.13.9 Subcontract Value REPOIt .........cccooiiiiiiiiiiicee e, 6-81
6.14 Process List (Contract AdMINISTration) ..........ccocevvririeieieiene e 6-84
7. Key Dates and ChecKIiSt EVENTS .........cccoiiiiiiiiiieeeee e 7-1
7.1 Contract and Civil Rights Applicability ..........cc.cccoveiiiiiiicc 7-2
T.1.1 KEY DALES ...ttt 7-2
7.1.2 CheCKIliSt EVENTS.......ooviiiiieiiiiee e 7-3

7.2 KBY DIALES. ... iieie ittt ettt nes 7-3
7.3 Checklist Scheduled EVENLS ..o 7-7
7.4 Checklist EVENE DALES........ccuiuiieieiiiieieisiesie e 7-12
8. Daily WOIK REPOITS....c.vieiiieiciie ettt re e 8-1
8.1 GENEral CONCEPLS. .....eiueeiiiierieste ettt 8-2
8.1.1 PIPEHNE....coiiiiiiic 8-3
8.1.2 ACCESSING SDIMS ..ot 8-4
8.1.3 Stockpiled Materials Information............c.ccooviiiiiiinii e, 8-4
8.1.4 Installed WOrk REPOIS ......cooveiiriiiiiiniesiisieeiee s 8-4
8.1.5 Pen-enabled Data ENtry..........cccoeieiiiiiiiiiieieee e 8-4

8.2 Data COIBCTION ......ciuiiiieieie e 8-4
8.2.1 Daily WOIK REPOITS ....cuveviiiieiieieiieiie et 8-4
8.2.2 DWR Information Tab in Daily Work Reports..........c.ccccvvvvrnnnennnn, 8-10
8.2.3 Contractors Tab in Daily Work RepOrts .........cccoceeereiincniiiiicienen, 8-17
8.2.4 Contractor Equipment Tab in Daily Work Reports ...........ccccevvenneee. 8-21
8.2.5 Daily Staff Tab in Daily Work RepOrts..........cccooerireiiiiniiiiecienen, 8-24
8.2.6 Work Items Tab in Daily WOrk Reports .........ccccceeeieiinineninicenen, 8-27
8.2.7 Daily Force Accounts Tab in Daily Work Reports ..........c.ccoovvveiennee. 8-49

8.3 DWR Template REPOITS .....ccvevviriiriiiiieieieiee s 8-60




8.3.1 DWR Template Usage REPOIT .......ccccviiriieiieiieiieie e 8-60

8.3.2 DWR Template Item Master REpOIt.........cccovevereniiienininisieeeee, 8-63

8.4 DAY DIAIY ...oeeiiieie it 8-65
8.4.1 DiIary AUNOIZE........cciiiiieieiee e 8-65
8.4.2 DIary ChArQe ......couoiuiiiiiieiieieiee et 8-65
8.4.3 SeleCting @ DIAIY ......cccviieieiiieie e 8-66
8.4.4 Creating @ NeW DIAIY......cccccoveiieeienie et 8-67
8.4.5 Authorizing Daily Work REpOItS ........ccccviiiiiiiecicsc e, 8-71
8.4.6 Previewing Daily Work Reports and DIaries..........c.ccoovveriiiinniennnn, 8-72
8.4.7 Charge Days and N0 Charge Days.........ccccevvererencieninineseeeeeeen, 8-77

8.5 Diary Adjustment WINAOW..........cccueueiiriieiinie e 8-80
8.5.1 Diary Adjustment Window Diary and Milestone Tab ...........c........... 8-81

8.6 DWR Reference TabIes........cocvoiiiieiiiie e 8-84
8.6.1 DWR MaSLEI LISt ......eieeiiieiieiesiieiieeie et 8-84

8.7 Daily WOrk Reports HiStOrY ........cccueieiieiieiesiesieenie e 8-92
8.7.1 DWR HISIOIY ...eeiiieiiiie sttt 8-92
8.7.2 WOrk IEM HiSIOIY ..o e 8-93
8.7.3 CONtractor HISTOIY ......cueiieieeie e 8-94

0. PHPRIING ... 9-1
9.1 Pipeling EXAmMPIE.......ooiiiie e 9-2
9.2 PIpeling PAneIS........cooiiieieiie et 9-3
9.3 Server to PM PIpeline..........coi oo 9-4
9.3.1 Server to PM Pipeline SUMMArY.........ccceiiiiiiieieie e 9-5
0.3.2 DIHAIY SEIECE.......eecieeeecec e 9-6
0.3.3 DWR SEIECL.....c.eiitiiiiiieiiieiieee e 9-8
9.3.4 Change Order SEIECT..........coiiieii e 9-9
9.3.5 FOrce ACCOUNt SEIECT ........ccveieiiiiieiesece e 9-10
9.3.6 Downloading Data from the SErver ..........c.ccccooevieieiicciese e, 9-11

9.4 PM 10 Server PIPEliNe.........ccooui et 9-13
9.4.1 Pipeline SUMMAIY ......ccoeiiiiicieceece et 9-13
9.4.2 DIAry SEIECE.......ooovieece et 9-14
9.4.3 DWR SEIECL........oitiiiiiiieiieieeee e 9-15
9.4.4 Sample and Test SEIECt .........coevveiiiiieie e, 9-15
9.4.5 Uploading Data to the SEIrVEr ...........cccveiieiiiicieece e, 9-16

9.5 Pipeline INfOrmation ..........ccooi i 9-16
9.6 Daily Work Report Applicability .........cccovoviiiiiiiie e 9-19
9.7 Materials Management Applicability ... 9-20
9.8 SitePad SynChronization...........cceoviiiiiii e 9-20
9.8.1 SiteManager to SitePad Synchronization............cccccoevvevieiieciieeinenn, 9-22

10. CoNtractor PAYMENTS.......cccuiiiiiie it srae e s e e aea e 10-1
10.1 Reference Tables (Contractor Payments) .........cccceveeeeienenenenescseeeeeenes 10-3
10.1.1 Price IndexX MaintenanCe.........ccecveuerieereeieseeseeee e se e see e e e 10-3
10.1.2 Autopay MaiNtENANCE .........cccoeiviiirieiinieie e 10-10
10.1.3 Contract Discrepancy OPLiONS .........cccccevveriereniereneseseseseeeeeenens 10-14




10.1.4 Contractor Payment Approval Levels.........cccooviiiiiiinniniiienins 10-15

10.2 EStimate GENEIAtION ......ccveiuieieiiesiieie ettt 10-17
10.2.1 Types Of ESHIMALES .......ccveiieiiiiiieiiirieseeeee e 10-19
10.2.2 Estimate Generation Parameters ..........ccceveeeerieeneeieesieeseesiesenneens 10-23
10.2.3 Stockpiled Materials.............coeiiiiiiiiiiicc e 10-26
10.2.4 Other PrOCESSES ...cvveueeiiiesieesiesieesiiesieeeesteestesseesseesteeeesseessesseesseeseeas 10-28
10.2.5 Estimate History and SUMMArYy..........cccocerienienieenienneseeseeie e 10-34
10.2.6 EsStimate DIiSCrEPANCIES .........coverviriiriiriieiieieieie et 10-40
10.2.7 AGJUSTMENTS ... 10-43
10.2.8 Contract AdJUSTMENTS......ccveiviieiriiriirieseeiee e 10-44
10.2.9 Estimate APProval...........cocooiiiiiiiiiiiiicec e 10-79
10.2.10 EStimate REJECHION .....cveiiiiiiiieiiieiecee e 10-87
10.2.11 EStimate TraCking .......cccoooeiiiininiiinieieee e 10-89
10.2.12 Enter Check NUMDEK ........ccv i 10-91
10.2.13 Contractor Payment Approval Levels...........cccocooviiiniiiiicienn, 10-92

10.3 Reports (Contractor PaymMents).........cccoererererinienieiene e 10-92
10.3.1 Summary by Project REpOIt ..........cccovvirieiiiiieiese e 10-94
10.3.2 Summary by FUNding REPOIt ........cccovviiiiieiecies e, 10-100
10.3.3 Estimate ACHIVILY LOG ....ooveiviriiiiiiiiiieeeee e, 10-103
10.3.4 Installed WOrk REPOIt........cccoiiiiiiiiiieieeee e, 10-104
10.3.5 Work Suspend/Resume Times RePOIt........cccceverirerenenneiennen, 10-107

10.4 Process List (Contractor PayMEeNtS).........ccovrerireriieieenie e 10-108
10.4.1 SUDMITEING @ PrOCESS ......veviviiiiiiiisieeiieeee e 10-109
10.4.2 Setting Process Submission Parameters..........cccoveveeresieeinereene 10-110
10.4.3 Creating a Process Schedule ..., 10-113
10.4.4 Summary to Contractor REPOIt ..........ccccvvieiiiiciieieec e 10-119

11, CRANQE OFUEIS ..ottt sb et 11-1

11.1 Change Orders General CONCEPLS........ccvveiriieerieiieieesie e 11-2
11.1.1 Creation of a New Change Order.........ccccvevieieevieiiese e 11-3
11.1.2 Maintaining Change OFders .........ccevveieeie i 11-3
11.1.3 Review and Approval of Change Orders .........ccccccevveeveeveiicieenee 11-3
11.1.4 Tracking the Change Order........ccccevveiiiiieiee e 11-4
11,15 REPOIS .ttt 11-4
11.1.6 Change Order ConditionS..........cccvcvveiieeieiiieiie e 11-4

11.2 Change Order Panel...........cccoooveiiiii i 11-7
11.2.1 Reference Tables (Change Orders) .......c.ccoevveiiieiie s 11-7
11.2.2 Change Order Approval RUIES.........c.ccveviiiiiiiiicee e, 11-11
11.2.3 Change Order EXplanations ...........cccccovveiiiiiieiie e 11-16

11.3 Change Orders - Creating and Maintaining............cccoeeeveeviieeiecsiesieesinnn 11-21
11.3.1 Change Order Header ............ccoveeieeiiiiiie e 11-23
11.3.2 Change Order ILemS .......cccooveiieiieece e 11-33
11.3.3 Change Order Items Folder Tab.......c.cccoeviiiiieiieciice e, 11-34
11.3.4 Adding an Existing Contract Item to the Change Order ................. 11-35
11.3.5 Adding a New Item to the Contract through the Change Order

PIOCESS. ..ttt e 11-36

Vi



11.3.6 Maintaining Change Order Item Information.............c.ccecvevvieennn, 11-39

11.3.7 Change Order Time AdjUStMENTS..........ccereiererineneseseeeeeeeees 11-44
11.3.8 Change Order EXplanations ...........cccooeieeienenencne e, 11-49
11.3.9 Deleting, Replacing or Disassociating Explanations ...................... 11-55
11.3.10 Item SuMMAary Window ..........ccceiveieneenienie e 11-56
11.3.11 Selecting the Contract and Change Order...........ccocvvveviiverenennnns 11-58
11.3.12 Navigation to Other Windows from the Item Summary Window 11-58
11.3.13 Change Orders ReVIEW / APPIOVE .......cccoereiverenenenenieeeeieeennes 11-59
11.3.14 Change Order Review and Approval Sequence............cccceevenenee, 11-59
11.3.15 Multiple Review and Approval Cycles...........ccccocvvininiiiiiicnenn, 11-60
11.3.16 Change Order REVIEW PrOCESS .........cceveierierierienienie s 11-60
11.3.17 Forwarding for ReVIEW (CO) ....ccocveiiiieiiiesie e 11-60
11.3.18 Selecting or Deleting Reviewers for the Change Order................ 11-61
11.3.19 Change Orders - Onling REVIEW .........cccooeieiiieniniiineeeeieiee, 11-63
11.3.20 Accessing the Change Order Review Window ...........c.cccceevennee, 11-64
11.3.21 Recording Review Recommendations: ...........cccocvvvreninnnicnnennn, 11-65
11.3.22 Tracking Review Status and ReSUltS...........cccceveriiinniiiinieien, 11-66
11.3.23 Notices to Selected REVIEWES: ........cccveieieiieieniesie e 11-66
11.3.24 Forwarding for Approval (CO) ......ccccvivieieiiieiene e, 11-66
11.3.25 SeleCting APPIOVELS: .....ccviiieieriesieriesieeieeee et 11-68
11.3.26 Replacing APPIOVELS. ....c..oiviiiiiiiriesisieeieie et 11-68
11.3.27 Forward to User for Change Order Approval ..........cccoovvevviieinennn, 11-69
11.3.28 Online APProval.........cccoooiiiiiiiiiiieeee e 11-72
11.3.29 Accessing the Change Order Approval Window .............cccceeeeeee, 11-72
11.3.30 Recording Approval Recommendations: ...........c.ccocovvrvrvnieinenn, 11-73
11.3.31 Notices to Designated APPrOVErS........cceoeivererererenesieeeeeneenens 11-74
11.3.32 Tracking Review Status and ReSUltS...........cccooveiiiineniiiiicien, 11-75
11.3.33 SIgNALUIe PAgE......c.eeiiieiiieiiesie e 11-75
11.3.34 TraCKING ..cveieieiiiieieiee e 11-77
11.4 Reports (Change Order)........ccouiieieieeiese s 11-80
11.4.1 Change Order REPOIT ......c..ooiiiiiiiiiiieieeee e 11-81
11.4.1 Unapproved Change Order Aging RepOrt.........cccocvvivivninivniicnienn, 11-82
11.4.2 Change Order/Reason Code Breakdown Report.........cccccevvvvenennn, 11-84
11.4.3 Time Extension Granted Report (CO) ......ccoovvereniniiiniiieieiee, 11-85

12, CIVIE RIGNTS .o 12-1
12.1 ReferenCe TabIES .......coiiiieiieiiee e e 12-2
12.1.1 Wage DECISIONS.......eciviiiiieiie it esiie st 12-2
12.1.2 Training Programs..........ccuciieiieiieeiie e 12-11
12.1.3 System User Type Mapping .......cccceeveerieiiieeneeiie e sie e e enee s 12-15

12.2 ContraCt COMPHANCE .......coivieiiieiee e 12-17
12.2.1 DBE COMMITMENES .....ooviiiiiiiiiiiiiiiesieeeeee e 12-19
12.3 TTAINING coveeiii ettt e et e et eebeesaeeaaeeanee s 12-21
12.3.1 Contract Training Plan ..........ccccooviiiiiiiic e 12-21
12.3.2 TTAINEES ...t 12-22

12.4 Key Dates and Checklist Events for Civil Rights...........cccccooeiiiiiiiiiinnnn 12-35

Vil



12.4.1 DISCIEPANCIES ....veevierieiiieiteeiesieesteeste et steestesseesseesteeeesreesbeeseesneenneas 12-35

12.4.2 Accessing Key Dates and Checklist Events Windows.................... 12-35
12.4.3 SeleCt CONIACE .......ccoueiiieiiieie e 12-35
12.4.4 KEY DALES ...t 12-36
12.4.5 Checklist Scheduled EVENtS..........cccoovviieiiiiiiniieceee e 12-36
12.4.6 Checklist EVENt DAtES .......ccovviiiiiieiieie e 12-37
12.4.7 Document SUDMISSION ......ccviiieiieiiiie e 12-37

12.5 Contractor PAyrollS.........cooiiiiiiieiiee et e 12-38
12.5.1 Selecting a Contractor Payroll............cccoceviiiiiiniiiccecee s 12-39
12.5.2 Payroll INformation ...........cccooiiiiiiiiineeee e 12-39
12.6 Reports (Civil RIGNES)........coiiiiiiiiiie e 12-40
12.6.1 DBE StatuS REPOIT........c.ooiiiiiiiiieieiees e 12-41
12.6.2 DBE Breakdown RePOIT.........ccocciiiiiiiiiiieiec e 12-44
12.6.3 Commitments by CONEraCtor ............covveieieiieieiesc e 12-46
12.6.4 Quarterly DBE Commitments REPOIt.........cccoceveiirineninieieeenn, 12-47
12.6.5 Trainee Affirmative ACtion REPOIt........ccocvieieiininiiinieeeeeene, 12-50
12.6.6 Annual EEO REPOIT .....cviiiiiiiiiiieeee e 12-56
12.6.7 Wage SUIVEY REPOI ........oeviiiiiieieeeeeee e 12-61
12.6.8 Trainee Accrual Exceptions REPOIt .........cccooeiereniniininieicieenn, 12-64
12.6.9 Wage Rate EXCEPLIONS .......ocvevviiiiiiiiiieieeee e 12-66

13. Materials ManagemeNT.........cooiiiiiiiiieiee et 13-1
13,1 OVEIVIBW ..ottt 13-2
13.2 Materials Management REPOIS..........cccovvieieeieiie e 13-2
13.2.1 Generate @ REPOI.......ccoiiiiiiiiiiiie it 13-2

13.3 MALEIIAIS ...ttt 13-3
13.3.1 Materials INVENTOIY ........ccceiieiieiice e 13-4
13.3.2 Sampling and Testing ReqQUIrEMENts ............ccccevevvereiieseeie e 13-38

13.4 APPIOVE LISES ...ovveiiciiceicce ettt 13-45
13.4.1 Approved Materials..........cccoeoieiiiiiiiccicce e 13-46
13.4.2 Filter-Search Lens and Open —Search Lens ............ccccoevevveieinennn, 13-50
13.4.3 MaLerial USEI.......cviieiiiieiesie et 13-50
13.4.4 Sampler QUalifiCationS...........ccccvveiiiiiececseee e 13-55
13.4.5 WEIUEKS ...ttt 13-60
13.4.6 Calibrated EQUIPMENL.......ocoiiieiice e 13-66
13.4.7 Testand Fee Schedule..........cocoiiiiiiiiiiice e, 13-69
13.4.8 Producer/Supplier, Plants, and Materials...........c.ccccccooviveeiieennnnnn, 13-70
13.4.9 Qualified Labs........ccoceeiiiiiiii e 13-81
13.4.10 Tester QUalifiCatiONS ........ccceeeviiiiiiei e 13-86

13.5 ApProved LiStS REPOIS ........civiiiieiiieiie et 13-91
13.6 CoNtraCt MAterialS .........ccveiieiiiiiiiee e 13-92
13.6.1 Building the Contract Materials LiSt............cccceviiviiiiiiiiicciee, 13-93
13.6.2 Maintaining Contract Materials LiSt ............cccoeviiviiiiiiiicciec, 13-95
13.6.3 Contract Sample and Testing Requirements...........cccccceevveerveennnne, 13-95
13.6.4 Materials Folder Tab ... 13-96

13.7 MiIX DESION .ottt 13-102

viii



13.7.1 Bituminous Concrete MiX DeSIgNS........ccccervererieneniiesen e 13-103

13.7.2 Portland Cement Concrete MixX DeSIgNS..........ccocevvrvreninnneienen, 13-140
13.7.3 Aggregate MiX DESIGNS........ccovriririiieieienesie e, 13-156
13.7.4 Mix Design APProval.........cccocoiiiiiiiiiieiene e, 13-167
13.7.5 Pavement Structural Design Data ...........cccceoeviieniiininiieieee, 13-168
13.7.6 Aggregate BIend...........ccoooeiiiiiiiiie e, 13-174
13.7.7 CONrACE MIXES ...cveeieieieeie et 13-176
13.7.8 Contract Mix Design Adjustment ...........cccceoeieieninenesieeieee, 13-177
13.7.9 Mix DeSign REPOITS .....cveviiiiiiiiriisieieee e 13-179

13.8 Sampling and TESEING ......cceiiririeieie e 13-180
13.8.1 Maintain Sample Information .............cccoeveieniiiineseeee, 13-181
13.8.2 Find Sample — Sample Tracking .........ccccoceveniieniiiniinieeee, 13-214
13.8.3 Sampling and Testing ReqUIrEMENtS ........cccceverenerereneeieee, 13-217
13.8.4 Standard Sample RemMarks ..........cccooiiiiienincieeee, 13-217
13.8.5 Sampling and Testing REPOITS .........cccoveieieiiiiieneereseeeeeee, 13-218

13.9 Process List (Materials Management) ...........ccoceeveerenenenenenesieeeeens 13-219
13.9.1 SUDMITING @ PrOCESS .....c.eeviviiiiiiiieieeiieee e 13-220
13.9.2 Sampling Checklist REPOIt ..........ccoovviieiiee e, 13-230
13.10 Pipeline Applicability .........cooveiiiiiiie 13-232
13.11 Sampling and Testing ProCEAUIES ..........cccoreririeiieiieie e 13-233
14. SiteManager LIMS AdMINIStration ..........ccocoiiiiiininiiieieesee e, 14-1
14.1 Defining Alternate Test WOrkflow...........cccoovveviiiiiiciicececece e 14-2
14.2 Defining Test Triggered EVENtS.........cccovvieiieie i 14-5
14.3 Maintaining Test Assignment Information...........c.ccccoevveveiiieii e 14-9
14.3.1 Adding and Removing Default TeStS........ccccovvveviveiiiieiieie e, 14-11
14.3.2 Default TeSt SEttiNGS ......ccovevviiieiieie e 14-11
14.3.3 Autofinalize SettingS......ccoveiviiiiiieie e 14-12

14.4 Maintaining Destination Labs for Lab UnitS.............ccccoeeveveiieviccccienen, 14-13
14.4.1 BypasSing LabsS........ccccveiiiiieiieiiese e 14-14
14.5 Maintaining Lab USEIS .......ccccouiiiiiiiiie et 14-14
14.5.1 Adding and Removing Lab Unit Privileges..........cccccoveiiveieinenn, 14-16

14.6 Maintaining ProducCt USEIS ...........coveiiiiiiecie ettt 14-16
14.6.1 Adding and Removing Product Group Privileges........c..ccceevevennen. 14-18

14.7 Defining ProduCt GrOUPS.......cc.eiieiieieieesie et ste ettt 14-18
14.7.1 Adding and Removing Product Groups .........cccceevverieieeseeniesneenn, 14-20

14.8 ReCeIVING SAMPIES ....ooiiiiiie et 14-20
14.8.1 Receiving Samples at Destination Lab.............cccceevveiiiiiieciecnnnnnn, 14-21
14.8.2 Select Sample LOCAtION.........ccvveieiiiiciie e 14-22
14.8.3 FIlter Criteria....ccoiieieiieieeieee et 14-23
14.8.4 Moving and Adjusting ColuMNS .........cccveviiiiieiie e 14-24

14.9 Receive Sample in Lab UnNit........cccccooiiiiiiiiic e 14-24
14.9.1 Receivinga Sample in Lab Unit .........cccoviiiiiiiiiiiii e, 14-26
14.10 Maintaining Group Security Within LIMS.............cooo i, 14-27
14.10.1 Adding and Removing Group Security Privileges.........ccccccoevu..e. 14-27
14.11 Entering TeSt RESUILS......cc.viiiiiiieiie e 14-28




14.11.1 Test Queue Criteria ChOICES ........covvveiiveiiiiiiecie e 14-30

14.12.2 FIEr CrIteria....ccvieeieieieieceeeie st 14-31
14.11.3 How Qualifications Determine Available Tests.........cccccceevvvrnnns 14-31
14.11.4 Material TeSt TEMPIALES.........ccciriiiiiiiiicee e 14-31
14.11.5 The Test Workflow in LIMS ..., 14-31
14.11.6 REQUEUEH TESES ...t 14-32
14.11.7 Ordering RELESES.........coveiiiiiiiiiiire e 14-32
14.11.8 Types of REMArKS........ccoeiiiiiiiiiieee e 14-32
14.10.9 PrIOMIEY . coeiieiiticeieieeeee et 14-32
14.11.10 TesSter ASSIGNMENTS ....ccvveveiieiieerieeee e sieeee e ie e neeas 14-32
14.11.11 DUE DS ......veeiiviiiieiiiieeereeee e 14-33
14.12 REVIEWING TESES ...evieieiiieiiietesiee et stee ettt neesreente s sneese e 14-33
14.12.1 TSt QUEUES ... .ceiuieiiie ettt sttt 14-37
14.12.2 Reviewing Tests as a Level 1 ReVIEWEr ..........ccccvvcvieriiiniienienn, 14-37
14.12.3 Reviewing Tests as a Level 2 ReVIEWEr ...........cccccvvivniinnicnienn, 14-38
14.12.4 ReqUEUING TESES ...ueiiiiieieieriesie st 14-38
14.12.5 Ordering RELESES.......coieriiiiiirie i 14-38
14.12.6 Excluding Test Results from Reports ..........cccocevvvivienininnieienn, 14-39
14.13 Maintaining TeSt QUEUES ........ccveieieierierie st 14-39
14.13.1 Understanding TeSt QUEUES ..........ccerererieiieiienieniesie s 14-42
14.13.2 Adding Tests t0 SAMPIES........ccciiiiiiiiiiicee e 14-43
14.13.3 Assigning Priorities and Due Dates ..........ccccceverinineninnnieienn, 14-44
14.13.4 Assigning Additional TESLErS.........cccvrieieieierere e 14-44
14.13.5 Assigning Tests to Different Lab UNitS.........cccoveveveiieniveieniinnnns 14-44
14.13.6 CanCeliNg TESES ....c.eeieieieiierie et 14-45
14.13.7 Understanding TeSt STatUS..........ccorvririeiieiiie e 14-45
14.14 REVIEW SAMPIES ..ot 14-47
14.15 ProduCt REVIEW GIOUPS.......ccviiiiiiiiiesie sttt 14-47
14.16 View-Only Sample INfOrmation ............ccoceveiiiiineieieiesccsese e, 14-47
14.16.1 Using the Generic Filter Criteria........coooovieieieneniiinieieieen, 14-48
14.16.2 FIEr CrIteria.....cveeeeeeieieiieiie st 14-49
14.16.3 Creating NeW FIlters ..o 14-49
14.16.4 Understanding Sample Information VIews ...........c.ccoovviinicinenn, 14-50
14.17 Review Samples WOrKfIoW ..., 14-58
14.18 Viewing and Comparing Test RESUILS .........ccccvriireieiiiinceeeeee, 14-60
14.18.1 Viewing and Comparing Multiple Test Results for a Sample ...... 14-62
14.19 Accepting Test Results and Indicating Completion Status....................... 14-63
14.20 FINalizing SAMPIES .....ooviiiiiiiee e 14-63
14.21 Sending Tests Back to the Lab ..., 14-64
14.22 Approving a Sample Rather than Authorizing a Sample ...........cccceenee. 14-64
Understanding the Impact of Authorizing or Approving Samples.............. 14-65
14.23 USEE SEIINGS ...cvvevveeeieiie ittt 14-66
14.23.1 CUSTOMIZING VIBWS ..ottt 14-66
14.23.2 Updating LIMS .......cooiiiieeeeeee e 14-66
14.24 General AUdit Trail ... 14-66




APPENAIX AL GIOSSANY ...ttt sttt nbe e anes 0-1

Appendix B: SiteManager Navigation ............cccecviieiieriiieseee e 0-1
Appendix C. Estimate Generation Calculation..............ccccooiiiiiiniiiinencees C-1
C.1 Delete Pending EStIMALE ..........cccveiiiieiieiie e C-3
C.2 Calculate Contract AQJUSIMENTS ........ccovivieiierieeie e e C-4
C.2.1 Applying Liquidated Damages — Working Day Contract..................... C-4

C.2.2 Applying Liquidated Damages — Calendar Day Or Fixed Completion
Date CONMIACT .......eeiiieieee e C-5
C.2.3 Applying INcentives/DISINCENTIVES .........cccecveieeieiiieieesie e seesie e C-6
C.3 Calculate Price AdJUSIMENTS.......cccueiuiiiieieerieeee e C-11
C.3.1 Rounding Method..........ccciviieiieieiie e C-14
C.3.2 EXAMPLES ... .ottt C-14
C.3.3 Calculate REtaIiNAgE ........cccvvveieiiieiieeie et C-16
C.3.4 Determine Initial Stockpile Payment.............ccccoovveiiiieiieve e, C-17
C.3.5 Calculate Stockpiled Materials............cccccveveiieieere e, C-17
C.3.6 Determine Quantity To Be Paid ..........cccccveviiieiieiece e, C-21
C.3.7 Auto Deduct Payment for Overrun emS........c.ccceevvveeevvereeieeseennn, C-24
C.3.8 Determine Training IEMS........cccoeveeiieiieiicie e C-26
C.3.9 Identify DIiSCrEPANCIES ......ccveveireeiieeie et C-27
C.3.10 Determine FUNding AMOUNES ........cccocvveiveiiiiieie et C-30
C.3.11 Calculate Autopay ItemMS..........cccieeiieiieiieie e, C-33
Appendix D. Retainage Calculation .............ccccoveiiiiiiieie e D-1
D.1 Calculating RetaiNage ..........coueiiiierieiiieeee e D-3
D.1.1 Retainage Calculation EXamples..........ccccoooiiiiiiiniiiiniiesc s D-4
D.1.2 EXAMPIE L. D-6
D.1.3 EXAMPIE 2. D-15
D.1.4 EXAMPIE 3. D-22
D.1.5 EXAMPIE 4. D-30
D.2 Application Of REtAINAGE ......c.coveiviriiiiieieiee e D-48
D.2.1 Application of Retainage EXamples...........ccoooomirieiiiiiencneneeen D-48
Appendix E: Materials Sampling and Testing Calculations..............c.ccocvvviiinnnnn. E-1
E.1 Important Terms t0 KNOW .......c.coiiiiiiiiieiiiie s E-3

E.2 How Sampling and Testing Requirement Criteria Priority 1, 2, 3, 4 are Used
EXAMPIE L oo E-4

E.3 Use Satisfied Represented Material Qty in Discrepancies Process Examples
2 AN .ttt r et be et e nre s E-5
E.3.1 EXAMPIE 2o E-6
E.3.2 EXAMPIE 3 .o E-6

E.4 How the Use Satisfied Represented Material Qty in Discrepancies Process
Indicator Is Used, EXamMPIe 4 .........ooviiiiieee e E-7
E.5 How the Use Satisfied Represented Material Qty in Discrepancies Process

Indicator Is Used, EXamPpPle 5 .....ccovviiiiiii e E-7

Xi



E.6 How Samples Meet Contract Sampling & Testing Requirements Based on

System Operational Parameters, EXample 6 ..........c.cccooeiiiinininiiieeee, E-8
E.7 How Samples Meet Contract Sampling and Testing Requirements Based on
System Operational Parameters (EXample 7)., E-10
E.8 Material Discrepancy Payment Calculation Explanation............ccc.cceevvnnen. E-12
E.9 Material Discrepancy Payment Adjustment Example 8.............ccccvvvvienennee, E-13
E.10 Material Sampling and Testing Discrepancies in the Estimate Generation
PrOCESS. ...ttt E-14
E.10.1 Recalculate Estimate Discrepancies ProCess ..........c.ccoverererveeenenn E-14
E.10.2 Material Discrepancy Payment Based on Satisfied Represented
Quantity in the Estimate Generation Process..........cccceevververeeseennnn. E-15
Material Discrepancy Payment Adjustment Example 1.........cccocooininiiiiicneen, E-16
Material Discrepancy Payment Adjustment EXample 2.........ccccoovevvvieniveneiiennnnn E-17
Appendix F. Assigning Multiple Subcontractors to a Single Contract Item.......... F-1
F.1 Part of the Quantity — Each subcontractor is responsible for installing a
portion of the total approved quantity of a contract item...............ccceeeveenen, F-2
F.2 Part of the Item — Each subcontractor is performing partial work on the total
approved quantity of a contract iteM...........cccccoeveiiii i F-6
Appendix G. Assigning Multiple Contractors to a Single Item............c.ccccoveienee G-1
G.1 Part of the Quantity — Each contractor is responsible for the complete item
OF WOTK .ottt es G-2
G.2 Part of the Item — A contractor is performing partial work on the whole
QUANTITY ..kt b ettt G-5

Xii



1. Introduction

1-1



AASHTOWare Project SiteManager
1. Introduction 1.1 Document Structure

1.1 Document Structure

The SiteManager User Reference Manual is a reference document for users of the AASHTO
SiteManager application. The user should refer to this manual only when a question cannot be
answered by referring to the SiteManager online help system. This manual describes all of the
SiteManager components, including their purpose, functions, and how to use them.

The SiteManager application is organized into the following eight major functional areas, which are
represented by icons on the main panel:

e Contract Administration
e Daily Work Reports

e Pipeline

o Contractor Payments

e Change Orders

e Civil Rights

e Materials Management

e Laboratory Information Management System (LIMS)

This manual is organized into the same eight functional areas plus introductory and supplemental
information. The topics Key Dates, Checklist Scheduled Events, and Checklist Event Dates are
covered in a separate section of the manual due to their importance throughout the life of the
Contract. The manual’s main sections are described below:

Section 1 Introduction

The Introduction describes the structure and objective of this manual. Refer to this section for an
overview of the manual’s topics, or to find out how this manual is intended to be used.

Section 2 Getting Started

The Getting Started section includes information to help the user get started using SiteManager.
This includes information about starting and exiting SiteManager, changing your password, and In-
Box message functions. This section also includes descriptions of SiteManager’s graphical
components and how to use them to navigate within the application and to accomplish tasks.

Section 3 General Concepts

The General Concepts function describes the menus, toolbars, and the components that are common
throughout the application. It includes common procedures for using online help, security, and
reporting.
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Section 4,5,and 6 Contract Administration

The Contract Administration section describes the reference tables that store standard Contract data,
such as default date types, Contract Item descriptions, and Vendor information. It provides an
overview of how to add Contracts to the system, and describes each panel that is used to view,
modify, or delete Contract data. It also describes the panels that are used to maintain data related to
Contracts, such as Contractor (Vendor) information, conference records, force accounts, dispute
records, evaluations, correspondence records, required documents, and Contract reports. This
section also describes how the system validates Contract status and how the Project Manager
finalizes a Contract.

Section 7 Key Dates, Checklist Scheduled Events, Checklist Event Dates

This section describes how the user views and maintains Key Date and Checklist Scheduled Event
data. This data is used to administer the Contract and to monitor compliance with Civil Rights
provisions.

Section 8 Daily Work Reports

The Daily Work Reports section explains the concept of reporting, transferring, and storing daily
Contract activity data. This section defines the data that is collected by the Daily Work Report
function, and describes how to record the data on SiteManager panels. It also describes how Daily
Work Reports are approved, combined to make Diaries, and maintained in the database.

Section 9 Pipeline

The Pipeline section describes the SiteManager components that are used to upload and download
data to and from the Server database, and to transfer data from one workstation to another in the
field. These components are provided specifically for the Project Manager and Inspector who must
transfer Contract data, Materials data, and Sample and Test data. This section explains how Pipeline
is used in conjunction with the Daily Work Report function and Materials Management.

Section 10  Contractor Payments

The Contractor Payments section describes the estimate generation process and the reference tables
that store data related to Contractor Payments. This section defines the estimate types and
generation parameters, and gives an overview of calculations performed by the system. It explains
how the system identifies Contract discrepancies and how the user can adjust Contracts and Contract
Items. It also explains the estimate approval cycle and the Contractor Payment reporting options.
The reference tables described in this section define the price adjustment indices, Autopay Items,
discrepancy options, and Contractor payment approval levels.

Section11  Change Orders

The Change Orders section describes the Change Order reference tables, types of Change Orders, the
approval process, and Change Order reporting options. It explains how the user creates and tracks
Change Orders.
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Section 12 Civil Rights

The Civil Rights section describes the reference tables and panels used to add and monitor data
related to Civil Rights. These components let the user define programs, maintain trainee records,
monitor compliance with DBE commitments, record wage decisions, and run reports on these
records.

Section 13 Materials Management

The Materials Management section stores Materials information, including inventory, specifications,
testing requirements, mix designs, and lists of approved suppliers, personnel, labs, equipment, and
fees. It explains how to build and maintain a Contract Materials List, how to enter sample data and
track test results, and how to run reports. It also provides online access to sampling and testing
procedures.

Section 14  Laboratory Information Management System (LIMS)

The Laboratory Information Management System section streamlines the sampling and testing
workflow from recording a sample to reviewing and authorizing samples. It explains how to capture
sample details, assign default tests, assign and receive at destination lab, and how to enter test
results, review test results, and authorize.

Appendix A Glossary
The Glossary defines terms used in the SiteManager application.
Appendix B SiteManager Navigation

This appendix includes an overview map of the SiteManager application and detailed maps for each
functional area of the application.

Appendix C Estimate Generation Calculation

This appendix describes the components of the estimate generation process and explains how the
system calculates the values reported on an estimate.

Appendix D Retainage Calculation

This appendix describes one component of estimate generation, retainage calculation, which
involves relatively complex calculations. Examples show the calculation results.

Appendix E  Materials S & T Calculations

This appendix gives an overview of the parameters and calculations for comparing sampling &
testing results to contract sampling & testing requirements.

Appendix F  Price Index Adjustment Calculation

This appendix gives an overview of the methods used by the system to calculate price adjustments.
Examples show the calculation results.
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1.2 Objectives

This document serves as a supplement to the SiteManager and SiteManager LIMS online help
system. The user can refer to this manual for information that is not covered in depth in the online
help. This includes field descriptions, expanded topic discussions, calculations performed by the
system, error message definitions, and system administration functions. Some of this information is
presented as separate appendices in this manual.

This manual assumes that the user is authorized to use every function provided by the application.

In actual usage, some SiteManager functions can only be used by the System Administrator, Project
Manager, or central office personnel with global Contract authority. Some users will have view only
rights to certain panels. In most cases, this manual does not identify the transportation agency
personnel who will have the authority to use each function; this is done by the transportation agency.

The transportation agency should keep at least one copy of this manual in every office for occasional
reference. The local technical support personnel should have a copy of this manual as part of a basic
reference set.

1.3 Procedures

SiteManager Procedures, the steps the user follows to access a component of SiteManager, vary
depending on whether the user has just entered the system or has been in some other component and
has already selected a common variable.

For instance, if the user enters the application and navigates directly to the Contractor Payments
component, the Estimate Summary window requires the selection of the desired Contract and
Estimate.

However, if the user has been working in the Contract Records component, already has a Contact
selected, and then navigates to the Contractor Payments component, the Estimate Summary window
displays for selection the Estimates for the Contract previously selected in Contract Records.

Note: The procedures in this manual describe how to access components of
SiteManager as if the user just entered the application.
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2.1 Understanding the General Workflow

2.1.1 AASHTOWare Project SiteManager Software

SiteManager is a comprehensive construction management and lab information management
software product that covers the complete construction and materials management process from
contract award through contract finalization in one enterprise-wide software package.

2.2 Starting and Exiting SiteManager

2.2.1 Starting SiteManager

The AASHTOWare Project SiteManager Construction Management

System is a Windows application, which will run on several different #
windows graphical user interfaces — Microsoft Windows XP and

Microsoft Windows Vista. For your operating system, you will start Figure 2-1.
SiteManager the same way you would any program on your computer. The SiteManager Icon

In Microsoft Windows, the SiteManager program will be located with its own icon displayed on the
main desktop, as illustrated in Figure 2-1.

For Microsoft Windows XP and Windows Vista

To start on the AASHTOWare Project SiteManager system:
1. Double-click the SiteManager desktop icon.

Type your logon identification name.

Press the Tab key.

Type your password.

a > w N

If appropriate in the Connect to drop-down list, click the expand arrow to the right of the
current selection and click the desired database choice.

o

Press Enter.
7. If appropriate in the Available Group for ... dialog box, click the group ID.

8. Press Enter.
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SiteManager Logon |

Trns port

SiteManager
ﬁT g

Construction Management Software

Uszer ID:||

Password: |

Connect to: | S erver ﬂ

| Logon I Change Passwuldl Close I

Copyright € 1336 by the American Azsociation of State
Highway and Tranzportation Officialzs, Inc.
444 Morth Capitol Street, MW, Suite 249
YW azhington, D.C. 20001 US54, [202] 624-5800

|Enter the Uszer Login 1d.

Figure 2-2. The SiteManager Logon Dialog

Available Groups for S¥YS1 |

Group Hame

|DCE [District Construction Engineer
JFED [Federal
fInptdar [Inspectar Mar

ING [Inguiry Only

Select the Group for the session. (1] 4

Figure 2-3. The Group Dialog Box

2.2.2 End-User Security — Changing Your Password

In addition to your network logon identity, SiteManager also has password protection. Your
SiteManager ID determines what information you have access to and whether you can update the
data or not. If you have any questions regarding your SiteManager security access, contact your
SiteManager system administrator.
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Change Password for S¥S1 X

2.2 Starting and Exiting SiteManager

Old Pazsword: ||

Mew Pazsword: |

Confirm Pazsword: |

oK

Cancel

|Eriter the OId User Password,

Figure 2-4. The Change Password Dialog Box

When a user fails to logon to SiteManager successfully after 3 attempts, a message appears advising
the user to contact the System Administrator. The System Administrator resets the user’s password.
The password is always reset to PASSWORD and is case sensitive. When any User logs on using
the default password PASSWORD, the only option visible (besides Cancel) is the Change Password
option. Users are forced to change their password before they can access the application.

There is an exception to the rule that 3 failed logon attempts lock the users out of the system. An
Inspector using SiteManager in standalone mode may have an infinite number of failed logon

attempts without being locked out of the system.
To change your password:
1. Start SiteManager.
On the logon screen, type your old password.
Click the Change Password button.
Type your old password.
Press the Tab key.
Type your new password.
Press the Tab key.

Type your new password, again.

© o N o 0 ~ w N

Click Ok.
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2.2.3 Exiting SiteManager

As with all Windows applications, the File menu’s Exit choice allows you m_-q-
to end your SiteManager work session and exit the application.

Additionally, SiteManager has an Exit button on the Toolbar that is even
more convenient. If you have been performing work and have changed
your data (or even if SiteManager is not sure) a warning message will
allow the data to be save before the application is closed or to cancel the
exit process.

Figure 2-5. The Exit Button

To exit SiteManager:
1. Click the Exit button.
Or
2. Click the File menu and click the Exit choice.

3. If appropriate, click the Yes or No button.

'\?) Save changes?

Mo | Cancel |

Figure 2-6. The Exit Warning Message

2.3 SiteManager Main Panel

After starting the SiteManager application, the SiteManager Main Panel will display the components
of the system as icons. The central functionality of SiteManager is divided into ten icons: Contract
Administration, Daily Work Report, Pipeline, Contractor Payments, Change Order, Civil Rights,
Materials Management, Accessories, System Administration, and Manuals. The icon representing
SiteManager Lab Information Management System (LIMS) is embedded within the Material
Management- Maintain Sample Information window.
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= SiteManager, Panel

S ManPanel ] Change Ordersl+] ]
S [ 4 © m X
O 5 by

Contract Daily "wark, Pipeline]+] Contractor Change Civil Rights[+] I aterialz

Adminigtration[+]  Reports(+) FPayments(+] Orders(+] i anagement(+]
L1 =

i 0 5

Acceszones(+] b anualz(+] Reparts

Administration(+]

Figure 2-7. The SiteManager Panel

2.3.1 Security and the SiteManager Components

The panels and icons to which an end-user has access are defined by the transportation agency. The
panel above and all following documentation will describe and illustrated the content of the all
components of SiteManager. A given end-user’s panels may not conform to the illustrations
(figures) unless they have security access to all components of SiteManager.

2.3.2 The SiteManager Status Bar

The SiteManager Status Bar at the bottom of the SiteManager window indicates your mode,
connection, database region, logon group and individual ID.

|Ready [Server [STest |[Inspl [traint

\ ey

Mode Connection Region Group ID Logon ID

Figure 2-8. The Status Bar

Panel Icons - SiteManager Functional Areas

Icon Description
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Icon

Description

i

Contract
Administration

Automates recording of important Contract data, including
Contractor contacts, Contractor documents, and plan
discrepancies.

Automates verification of Contractor payrolls.

Provides a mechanism to modify a Contract and document that
change.

Tracks critical dates for recurring contract items and special events.
Calculates liquidated damages and contract retainage.

Supports Contract Management with reference table viewing and
maintenance for funding sources, item masters, vendors, and
administrative offices.

Allows SiteManager users to enter and maintain SiteManager
Contract data, including project items and funding.

Controls Contract access through Contract specific and
administrative office authority.

Maintains Contractor and Subcontractor details.
Assists project management by tracking Contract status.

Furnishes capability to monitor Contract disputes/claims.

Daily Work Report

Collects Inspector Daily Work Reports data, field samples, field
tests, and stockpiled materials used.

Automatically transfers (download) base Contract data for
reference (Contract items, quantities, etc.).

Collects and maintains Contractor data including Contractors
working, work performed, and equipment used.

Collects and maintains installed item quantities, weather conditions,
staff/consultant hours, and Force Account information (labor,
equipment, and materials).

Links to reference documents stored in third party packages such
as word processors, spreadsheets, sketching tools, etc.

Allows on-line review of the Daily Work Report and authorization for
incorporation into the Estimate process.

Allows collected data on a laptop or pen-enabled laptop computer
in the field or a workstation in a project office to be transferred
(uploaded) to the SiteManager database.

Pipeline

Allows the Project Manager and Inspector to upload and download
data.
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Icon Description

. Automatic generation and approval of payment estimates, based on
. the Contract and any Liquidated Damages, Contract Adjustments,
o and stockpiled data.

Automatic calculation of DOT-defined adjustments for liquidated
damages, incentives, disincentives, and Contract item price
adjustments.

Contractor Payments

Automatic calculation of retainage amounts, encumbered amounts
for securities, and escrow accounts, based on Contract parameters.

Discrepancy reporting and resolution during the estimate process
for certified payrolls, DBE commitments, item overruns, and
material testing deficiencies.

Tracking the estimate from the generation process through the
approval process.

Creation of voucher data from the payment process which can be
used as input to a DOT-specific financial management system.

Automatic management of stockpiled material as the material is
being used.

Provide Stand Alone capability (i.e., Installed Work Summary
Report).

Ensures Contractor acceptance of changes by including
0 Contractors in change order review and approval process.
Ensures consistency in the change order process.

Change Order Establishes, maintains, and approves Force Accounts which
includes details on labor, equipment, and material cost.

Tracks review and approval process to ensure accountability.

Assists in future planning by providing a means to track and identify
reasons for change.

I Automates recording and tracking of Disadvantaged Business
m Enterprise goals/commitments, including the ability to track DBE
= work performed on non-goal contracts.
Civil Rights Automates generation of Federal Highway Administration DBE

report detailing the level of DBE earnings on federal contracts.

Allows for planning and tracking of contract On-the-Job Training
goals, including number of trainees, number of hours, and wage
rate adjustments.

Automates reporting of potential wage rate violations based on pre-
defined Department/DOL wage decisions.

Automates generation of annual Equal Employment Opportunity
reports based on contractor payrolls.

Automates accrual of department trainee experience (even across
contracts) based on contractor payrolls and alerts department
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Icon Description

personnel to potential violations

Automates tracking of training experience on non-department
contracts.

Maintains Material Information.

X Documents Sampling and Testing for a Contract or Client.
Incorporates Sampling and Testing requirements.
Material Management Maintains Approved lists.

Creates and maintains five types of Mix Designs.
Provides thirty Test windows.

Provides Stand-alone capability (Sampling & Testing and Approved

list).
Groups SiteManager Lab Information Management System (LIMS)
U_ﬂ5 process functions into one area and provides a point of access for
ol | LIMS users.
Lab Information Integrates seamlessly with Material Management to streamline the
Management System sampling and testing workflow from recording a sample, to

reviewing, enter test data, and authorizing the sample.

Provides Stand-alone capability

Allows access to the In-Box, SiteManager’s e-mail facility and to the
5”5 Process Status Monitor.

Accessories

Groups SiteManager system functions into one area and provide a
single point of access for System Administrators.

Provides comprehensive security features with flexible

System Administration administration.

Facilitates adding of custom templates.

Allows access to on-line versions of the User Reference Manual
!'E-E‘i and Sampling and Testing Procedures.

Manuals

Allows a user to navigate directly to agency defined custom reports

E and documents.

o]

Reports

Reports
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Table 2-1. SiteManager Icons Table

2.3.3 Navigating in SiteManager Using the Main Panel

The SiteManager Panel is used to navigate to the components of the SiteManager application. The
highest level is the SiteManager folder tab that contains the different functional groups, with each
group individually represented by an icon. Double-clicking the icon of a functional group brings up
another folder tab consisting of the sub-groups or the actual windows contained within that
functional group. As icons are selected, the next level’s folder tab appears next to the previous level.

To select a main panel component of SiteManager:
1. Double-click the component’s icon.
To select up or down a level in SiteManager:

1. Click the level’s folder tab.

Click the folder tab to go Double-click the component’s Click the folder tab to go
up a level ¥ / icon to open it , down alevel
Main Panel ’[ | Materials Management(s] Material Information(+)
Y s I v
& = = il
Material Material Contract Contract Material — Approved Approved Lists  Mix Design[+]
[nformation{+] Information b aterialz(+] Reports[+] Lists[+] Reports(+]

Report[+]

=g B B

b Dezighn Sampling and  Sampling and
Fieports[+) Testing(+) Testing
Reports(+)

Figure 2-9. Navigating in SiteManager

2.4 Accessories

The Accessories panel provides access to the SiteManager communications and process monitoring
components. These components include:

= [n-Box,
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= Distribution List,
=  System Attachments,
= Process Status Monitor, and
To access Accessories:
1. On the Main Panel, double-click the Accessories icon.

2. Double-click the icon of the desired Accessories component.

(E¥SiteManager Panel | | | | | |1 L] ] L e

Main Panel T Accessories[+) ]

Y 12

Distribution List User Job Moritor _ Custom List ~ ADHOC Query  View Saved System
Record Usage Tool Reports [PSR]  Attachments

Process List

Figure 2-10. The Accessories Panel
2.4.1 In-Box Concepts

The SiteManager In-Box provides three types of electronic messaging:

= User generated messages using the SiteManager In-Box, E
= Access to compatible electronic mail systems, and

Figure 2-11.
= System Generated Messages received in the SiteManager In- The In-Box Icon

Box.

In-Box E-mail Capability

The SiteManager In-Box provides electronic mail capability for users, allowing them to send and
receive electronic mail messages to each other through SiteManager mail. SiteManager users can
send, receive, reply, forward and print SiteManager mail, but cannot send attachments. Users also
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have the option to delete a single message or, if desired, several messages at a time. When a user
deletes mail messages, SiteManager marks them for deletion so they will no longer appear in the
user’s In-Box. The marked messages are retained until the next archival process, when SiteManager
will permanently delete the messages.

ﬂln-an _ (O] x|

User Name D ate-Time Subject =l
0423539 15:54:02  |Change Order Approval Cycle
04/13/99 17:13:29 |Estimate Nbr D002 of Contract ID 011999 Awaiting

Spztem Administrator 1

o oL

Figure 2-12. The In-Box Window

Additionally, SiteManager’s In-Box provides menu level access to DOT’s native mail system. The
native mail system must conform to one of two messaging standards:

= Messaging Application Programming Interface (MAPI) or

= Vendor Independent Messaging (VIM).

Mail systems, such as Microsoft Mail or Exchange are MAPI compliant while packages such as
Lotus Notes and CC:Mail are VIM compliant.

Although SiteManager provides a menu option to access the external mail, it does not display the
external mail message headers in SiteManager.

In-Box as a Workflow Manager

In addition to SiteManager mail and external mail, the In-Box acts as a workflow manager by
routing System Generated Messages to the appropriate users. These messages are automatically
generated by SiteManager and provide any number of users with access-specific SiteManager
functions. System Generated Messages are primarily used to automatically jump to specific
windows when further action is required by a user.

For example, when the user generates an estimate, SiteManager delivers a System Generated
Message to the user’s In-Box.
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After the user opens the In-Box message,

= |f the estimate generation was successful and the request was for a progress or final
estimate, SiteManager will display the Estimate Summary window.

= |f the estimate generation was successful and the request was for a supplemental estimate,
SiteManager will display the Contract Adjustments window.

= |f the estimate generation was unsuccessful, then SiteManager will display the Estimate
Activity Log report.

Using the In-Box
The In-Box is accessed using the Accessories panel.
To start the In-Box:

1. Double-click the Accessories icon.
2. Double-click the In-Box icon.

To open a mail message:
1. Click the message.

2. Click the Services menu and click the Read Mail choice.
To close a mail message:

1. Click the Close button.
To check for new mail messages:

1. Inthe In-Box, click the File menu and click the Refresh choice.
To delete a mail message:

1. Click the message to be deleted.
2. Click the Delete button.

To delete two or more mail messages:

1. Press and hold down the SHIFT key.
2. Click the first and last mail message in the range of messages to be deleted.

3. Click the Delete button.

To delete two or more mail messages that are not in a range:
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Select the first mail message to be deleted.
Press and hold down the CTRL key.

Click each one of the remaining mail messages to be deleted.

A w0 P

Click the Delete button.
To print a message:

1. Open the message.

2. Click the Print button.
To close the In-Box:

1. Click the File menu and click the Close choice.

Replying to or Forwarding a Message

When a message is opened, the Reply and Forward menu choices allows the user to reply to or
forward a SiteManager message to other SiteManager users. When replying to a SiteManager
message, the original mail message is not attached with the reply message. When forwarding a
SiteManager message, the original message is included.

¥ Reply From Project Manager 1 | _ (O] x|
From: |Proiect Manager 1
TO: [Project Manager 1

CC:|

Subject: |Fleply - Forward Submitted Documents

Message
The Document # 1 For Contract #5ITEMGR_30 is available for review

|

Kl I
Reply
[From : Project Manager 1 |

To: Project Manager 1
CC: b
Subject : Forward Submitted Documents

Ki e

Figure 2-13. The Reply Window
To reply to a message:
1. Open the message.

2. Click the Services menu and click the Reply choice.
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3. Click to place your insertion point below the subject in the text area.
4. Type your reply.
5. Click the Services menu and click the Send choice.
To forward a message:
1. Open the message.
2. Click the Services menu and click the Forward choice.
3. Address the message
4

Click the Services menu and click the Send choice.

Creating a Message

A SiteManager mail message may be sent to other SiteManager users using the Compose menu
choice of the In-Box.

Eﬂead / Forward / Compose Mail H[=1E3

From: |F'roiecl Manager 1

T0: ISystem Administrator 1

CC: [System Administrator 2
Subject: | Contract #SITEMGR_30

Message

Please update your contract information by close of business on 5/31,/33)

I»

Figure 2-14. The Compose Window
To create a message:
1. Click the Services menu and click the Compose choice.
2. Address the message
3. Press the Tab key to advance to the Subject heading.
4. Type a subject for your message
5. Press the Tab key.
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6.
7.

Type your message.

Click the Services menu and click the Send choice.

Addressing a Message

When creating a new message or forwarding an existing message, it can be sent to an individual
SiteManager user or to multiple SiteManager users. However, it can NOT use SiteManager

distribution lists which can only be accessed by system generated messages.

T ——
Di { gineer 1
District Construction Engineer 2
|bistrict Testing Engineer 1
|bistric:t Testing Engineer 2

Field Materials Engineer 1

Field Materialz Engineer 2

flameTst1
|[~JameTst1 0
R 1
|

0K Cancel |

Figure 2-15. Addressing - Control+Clicking Allows Multiple IDs to be Selected

To address a message:

1.

2
3.
4

Click to place the insertion point in the To: or CC: field.
Click the Services menu and click the Select Users choice.

Select the recipient’s name.

Click Ok.

To select multiple names next to each other:

1.
2.

Click the first name.

Hold down the Shift key and click the last name.

To select multiple names NOT next to each other:

1.

2-16
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2.4.2 Distribution List

To facilitate easier handling of multiple users, SiteManager provides a Distribution list. These lists
are typically created by users only for system generated messages. The user can assign these lists to
specific processes that generate system messages through specific SiteManager functions. For
example, the Distribution List field on the Contract Key Dates window allows the user to select a
user group to which a message is automatically sent, when a key event does not occur.

¥ Distribution List

erf Test List

Distribution List I -

-

Esel Name - User Name H
32 bit l4.dams Congstruction Corporation

Carrie Smith Add -> | Central Office 1

Central Office Materials Engineer 2 — Cortral Offoa 2

C?Iorado Test <- Remove | Central Office Materials Engineer 1

Diane Menz

e Day in Life - Central Office

MNameT stl Add All 3> | ['ay in Life - Field Inspector

MameTst10 D ay in Life - Project Manager

MameT st3 <<- Rem All | D ay in Life - System Admin

NameT st4 - District Construction Engineer 1 =
< of ol of

Figure 2-16. The Distribution List Window
To add a new distribution list:
1. On the Accessories panel, double-click the Distribution List icon.
2. Click the New button.

3. Type the descriptive name of no more than 20 characters (including spaces and special
characters) for the distribution list.

In the User Name list box on the left side of the window, scroll to and click the user’s name.
Click the Save button.
Continue steps 4-5 until all recipients are included.

Click Ok.

© N o o &

Click the Save button.

To modify an existing distribution list:
1. Inthe Distribution List box, scroll to and click the list to be modified.

To remove a user:

2-17



AASHTOWare Project SiteManager
2. Getting Started 2.4 Accessories

1. Inthe User Name list box on the right side of the window, scroll to and click the user’s
name.

2. Click the Remove button.

To add a new user:
1. Inthe User Name list box on the left side of the window, scroll to and click the user’s name.
2. Click the Save button.

To delete a distribution list:
1. Inthe Distribution List box, scroll to and click the list to be deleted.
2. Click the Delete button.
3. Click Ok.
4. Click the Save button.

2.4.3 Process Status Window

The Process Status window is accessed through the SiteManager Accessories functional area. This
window is available almost system wide by selecting Process Status from the Services menu. The
window consists of two tab pages: Regular and Scheduled.

Regular Tab

The Regular tab page lists DPS submitted processes; that is, RTF custom report processes,
SiteManager PowerBuilder reports, and background or batch processes. Here, authorized users can
see the current status of submitted processes, delete submitted or complete jobs, or drill down to
view or print the output produced by completed or failed processes.

[ Process statex ||| 1 11 11— R =11

Regular = Scheduled =
Process Name Status Date Start Time | End 4
Submitted

RCPCSUM1B REXX Emar £/23/0 10:14am  |10:14 am 10:14an
RCPCSUM1B REX Emor 6/28/01 1017 am  [10:17 am 10:17 an
RCACONSTA Daily REX Eror E/26/01 05:11 pm 10:00 am 10:46 an
RCAITATYA Weekly RE> Error E/26/01 05:14 pm 10:46 am 10:46 an
Monthly Contract Status RE< Emor E/26/01 05:18 pm 10:50 am 10:50 an
SONYATSTA Application Errar E/23/01 10:58 am 10:53 am 10:59 an
RCAITATYA Weekly RE>X Error E/26/01 05:14 pm 11:03 am 11:09 an
RCPCSUM1A Completed E/28/01 11:13 am 11:13 am 11:13 an
testl Completed B/28/01 12:03 pm 12:03 pm 1209pn
SONYATSTA Completed E/23/01 12:40 pm 12:40 pm 12:40 pn
TEST41014 Application Error E/28/01 01:27 pm 01:43 pm 01:48 pn
Monthly Contract Status RE>< Emor E/26/01 05:18 pm 01:49 pm 01:49 pn
RCAITATYA Weekly REX Error 6/26/01 05:14 pm 01:43 pm 01:49 pn
RCAITATYA RE>X Error 6/28/01 02:36 pm 02:36 pm 02:36 pn
I:\FI',AITDTYH RFX Frenr R/28/M N23R nm I N2 3R nm n2-3R ;\ X
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Figure 2-17. The Process Status Window Regular Tab

Field Description

Process Name The name of the process.

Status Textual description of the process status; for example, Process
Running, Application Error, Complete.

Date Submitted Date the job was submitted.

Queue Time Time the job was submitted.

Start Time Time the job started processing.

End Time Time the job finished processing.

Server IP address of the server to which the job was submitted and run.

Table 2-2. The Process Status Regular Tab Field Names Table

Scheduled Tab

The Scheduled tab page lists DPS submitted processes; that is, RTF custom report processes,
SiteManager PowerBuilder reports, and background or batch processes. Here, authorized users can
see the current status of submitted processes, delete submitted or complete jobs, or drill down to
view or print the output produced by completed or failed processes. The processes listed on the
Scheduled tab are those processes which have be set to run on a specific schedule by an authorized
user.

Standard SiteManager window and tab-level security applies to the Scheduled tab page window.
Only those processes to which the user has been assigned security access will be presented on the
displayed list.
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([ElProcessstatus | | 1] [1 T LR Y =B}
" Regular Scheduled

Process Profile Schedule

Submitted

2 PM on Tue, every week 05:17 pm  ({07/10/01

SMBAPP RCOCORPTA Mt 5:24 PM on day 3 of the month 07/03/01 O5:18pm |08/03/01  05:24 pm
SMBAPP RCAITATYA Dailat 5:139 PM every day 07/03/M 0516 pm  |07/06/01 0513 pm
SONYATST SONYATSTA At 5:35 PM every day 07/03/01 05:30pm  |07/06/01  05:35 pm

«| | »

Figure 2-18. The Process Status Window Scheduled Tab

Field Description
Process The name of the process.
Schedule Textual description of the process schedule; for example, Time,

Day of Week and Frequency

Date Submitted Date the job was submitted.

Queue Time Time the job was submitted.

Next Run Date Date the job will next run.

Next Run Time Time the job will next run.

Last Run Time Time the job was last run.

Server IP address of the server on which the job is scheduled to run.

Table 2-3. The Process Status Scheduled Tab Field Names Table

2.4.4 System Attachments

System Attachments are a stand-alone version of the URL, Plug-In and
OLE functionality of SiteManager. The stand-alone feature allows URL
links, Plug-In applications, and OLE objects to be accessible to the User by IF
clicking the System Attachments icon through the Accessories panel.

URL attachments are links to html documents Figure 2-19.
The System
Plug-In attachments allow access to other programs similar to the OLE Attachments Icon

function. The Plug-In functionality also allows a limited amount of data to
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be automatically passed to a Plug-In application upon execution.

OLE object attachments are links to external documents.

URL and Plug-In Attachment Icons

Icon

Description

Activates the Attachments window.

Appears on the Accessories panel, and activates the stand-alone
Attachment window.

Appears on the toolbar of any window that may have an attachment
associated with it. An Attachment icon without a paperclip signifies there are
currently no attachments associated with the current record

i

Attachments

Activates the Attachments window.

Appears on the Accessories panel, and activates the stand-alone
Attachment window.

Appears on the toolbar of any window that may have an attachment
associated with it. An Attachment icon without a paperclip signifies
there are currently no attachments associated with the current record

E

Run Attachments

Allows User to activate Plug-In applications or URLs associated with the
window.

U]

New URL

Opens a dialog box allowing the properties of a URL attachment to be
modified or entered.

[e]

New Plug-In

Opens a dialog box allowing the properties of a Plug-In attachment to be
modified or entered.

o

New OLE

Opens a dialog box allowing the properties of an OLE attachment to be
modified or entered.
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Table 2-4. The Attachment Icon Table

Attachment Usage

BlsystemAtachments || || | | MEK

Name Type Description

[phhhhhhh URL  [Hotmaiaiahagh
i calculator EXT g
i website URL finfatech fie
fest Plug Fagfaft

ry again Flug [resdaith
ahooo URL  frewsahoo

Figure 2-20. The System Attachments Window
To use Plug-In, URL, and OLE attachments:

1. The previously-created URL, Plug-In, and OLE attachments appear on a table grid on the
Attachments window. Sort and Filter features may be used on this window by right-clicking
and choosing a feature from the Object menu.

2. Double-click the desired attachment to activate, or highlight the desired attachment and click
the Run Attachments icon.

3. Activating a Plug-In opens the specified application in a separate window. Activating a URL
or HTML File item launches the system’s default browser. Activating an OLE opens the
specified document.

4. Once the User has completed work with the URL, Plug-In application, or OLE document the
browser or application may be closed as normal.

2.4.5 Reports

The Reports icon will allow an agency to define an external link to Custom Reports or documents.
When a user double clicks the Reports icon, an external reporting tool or application of the Agency’s
choosing will be launched. The Reports icon will not appear on the Main Panel by default. If an
agency chooses to use the Reports icon from the Main Panel, the Agency’s System Administration
will have to define the external application and provide users with appropriate Group Security.
Please refer to the External Applications section located in Section 10 — System Settings of the
SiteManager System Managers Guide for further information.

To access the Custom Agency Reports:

1. On the SiteManager panel, double-click the Reports icon.
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3.1 Menus
The following guidelines apply to the use and structure of SiteManager menus.
= SiteManager menus may have up to three levels with the main menu as the first level.

= Menu choices that invoke dialog boxes have an ellipsis (...) at the end of the choice.

= Menu choices that invoke a cascading submenu will have an arrow () at the end of the
choice.

M4 AASHTO SiteManager [ 5] %]

File Edit Services “Window Help

D8] 2] D[S || O[]

. —————————

Contract ID: [SITEMGR_30 Fed St/Pr Prj Nbr: [NONE/OO
ﬂ Primary PCH: lm
Division: IEIZ— District: I_ Area: I— 7
q Progress Sched:l ¥ariance Pct: I—EIU ¢
—] Desc: |E><TEND ACCELLERATION LANE & CLOSE CROSS-OVER ¢
Time Charges: IW Bid Days: W Bid Amt: I_
Contract Type: Im I~ Fed Dversight
Ll_ Work Type:|25— [~ Local Dversight Proposal Fund Type:
Spec Yl:lﬁ Unit System: IEngT Suppl Spec Bk Yr: I_ Alli)lll
47

Figure 3-1. SiteManager Menus

Some menu choices will be applicable in some instances and not applicable in others. For example,
a menu choice may be applicable for one folder tab and may not be applicable for the second folder
tab. When the menu choice is applicable for the active folder tab, it will display normally. When
the menu choice is not applicable for the active folder tab, it will not appear on the menu.

Other menu choices may be applicable but only if a preliminary step is performed. For example, a
menu choice may be applicable if you are in a new record, but not applicable when you have an
existing record open. When the menu choice is applicable, it will be enabled and will display
normally. When the menu choice is NOT applicable, it will be disabled and will display in gray.
The menu choice will be enabled or disabled depending on the circumstances.

Menu choices often have a corresponding toolbar button.

Keystroke shortcuts are assigned to all menu choices that do not invoke a dialog box or a cascading
submenu. Keystroke shortcuts appear in the menu to the right of the menu choice. Keystroke
shortcuts do not clash with those commonly used by the Microsoft Windows standard. For instance,
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even when there is no Edit menu, the CTRL+C keystroke shortcut will copy the current selected
column value to the Clipboard.

All menu choices will have keystroke accelerators assigned. The menu itself will be invoked using
the underlined letter in the menu name in combination with the ALT key. The menu choice will be
invoked by typing the underlined letter in the menu choice’s name.

When appropriate, an object menu can be invoked by right clicking the column.

The SiteManager application has two menus to display. One is at the frame level and the other is at
the sheet level.

The sheet level menu could be any one of the several functional level sheet menus which in turn
were inherited from the frame, with additional menu choices added for relevant functionality. The
Frame level menu contains only a few menu choices that provide access to the application level
functions such as bringing up the SiteManager Main Panel and exiting the application. At the sheet
level, each window will display only one menu bar and one tool bar, with some of the frame level
menu choices incorporated on the sheet menu itself.

3.2 Using SiteManager Menus and Toolbar

SiteManager menus can be accessed using the mouse or using the keyboard. Many SiteManager
menu choices can also be accomplished using a keystroke shortcut. Keystroke shortcuts appear in
the menu to the right of the menu choice.

To use a SiteManager menu using the mouse:
1. Click the desired menu and click the desired choice.
The following guidelines apply to the use and structure of SiteManager toolbars.
= The most often used menu choices have a corresponding toolbar button for ease of use.
= Buttons used on toolbars are consistent throughout the application.

= All toolbar buttons have Tool Tips — text associated with the button that describes what
the button does.

If a toolbar button is sometimes applicable, it will be enabled or hidden depending on which folder
tab is active. For example, a toolbar button may be applicable for one folder tab and may not be
applicable for the second folder tab. When the toolbar button is applicable for the active folder tab,
it is enabled and displays normally. When the toolbar button is not applicable for the active folder
tab, it does not appear on the toolbar.
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3.2.1 Accessing SiteManager Menus With the Keyboard

As an alternative to using the mouse, all SiteManager menus can be selected using the keyboard.
Some SiteManager menu choices can also be performed using keystroke shortcuts.

To use a SiteManager menu using the keyboard:
1. Hold down the ALT key and press the underlined letter in the menu name.
2. Type the underlined letter in the menu choice’s name.

To perform a SiteManager menu choice using a keystroke shortcut:

1. Hold down the CTRL key and press the letter that performs the shortcut (e.g., CTRL+C
copies the selected data).

3.2.2 Toolbar Buttons

Main
Panel Exit New Close Save
=l [ R sl = = D =
Toolbar Help Open Delete Remarks

Figure 3-2. The SiteManager Toolbar

To identify what a button does, use the Tool Tip for the button. If you check the menus, you will
find a comparable capability on the menu.

The SiteManager Toolbar is accessed using the mouse. Buttons, unlike icons, require only a single
click. The SiteManager Toolbar has seven common toolbar buttons to display: Exit, New, Open,
Close, Delete, Save, and Help.

Toolbar Tool Tip Comparable Description
Button Menu Function
+ Exit File menu’s Exit | EXits the application. It asks for
m- choice saving of changes if the there are

unsaved changes.

P Help Help menu’s Brings up the SiteManager Help
Lﬁll Contents choice | Contents Window.
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Toolbar Tool Tip Comparable Description
Button Menu Function
New File menu’s Is used in context to clear all the
D New choice columns for data entry. If the sheet
contains more than one control
capable of creating new rows, the New
option creates a new row on
whichever control is currently active.
If changes have been made to the
current record, it prompts you to save
changes before clearing the current
record.
E’; Open File menu’s Allows another record to be selected.
Open choice Typically, it is applicable to the
current tab.
IEF; Close File menu’s Closes the current sheet. It prompts
Close choice for saving any changes before closing

the sheet.

]

Delete Edit menu’s
Delete choice

Like the New choice, the Delete
choice contextual and is applicable for
the current control. It prompts for a
confirmation from the user through a
message.

H Save
L]

File menu’s
Save choice

The Save button saves your current
work. If you performed some deletion
during a work session, you may need
to reconsider whether the deletion was
correct before saving. After you have
saved, you may not be able to undo
the deletions.

[U—_]I Remarks | Services menu’s

Remarks choice

Displays the Remarks dialog to attach
freeform comments.

Table 3-1. The Toolbar Button Table

To display a Tool Tip:

1. Position the mouse point on the button (and hold the mouse still).

To use a SiteManager toolbar button:

1. Click the desired button.
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Depending on what SiteManager window you are using, other buttons may appear on the Toolbar.
These other buttons are equivalent to some SiteManager menu option that you use.

3.3 Frame Menus
At the frame level, there are three menus: File, Window, And Help.

The File menu has the standard choices of Print Setup, Main Panel and Exit. The Print Setup choice
invokes the standard Windows Print Setup dialog. The Main Panel choice displays the SiteManager
Panel window, which is useful in cases where the panel was closed at the frame level through the
Close choice of the control menu. The EXit choice exits the SiteManager application.

Eile
Print Setup  Chrl+L

Main Panel Crrl+k

E it Alt+F4

Figure 3-3. The File Menu

The other two menu options, Window and Help, are the standard Microsoft Windows menus with
choices that function according to Microsoft Windows standards.

Wafindon
Tile Shift+F 4
Layer Shift+F3
LCazcade Shift+F5

Figure 3-4. The Window Menu

LContents F1
Search for Help an...  Chrl+v'
Glogzam Chrl+

Current yWindow Ctrl+F1

About Sitetanager  Chl+Shift+&,

Figure 3-5. The Help Menu
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3.4 Window Menus

The window level has five menus: File, Edit, Services, Window and Help. These options are
applicable at the tab level.

3.4.1 File Menu

The File menu at the sheet level includes the frame level choices with the same functionality: Print
Setup, Main Panel and Exit. It also contains several sheet specific choices: New, Open, Close,
Delete, Save, Refresh, Print Preview and Print.

Open Ctrl+0
Cloze Chrl+F4
Mew Clrl+M
Delete Chrl+Dr
Save Chrl+5

Refrezh Clrl+F

Print Setup  Chrl+ll
Print Preview  Chil+w
Print Clrl+P

Main Panel  Chrl+hd

E xit Al+F4

Figure 3-6. The Sheet’s File Menu

The following SiteManager File menu choices are standard throughout the application and are
always performed in the same way. Sheet-specific menu functions are discussed with the applicable
SiteManager functionality.

Menu Choice Description

Open Allows another record to be selected. Typically, it is
applicable to the current tab.

Close Closes the current sheet. It prompts for saving any
changes before closing the sheet.

New Is used in context to clear all the columns for data
entry. However, if the sheet contains more than one
control capable of creating new rows, the New option
creates a new row on whichever control is currently
active.
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Menu Choice Description
Delete Like the New Choice, the Delete choice is contextual

and is applicable for the current control. It prompts
for a confirmation from the user through a message.

Save Saves the current unit of work.

Refresh Clears the current changes to the record and retrieves
the record again.

Print Setup As with the Frame option, Print Setup displays the
standard Windows Print Setup.

Print Preview | Displays a preview of the current print selection.

Print Prints the current data.

Main Panel Opens another window or another instance of the
same window. It invokes the navigation panel from
which the appropriate choice of the window can be
selected.

Exit Exits the application. It asks for saving of changes if
there are unsaved changes.

Table 3-2. The File Menu Choices Table

Changing the Print Setup
The File menu’s Print Setup choice is used to change the standard Window print setup dialog.
To change the print setup:

1. Click the File menu and click the Print Setup choice.

2. Make the desired changes to the dialog.

3. Click OK.

Printing

The File menu’s Print choice is used to print. In a report, the Print choice prints the entire report. In
a window, it prints the current focus of the window. Most SiteManager windows are divided into
two or more zones. The results of the Print choice varies depending on which zone is active.
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Descriptions Proj Distribution

Contract ID [TRAIN_104

Adjustment
Amount

05/28/37 Other Adjustment (See Remarks) train $20,000.00

A SiteManager 1
05/28/9 Supplemental Amount has been applied  |SYSTEM $1.500.00

Window with
Three Zones

N~ Entered Date: |05/28/97 User ID: |traint Est. Nbr: 0001

Adjustment Description: |Dther Adjustment (See Remarks]
Adjustment Amount: |$20,000.00
Reference Doc:

Remarks: [Dondra IS

Figure 3-7. The Zones of a SiteManager Window
To print:
1. Inawindow, click the area of the window that you wish to print.
2. Click the File menu and click the Print choice.
3. Make the desired changes to the dialog.
4. Click OK.

Using Print Preview

The File menu’s Print Preview choice is used to preview what will print. Since most windows print
the current focus of the window, the Print Preview choice helps you determine that the focus is
correct before you print.

To preview what will print:
1. In awindow, click the area of the window that you wish to preview.
2. Click the File menu and click the Print Preview choice.

3. View the selection that will be printed.

4. Click OK.
Components Description
Next button Displays the next page of a multi-page selection.
Prior button Displays the prior page of a multi-page selection.
Print button Invokes the Print dialog.
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Setup button

Invokes the Print Setup dialog.

Zoom button

Invokes the Zoom dialog to magnify or reduce the display of
the print preview.

Close button

Closes the print preview

Rulers check
box

Displays or hides the rulers

Save As button

Invokes the Save As dialog allowing the results of the print

preview to be saved in other file exportable file formats.

Table 3-3. The Print Preview Components Table

5 E stimate History [_ (O] x|
Contract ID: |I321 293 Descriptionl: |bridge work
Estimate Met Pay Period PM PM Last Appr. Last Appr. [Est ~
Number End Date User ID Sta

0n02

Appr. Date
$18,000.0001/07/93 SYs2 03/18/39 S
$6.940.0001/06/93 551 02/23/39 551 02/23/93  |APR

User ID

000

$5,500.0001/05/93 S5l 02/23/39 5751 02/23/93  |APR

Fa
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Figure 3-8. A SiteManager Window with a Multi-Row Focus
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Print Preview [ %]
Next | Prior | Print | Setup... .. | SaveAs... I Close | v Rulers
.|.I.|.|.|.I.|.‘|.|.I.|.|.|.I.|.2|.|.I.|.|.|.I.|f3|.|.|.|.|.|.I.|:‘l.l.l.l.|.|.I.|.5|.|.I.|.|.|.I.|P|.|.I.|.|.|.I.ﬂ

‘_E Estimate Net Pay Period PM PM Last Appr. Last Appr. Est

| Number End Date User ID Appr. Date User ID Date |Stat

3 |oooz $18,000.00 01007433 552 03113433 552 03118139 |APRV

1 4 0002 $6,940.00 01/06¢93 SYst 02023499 SYst 02123439 APRV

e ] $5,500.00 01/05/93 SY51 02423433 551 022339 |APRV

2]

33

43 =

Figure 3-9. The Print Preview of a SiteManager Window With a Multi-Row Focus

Exporting A Window’s Print Results —The Print Preview’s Save As Button

The Print Preview is a File menu choice only available in a window, not as a report. The Save As
button of the Print Preview allows the current focus to be saved in other exportable file formats.

To save the print preview results in another format:
1. Inawindow, click the area of the window that you wish to preview.
2. Click the File menu and click the Print Preview choice.
3. Click the Save As button.

4. Inthe Save File As Type drop-down list, click the expand arrow to the right of the current
selection and click the desired choice.

5. To include column headings, choose a With Headings file type.
6. Highlight the text in the File Name field.

7. Type the name for the file.

Note: The Save Rows As dialog also does not have the more traditional Windows
methods of changing drive and folders. An exported file is created in the default
directory and drive on which SiteManager is installed. A path can be typed in front of the
filename to control where the file is created. The path C:\DATA\ACTCONT.PSR creates
a file named ACTCONT.PSR in a directory named DATA on the C drive.

8. Click OK.
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Radio Button

File Extension

File Format Description

Text TIXT ASCII Tab Separated (Delimited) format

Csv .CSV ASCII Comma Separated (Delimited)
format

Dbase 2 .DBF dBase 2 format

Dbase 3 .DBF dBase 3 format

DIF .DIF Date Interchange Format

Excel XLS Microsoft Excel Spreadsheet format

HTML Table HTM Hyper Text Markup Language table
format (Can be viewed in a web
browser.)

PowerSoft Report | .PSR PowerSoft Saved Report format (Can
also be viewed in SiteManager.)

SQL .SQL ASCII text file containing the SQL
syntax required to recreate the
datawindow object when run through the
database.

SYLK SLK Microsoft MultiPlan format

Text TIXT Text file format (Can be viewed in any
text editor.)

Windows Metafile | WMF Windows Metafile graphical format

WKS \WKS Lotus 123 early format

WK1 WK1 Lotus 123 later format

Table 3-4. The Print Preview Save As File Formats Table
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Save As H
File name: Folders:
* xls | c:\smapp

- Cancel |
- i o -
e Network._ .. |
[ checkin
[C3 checkout
[ cms o
= 3 smdb -
Save file as type: Drives:
Excel j I = e j

Figure 3-10. The Print Preview Save A Dialog

Displaying the SiteManager Panel

The File menu’s Main choice is used to invoke the main SiteManager navigation panel. Typically,
the SiteManager navigation panel is activated to open another SiteManager component without

closing the current active component.

To display the SiteManager Panel:

1. Click the File menu and click the Main Panel choice.

2. Click the desired icon.

E SiteManager, Panel

Main Panel T System Administration[+) T Conlract Administration(+)
§ B & 2 © m X
C ct Daily Whork Pipeline(+] Contractor Change Civil Rights{+] Materials
4, Il Reports(+) Payments(+] Orders(+] tanagement|+]

BE E R L
Accessores(+] System M anuals(+] Reportz

Administration(+]

Figure 3-11. The SiteManager Main Panel
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Exiting SiteManager

The EXxit choice exits the SiteManager application. The command can be accessed from the File
menu or from a toolbar button. If current work has not been saved, a warning message displays to
allow you to save the data before the application is closed or to cancel the exit.

[!_1—
Figure 3-12. The Exit Button
To exit SiteManager:
1. Click the File menu and click the Exit choice.
OR
2. Click the Exit button on the toolbar.

3. If the warning message displays, choose the desired choice.

+# Contract funding Eq
':3) Save changes?

Yes

Cancel |

Figure 3-13. The Exit Warning Message

3.4.2 Edit Menu

The Edit menu has standard Microsoft Windows choices: Undo, Cut, Copy and Paste. These
function as they would in any Windows program. The Undo choice has a limited functionality. If
you delete a field and immediately choose Undo, the field value will most likely be brought back.
However, if you have deleted a record, the Undo function will not undo the deletion.

The following SiteManager Edit menu choices are standard throughout the application and are
always performed the same way. Sheet specific menu functions are discussed with the applicable
SiteManager functionality.
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E dit
Undo Chl+2

Cut  Chrl+x
Copy  Chl+C
Paste Chl+y

Figure 3-14. The Edit Menu

Menu Choice Description

Undo Undoes the last change.

Cut Cuts the selected area from
the item.

Copy Copies the selected area
from the item.

Paste Pastes the contents of the
clipboard.

Table 3-5. The Edit Menu Choices Table

If menu item does not pertain to the current window, the menu item is unavailable. For example,
you cannot cut or copy a column unless a column is selected.

To select a field using the mouse:
1. In the desired field, position the I1-beam in front of the current entry.
2. Press the mouse button and drag to highlight the current entry.

To select a field using the keyboard:

1. Press the Tab key repeatedly until the field is highlighted.

Undo

The Edit menu’s Undo choice changes a field back to the previous entry if the user has not
performed a Save on the record.

To undo:

1. Click the Edit menu and click the Undo choice.
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Cutting, Copying, and Pasting

When a column value is selected, the value can be moved (cut) if the entry is incorrect. A field
value that needs to be entered repeatedly may also be copied to reduce typing.

To move (cut) the current selection:

1. Select the column value(s) to be moved.

2. Click the Edit menu and click the Cut choice.
Or

3. Hold down the Ctrl key and press the letter X.
To copy the current selection:

1. Select the column value(s) to be moved.

2. Click the Edit menu and click the Copy choice.
Or

3. Hold down the Ctrl key and press the letter C.
To paste the current contents of the Clipboard:

1. Position the insertion point in the column location to receive the value.

2. Click the Edit menu and click the Paste choice.
Or

3. Hold down the Ctrl key and press the letter V.

Cutting, Copying, and Pasting from MS Word into SiteManager

The following steps need to be taken to configure MS Word BEFORE typing remarks that are
meant to be copied and pasted into Site Manager. This preserves special characters (single quotes,
double quotes, dashes, etc.) and enables them to be saved into the database. Please NOTE that doing
these configuration changes AFTER the remarks have been typed will result in the special
characters being changed to question marks (?) in SiteManager.

1) Click FILE

2) Click HELP

3) Click OPTIONS

4) Click PROOFING

5) Click AUTOCORRECT OPTIONS
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6) Click AUTOCORRECT tabpage > Uncheck “Replace text as you type”

7) Click AUTOFORMAT AS YOU TYPE tabpage > uncheck everything under “Replace as
you type” section.

8) Click AUTOFORMAT tabpage > uncheck everything under “Replace”

9) Click OK

10) Click OK

3.4.3 Services Menu

The Services menu has several menu options grouped together. Some of the options like Address
and Remarks extend the functionality. The other choices provide extended services.

The Services menu is also the most variable SiteManager menu. It contains choices specific to the
active SiteManager window in addition to the ones listed in the following table. When there is a
Service menu, it is a good habit in SiteManager to check its contents for the additional choices.

The Services menu is the most important menu for accessing custom SiteManager functionality.

The options that appear in the Services menu may suggest the next logical step to take, such as
Choosing Keys, or may suggest additional actions which could easily be overlooked, such as adding
a Remark or recording an Address. On the other hand, the absence of these options might suggest an
alternative course of action such as clicking the Open button, rather than Choose Keys.

Window  Help
Hemarks Chrl+alk+H
Address Chrl-rs b+,

Genenc Figlds  Chl+alt+0

Cuztom Becord  Crrl+5 hift+L

Figure 3-15. The Services Menu

Menu Choice Description
Choose Keys Becomes available when the New choice is invoked. It brings
up the pick list from which the appropriate value(s) can be
chosen.
Address Invokes the address (context sensitive).
Remarks Invokes the remarks dialog.
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Generic Fields | Displays a standard set of customizable, generic fields.
Depending on the customization, these fields can be strings,
codes, flags, or numbers.

Other menu Other functional area specific menu choices (such as
choices Approve) are incorporated under Services.

Table 3-6. The Service Menu Choices Table

Not every options available from the Services menu is listed here. Itis a good idea to check the
menu to see what options are available for the window.

Choose Keys

The Choose Keys choice displays a list of key field(s) to be selected. In many instances in
SiteManager, the Choose Keys choice must be selected before a new record can be created.
Choosing Keys is fundamental to using SiteManager.

To choose keys:
1. Click the Services menu and click the Choose Keys choice.
2. Inthe list box, scroll to and double-click desired value.

3. Repeat step 2 until all initial values are selected.

— Sel

Item |

Spec Year |

Find :

— Item

Item Code English/Metric Description =
001-0000 English MISC ITEMS
001-0000 English MISC ITEMS
001-0000 Metric MISCITEMS
001-0000 tetric MISC ITEMS
001-0001 English BOMD INTEREST
001-0001 tetric BOMD INTEREST
001-0100 English COMNSTR SUPYR DOME BY OTHER THAN DOT PERSOMEL -
001-0100 etric COMSTR SUPYR DOME BY OTHER THAM DOT PERSOMEL - —

OK I Cancell

Figure 3-16. The Choose Keys Window
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Address

Address information is tracked by a variety of components in SiteManager. The Address choice
displays an address dialog that allows this information to be recorded.

PYMT AND/OR BILLN "+l | Address For: |
BILLING ADDRESS —~Address
RECORD FOR FAX ONI Line 1: |
HOME ADDRESS [ALL Line 2: |
MAILING ADDRESS (PIg"  _ Line 3- [

|

[

City:

State/Prov:

Zip/Postal: I

Country: | | =

=l

—Contact Numbers

Phone: I Ext: I

FAX: |

Figure 3-17. The Address Dialog
To attach an address:

1. Click the Services menu and click the Address choice.

N

In the address type list box, scroll to and click the desired type of address.
3. Inthe first field, type the appropriate information.

4. Press the Tab key.

5. Repeat step 2-3 until all text address information has been entered.

6. In the State/Prov drop-down list, click the expand arrow to the right of the current selection
and click the desired choice.

7. In the Country drop-down list, click the expand arrow to the right of the current selection
and click the desired choice.

8. Click outside the Address dialog to close the address.

9. Click the Save button.
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Remarks

As with Addresses, Remarks may be attached to a variety of records in the various components of
SiteManager. The Remarks choice displays a freeform dialog that allows any comment to be
recorded.

When Remarks are available for a SiteManager window, the presence of the Remarks button on the
Toolbar serves as a reminder that they are appropriate, makes it easier to access Remarks, and,
unlike other Service menu choices, precludes the need to check the Services menu to see if Remarks

are available.

Figure 3-18. The Remarks Button
To attach a remark:
1. Click the Remarks button.
Or
2. Click the Services menu and click the Remark choice.
3. Type the desired comment.
4. Click outside the Remarks dialog to close the Remark.

5. Click the Save button.

Generic Fields

Generic fields are agency-defined fields attached to some of the SiteManager windows. After the
installation of SiteManager, an agency attaches descriptive labels to the generic fields of
SiteManager. Data entered in these fields is unique to that agency. Once this customization has
been performed, the agency sets up procedures for the uniform maintenance of the data in its
customized fields.

The components of SiteManager that have this Generic Fields option are:
= Contract
= Vendor
= Office Information
= Address

= Vendor Personnel
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Item Master
Affiliates

Vendor Work Class
Vendor Security
Project Category
Contract Item

Sub Contract
Contract Project
Contract Milestone
Change Order
Checklist Events
Contract Estimates

Diary Milestone Credit
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Registration Number |
Amount [0
Reg Date [00/00/00 |

Figure 3-19. A Generic Fields Dialog Customized by an Agency

To update generic fields:

1.

W

Click the Services menu and click the Generic Fields choice.

In the first field, type the appropriate information.

Press the Tab key.

Repeat steps 2-3 until all data field information has been entered.

Click outside the Generic Fields dialog to close.
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6. Click the Save button.

3.4.4 Window Menu

The Window menu contains the Microsoft Windows standard menu choice. All active SiteManager
windows are displayed at the bottom of the Window menu.

The following SiteManager Window menu choices are standard throughout the application and are
always performed in the same way. Sheet specific menu functions are discussed with the applicable
SiteManager functionality.

Window
Tile Shift+F 4
Layer Shift+F3
LCazcade Shift+F5

Figure 3-20. The Window Menu

Menu Choice Description
Tile Tiles the open sheets
Layer Layers the open sheets
Cascade Cascades the open sheets

Table 3-7. The Window Menu Choices Table

Window menu choices are used when you have more than one component of SiteManager open.
Controlling the way the windows display can aid in navigation between these components.

Tiling

Tiling evenly divides the screen into the number of SiteManager components that you have active.
Tiling is used to display two SiteManager components side by side to compare the entries in each or
to return a single component to full screen once you have closed the other component. Typically, it
is not used when more than two components of SiteManager are active since you would not be able
to see enough of each component to make it worthwhile. Unless you have a very large display, tiling
with more than two SiteManager components open may not be very useful.

To change your screen to a tile display:
1. Open the SiteManager components that you want to tile.

2. Click the Window menu and click the Tile choice.
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FIAASHTO SiteManager =1 E3

File Edit Services Window Help
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Status:
Last Modified User ID: [1ab0833 Last Mc Product Name: |Admisture A
Effective Date: W Expiration Date: [EI
Product Category: [&dmisture =l

Manufacturer Name: |M anufacturer

Acceptance Method: [Manufacturer Certification =]

\ Ready

Figure 3-21. Two SiteManager Components Tiled

Cascading

Cascading makes the number of SiteManager components that you have active an equal size and
arranges each component in an overlapping offset window. Typically, cascading is used to display
more than two open SiteManager components. When you have a need to navigate between more
than two open SiteManager components, the Cascade choice may make it easier to move between
them.

To cascade:
1. Open the SiteManager components that you want to cascade.
2. Click the Window menu and click the Cascade choice.

3. Click the visible portion of the window you want to display.
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Figure 3-22. hree SiteManager Components Cascaded

Layering

Layering displays the SiteManager component that you have active in the most efficient full screen
display. Typically, layering is used to give each active component a full window for display or to
return a single active component to full display after you have closed the other components that were
tiled or cascaded.

To layer:
1. Open the SiteManager components that you want to layer.
2. Click the Window menu and click the Layer choice.

To move between multiple layered SiteManager components:

1. Click the Window menu and click the name of the SiteManager component from the list.
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Window
Tile Shift+F4
Layer Shift+F 3
LCazcade Shift+F5

v 1 Server to PM Fipeline
2 Price Index Maintenance

Figure 3-23. The Window Menu With Two SiteManager Components Active

3.4.5 Help Menu

The Help menu contains the standard Microsoft Windows options. The non-standard exception,
Current Window choice, displays the help for the current window including the fields. All other
options work in the standard format.

The Help menu contains standard Help choices: Contents, Search Help on, and Glossary. Help in
SiteManager works like any other Microsoft Windows Help.

Help
Contents F1
Search for Help on...  Chl+y
Glozzary Chil+G

Current "indomw Ctrl+F1

About SiteManager  Chl+S hift+4,

Figure 3-24. The Help Menu

Menu Choice Description

Contents Brings up the SiteManager Help Contents Window.

Search for Help on Brings up the SiteManager Help Search Window.

Glossary An alphabetized list of the items on the Help Contents
Window.
Current Window Brings up help window and displays the help on the

current active window.

About SiteManager Information about SiteManager Version.
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Table 3-8. The Help Menu Choices Table

Accessing Help Using the F1 Key

SiteManager help is context sensitive. When you are in a SiteManager window and have a question
about the window, pressing the F1 key invokes the help for that particular window.

& CMSAPPD4 [_[OIx]
File Edit Bookmark Options Help

Quntentsl ﬁearchl Back I Print | « I 2 Iﬁlossaryl

Selecting or Adding a Conference in Contract Records =

The Select Construction Conference Data panel lets the User select a Conference from a list of Conference
Titles and Dates, or add a new conference. The User can find, sort, and filter the Conference list.

To access the Select Canstruction Conference Data panel
1. Onthe Contractor Management panel, double-click the Construction
Conference icon.

When the Select Construction Conference Data panel opens, it displays a list of Contracts. After the User

selects a Contract ID, the panel displays a list of conferences for the selected Contract. The fields are defined
in the following list

Field Name and Description

Conference Date - Construction Conference - Selecting or Adding a Conference

Conference Title - Construction Conference - Selecting or Adding a Conference

To view a Construction Conference recard

1. Onthe Contractor Management panel, douhle-click the Construction
Conference icon. The Construction Conference panel opens.

2. Click the Open button. The Select Construction Conference Data panel
opens

3. Inthe Contract ID list hox, scroll to and click the desired choice.

4. Click Ok. If the selected Contract has conference records, the select panel
displays a list of conference titles and dates.

5. Inthe Construction Conference list box, scroll to and click the desired
chaice.

6. Click Ok. The Construction Conference panel displays data for the selected
conference

Figure 3-25. The F1 Key Invokes Help

To access Help using the F1 key:
1. In a SiteManager window, press the F1 key.

2. When finished, click the File menu and click the Exit choice.

Accessing Help by Contents

The Content choice or the Help toolbar button display an alphabetized list of Help Topics that can be
browsed for the subject on which you need help.

To access Help by Contents from the menu:
1. Click the Help menu and click the Contents choice.
2. In the topics list box, scroll to and click the desired topic.

3. When finished, click the File menu and click the EXxit choice.
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Figure 3-26. The Help Button
To access SiteManager Help with the toolbar:
1. Click the Help button.

2 AASHTO SiteManager Help
File Edit Bookmark Dptions Help

3. General Concepts

P[] B3

Qunlentsl ﬁearchl Back | Print I << | >3 Iﬁlussaryl

Contents

The following Help Topics are available:

General Concepts

Edit Menu - Cutting, Copying, and Pasting

Edit Menu - Undo

E dit Menu Choices

File Menu - Dizplaying the Sitebd anager Panel
File Menu - E xiting Sitetd anager sing the Menu

Filz benu - Exporting & *Windows Print Besults - Print Previews Save Az Button

File Menu Choices

General Procedures - Documentation Support

zing Help by Contents Using the Menu
Help Menu - Accessing Help Using the F1 Key

Help Menu - On-Line Help Development

Help bMenu - Using Help by Searching

Help kenu - Uszing the Current 'Window Help

Help tenu Choices

Menuz - Edit Menu

Menuz - File Menu

Menusz - Frame Menus
Menus - General Guidelines

Menus - Help Menu

Menus - Menu Layout

Menuz - Object Menu Choices
Menuz - Object Menu

Menus - Services Menu

Menus - Using Sitebd anager Menus
Menus - Window bMenu

Menuz - Window Menus

Figure 3-27. The Help Contents

Using Help by Searching

The Search for Help on choice displays a lengthy, alphabetized list of Help Topics that can be

browsed or searched for the subject on which you need help.

To access Help by searching:

1. Click the Help menu and click the Search for Help on choice.

2. Type the topic on which you need help.
3. Click the topic.
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4. Click the Display button.

5. When finished, click the File menu and click the Exit choice.

Help Topics: AASHTO SiteManager Help EHE

Index |Fin.;| I

1 Tuvpe the first few letters of the word you're looking far.

2 Click the index entry you want, and then click Dizplay.

Accezsing SOMS in DwWR il
Accezsones

Adrministrative Offices Panel

Aggregate Blend

Aggregate Mix Designs

Aggregate Mix Designs Compression Strength Folder Tab

Aggregate Mix Designs Description Folder Tab

Aggregate Mix Designs Gradations Folder Tab

Aggregate Mix Designs Maternials Folder Tab

Annual EEQ Report

Approval Groups Window

Approval Bules Window

Approval wWindow

Approved Lists con

Approved Lists Reports

Approved Materialz

Autopay [term Window ;I

Dizplay I Priri... | Cancel |

Figure 3-28. The Help Search

Using the Current Window Help

With any SiteManager window active, the Help menu’s Current Window choice accesses context
sensitive help that includes Help on fields.

To access Help on the current window:
1. Display the SiteManager window for which you need help.
2. Click the Help menu and click the Current Window choice.
3. When finished, click the File menu and click the Exit choice.
To access Help on a field:
1. Display the SiteManager window that has the field for which you need help.

2. Click the Help menu and click the Current Window choice.
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3. Inthe field list, scroll to and click the desired field.
4. When finished, click the File menu and click the Exit choice.

< SiteManager [ [O] x|

File Edit Bookmark Option: Help

Qontentsl Search I Back I Print I 44 I > Iglossalyl
Aggregate Mix Designs Compression Strength Folder Tab

To add a new Aggregate Mix Design compression strength:

1. Add or open the Mix Design description.

2. Clickthe Compression Strength foldertab.

3. Inthe Age field, type the desired walue.

4. Inthe Age Type drop-down list, click the expand
arrow to the right of the current selection and click
the desired choice.

5. Pressthe Tab key.

6. Inthe Cement Percent field. type the desired
walue.

7. Pressthe Tab key.

8. Inthe Compression Strength field, type the
desired value.

9. Inthe Compression Strength Units Type
drop-down list, click the expand arrow to the right of
the current selection and click the desired choice.

10. *When complete, click the Save button.

Figure 3-29. The Help on a SiteManager Window

3.5 Object Menu

The Object menu can be opened by right clicking a column. When the standard Windows selection
pointer is positioned on a column that can be searched, it is replaced by the Search Lens. The Search
Lens indicates that an Object menu can be invoked to perform a search by clicking the right mouse

button.

Figure 3-30. The Search Lens

As with other Windows applications, the available choices in the Object menu are context sensitive,
depending on what column the selection pointer is positioned on and whether it is selected. When
choices in the object menu are unavailable, their inactive status usually indicates the column is not
selected. The Object menu includes five choices described in the following.
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Search

Eilter
Find
Sort

Showy Filters Sart

Figure 3-31. The Object Menu

Object Menu Choices Description

Search Searches for the specified field value.

Filter Eliminates all records other than the Filter
criteria.

Find Finds the specified field value.

Sort Sort the records in ASCII order in either
ascending or descending order.

Show Filter/Sort Displays the applied Filter/Sort criteria.

Table 3-9. he Object Menu Choices Table

The Object menu is a context sensitive capability. To make data entry and retrieval easier, the
choices that appear in the Object menu are determined by where you right click. For instance, when
you position the pointer above a searchable field, the Search Lens appears. Right clicking the
searchable field produces an Object menu with the Search choice as the only available choice.

The Filter and Find functions also provide users with the ability to limit the data retrieved from the
SiteManager database by specifying criteria using relational operators. The Clear function clears the
current data retrieval choice in effect. The Show Filter/Sort choice shows the current criteria in
effect for these choices.
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Cut
Paste

Copy
Clear

Search

Filter
Find
Sart

Show Filters Sort

Figure 3-32. The Object Menu

3.5.1 Search

When a data entry field requires selecting a value from a list of possible values, the Search choice
allows the user to limit the list and quickly select the desired value.

ﬂPortland Cement Concrete Mix Design Description

e e e ——
Description Froperties M aterials Gradations

Mix ID:
Material Code: | @)\\ |

Producer Supplier Code: |

Designer Name:

|
|
Concrete Class Type: I:E

Effective Date: |01/31/97 Termination Date: IDUHDUKDU
Approved Date: 00/00/00 Approved By User ID: I

Figure 3-33. The Search Lens Appears
To search on a field:
1. Position the selection pointer (changes to the Search Lens) over a search field.
2. Click the field using the right mouse button.
3. From the object menu click the Search choice.
4. Select the correct record from the list.

5. Click OK.
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Search Window E |

Item Code | Spec Year Short Deszcription =

MISC ITEMS

001-0000 1983 MISC ITERS

001-0000 1983 MISC ITERS

001-0000 1983 MISC ITERS

001-0000 1992 MISC ITERS

001-0000 1932 MISC ITERS

001-0000 1992 MISC ITERS

001-0000 1932 MISC ITERS =

| | » |
1] 4 Cancel

Figure 3-34. The Search Window

3.5.2 Filter

The Filter choice allows the user to specify filtering criteria for SiteManager fields and limiting their
values using relational operators. Each time a window displays, the filtering criteria, marked as
default, is automatically applied, thereby limiting the amount of data retrieved. Only one default
filter criterion can be in effect for a window at any given time.

Note: When creating multiple conditions, remember that AND joins are executed before
OR joins.

To filter out other records:
1. Position the selection pointer over a record
2. Click the record using the right mouse button.
3. From the object menu click the Filter choice.
4. Click the Add button.

5. In the Field drop-down list, click the expand arrow to the right of the current selection and
click the desired field.

6. Inthe Condition drop-down list, click the expand arrow to the right of the current selection
and click the desired choice.

7. Inthe Value field, select the current entry and type the desired value.

8. To add additional conditions, click the Add button.
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9. Inthe Join drop-down list, click the expand arrow to the right of the current selection and
click the desired choice.

10. Repeat steps 5-9 until you have selected all conditions.

11. Click OK.

Field Condition Value Join Insert

[ [=1]-= [=1] and = Add

[—- - -] =

Bemove

Clear

Test

Load. .

Save. .

Cancel

Help

Figure 3-35. The Filter Criteria Window
3.5.3 Find

When a window displays as a scrollable list, the Find choice allows the user to get to a specific row
by selecting the appropriate value to find.

Note: When creating multiple conditions, remember that AND joins will be executed
before OR joins.

To find specific records:
1. Position the selection pointer over a record
2. Using the right mouse button, click the record.
3. From the object menu click the Find choice.
4. Click the Add button.

5. In the Field drop-down list, click the expand arrow to the right of the current selection and
click the desired field.
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6.

10.

11

In the Condition drop-down list, click the expand arrow to the right of the current selection
and click the desired choice.

In the Value field, select the current entry and type the desired value.
To add additional conditions, click the Add button.

In the Join drop-down list, click the expand arrow to the right of the current selection and
click the desired choice.

Repeat steps 5-9 until you have selected all conditions.

. Click Ok.

3.5.4 Sort

When the window displays as a list, the Sort feature allows the user to sort the list based on specified
criteria. Each time the window displays, the default sort criterion is automatically applied. As with
the Filter function, only one default sort criterion can be in effect for a window at any given time.

To sort the records:

1.

W
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Position the selection pointer over a record
Using the right mouse button, click the record.
From the object menu click the Sort choice.
Click the Add button.

In the Field drop-down list, click the expand arrow to the right of the current selection and
click the desired field.

In the Order drop-down list, click the expand arrow to the right of the current selection and
click the desired choice.

To add additional sorts, click the Add button.
Repeat steps 4-7 until you have selected all sorts.

Click Ok.
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Sort Criteria - New Sort |

Field | Order

| M——————~ |- < rcing b

I |xJ|Descending [=] Add

Insert

RBemove

Clear

Load...

Save. .

114

Cancel

Help

Figure 3-36. The Sort Window

3.5.5 Show Filter/Sort

The Display Filter/Sort choice displays the current criteria in effect.

To display the current criteria:

1.
2.

Position the selection pointer over a record
Using the right mouse button, click the record.
From the object menu click the Show Filter/Sort choice.

Click Ok.

3.6 Documentation Support

Online versions of the User Reference Manual and the Sampling and Testing Procedures for your
agency are accessible as a PDF file. The Sampling and Testing Procedures are a resource provided
by AASHTO.

To access online documentation:

1.

2.

On the Main Panel, double-click the Documentation icon.

Double-click the documentation icon you wish to reference.
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Figure 3-37. The Documentation in Adobe Acrobat

To navigate in Adobe Acrobat:

1. Click the Next Page button.
Or

2. Click the Previous Page button.
Or

3. Click the First Page button.
Or

4. Click the Last Page button.

Or
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5. Click the Go To button.
6. Type page number you want to which you wish to go.

7. Press Enter.

3.7 Reports

The following procedures are a general description of how to generate PowerBuilder-based
SiteManager reports. Each chapter of the manual describes report specific to each component of
SiteManager.

Reduce the zoom to 80 to view the entire page of the report.
To generate a report:
1. Select the Reports icon for the desired report.
2. If applicable, select the criteria.
3. Select the option for the desired format
= By Summary (selects all items)
= By Criteria (field name) selects an individual field.
If you select By Ceriteria, click the field using the right mouse button.
Perform a Search using the object menu (referenced in the Getting Started section).
Click OK.

4. To generate a PowerBuilder-based report, double-click the desired report icon and select the
criteria.

5. To generate the report online, click OK.

6. To generate the report to a file, select the Generate Off-line File check box (ON) and
click OK.

7. To generate and print the report, select the Generate Off-line Print check box (ON)
and click OK.

The Summary by Project Report is unique in that multiple reports may be generated in a batch print
process.

To select multiple reports to be printed:
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1. On the Report Criteria window, select the Generate Off-line Print check box (ON).

2. Highlight the desired criteria by holding down the Shift or Ctrl keys and clicking the desired
report criteria. The Shift key allows an entire block of criteria to be selected, while the Ctrl
key allows individual rows of criteria to be selected.

3. Click OK.

3.7.1 Report Options

The report options are available as toolbar buttons or menu options for reports that have been
generated online.

Components Description
Close button Closes the report preview.
Save button In a simple report (see Save Reports section) invokes

the Save dialog allowing the report to be saved in a
PSR file format.

Print button Prints the report.

Prior button Displays the prior page of a multi-page selection.

Next button Displays the next page of a multi-page selection.
Zoom spin button Magnifies or reduces the display of the report preview.

Copies spin button Allows more than one copy of the report to be printed.

Table 3-10. The Report Components Table

3.7.2 Saving, Opening, and Exporting Simple Reports

There are two types of reports in SiteManager: simple and complex. Simple report can be saved
and exported, but complex reports cannot. The File menu’s Save choice (or the Save button) and the
Service menu’s Export choice are active for a simple report. They are not active for a complex
report.

Saving and Opening Simple Reports

A simple report can be saved for later retrieval. SiteManager saves the report using a .PSR
extension. The View Saved Report icon on your reporting panel can be used to open a saved report.

To save a report:
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1.

Or

4.
5.

Click the File menu and click the Save choice.

Click the Save button.
Type the name for the file.
Change the drive and directory as desired.

Click OK twice.

To open a saved report:

1.
2.
3.
4.

Double-click the View Saved Reports (PSR) icon on the reports panel.
Change the drive and directory as needed.

Select the PSR file.

Click OK.

Exporting Simple Reports

A simple report can be exported into file formats other than PSR. To access an exported simple
report file, you must have an applications software package that can access one of the file formats.

File Extension File Format Description
TIXT ASCII Tab Separated (Delimited) format
XLS Microsoft Excel Spreadsheet format
\WKS Lotus 123 early format
\WMF Windows Metafile graphical format

Table 3-11. The Export File Formats Table

To export a report:

1.
2.

Click the Services menu and click the Export choice.
Type the name of the file.

Click the expand arrow to the right of the Save File As Type drop-down list and click the
desired file format.

Change the drive and directory as desired.
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5. Click OK twice.

3.8 Plug-In, URL, and OLE Attachments

The URL/Plug-In/OLE functionality of SiteManager allows URL links, Plug-In applications, and
OLE documents to be attached to certain SiteManager functions or specific records within that
function. The stand-alone feature also allows URL links, Plug-In applications and OLE documents
to be accessible to the User through a separate Attachments window accessed through the
Accessories panel.

Attachments may be associated with a specific record. Attachments may also be configured to either
activate when a window is opened or when selected through the Attachment window. System-based
attachments are URL links, Plug-In applications, and OLE documents that do not need to be
associated with a specific SiteManager function or record. System Attachments are accessed
through the Accessories panel.

URL links, Plug-In applications, and OLE documents may be associated to:

Material Test Templates

= DWR Templates

= Contracts

= Contract Estimate History

= Correspondence Log

= Construction Conference

= Change Order Header

= DWR - Record Work Item

= Maintain Sample - Additional Sample Data
= SUPERPAVE Mix Design

= Portland Cement Concrete Mix Design
= Force Accounts

= Contract Adjustments

= Contract Time Adjustments

= Line Item Adjustments
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= Contractor Evaluation
= Milestone Time Adjustment

Attachments are activated by a User click or configured to trigger automatically when a window to
which an attachment is associated is initialized. Each Plug-In application, URL, or OLE document
may be associated to a specific record.

The Plug-In functionality also allows a limited amount of data to be automatically passed to a Plug-
In application upon execution.

3.8.1 URL, Plug-In and OLE Attachment Icons

= Activates the Attachments window.

Appears on the Accessories panel, and activates the stand-alone
Attachment window.

Appears on the toolbar of any window that may have an attachment
associated with it. An Attachment icon without a paperclip signifies
there are currently no attachments associated with the current record.

@? Activates the Attachments window.

Appears on the Accessories panel, and activates the stand-alone
Attachments Attachment window.

Appears on the toolbar of any window that may have an attachment
associated with it. An Attachment icon with a paperclip signifies
there is an attachment associated with the current record.

:_i: Allows User to activate Plug-In applications or URLSs associated
with the window.

Run

Attachments

D—l Opens a dialog box allowing the properties of a URL attachment to
be modified or entered.

New URL

Opens a dialog box allowing the properties of a Plug-In attachment
to be modified or entered.

5

New Plug-In

- Opens a dialog box allowing the properties of an OLE attachment to

oL
be modified or entered.
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New OLE
Document

% Deletes the current OLE document.

Delete OLE
Document

Table 3-12. The Attachment Icon Table

3.8.2 Attachment Usage

Hame Type Description Autorun
wordpad for contract C10786

Figure 3-38. The Attachment Window

To display Plug-In, URL, and OLE attachments:

1.
2.
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Navigate to the SiteManager function associated with the attachment you wish to use.

Click the Attachment icon to access the Attachment window.

Note: As the attachment is associated to a specific record, that record must be opened
before accessing the Attachment Window. The Autorun feature indicates that the
attachment will be run as soon as the Attachment Window is opened without the user
having to click the Run button.

The previously-created URL, Plug-In, and OLE attachments appear as a table grid on the
Attachments window. Sort and Filter features may be used on this window by right-clicking
and choosing a feature from the Object menu.

Double-click the desired attachment to activate, or highlight the desired attachment and click
the Run Attachments icon.

Activating a Plug-In opens the specified application in a separate window. Activating a URL
or HTML File item launches the system’s default browser. Activating an OLE opens the
specified document.
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6. Once you have completed work with the URL, Plug-In application, or OLE document, the
browser or application may be closed as normal.

7. Once the appropriate area of SiteManager has been reached, the creation steps are identical.

Hame Type Description Autorun
wordpad for contract C10786

Figure 3-39. The Attachment Window

Field Description
Name Name of the attachment
Type OLE, URL or Plug (executable)
Description Short textual description of the attachment.
Autorun Indicates that the attachment will be run as soon as the user
opens the attachment window.

Table 3-13. The Attachment Window Field Description Table

To access the Attachments window, click the Attachments button, or click the Services menu and
click Attachments.
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Plug-In Attachment Definition

¥ plug-in Attachment et
Enter command line:
Build Command. _. ]
Description:
Attachment Security:
_Description ] Deseription Access
ACCTPG  [Accounting - Projects and Grants Add -> 1
IEDMASET [Administrative Assistant T
ICOSTEST [Cost Estimates - m—*’
IFINLENG  [Finals Engineer
(T lFquiry Tly - DWW
lINSP IFspector Standalone _Re i
WNEETET [FieldInspector/Tester .i..M
[INEETETS [Field Inspector/T ester - Gtandalons _{ s Bemall
J e
[ Bun Automatically
Add LCancel
Figure 3-40. The Plug-In Attachment Window
Field Description
Name Required field. The user-entered name of the attachment
entered in freeform text.
Enter Command The executable application’s command line. Either entered
Line by the user or returned through the Build Command
function.
Description Not a required field. A short, user-entered description of
the executable application in freeform text.
Attachment Security | Allows the user to restrict access to the attachment at the
Group level.
Run Automatically If checked, the Plug-In is executed upon activation of the
window it is attached to.

Table 3-14. The Plug-In Attachment Window Fields Table

To create a new Plug-In Attachment:
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1. Click the New Plug-In button to access the Plug-In Attachment window.

2. On the Plug-In Attachment window, click the Name field and add a name for the new plug-
in.

3. Click the Enter Command Line field. The command line may be entered directly into this
field or returned from the Build Command button.

Note: The Build Command function is discussed in the next section.
4. Click the Description field and enter a description.

5. In the Attachment Security box, choose the Group(s) to which this Attachment will be
visible and click Add to add each one to the Access box.

6. To make the Plug-In executable upon window initialization, click the Run Automatically
box on.

7. After all fields defining the Plug-In are entered, click the Save button.
Note: The Run Automatically check box does not appear in the stand-alone function.

The Build Command Function

The purpose of the Build Command function is to assist you in the set up of a plug-in attachment’s
executable command line and any additional data that needs to be passed to the application at
execution.

Build Command Line I
Command Line:

Executable File:

Select File...
—Parameters
Field Variables: { ser id
user passward
Other:
Add I
oK | clear | [ cancel |

Figure 3-41. The Plug-In Attachment Build Command Window
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Field Description
Command Line This protected field displays the command being built from

the Executable File, Parameters: Field Variables, and
Parameters: Other fields. This line may not be longer than
255 characters.

Executable File Required field. This may be entered by the user or populated
by selecting a file from the Select File function.

Parameters: Field Field variables are selected from the list provided. This list
Variables will differ depending upon which function is being accessed.
Variables are retrieved from the SiteManager database and
passed to the executable application.

Parameters: Other | Variables entered in this field are passed as entered to the
plug-in application when it is activated by a user.

Table 3-15. The Plug-In Attachment Window Fields Table

To build a command using the Build Command function:
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1.

On the Plug-In Attachment window, click the Build Command button. The Build
Command window opens.

Enter the executable command path or click the Select File button.

a. The Select File window opens, allowing browsing of the system’s directories to locate
and select an executable file and its path directory.

b. Click Open. The file name and path are passed to both the Executable File and the
Command Line fields.

If desired, select an item from the Parameter Field Variable list by clicking on the desired
item. Click the Add button to add the field variable to the Command Line. These variables
for the selected record will be passed to the plug-in attachment when it is activated.

a. If the attachment is for Contracts, the Contract ID is a variable that may be passed to the
attachment automatically by the system.

b. Since a space is the defined parameter delimiter for plug-in command lines, there should
be no spaces in the path defining where the plug-in attachment can be found by the
system. For example, if a user wishes to have a plug-in attachment that initializes a Word
document called form.docx, the command line might be:

c:\program files\msoffice\winword\winword.exe c:\templates\form.docx
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If the command line were written as follows, the command would not work because of
the space in the My Documents directory name:

c:\program files\msoffice\winword\winword.exe ¢:\my documents\templates\form.docx

4. To add additional data to be passed to the application at execution, click the Parameter:
Other field and enter the desired data.

5. Click Add. The additional data appears on the Command Line.

6. When the Command Line has been completed, click the OK button. The Build Command
Line window closes, and the Command Line is passed to the Plug-In Attachment window’s
Enter Command Line field.

Plug-In Fields Available

The following table, organized by SiteManager functionality, lists the fields available to the Plug-In
function.

Functional Field ID Field Description
Area
All Areas
USER User ID
PSWD User Password

Daily Work Reports

CONT DWR Contract ID
Daily Work Report Date
DATE
INSP DWR Inspector User ID
PROJ DWR Project Number
ITEM DWR Line Item Number
LOCA DWR Location Sequence Number

Materials Management

SMPL Sample 1D

METH Test Method
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Functional Field ID Field Description
Area
TST# Sample Test Number
RGHT User Rights
MTR# Material Code
SPBY Sampled By
PSC# Producer/Supplier Number
ATHZ Authorized By user ID
RVS# Revision Number
SPFR Sampled From
GEOA Geographic Area
STAT Sample Status
MIX# Sample Mix ID
MIXT Sample Mix Design
LAB# Lab ID
SPDT Date Sampled
AZDT Date Authorized
CMDT Date Completed

Contract Administration

CONT

Contract ID

EST#

Estimate Number

Table 3-16. The Fields Available for Plug-Ins Table
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URL Attachment Definition

Description:

=2 Plug-in Attachment =]
T R
Enter command line:
Build Command. .. ]

Attachment Security:

Group 1D Description - Description e
Accounting - Projects and Grants Add > i

DMASST [Edmiristrative Assistant

Add All ->> i

COSTEST [Cost Estimates

FINLENG  [Finals Engineer

MO [IFquiiny Tkl - DR

IMSF. [[Fspector Standalone P I
IMSPTST [Field Inspecton/ T ester

+]

IMSPTSTE [Fisld Inspecton/Tester - Standalc'.njl’ <¢-Hem All
>

[ Run Automatically

Add |  Cancel

Figure 3-42. The Select File or URL Window

Field Name

Description

Name

Required field. The user-entered name of the
attachment, entered in freeform text.

Enter the URL or
Specify a Local File

Required field. The location of a local html document
or web page address.

Description

Not required. A short, user-entered description of the

html document or web page address.

Table 3-17. The Select File or URL Attachment Window Fields Table

To create a new URL or HTML File attachment:

1. Click the New URL button to access the Select File or URL window.

2. Click the Name field and

add a name for the new URL.
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3. Click the Enter Command Line field. The command line may be entered directly into this
field or returned from the Choose File function.

4. Click the Description field and enter a description.

5. Inthe Attachment Security box, choose the Group(s) to which this Attachment will be
visible and click the Add button to add each one to the Access box.

6. After all fields defining the URL or HTML file are entered, click the Save button.

OLE Attachment Definition

Insert Object x| |

Create New | Create From File I Inzert Control I

Object Type:
ActionBywr Class - ™ Display Az lcon
ActorBwr Clazs
Adbook Document
Adbook. Document D
Adobe Acrobat Document
Bitmap Image ColorBwr Clazs

ColarBwr Clazs
Cr Behawiar Factary
DataCH Clazs

DHTHML Edit Contral for IES

DHTHML Edit Contral 5 afe for Scripting fc
EffectBywr Class ;I Browse. . |

— Hesult

Inzerts a new ColorByr Clazs object into pour

document.

k. I Cancel |

Figure 3-43. OLE Insert Object Dialog Box (Create New Tab)

Field Name Description

Object Type List of OLE-compliant applications that are installed on the
client machine that may be used to create an OLE document.

Table 3-18. The OLE Insert Object Dialog Box Fields Table
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B0LE Anochwens ||| [ [ [ ]

OLE contents:

ordPad D ocument

D escription:

Attachment Security:

Description - Description Access |
Add >

Finals Engineer

Field Inspector/Tester

Field Inspectar/Tester - Standalone

<- Hemove

td anager - Inquiry Only

CTEN
Add All ->> |
[+ e

Froject kanager o ¢ Bem All |
| 3|

[~ Run Automatically

Add I- LCancel |

Figure 3-44. The OLE Attachment Definition Window

Field Name Description
Name Required field. The User-entered name of the attachment,
entered in freeform text.
OLE Contents A non-editable field which indicates the application in which
the OLE attachment is generated.
Description A freeform text explanation of the OLE attachment and its

purpose.

Description

Attachment Security: The Group ID to which the attachment is to be accessible.
Group 1D
Attachment Security: The full, descriptive name of the Group ID.

Run Automatically

When checked, this box indicates that the OLE will be run
automatically when the Attachments icon is clicked.

Table 3-19.

The OLE Attachment Definition Window Fields Table

To create a new OLE attachment:

1. Click the OLE button to access the Insert Object dialog box.
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2.

W

Select the type of OLE object to be created by clicking the application name in the Object
Type box.

Click OK. The OLE Attachment definition window appears

Click the Name field and enter a name for the OLE attachment.

5. Click the Description field and enter a description.

In the Attachment Security box, choose the Group(s) to which this Attachment will be
visible and click the Add button to add each one to the Access box.

If it is desirable to have the OLE attachment appear upon entering the Attachments window,
select the Run Automatically check box.

After all fields defining the OLE are entered, click the Add button.

On the Attachments window, double click the OLE definition just created to begin creating
the OLE document.

10. When finished, click File then Update, and close the window normally.
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Contract Administration includes the reference data and program functions that are used to view,
add, modify, and delete contract records. These are grouped on the following panels:

Panel Name Description
Reference Tables The Reference Tables (CA) panel contains the
(CA) Panel contract defaults and standard data. This includes the

vendors, funding sources, and items that you can add
to contracts. The Interface Load Messages window
displays the results of processes that load data from

other systems.
Contract Records The Contract Records panel contains the functions
Panel that maintain contract records. This includes the

contract description, milestones, projects, categories,
items, funding, stockpiled materials, key dates,
scheduled events, permits, user authority, and design
evaluations.

Contractor The Contractor Management panel contains
Management Panel functions for recording contract-specific data on
prime contractors and subcontractors. This includes
conference and document tracking, subcontract
descriptions, contractor payrolls, progress schedules,
and contractor evaluations.

Reports Panel The Reports panel contains contract-specific reports.
These include reports on contract status, contractor
status, subcontract value, disputes and claims, item
quantity, item work, and contract history.

Table 4-1. Contract Administration Panels Table
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(B sicManager Panet ||| |11 1 1T

Main Panel T" " Contract Administration{+) 7]’ Reference Tables(Ca+)

M B @ B =

Reference Contract Contractar Reports [CA+]  Process List
Tables(CA+) Records(+)  Management(+)

Figure 4-1. Contract Administration Panel
To access the Contract Administration panel:

1. On the SiteManager main panel, double-click the Contract Administration icon.

4.1 Reference Tables (Contract Administration)

The Contract Administration reference tables store the defaults and the agency-defined standards
that are added to contracts. Typically, the reference table data is loaded into SiteManager from
another system using an interface load process. This section of the manual describes how to view
and maintain the reference table data in SiteManager.

Through the Reference Tables (CA) panel, you can add the following standards and defaults to the
reference tables if you are an authorized user: administrative offices, funding sources, vendor
information, default key date types, default checklist event types, and default liquidated damage
rates. The Reference Tables (CA) panel cannot be used to add the default critical date types or items.
The default critical date types were defined during system development. Items are added to the Item
Master via the pre-construction system load program.

The defaults include the critical date types, key date types, checklist event types, and the liquidated
damage rates. After defaults are entered in the reference tables, SiteManager adds the defaults to
new contracts automatically. For other contract defaults, see the topic System Operational
Parameters for Contracts.

The standards include the administrative offices, items, funding sources, and vendor information.
The standards are defined by the transportation agency. After standards are entered in the reference
tables, you can add standard data to a contract by selecting it on the appropriate SiteManager
window. For example, the funding sources can be selected on the Contract Funding window.

I Important! SiteManager will not let users overwrite the Reference Table data loaded
from the pre-construction system by the interface load process.

The Reference Tables (CA) icons represent the following windows:
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= |Interface Load Messages
= Administrative Offices

= |tem Master

= Funding Sources

= Vendors

= Default Critical Dates

= Default Key Dates

= Default Checklist Events

= Default Liquidated Damages

E SiteManager Panel E
Iain Panel T Contract Administration(+] T Reference Tables[CA+)
MeTsage. < [y = — Schedule
2 Factoryl
= B &5
Ul Administrative  ltem Master  Funding Sources  Vendors Default Critical — Default Key
Offices Dates Dates
Default Checklist Default
Events Liquidated
Damages

Figure 4-2. Reference Tables (CA) Panel
To access the Reference Tables (CA) panel:

1. On the Contract Administration panel, double-click the Reference Tables (CA) icon.

4.1.1 Interface Load Messages

This Interface Load Messages window lists the messages generated during the interface load
processes. You can view and delete the messages on this window, and you can find, filter, and sort
the message list.
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Reference data load process
(REFLOAD)

Reference Table data is loaded into SiteManager
from another system by the REFLOAD process.

Pre-construction Contract
data load process
(PRELOAD)

New contracts are loaded into SiteManager from
the pre-construction system by the PRELOAD
process.

Construction Contract data
load process (CONLOAD)

Contracts to be converted are loaded into
SiteManager from the pre-construction system by
the CONLOAD process.

Table 4-2. Interface Load Process Table

ﬂlnlellace Load Messages [_[O] x|
Load
Date Process | Contract ID Table ID Message
| 13330408 REFLOAD Record 10 invalid
. 19930408 | REFLOAD T_INTRFC_MSG NULL during insert]
19930408 | REFLOAD T_INTRFC_M5G Record 8; SOLSTATE = 23000N[INTERSDLY][ODEC Orac
19930408 | REFLOAD T_INTRFC_MSG Oracle]0RA-01400: mandatory (MOT NULL) column is miss
19930408 | REFLOAD T_INTRFC_MSG Record 3; SOLSTATE = 23000MINTERSOLY][ODEC Qrac
19930408 | REFLOAD T_INTRFC_MSG Oracle]0RA-01400: mandatory (MOT MULL) colurmn is miss
19930408 | REFLOAD T_INTRFC_MSG MULL during insert]
19930416 | REFLOAD T_INTRFC_M5G Oracle]0RA-01400: mandatory (MOT NULL) column is miss
19930416 | REFLOAD T_INTRFC_MSG NULL during insert]
19930416 | REFLOAD Record 10 invalid
19930416 | REFLOAD T_INTRFC_MSG Oracle]0RA-01400: mandatory (MOT MULL) colurn is miss
19930416 | REFLOAD T_INTRFC_MSG Record 8; SALSTATE = 23000MINTERSOLY][ODEBC Qrac
19930416 | REFLOAD T_INTRFC_M5G MULL during insert]
19930416 | REFLOAD T_INTRFC_M5G Record 3; SOLSTATE = 23000N[INTERSOLY][ODEC Orac
1
Ready [Server [FROD [SMADMIN  [S'YS1
Figure 4-3. Interface Load Messages Window
Field Name Description
Date Date the interface load message was generated.

Load Process

Name of the interface load process that generated the
message (REFLOAD, PRELOAD, or CONLOAD).

Contract ID

Transportation agency-defined 1D for the contract
associated with the interface load message.




AASHTOWare Project SiteManager™

4. Contract Administration - Reference Tables 4.1 Reference Tables (Contract Administration)
Field Name Description
Table ID Name of the database table associated with the

interface load message.

Message Interface load message text.

Table 4-3. Interface Load Messages Window Fields Table
To delete an interface load message:
1. On the Reference Tables (CA) panel, double-click the Interface Load Messages icon.

2. To select one message to delete, click the row. To select multiple messages, hold the Ctrl
button and click the left mouse button on each row.

3. Click the Delete button. The selected message is deleted from the list.
4. Click the Save button.

You can use the find, filter, or sort functions to find specific information.

4.1.2 Default Liquidated Damage Rates

The Default Liquidated Damages window lets you view and modify the default liquidated damage
rates. SiteManager adds a default rate to new contracts based on the bid amount of the contract. On
the Default Liquidated Damages window, you can enter the rate per day for each contract bid
amount range. The system only displays the highest value for each range. The lowest possible value
for the Contract Amount Range is $0.00, while the highest possible value is always
$9,999,999,999.99.

If you do not enter a contract’s liquidated damages rate manually, the system adds the default rate to
the contract automatically when the contract status is changed to active.
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EDEfault Liguidated Damages

Contract Range Max Amt Hate Amount -
m 490,00

55.555.00 500.00
100,000.00 530.00
250,000.00 £10.00
500,000.00 ¥30.00

1.000,000.00 300.00
2.000,000.00 1.150.00
4.000,000.00 1.510.00
8.000,000.00 2.030.00
12.000,000.00 2.550.00
16.000,000.00 3.150.00
18.000,000.00 3.330.00
20.000,000.00 3.510.00
22 000,000.00 3.630.00
24.000,000.00 S,B?EI.EIEI;I

Figure 4-4. Default Liquidated Damages Window

Field Name Description
Contract Range The maximum amount for which the liquidated damages
Max Amount rate can be used. The total contract bid amount must be

equal to or less than this amount and more than the
previous ending amount. This value must be unique. For
states with one standard amount for all contracts, this
value defaults to 99,999,999,999.00 and cannot be
modified.

Liquidated Damages | The default liquidated damages rate per day. This amount
Rate Amount is associated with the Contract Range Maximum Amount.

Table 4-4. Default Liquidated Damages Window Fields Table
To add a default liquidated damages rate:
1. On the Reference Tables (CA) panel, double-click the Default Liquidated Damages icon.
2. Click the New button. An empty row is inserted before the selected row.
3. Type the ending range for the Contract Range Max Amt.
4. Press the Tab key.
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5. Type the Rate Amount.
6. Click the Save button.
7. Click the Yes button.
The list is sorted in ascending order of ending range amounts.

The large value in the last row cannot be modified or deleted.

4.1.3 Default Critical Dates

The Default Critical Dates window lets you view and modify the default critical dates. The default
critical date types were defined during system development. The transportation agency cannot add,
modify, or delete the critical date types. However, if you are an authorized user, you can modify the
default critical date settings. SiteManager adds the default critical dates automatically to each new
contract. The critical date types are listed here in alphabetical order:

= Accepted Date

= Adjusted Completion Date

= Award Date

= Checked Out to Field Date

= Contract Archived Date

= Contractor Bankruptcy Date

= Contractor Default Date

= Contractor Final Release Date
= Contract Iltems Complete Date
= Execution Date

= Letting Date

= Notice to Proceed Date

= Open to Traffic Date

= Original Completion Date

= Physical Work Complete Date

= Price Adjustments Base Date
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= Signed Date
= Substantial Work Complete Date
=  Work Begin Date

These dates are considered critical because SiteManager includes them in the standard contract
record reports.

ﬂ Default Critical Dates =3

Critical Date Type Required to Activate = Required to Finalize

Accepted Date

=

Adjusted Completion D ate
Contract Archived Date
Award Date

Contractor Bankruptcy Date
Checked Out to Field Date
Contractor Default Date

Execution Date

Contractor Final Release Date

Letting Date

Motice to Proceed Date -
4 » I

Critical Date Type: lﬁccepled Date [T Required to Activate
Distribution List: | [ Required to Finalize

Recipient ID: |

Message Text: |

<X|=Z=[=|L|=|=|=(=|=
ZZ|Z|ZZ|Z|Z2ZZZpp=

Figure 4-5. Default Critical Dates Window

Field Name Description

Critical Date System-defined default critical date type. The default critical
Type date types were defined during system development. The
transportation agency cannot add, modify, or delete the
critical date types.

Required to Indicates that a critical date event must occur before the
Activate contract status can be changed from Pending to Active (e.g.,
the Execution Date). A critical date cannot be both Required
to Activate and Required to Finalize.

Required to Indicates that a critical date event must occur before the

Finalize contract status can be changed to Complete. A critical date
cannot be both Required to Activate and Required to
Finalize.

Distribution Group to be notified when the actual date of the critical date

List event is entered. You can search this field. After valid entry

of a distribution list, the Recipient ID field is protected.
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Field Name Description
Recipient ID Person to be notified when the actual date of the critical date

event is entered. You can search this field. After valid entry
of a recipient ID, the Distribution List field is protected.

Message Text Standard message to be sent to the recipient(s).

Table 4-5. Critical Dates Window Fields Table
To make a critical date Required to Activate:
1. On the Reference Tables (CA) panel, double-click the Default Critical Dates icon.
2. Click the critical date.

3. If the date is currently not required for either status change, click the Required to Activate
radio button.

4. Click the Save button.
To select one or more recipients for notification that a date has occurred:
1. On the Reference Tables (CA) panel, double-click the Default Critical Dates icon.

2. Inthe Distribution List field or the Recipient ID field, type the entry or click the right
mouse button and perform a Search.

3. Click the Save button.

4.1.4 Default Key Dates

The Default Key Dates window lets you add, modify, and delete the default key dates. The key date
types are defined by the transportation agency in the system code tables. On the Default Key Dates

window, you can add pre-defined key date types to the default list. You can find, filter, and sort the
list, and modify the key date settings. SiteManager adds the default key dates automatically to each

new contract.

The main purpose of a key date is to monitor a key contract activity and notify personnel when the
activity actually occurs.

4-10
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E Default Key Dates M= E3

Fed/State/
Prov Ind

Key Date Type Required

to Activate

Required
to Finalize

Closed to Traffic Date

N o

Key Date Type: |Elosed to Traffic Date

Fed/State/Prov Ind: | Federal [~ Required to Activate
" State/Province
* Both [ Required to Finalize

Distribution List: |

Recipient User ID:

Message Text: |

Figure 4-6. Default Key Dates Window

Field Name Description
Key Date The key date types are the names given by the
Type transportation agency to the key dates (e.g., Closed to

Traffic Date, State Final Inspection Date, Open to Traffic
Date). The key date type is a required field and must be
unique. This field is protected unless you select the New

menu option.
Required to Indicates that a key date must occur before the contract
Activate status can be changed from Pending to Active (e.g.,

Letting Date, Award Date, Execution Date). A key date
cannot be both Required to Activate and Required to
Finalize.

Distribution Group to be notified when the actual date of the key date

List event is entered. You can search this field. After valid
entry of a distribution list, the Recipient User ID field is
protected.

Required to Indicates that a key date is part of the contract

Finalize finalization process. A key date cannot be both Required
to Activate and Required to Finalize.

Recipient Person to be notified when the actual date of the key date

User ID event is entered. You can search this field. After valid
entry of a recipient, the Distribution List field is
protected.
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Field Name Description
Fed/State/ Indicates that this date is for federal contracts,
Prov Ind state/province contracts, or for both types of contracts.
This is a required field.
Message Text | Standard message to be sent to the recipient(s).

Table 4-6. The Default Key Date Window Fields Table
To add a default Key Date type to the window:
1. On the Reference Tables (CA) panel, double-click the Default Key Dates icon.
2. Click the New button. An empty row is added to the list.

3. Inthe Key Date Type drop-down list, click the expand arrow and click a Key Date Type on
the list of available Key Date Types.

4. |In the Fed/State Prov Ind field, select one of the radio buttons.

5. Click the Save button.

4.1.5 Default Checklist Events

The Default Checklist Events window lets you add, modify, or delete the default checklist events.
The checklist event types are defined by the transportation agency in the system code tables. On the
Default Checklist Events window, you can add pre-defined Checklist Event types to the default list.
You can find, filter, and sort the list, and modify the checklist event settings. SiteManager adds the
default checklist events automatically to each new contract.

The main purpose of a checklist event is to schedule an event that occurs more than once or at
regular intervals, and to notify personnel when a date arrives and an action (e.g., approval) has not
occurred.

4-12
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EDe[aull Checklist Events [_ (O] x|
Event Type Event Group Type | Fed/State/ | Required Doc Type Discrepancy Required ~

Prov Ind
Bonding Yerified User Defined Federal

Indicator | to Activate

Final Inspection Completed  |User Defined State/Frovince M M
DBE Commitment Verified User Defined M N

o o

Event Type: |Bonding Verified Fed/State/Prov Ind: |+ Federal
Event Group Type: [User Defined =] ; g:]at:le}'vaince
Required Doc Type: [Spaces =] [~ External Indicator
F Type: [Monthly =] [ Required to Activate
Event Day: IT [ Discrepancy Indicator
Distribution List: | Recipient User ID: W

Message Text: |

Figure 4-7. Default Checklist Events Window

Field Name Description

Event Type The event types are the names given by the transportation agency
to the checklist events that occur throughout the life of the
contract (e.g., Bonding Verified, DBE Commitment Verified,
Final Inspection Completed). The Event Type is a required field
and must be unique. This field is protected unless you select the
New menu option.

Event Group | Grouping of associated event types (e.g., EEO, Training, and

Type Certification). This is a required field.
Frequency For repetitive events, the frequency with which they occur (i.e.,
Type Daily, Weekly, Biweekly, Monthly, Quarterly, Semi-Annually,

Annually, and One Time Only). This is a required field. If you
select One Time Only, you can also select Required to Activate.

Event Day The day of the week or month that the event is to occur. For
weekly and bi-weekly events, enter the day of the week (01-07).
For monthly events, enter the day of the month (01-30). This field
is protected for all other frequency types.

Required Doc | Transportation agency-defined codes identifying each type of
Type document (e.g., Trainee report, EEO report, and Material
Certification). This field is required when the External Indicator
is checked (ON).
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Field Name Description
Required to Indicates that an event must occur before the contract status can
Activate be changed from Pending to Active (e.g., ‘DBE commitment

verified").

Discrepancy
Ind

Indicates that if an event has not occurred before estimate
generation, it will be reported as a discrepancy.

Distribution Group to be notified when the event’s projected date expires

List before the actual date is entered. You can search this field. After
valid entry of a distribution list, the Recipient User ID field is
protected.

External Indicates that a document is due to be received from an external

Indicator source.

Recipient Person to be notified when the event’s projected date expires

User ID before the actual date is entered. You can search this field. After
valid entry of a recipient, the Distribution List field is protected.

Fed/State/Pro | Indicates that the checklist event is for a Federal Contract,

v Ind State/Province Contract, or Both. This is a required field.

Message Text

Standard message to be sent to the recipient(s).

Table 4-7. Default Checklist Event Window Fields Table

To add a checklist event to this window:

On the Reference Tables (CA) panel, double-click the Default Checklist Events icon.

Click the New button. An empty row is added to the list.

In the Event Type drop-down list, click the expand arrow and click an event type on the list

of available Event Types.

In the Fed/State Prov Ind field, click a radio button.

4.1 Reference Tables (Contract Administration)

5. Press the Tab key.

6. Inthe Event Group Type drop-down list, click the expand arrow and click an Event Group
Type on the list of available types.

7. Press the Tab key.

8. To require the receipt of an external document, in the Required Doc Type drop-down list,
click the expand arrow and click the document type.
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9.

10.

11.
12.

13.

14.

15.
16.
17.

18.

4.1.6

Press the Tab key.

To require the receipt of an external document, click the External Indicator check box
(ON).

Press the Tab key.

In the Frequency Type drop-down list, click the expand arrow and click the frequency of the
event.

If the Frequency Type is Weekly, Bi-weekly, or Monthly, tab to the Event Day field and
type a number representing the day of the time period on which the event is to occur (e.g.,
type 3 to represent the third day of each month).

If the Frequency Type is One Time Only, tab to the Required to Activate check box. If
desired, click the check box (ON).

Press the Tab key.
To require a discrepancy notification, click the Discrepancy Ind check box (ON).

To select a recipient or recipients, tab to either the Distribution List field or the Recipient 1D
field and type the entry, or click the right mouse button and perform a Search.

Click the Save button.

Funding Sources

The Funding Sources window lets you add, modify, and delete standard funding sources. You can
view but not modify funding sources loaded from the pre-construction system. After a funding
source is entered on the Funding Sources window, you can add the funding source to a contract by
selecting it on the appropriate SiteManager panels (e.g., Contract Funding).
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ﬂFunding Sources [ [O] x|

Funding Source List

Funding Src Cd Description Participation Pct ;.
#503 CONVERSION STATE FUNDING 0
F030 EMERGENCY RELIEF FUNDS 100.00
000 ENGLIS[STANDARD) TEST 0
F090 FHw&, (010] FUNDS 7E.87 _.
F14E FHw&, (075] FUNDS 76.87
F100 FH'w, (081) FUNDS 80.00
F144 FHw&, [085] FUNDS 80.00
F148 FHw& (138] FUNDS 90.00

M|

Funding Source Detail

Funding Source Code: |[FO03

Funding Source Desc: [ADVANCE CONSTRUCTION INTERSTATE FUM

[V Fed Aid Funding Indicator Accounting Fund Code: |109 [¥ Preconstruction Indicator
Participation Percent: |9ELDD Fund Prefix: |[AC][I] Funding Group: [FH'w4

Figure 4-8. Funding Source Window

Field Name

Description

Funding Source
Code

Identifies a source of funding (e.g., Federal grant, Federal
fuel tax, State general fund). This is a required field. This
field cannot be modified after the funding source is
saved.

Description

Name or description of a funding source.

Fed Aid Funding
Indicator

Indicates whether or not this fund contains federal aid
dollars.

Accounting Fund
Code

A code assigned to a fund by the transportation agency’s
accounting department. This field cannot be modified
after the funding source is saved.

Pre-Construction
Ind

Indicator to show that the data is from the pre-
construction system and cannot be modified.

Source The percentage of this fund paid by federal aid. This field
Participation is required if the Federal Aid Funding Indicator is
Percent checked (ON).

Fund Prefix An alternate identification code for a fund.

Funding Group

Allows several funds to be associated with the same
group code.

Table 4-8. Funding Source Window Fields Table
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To add a funding source to the reference table:

1.
2.

A

®

10.
11.

12.
13.
14.
15.
16.
17.

On the Reference Tables (CA) panel, double-click the Funding Source icon.
Click the New button.

In the Funding Source Code field, enter the source of funding (e.g., Federal grant, Federal
fuel tax, State general fund).

Press the Tab key.
In the Description field, enter a name or description of the funding source.
Press the Tab key.

If the funding includes federal aid money, click the Fed Aid Funding Indicator check box
(ON).

Press the Tab key.
Click the Accounting Fund Code field and type the code assigned to the fund.
Press the Tab key.

If the funding includes federal aid money, in the Participation Percent field, type the
percentage of this fund paid by federal aid.

Press the Tab key.
In the Fund Prefix field, type the fund prefix.
Press the Tab key.
In the Funding Group field, type the funding group.
Click the Save button.
To delete a funding source from the reference table:
a. On the Reference Tables (CA) panel, double-click the Funding Source icon.
b. Inthe Funding Source list box, scroll to and click the funding source.
c. Click the Delete button.
d. Click OK.

If the funding source is loaded from the pre-construction system, the data cannot be modified or
deleted in SiteManager.
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4.1.7 Item Master

4.1 Reference Tables (Contract Administration)

The Item Master window lets you view the standard Item list. An interface load process adds the
items from the pre-construction system to this list. You cannot add, modify, or delete Item Master
data. The default sorting order of the list is by Item Code first, then Spec Year, and then Unit. You
can find, filter, and sort any column on the list. The selected item’s Historical Price is displayed only
if you have the authority to view this data. You can add a standard item to a contract by selecting the
item on the appropriate SiteManager window (e.g., the Items window).

' Ttem Master

Item Code

Spec
Year

Short Description

03361B01G
019361R01G
019361C21C
013361C21C
03361C210
9361C210
M9361C21E

TIME COST TO SUBSTANTIALLY COMPLETE
TIME COST TO SUBSTANTIALLY COMPLETE
FPERFORMANCE BOND
FERFORMAMNCE BOND
FAYMENT BOMD

PAYMENT BOMD

PERFORMAMNCE BOND AMD PAYMENT BOMD

LLIKP SLIM
LLUIKP SLIM
LLIKP SLI

Alternate 1D:

Spec Book Reference: |

Description: |F'EF|FDFHMAN CE BOND

J  Material Item

J» Obsolete ltem [ Major ltem | Suppl Desc Req'd v Lump Sum Item

Item Historical Price: |$.DDDDD

Fuel Adjust Type: I

Figure 4-9. The Item Master Window

Description

Field Name Description

Item Code Transportation agency-defined code that identifies an
Item.

Spec Year The year of the specification book in which the item
appears.

Unit The unit of measure for this item.

Unit Type Indicates that the measurement system used is English
(E) or Metric (M).

Short Short text description of the item.

Alternate ID

Alternate ID of an item.

Spec Book
Reference

Identifies an item-specific section or paragraph from
the transportation agency’s spec book.

Description

Text description of an item. Two lines are provided.
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Field Name Description

Material Item | Indicates that materials are associated with the item.
Indicator

Obsolete Item | Indicates that this item is obsolete and no longer used.

Indicator

Major Item Indicates that an item is important enough to be

Indicator printed on the notice to iontractors, regardless of the
dollar amount allocated to it.

Require When checked, indicates that a supplemental

Supplemental | description must be entered for an item being added to
Description a project.
Indicator

Lump Sum Indicates that the selected item is a Lump Sum item.
Item
Indicator

Fuel Adjust Fuel price adjustment type to use for this item.
Type

Item Historical price of an item.
Historical
Price

Table 4-9. Item Master Window Fields Table
To view reference table item data:
1. On the Reference Tables (CA) panel, double-click the Item Master icon.

2. Inthe Item list box, scroll to and click the item or perform a Find. The window displays data
for the selected item.

4.1.8 Vendors

The Vendors window lets you add, modify, and delete vendors and related data in the reference
table. The vendors are the material suppliers, contractors, financial institutions, insurance companies,
consultants, and others who provide goods and services to the transportation agency. Typically, an
interface load process adds the vendors from the pre-construction system to SiteManager. You
cannot modify or delete Vendor data loaded from the pre-construction system. You can add Vendor
data to a contract by selecting it on the appropriate window (e.g., the Contract Prime Contractor
folder tab). The Vendors window contains the following folder tabs:
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Tab Name Description
Description The Description folder tab displays the vendor description.
The vendor addresses and remarks can be accessed from this
folder tab.

Work Classes | The Work Classes folder tab displays the vendor’s work
classes and the qualification amount for each type.

Affiliates The Affiliates folder tab displays the vendor’s affiliates (i.e.,
the other vendors affiliated with this vendor) and their
relationship. The affiliate addresses can also be accessed from
this folder tab.

Personnel The Personnel folder tab displays the vendor’s personnel. The
vendor personnel addresses can also be accessed from this
folder tab. If the vendor is a prime contractor, the personnel
entered here can be selected as prime contacts for specific
contracts on the Contract Prime Contractor folder tab.

Prime The Prime Contacts folder tab displays the vendor’s personnel

Contacts who have been selected as the prime contacts for specific
contracts.

Associates The Associates folder tab displays the vendor’s associates (i.e.,

the other vendors associated with this vendor) and the role of
the associate. If the vendor is a prime contractor, the vendor’s
insurance company and surety company must be entered here
before they can be selected for specific contracts on the prime
contractor folder tab.

Security The Security Accounts folder tab has a security accounts
Accounts section and a security transaction section. The security
accounts section displays the vendor’s security accounts; the
security transaction section displays a history of transactions
made against the selected account at the financial institution.

Securities On the Securities Usage folder tab, you can associate the
Usage vendor’s security accounts to specific contracts for use in lieu
of retainage. After a contract is selected, the current retainage
percentage and other contract amounts are calculated by the
system and displayed on this folder tab.

Table 4-10. Vendor Window Folder Tabs Table

4-20



AASHTOWare Project SiteManager™
4.1 Reference Tables (Contract Administration) 4. Contract Administration - Reference Tables

Vendor Description

The Vendor Description folder tab lets you add and modify the vendor descriptions and addresses.
You can view but not modify vendor data loaded from the pre-construction system. The vendor
remarks can also be accessed from this folder tab. The Ethnic Group and Gender fields are displayed
only if you are authorized to see this data. The ethnic group and gender data is required for federal
reports when the vendor is a DBE.

ﬂVenduls H=] B3
Description “Work Classes ~ Affliates  Personnel  Prime | Associales | Secuity  Secuities |
Contacts Accounts Usage
vendor ID: ST IRS Tax Nbe:|
Short Name: |
Full Name: |
Vendor Type: | [x] Al Vendor ID: I—
DBE Type: [Spaces =] Cert Type: [Spaces =l
Cert Date: [10/00/00 | Cert End Date: [00/00/00
Corp Type: [Spaces =] Corp State: [ =l
Prequal Date: lm Prequal End Date: Im
Uncompleted Work Amount: I—DDU [ Preconstruction Indicator
Ethnic Group: ISpaces Gender: I—

Figure 4-10. Vendor Description Folder Tab

Field Name Description

Vendor ID Transportation agency-defined 1D for the vendor.
Usually the company's Federal Tax ID.

IRS Tax Nbr Federal Employer tax ID number.

Short Name Short name for the vendor.

Full Name Full name of the vendor.

Vendor Type Identifies which type of company the vendor is (e.g.,

Prime, Subcontractor, Sub-Subcontractor). This is a
required field.

DBE Type Transportation-agency defined code to indicate that
the vendor has certification as a Disadvantaged
Business Enterprise (DBE). Examples are DBE,
MBE, and WBE. ‘Not a DBE’ is also a valid DBE

Type.
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Field Name Description

Corp Type Identifies the vendor’s company type (e.g., private
corporation, public corporation, partnership).

Corp State Identifies the vendor’s state or province of
incorporation.

Cert Type Code indicating whether the DBE is certified by the
federal government, state/provincial government, or
both. If the vendor is a DBE, this field is required.

Cert Date For DBEs, the DBE certification date. If the vendor

is a DBE, this field is required.

Cert End Date

The date on which the vendor’s DBE certification
expires.

Prequal Date

For transportation agencies that pre-qualify
contractors, the date on which the vendor was pre-
qualified.

Prequal End Date

The date on which the vendor*s pre-qualification
expires.

Uncompleted Work
Amount

Displays the uncompleted work amount for this
vendor. The uncompleted work amount is the sum of
the vendor’s current prime contractor and
subcontract amounts minus the vendor’s installed-to-
date amounts.

Preconstruction Ind

Indicates whether or not the data is from a pre-
construction system.

Ethnic Group

Transportation agency-defined code identifying the
vendor’s certified ethnic background (e.g., Black
American, Hispanic American, Native American).
The Ethnic Group field is only displayed if you is
authorized to see this data.

Gender

Indicates the vendor’s certified gender (i.e., Male or
Female). The Gender field is only displayed if the
user is authorized to see this data.

Table 4-11. Vendor Description Folder Tab Fields Table

4.1 Reference Tables (Contract Administration)
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To view a vendor description:

1.

o g ~ w D

~

10.
11.
12.
13.
14.
15.
16.
17.
18.

19.

20.
21.
22.
23.

On the Reference Tables (CA) panel, double-click the Vendors icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
To access the vendor’s address, click the Services menu and click the Address choice.

In the Address Type list box, scroll to and click the address type. If the address type has
multiple addresses, use the Prior and Next toolbar buttons to access all addresses.

To add a new vendor:

On the Reference Tables (CA) panel, double-click the Vendor icon.
Click the New button.

In the Vendor ID field, type the vendor’s ID.

Press the Tab key.

In the IRS Tax Nbr field, type the IRS tax number.

Press the Tab key.

In the Short Name field, type the short name of the vendor.

Press the Tab key.

In the Full Name field, type the full name of the vendor.

In the Vendor Type drop-down list, click the expand arrow and click the vendor type.

If the vendor is a DBE, in the DBE Type drop-down list, click the expand arrow and click
the DBE type.

If the vendor is a DBE, in the Cert Type drop-down list, click the expand arrow and click the
certification type.

Press the Tab key.
If the vendor is a DBE, in the Cert Date field, type the DBE certification date.
Press the Tab key.

If the vendor is a DBE, in the Cert End Date field, type the DBE certification expiration
date.
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24,

25.

26.
27.
28.
29.

30.

31.
32.
33.
34.

35.
36.
37.

38.
39.
40.

41.
42.

43.
44,
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In the Corp Type drop-down list, click the expand arrow and click the vendor’s corporation
type.

In the Corp State drop-down list, click the expand arrow and click the vendor’s state or
province of incorporation.

Press the Tab key.
In the Prequal Date field, type the date on which the vendor was pre-qualified.
Press the Tab key.

In the Prequal End Date field, type the date on which the vendor’s pre-qualified status
expires.

In the Ethnic Group drop-down list, click the expand arrow and click the vendor’s ethnic
group.

In the Gender drop-down list, click the expand arrow and click the vendor’s gender.
To enter the vendor’s address, click the Services menu and click the Address choice.
In the Address Type list box, scroll to and click the address type.

Type the Line 1 address information. If necessary, tab to and type Line 2 and Line 3 address
information.

Press the Tab key.
In the City field, type the vendor’s city location.

In the State/Prov drop-down list, click the expand arrow and click the vendor’s state or
province.

Press the Tab key.
In the Zip/Postal field, type the vendor’s zip code or other postal code.

In the Country drop-down list, click the expand arrow and click the vendor’s country
location.

Press the Tab key.

Type the vendor’s primary phone number. If necessary, tab to the ext field and type the
phone number extension.

Press the Tab key.
In the FAX field, type the Vendor’s FAX number.
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45. To add another address of the same type, click the New button and repeat steps 27 through
37.

Or
46. To add another address type, repeat steps 26 through 37.
47. To close the Address box, click the Description folder tab.
48. To save the new vendor description, click the Save button.

To be selected as a prime contractor, a vendor must have a payment address.

Address Function

In SiteManager, you can enter many types of addresses depending on the functional area. For
example, a vendor can have shipping address, billing address, a field address, etc. A common
interface has been developed to provide the same address functionality across the system.

The Address functionality has been implemented in two ways:

1. Access to the address through Address option under Services menu or an Address button on
the main toolbar. Clicking the Address button or selecting Services/Address causes a pop-up
address window to appear.

2. The address information appears directly on the currently-selected window. This occurs
when the window has enough space to accommodate the address. The Address window in
Administrative Offices is an example of this type.

If a window does not allow address entry through the pop-up window, the Services/Address menu
option and the Address button will not be available. In some cases, the Address button may appear
in the toolbar, but it does not function. It beeps. The Services/Address menu option will appear
dimmed and will not function when address entry is not allowed.

When the address pops up, initially it displays the address for the first address type if the address
already exists. Payment Address is the default address type. If the vendor, trainee, etc. has
multiple address types, a list of available address types and an icon adjacent to each type indicating
an address exists for that type is displayed. If a new address is to be entered, the address entry area
is empty and you must click the new button.

The Address Pop-up

The Address pop-up window is divided in two parts. The first part, Types, displays a list of
available address types. If a check mark B appears next to the address type, an address for that type
has been entered. Whenever you select a type by clicking it, the corresponding address appears in
the Address part of the window and the cursor is placed there. Each address type can have multiple
addresses. For example, a vendor could have many Field Trailer type addresses. You can see that
multiple addresses are listed because the Address part of the window shows how many pages
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(addresses) are listed (i.e., 1 of 4). When the address pop-up appears, up and down arrows are
present on the toolbar. The arrows are used to move through the list of addresses for a type.

Create an Address one time - Associate it thereafter

A new address is created one time only. Thereafter, the address is associated with the window by
selecting it from the appropriate picklist. For example, a new vendor is created in the Contract
Admin. Reference tables, Vendor window. In the contracts, Prime Contractor tab, the Current
Prime, Prime Contracts, and Prime Associates fields are completed by searching, selecting and
associating the address to the field. The addresses for these fields are created in the Vendor window
tabs, not in the contracts window tabs.

An address is maintained, modified, or deleted in the window where the address was created. An
address may not be deleted if it is associated to any contract. Clicking the Delete button deletes the
address for the selected address type. The association of the address takes place in any window
where the address capability exists. As in the preceding example, the address is created, maintained
or deleted in the Vendor tabs, but is associated in the Contracts, Prime Contractor tab.

If an address pop-up window appears with the address fields dimmed, the address originated in a
pre-construction contract and cannot be modified or deleted.

An address may be maintained without ever being associated. For example, the address and
telephone numbers for an EEO officer may never be associated.

A new, modified or deleted address is saved on window where the address was opened. The address
is automatically saved when the origination window is saved. Save is performed on the window, not
on the address object.

The Address function is available or displayed in the following components of SiteManager:
= Contract Administration, Reference Tables, Vendors icon folder tabs:
= Description - Create, modify or delete
= Personnel -  Create, modify or delete
= Affiliates-  Display only
= Associates - Display only

o Affiliates and associates are vendors. Select the Vendors ID to add, modify or delete
an address for them.

= Prime Contact - Display only - associated in the Prime Contact tab
= Civil Rights, Contract Compliance, Trainees icon

= Materials Management, Approved Lists icon
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= Inspectors

= Welders

= Producer/Supplier
= Qualified Labs

= Testing Personnel

The address function works consistently across the system. Although the following figures and

AASHTOWare Project SiteManager™

procedures relate specifically to Vendors, the methodology applies across the system.

Etonllacls M=l E3
Description Location Payment Data  Critical Dates Primary Prime DBE Commit — Training Plan
D. L Cantrack

Payment Address
BILLING ADDRESS

e
[’ |

Address For: |GF|EENBANK SERVICES COMPANY, INC
-BILLING ADDRESS 1 -of-1

FIELD TRAILER ADDR
PREQUALIFICATION A

Line 1: |4BD1 OAKLAWN BLVD.
Line 2: |

rs Paid

Pr

STREETADDRESS OR .| | |[ine3 |

City: |HDPEWE LL
State/Prov: I‘\IA Z|
Zip/Postal: IZBBBD-EIEIEID

|United States of America

Country:

—Contact Numbers

Ext: I—

Phone: [304-455-8533

Figure 4-11. Address Pop-Up Window

Field Name Description
Types This is a list of available address types. You can select
only one type at a time.
Address This is the actual address for the selected type.

One field of Line 1, 2, or 3 is a required field.

City, State or Province and Zip/Postal are required fields.

Messages will appear to complete required fields on the
Address pop-up when you save the window.

Table 4-12. Vendor Description Folder Tab Fields Table

To create an address for a new vendor:

4. Contract Administration - Reference Tables
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o

10.

11.
12.
13.

14.
15.

16.
17.
18.

19.
20.
21.

4-28

On the main panel, double-click the Contract Administration icon.

On the Contract Administration icon, double-click the Reference Tables icon.
On the Reference Tables panel, double-click the VVendors icon.

Select the Description folder tab.

Click the New button.

In the Address Type list box, scroll to and click the address type.

Type the Line 1 address information. If necessary, tab to and type Line 2 and Line 3 address
information.

Press the Tab key.
In the City field, type the vendor’s city location.

In the State/Prov drop-down list, click the expand arrow and click the vendor’s state or
province.

Press the Tab key.
In the Zip/Postal field, type the vendor’s zip code or other postal code.

In the Country drop-down list, click the expand arrow and click the vendor’s country
location.

Press the Tab key.

Type the vendor’s primary phone number. If necessary, tab to the ext field and type the
phone number extension.

Press the Tab key.

In the FAX field, type the vendor’s FAX number.

To add another address of the same type, click the New button and repeat Steps 6 through 17.
Or,

To add another address type, repeat Steps 6 through 17.

To close the Address box, click the Address button or just outside the Address pop-up.

To save the new vendor description and address, click the Save button.
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E\Fendots =] E3
Description “Work Classes ~ Affilates | Pewsonnel  Prime | Associates | Secuity | Securties |
Contacts Accounts Usage
Vendor ID:§ IRS Tax Nb:|
Short Name: |
Full Name: |
Vendor Type: [ [x] ARt Vendor ID: I—
DBE Type: [Spaces =l Cert Type: [Spaces =1
Cert Date: [00/00/00 | Cert End Date: [00/00/00
Corp Type: [Spaces =1 Corp State: [ [=]
Prequal Date: W Prequal End Date: W
u pleted Work A t: I—UUU [T Preconstruction Indicator
Ethnic Group: |Spaces Gender: I—

Figure 4-12. Vendor Window and Folder Tabs

Addresses for vendors and personnel are created using the procedures for creating a new address in
the Description tab. Affiliates, Prime Contacts, and Associates folder tabs are display only.

The same procedures apply in Trainees and Materials Approved Lists.

To modify an address:

1.

© 0o N o a0 B~ w D

L e i e =
A W N L O

Navigate to the window where the address was created.

Click the Open button and select a vendor from the picklist.
Click OK.

Click the Address button or the Services/Address choice.
Select the desired Address type.

Type the new information.

Click the Address button or click outside the pop-up to close it.
Save the window.

The same procedures apply in Trainees and Materials Approved Lists.

. To delete an address not associated to a contract

. Navigate to the window where the address was created.
. Click the Open button and select a vendor.

. Click OK.

. Click the Address button or the Services/Address choice.
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15. Select the desired address type (use the up and down arrows on the toolbar to move through
multiple addresses for a type.)

16. Click the Delete button.

17. Click the Address button or click just outside the pop-up to close it.

18. Save the window.

19. The same procedures apply in Trainees and Materials Approved Lists.

20. To associate an address with a contract:

21. On the main panel, double-click the Contract Administration icon.

22. On the Contract Administration icon, double-click the Contract Records icon.
23. On the Contract Records panel, double-click the Contract icon.

24. On the Contracts window, select the Description folder tab.

25. On the Description folder tab, click the Open button and select the desired contract.
26. Double-click the highlighted contract or click OK.

27. Select the Prime Contractor folder tab.

28. Click on the Prime Contractor field to focus.

29. Associate a new vendor’s address by clicking the New button and selecting a vendor from
the picklist,

30. Or

31. Change the existing vendor by clicking the Open button and selecting a different vendor
from the picklist.

32. Click OK on the Vendor picklist.

33. On the Prime Contractor folder tab, click the Services menu and choose the Select Address
choice.

34. Click the Address button or click just outside the pop-up to close it.
35. Save the window.
The same procedures apply in Trainees and Materials Approved Lists.

If an incorrect address is associated to a contract, the address is replaced with the correct address.
The incorrect address is not deleted, but is replaced using the procedures for associating an address
with a contract. SiteManager recognizes the most current association.
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Vendor Work Classes

The Vendor Work Classes folder tab lets you add, modify, and delete the work class type and
qualification amount for the selected vendor. If the vendor was loaded from the pre-construction

system, you can view but not modify the data on this folder tab.

E\I’endors !E[ [ |
—_ e e e e . T .
Description Work Affiliates Personnel Frime Agsociates Security Securities
Classes Contacts Accounts Usage
Vendor ID: |GEI22 Short Name: [GREENEANK SERVICES COMPANY, INCORPORATE

Workclass Type Qualification Amount
GENERAL HIGHwAY CONSTRUCTION B

oL .01

Figure 4-13. Vendor Work Classes Folder Tab

Field Name Description
Workclass Type Code that identifies the major type of work class for a
vendor (e.g., Roadway Construction, Bridge Construction,
Utilities).

Qualification Amt Amount specified for the major type of work for which
the vendor is qualified.

Table 4-13. Vendor Work Class Folder Tab Fields Table

To add a vendor work class to the reference table:

1.
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On the Reference Tables (CA) panel, double-click the VVendor icon.
Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.

Click the OK button. The Description folder tab displays data for the selected vendor.

On the Vendors window, click the Work Class folder tab.
Click the New button.

4. Contract Administration - Reference Tables
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7. Inthe Work Class Type drop-down list, click the expand arrow and click the vendor’s work
class type.

8. Press the Tab key.
9. Inthe Qualification Amt field, type the vendor’s qualification amount.

10. Click the Save button.

If the vendor is from a pre-construction system, both the Work Class Type and the Qualification
Amount fields are protected, and no work classes can be added.

Vendor Affiliates

The Vendor Affiliates folder tab lets you add, modify, and delete the affiliates for a selected vendor.
The affiliates are also vendors and must be entered in SiteManager as vendors before they can be
selected as affiliates. On the Vendor Affiliates folder tab, you specify the affiliate’s relationship to
the vendor. For example, a ‘joint venture’ contract must have a prime contractor with a ‘joint’
affiliate. If the vendor was loaded from the pre-construction system, you can view but not modify the
data on this folder tab.

E\Fendols |- [O] x|
Description  “Work Classes  Affiliates Personnel Prime: Associates Security Securities
Contacts Accounts Usage
Yendor ID: |DL333 Short Name: |LBX General Contractors
Affiliate Short Name Relationship Type Ownership % iI
I [ .00

Figure 4-14. Vendor Affiliates Folder Tab

Field Name Description

Affiliate Short Name | Abbreviated name of the vendor. You can search
this field. This field is required.

Relationship Type Type of affiliate (e.g., parent, joint, partner). This
field is required.

Ownership % The vendor's percentage of ownership of the
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Field Name Description
affiliate. This field is required.

Table 4-14. Vendor Affiliates Folder Tab Fields Table

To add a new vendor affiliate to the reference table:

9.
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On the Reference Tables (CA) panel, double-click the VVendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Affiliates folder tab.

Click the New button.

In the Affiliate Short Name field, type the short name of the vendor’s affiliate or perform a
Search.

In the Relationship Type drop-down list, click the expand arrow and click the relationship of
the affiliate to the vendor.

Press the Tab key.

10. In the Ownership % field, type the vendor’s percentage of ownership of the affiliate.

11. Click the Save button.

If the vendor is from a pre-construction system, all the fields are protected and no affiliates can be

added.

Vendor Personnel

The Vendor Personnel folder tab lets you add and modify personnel records for the selected vendor.
You can also add and modify vendor addresses. This folder tab is primarily used to enter the contact
person and DBE-related personnel for the vendor, especially vendors who are prime contractors. The
folder tab displays the vendor personnel list and data for the person selected on the list. The Social
Security Number (SSN) or Social Insurance Number (SIN), Ethnic Group, and Gender fields are
displayed only if you are authorized to see this data.
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E\f'endols H=] E3
Description  ‘work Classes Affiliates Personnel Prime Associates Security Securities
Contacts Accounts Usage
VYendor ID: |DLSSS Short Name: ILBX General Contractors

Person Name Dfficer Title

PRESIDENT 000-00-0000

Person Name: |Christina Marris User |D:|
Officer Title: [FRESIDENT [=] SSN: [o0-00-0000
Ethnic Group: [Caucasian =1 Gender: "M < F

Figure 4-15. Vendor Personnel Folder Tab

Field Name Description

User ID Transportation agency-defined ID for the user. You can
search this field.

Personnel Name The name of a person employed by the vendor. When a
valid User ID is entered, this field defaults to the name
associated with the User ID and cannot be modified. The
name must be unique for the vendor. This is a required
field.

Officer Title Transportation agency-defined code that identifies the title
of the vendor’s employee (e.g., Owner).

SSN/SIN Social Security Number or Social Insurance Number of the
vendor’s employee. This field is displayed only if you are
authorized to see this data.

Ethnic Group Transportation agency-defined code identifying an ethnic
background (e.g., Black American, Hispanic American,
Native American). This field is required when the vendor is
a DBE (i.e., a DBE Type is entered on the Vendor
Description folder tab). The Ethnic Group field is displayed
only if the user is authorized to see this data.

Gender Indicates the gender of the person employed by the vendor
(i.e., Male or Female). This field is required when the
vendor is a DBE (i.e., a DBE Type is entered on the
Vendor Description folder tab). The Gender field is
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Field Name Description

displayed only if the user is authorized to see this data.

Table 4-15. Vendor Personnel Folder Tab Fields Table

To add vendor personnel to the reference table:

1.
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14.

15.
16.
17.

18.
19.
20.

On the Reference Tables (CA) panel, double-click the VVendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Personnel folder tab.

Click the Person Name field and type the person’s name.

In the Officer Title drop-down list, click the expand arrow and click the title.

Press the Tab key.

In the SSN field, type the person’s social security number.

. In the Ethnic Group drop-down list, click the expand arrow and click the ethnic group.
. To select a Gender, click the ‘M’ or ‘F’ radio button.
. To enter the vendor’s address, click the Services menu and click the Address choice.

. In the Address Type list box, scroll to and click the address type. If an address is displayed,

click the New button to add another address of the same type.

Type the Line 1 address information. If necessary, tab to and type Line 2 and Line 3 address
information.

Press the Tab key.
In the City field, type the person’s city location.

In the State/Prov drop-down list, click the expand arrow and click the person’s state or
province

Press the Tab key.
In the Zip/Postal field, type the person’s zip code or other postal code.

In the Country drop-down list, click the expand arrow and click the person’s country
location.
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21. Press the Tab key.

22. In the Phone field, type the person’s primary phone number. If necessary, tab to the ext field

and type the phone number extension.

23. Press the Tab key.

24. In the FAX field, type the person’s FAX number.

25. To close the Address box, click the Personnel folder tab.

26. To save the new personnel description, click the Save button.

To be selected as a contact person for a vendor who is a prime contractor, the person must have a
title and an address entered.

To delete vendor personnel from the reference table:

1.
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On the Reference Tables (CA) panel, double-click the VVendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the Vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Personnel folder tab.

In the Personnel list box, scroll to and click the person.

Click the Delete button.

Click OK.

Vendor Prime Contacts

The Vendor Prime Contacts folder tab lets the user view the vendor’s personnel who have been
selected as prime contacts. A prime contact is a prime contractor’s contact person for a specific
contract. The Prime Contacts folder tab displays the name and contact type of the person and the
Contract ID for which the person is a contact. The user cannot add, modify, or delete a prime contact
on this folder tab. To add a prime contact, the user must first enter the name as personnel on the
Vendor Personnel folder tab. Then the user can select the name as a prime contact for a specific
contract. This is done on the Contract Prime Contractor folder tab.
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Blvendors — O x

Description  Work Classes Affiliates Personnel Prime Associates Security Securities
Contacts Accounts Uszage

Vendor ID: [S018 Short Name:  [SHIRLEY CONTRACTING CORP.

Contact Name

Kirk. Clark.

Figure 4-16. Vendor Prime Contacts Folder Tab

Field Name Description
Contact Name Name of the person who is a contact for this vendor.
Contact Type Title of the person who is a contact for this vendor
(e.g., EEO).
Contract ID Transportation agency-defined ID of the contract for

which this person is a contact.

User ID Transportation agency-defined 1D of the user who is a
contact for this vendor.

Table 4-16. Vendor Prime Contact Folder Tab Fields Table
To view a vendor’s prime contacts:
1. On the Reference Tables (CA) panel, double-click the VVendor icon.
Click the Open button.
On the Vendor Pick List window, scroll to and click the vendor or perform a Find.

Click the OK button. The Description folder tab displays data for the selected vendor.

a ~ w N

On the Vendors window, click the Prime Contacts folder tab.

If prime contacts have been recorded for the selected vendor, the window displays the prime contact
data.
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The user cannot add, modify, or delete a prime contact on this folder tab.

Vendor Associates

The Vendor Associates folder tab lets the user add, modify, and delete the associates in the reference
table. The associates are also vendors and must be entered in SiteManager as vendors before they
can be selected as associates. On the Vendor Associates folder tab, select the type of association the
associate has with the vendor.

To be selected as a prime contractor, a vendor must have at least two associates—an insurance
company and a surety company.

ﬂ\l’endms H=] E3
Description ‘work Classes Affiliates Personnel Prime Associates Security Securities
Contacts Accounts Usage
Vendor ID: p‘|25 Short Name: [I & K CONSTRUCTION

Associate Short Name Associate Type AI

o .0

Figure 4-17. Vendor Associates Folder Tab

Field Name Description
Associate Short Short name for an associate of the vendor. The user
Name can search this field. This field is required.
Associate Type Type of Vendor Associate (e.g., Surety, Escrow).
This field is required.

Table 4-17. Vendor Associates Folder Tab Fields Table
To add a vendor associate to the reference table:
1. On the Reference Tables (CA) panel, double-click the Vendor icon.
2. Click the Open button.

3. On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
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Click the OK button. The Description folder tab displays data for the selected vendor.

On the Vendors window, click the Associates folder tab.

Click the New button.

Click the Associate Short Name field and type the name of the associate or perform a

Search.

4. Contract Administration - Reference Tables

In the Associate Type drop-down list, click the expand arrow and click the type of associate.

To save the new associate description, click the Save button.

To delete a vendor associate from the reference table:

On the Reference Tables (CA) panel, double-click the Vendor icon.
Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.

Click the OK button. The Description folder tab displays data for the selected vendor.

On the Vendors window, click the Associates folder tab.

In the Associate Short Name list box, scroll to and click the vendor.
Click the Delete button.

Click OK.

Vendor Security Accounts

The Vendor Security Accounts folder tab lets the user add, modify, and delete the vendor’s security
accounts and account transactions. The folder tab has a security account list at the top and a

transaction section at the bottom. The transaction section lists the transactions made against the

selected account at the financial institution. The transactions are the amounts deposited and
withdrawn, which are recorded as credits and debits to the account.

The usage of the securities on contracts is shown on the Securities Usage folder tab.
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ﬂ\rendols [_[O] x]
Description Work Classes Affilistes Personnel Prime Associates Security Securities
Contacts Accounts Usage
Yendor ID: I]125 Short Name: p&KCDNSTHUCTIDN

Account ID Description Current Retainage Amount =~
Balance Required Available
UNTRUST

Transaction

Type Sec Type Certificate ID Amount Post Date  |Maturity Dt Comments

Credit B Bond  ERIR9432-RT-4230 $10,000.001939/04/27 12:09  04/27119

Figure 4-18. Vendor Security Accounts Folder Tab

Field Name Description
Account ID Transportation agency-defined ID for a security account
for the vendor.
Description Description of a security account for the vendor.
Current Balance Current value of a security account for the vendor. The

current balance is the sum of all credits to the account
minus the sum of all debits to the account. This value is
calculated by the system. The system will not accept
account transactions that make the current balance
negative.

Retainage Required | The amount required to be encumbered for all the
contracts associated to this account. The required amount
is the sum of all estimate retainage amounts and
securities used amounts for all contracts associated with
this account. This value is calculated by the system.

Amount Available Amount of the current balance that can be encumbered.
The amount available is the difference between the
current balance of the account and the total amount
encumbered for all contracts associated to the account.
This value is calculated by the system. The system will
not accept account transactions that make the amount
available negative.

4-40



AASHTOWare Project SiteManager™
4.1 Reference Tables (Contract Administration) 4. Contract Administration - Reference Tables

Field Name Description

Transaction Type Type of transaction (D = Debit or C = Credit).

Transaction Sec Type of security (e.g., Bond, Certificate of Deposit).
Type
Transaction Certificate of Deposit ID number.

Certificate ID

Transaction Amount | Amount of the transaction. Only positive values are
accepted in this field. (If the amount is a withdrawal,
enter ‘D’ for debit as the Transaction Type.) A value that
makes the account negative cannot be entered.

Transaction Post System-generated date when the transaction is entered
Date into the system.

Transaction Date on which the security matures.

Maturity Date

Transaction Description of the transaction.

Comments

Table 4-18. Security Account Folder Tab Fields Table

To add a security account:

1. Onthe Reference Tables (CA) panel, double-click the VVendor icon.
Click the Open button.
On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Security Account folder tab.
In the Account ID field, type the security account ID.
Press the Tab key.

In the Description field, type the name of the account.

© © N o g ~ W n

Click the Save button.

The system updates the current balance of the account when the user records transactions. The
system calculates the retainage required and the amount available when the user associates contracts
with the account and securities are encumbered in lieu of retainage.
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To delete a security account:

1.
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On the Reference Tables (CA) panel, double-click the Vendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Security Account folder tab.

In the Account ID list box, scroll to and click the account.

Click the Delete button.

Click OK.

If a security account is associated with a contract, the account cannot be deleted. When an account is
deleted, the account transactions are also deleted.

To add a security transaction:

1.
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11.
12.
13.
14.
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On the Reference Tables (CA) panel, double-click the VVendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Security Account folder tab.

In the Account ID list box, scroll to and click the account description.

Click the Transaction datawindow.

Click the New button.

In the Type drop-down list, click the expand arrow and click the transaction type (‘D’ for
debit or ‘C’ for credit).

. In the Sec Type list box, click the expand arrow and click the security type.

Press the Tab key.
In the Certificate ID field, type the ID number.
Press the Tab key.

In the Amount field, type the amount of the transaction.
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15. Press the Tab key. The current date is displayed in the Post Date field.

16. In the Maturity Date field, type the date on which the security matures.

17. Press the Tab key.

18. In the Comments field, type additional information about the transaction.

19. Click the Save button. The current balance is updated.

The user cannot add or delete an account transaction that would cause the current balance or the

amount available to become negative.

Vendor Securities Usage

4. Contract Administration - Reference Tables

The Vendor Securities Usage folder tab lets the user associate security accounts with contracts, and
displays the securities used in lieu of retainage. A security account can be associated to one or more
contracts, or not associated with any contract. The folder tab lists the accounts at the top and displays
contract data at the bottom. In the Contracts section, the user can select contracts to associate with an

account.

The security accounts are entered on the Security Accounts folder tab.

EVendms (O] x]
Description  “Work Classes Affiliates Perzonnel Prime Associates Security Securities
Contacts Accounts Usage
Vendor 1D: p125 Short Name: p &K CONSTRUCTION
Account ID Description Current Hetainage Amount -
Balance Required Available
4005-29-41 SUNTRUST 10000 10000
KI LILI
Contract ID RETAIN PCT: |2.50
u Cont Securities/Hetainage Amounts
Original: I 41.717.816.40 Required: I
Installed: I Covered: I
Paid: I Difference: I .00
Figure 4-19. Vendor Securities Usage Folder Tab
Field Name Description
Account ID Transportation agency-defined ID for a security account
for a vendor.
Description Description of the security account.
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Field Name Description
Current Balance Current value of the account. The current balance is the

sum of all the credits to the account minus the sum of all
debits to the account.

Retainage Required | The amount required to be encumbered for all the
contracts associated to this account. The required amount
is the sum of all estimates’ retainage amounts and
securities used amounts for all contracts associated with
this account.

Amount Available | Amount available that can be encumbered. The amount
available is the difference between the current balance of
the account and the total amount encumbered from the
amount for all the contracts associated to the account.

Contract ID Transportation agency-defined ID for the contract.

Retain Pct Percentage retainage for the contract.

Contract Original Displays the bid amount of the contract. The contract bid
Amount amount is the sum of the contract item amounts (item
quantity * item price).

Contract Installed | Displays the total installed amount for the contract. The

Amount installed amount is the sum of the installed-to-date
amounts from the Daily Work Reports (quantity * item
price).

Contract Paid Displays the total paid amount for the contract. The

Amount contract paid amount is the sum of the estimate net pay
totals.

Covered Amount Displays the total amount covered by the securities for
this contract. The covered amount is the sum of all
estimates’ securities used amounts.

Required Amount | Displays the required retainage withholding from this
account for this contract. The required amount is the sum
of all estimates’ retainage amounts and securities used
amounts.

Difference Amount | Displays the difference between the covered amount and
the required amount.

Table 4-19. Vendor Securities Usage Folder Tab Fields Table
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To associate a contract to a Security account:

1.
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On the Reference Tables (CA) panel, double-click the Vendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected VVendor.
On the Vendors window, click the Securities Usage folder tab.

In the Account ID list box, scroll to and click the account description.

Click the New button.

In the Contract ID drop-down list, click the expand arrow and click the contract.

Click the Save button.

The drop-down list displays the contract IDs for which the vendor is the prime contractor. After a
contract ID is selected, the window displays data for the selected contract.

To disassociate a contract from a security account:

1.
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On the Reference Tables (CA) panel, double-click the Vendor icon.

Click the Open button.

On the Vendor Pick List window, scroll to and click the vendor or perform a Find.
Click the OK button. The Description folder tab displays data for the selected vendor.
On the Vendors window, click the Securities Usage folder tab.

In the Account ID list box, scroll to and click the account description.

In the Contract ID drop-down list, click the expand arrow and click the contract ID.
Click the Delete button.

Click OK.

4.1.9 Administrative Offices

The Administrative Office window lets the user add, modify, and delete the offices in the reference
table. Every state or province must have at least three levels of administrative offices—the
transportation agency headquarters and two lower levels. No state or province can have fewer than
three or more than four levels. States or provinces with three levels will display three office
datawindows. States or provinces with four levels will display four office datawindows. The office
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level field labels are stored in a system operational parameter table. Since the transportation agency
defines the labels, this manual does not specify the actual labels that appear on the window.

The office datawindows display top to bottom on the left side of the window. The selected
(highlighted or focused) office’s address will display on the window’s right side. Upon entry into
this window, the first row in the level two office datawindow will be highlighted, and the address
information pertaining to that office will appear on the datawindow on the right side.

To view the information for a different Level 2 office or a specific Level 3 or 4 office, the user must
select the desired row in the proper office datawindow. Third-level offices are subordinate to the
highlighted second-level office. Fourth-level offices are subordinate to the third-level offices.

The current selected office is listed at the top of the datawindow on the right side (above the address
information).

EAdminisllalive Offices

I Central: |
Division | Engineer | « Division: 01
~Address -1 -of -1
02 DCE2 Line 1: 5873 Long Drive
0 DCET Line 2: |
L DLET LI Line 3: |
District | Engineer | + City: [Calumbia
State/Prov: |South Carolina =
0 DCED ZipfPostal: 3170 |
03 DTE1 - _
04 DTE1 ;] Country: IUmted States of America E
A Enai ~—Contact Numbers
rea ngineer | i -
Phone:[ | Eat I
2 COM2 FAX: l—
3 | DTET
4 I COM1 LI

Figure 4-20. Administrative Offices Window

Field Name Description
Level 1 Office The name of the Level 1 office. The Level 1 office is the
) transportation agency headquarters (i.e., the Central Office
(user-defined or Department of Transportation).
label)
Level 2 Office The office number or transportation agency-defined ID of
_ the Level 2 office. The Level 2 office can have any user-
I(u;ellr)-deflned defined label, such as District, Division, Region, or Section.
abe
Level 2 Office User ID of the Level 2 office’s chief engineer. You can
Engineer search this field. The title of engineer is unrelated to the

4-46



4.1 Reference Tables (Contract Administration)

AASHTOWare Project SiteManager™

Field Name

Description

transportation agency’s actual title used.

Level 3 Office

(user-defined
label)

The office number or transportation agency-defined ID of
the Level 3 office. The Level 3 office can have any user-

defined label, such as District, Division, Region, or Section.

Level 3 Office
Engineer

User ID of the Level 3 office’s chief engineer. You can
search this field. The title of engineer is unrelated to the
transportation agency’s actual title used.

Level 4 Office

(user-defined
label)

The office number or transportation agency-defined ID of
the Level 4 office. The Level 4 office can have any user-

defined label, such as District, Division, Region, or Section.

If a state a province has only three office levels this list and
its columns will not display.

Level 4 Office
Engineer

User ID of the Level 4 office’s chief engineer. You can
search this field. The title of engineer is unrelated to the
transportation agency’s actual title used.

Address Line 1

First address line that identifies the office location.

Address Line 2

Second address line that identifies the office location.

Address Line 3

Third address line that identifies the office location.

City City location of the office.

Zip/Postal Postal code for the office.

State/Prov Two-character abbreviation for the state/province.

Country Four-character code identifying the country.

Phone Primary telephone number for the office.

Ext Extension number of the primary telephone number for the
office.

FAX Primary fax number for the office.

Table 4-20. Administrative Office Window Fields Table

4. Contract Administration - Reference Tables

To add the Level 1 office:

1. On the Reference Tables (CA) panel, double-click the Administrative Offices icon.
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23.
24,
25.
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Click the Level 1 office field. (The Level 1 office is displayed in the top left corner. The
window will not have a label that says ‘Level 1.” The office level labels are user-defined.)

Click the New button.

Type the ID of the Level 1 office.

Press the Tab key.

In the Line 1 field, type the first line of the office address.

If necessary, tab to Line 2 and Line 3 and type additional address lines.
Press the Tab key.

In the City field, type the city name.

. In the State/Prov drop-down list, click the expand arrow to the right of the current selection

and click the state or province.
Press the Tab key.
In the Zip/Postal field, type the ZIP code or other postal number.

In the Country drop-down list, click the expand arrow to the right of the current selection
and click the country.

Press the Tab key.

In the Phone field, type the office’s primary phone number.

Press the Tab key.

In the Ext field, type the phone number extension.

In the FAX field, type the office’s primary fax number.

To save the office description, click the Save button.

To add a new Level 2 office:

On the Reference Tables (CA) panel, double-click the Administrative Offices icon.

Click the Level 2 office datawindow. (The Level 2 office IDs are displayed directly under the
Level 1 office ID. The window will not have a label that says ‘Level 2.” The office level
names are user-defined.)

Click the New button. A new row is added to the end of the list.
Type the office ID of the new office.
Press the Tab key.
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26.

217.
28.
29.
30.
31.
32.

33.
34.
35.

36.
37.
38.
39.
40.
41.
42.
43.
44,

45.

In the Engineer User ID field, type the User ID of the office’s Chief Engineer or perform a
Search.

Press the Tab key.

In the Line 1 field, type the first line of the office address.

If necessary, tab to Line 2 and Line 3 and type additional address lines.
Press the Tab key.

In the City field, type the city name.

In the State/Prov drop-down list, click the expand arrow to the right of the current selection
and click the state or province.

Press the Tab key.
In the Zip/Postal field, type the ZIP code or other postal number.

In the Country drop-down list, click the expand arrow to the right of the current selection
and click the country.

Press the Tab key.

In the Phone field, type the office’s primary phone number.

Press the Tab key.

In the Ext field, type the phone number extension.

In the FAX field, type the office’s primary fax number.

To save the office description, click the Save button.

To delete a Level 2 office:

On the Reference Tables (CA) panel, double-click the Administrative Offices icon.

In the Level 2 office datawindow, scroll to and click the office ID. (The Level 2 offices are
displayed directly under the Level 1 office ID. The window will not have a label that says
‘Level 2.” The office level names are user-defined.)

Click the Delete button.

For more information on making individual users available as engineers for administrative offices,
please refer to the section on User Security.
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4.2 System Operational Parameters for Contracts

The following are the default settings of the system operational parameters related to contract
administration. The system operational parameters are defined by the transportation agency. For
information on how your SiteManager installation varies from these defaults, contact your local

support personnel.

Default Description
Number of Office The number of administrative office levels, including the
Levels central office, for the state/province. The state must have

a label identifying each level as division, section, region,
district, area, etc. Every state/province must have at least
two levels below central office. No state/province can
have more than three levels below central office. The
range is 3 to 4. The default is 3.

Level 1 Office Long

Label to identify the first level office. Examples are
Division, Section, Region, District, Area. The default is
Central.

Level 2 Office Long

Label to identify the second level office. Examples are
Division, Section, Region, District, Area. The default is
District.

Level 3 Office Long

Label to identify the third level office. Examples are
Division, Section, Region, District, Area. The default is
Residency.

Level 4 Office Long

Label to identify the fourth-level office. Examples are
Division, Section, Region, District, Area. The default is
Area.

Level 1 Office
Short

Label to identify the first-level office. Examples are
Division, Section, Region, District, Area. The default is
Cent.

Level 2 Office
Short

Label to identify the second-level office. Examples are
Division, Section, Region, District, Area. Default is Dist.

Level 3 Office
Short

Label to identify the third-level office. Examples are
Division, Section, Region, District, Area. The default is
Resi.
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Default

Description

Level 4 Office
Short

Label to identify the fourth-level office. Examples are
Division, Section, Region, District, Area. The default is
Area.

Level 2 Office Left

The beginning (leftmost) position of the state's/province's
second level of administrative office in the five-character
AASHTOWare Project™ office number format. The first
level is central or department. The second level could be
division, region, district, etc. The third level could be
district, area, residency, etc. Valid values are 1 through 5.
The default is 0.

Level 2 Office
Right

The ending (rightmost) position of the state's/province’s
second level of administrative office in the five-character
AASHTOWare Project office number format. The first
level is central or department. The second level could be
division, region, district, etc. The third level could be
district, area, residency, etc. Valid values are 1 through 5.
This position must be equal to or greater than the
beginning (left-most) position. The default is 0.

Level 3 Office Left

The beginning (leftmost) position of the state's/province's
third level of administrative office in the five-character
AASHTOWare Project office number format. The first
level is central or department. The second level could be
division, region, district, etc. The third level could be
district, area, residency, etc. Valid values are 1 through 5.
The default is 0.

Level 3 Office
Right

The ending (rightmost) position of the state's/province’s
third level of administrative office in the five-character
AASHTOWare Project office number format. The first
level is central or department. The second level could be
division, region, district, etc. The third level could be
district, area, residency, etc. Valid values are 1 through 5.
This position must be equal to or greater than the
beginning (left-most) position. The default is 0.

4. Contract Administration - Reference Tables
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Default Description

Level 4 Office Left | The beginning (leftmost) position of the state's/province's
fourth level of administrative office in the five-character
AASHTOWare Project office number format. The first
level is central or department. The second level could be
division, region, district, etc. The third level could be
district, area, residency, etc. Valid values are 1 through 5.
The default is 0.

Level 4 Office The ending (rightmost) position of the state's/province's
Right fourth level of administrative office in the five-character
AASHTOWare Project office number format. The first
level is central or department. The second level could be
division, region, district, etc. The third level could be
district, area, residency, etc. Valid values are 1 through 5.
This position must be equal to or greater than the
beginning (leftmost) position. The default is 0.

Maximum Allowed | The default value for the maximum percentage of the total
Subcontractor % contract amount the prime contractor is allowed to
subcontract (excluding specialty items).

Progress Schedule | The default percentage difference between a contract’s
Variance scheduled completion date and the actual completion date,
which will generate a warning message when exceeded.
The default percentage is 0. The user can override the
default while setting up a contract.

Default Funding The user-designated code that identifies the default
Source Code contract funding source. The code appears in the Funding
Source Code field on the Contract Funding window. The
user can override the default while setting up a contract.

Table 4-21. System Operational Parameters Fields Table

4.3 Tab-Level Security for Contracts

SiteManager provides the system administrator with the ability to establish security level access for
each Contract tab for each SiteManager user group.

For example, a user group that monitors on-the-job training commitments may require Update access
to the Training Plan tab, whereas a different user group might be assigned No Rights to this
information.
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These security levels are set on the Group Security window. Each tab name will appear on the
window, and access for each tab may be set to Update, Inquiry, or No Rights.
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5.1 Adding New Contracts

SiteManager gives the user the option of adding new contracts either by loading the data from a
preconstruction system or by entering the data into SiteManager one field at a time. The agency
specifies which method to use and should provide the user with instructions for any preconstruction
system used in conjunction with SiteManager.

The procedures given here describe how to add contract data to the SiteManager database through
SiteManager’s windows and data entry fields. An authorized user can add a new contract using
these data entry procedures. New contract from the preconstruction system may also need some data
added or modified by an authorized user.

New contract are given pending status by default. While a contract is in pending status, an
authorized user can modify the contract data and even delete the contract, if necessary. To begin
tracking the construction work in SiteManager, an authorized user must change the contract’s status
to active. Whenever a contract’s status is changed, the system notifies selected personnel.

To add a new contract, the user must have a Level 1 or Level 2 office assignment, Contract Record
window update rights, and belong to a group with office-wide access. For more information, refer to
the Security Administration topic.

5.1.1 From Preconstruction Systems

AASHTOWare Project™ (formerly AASHTO Trnseport®) is one of the preconstruction systems that
can be used to add a new contract to the SiteManager system. In addition to AASHTOWare Project,
there are several other preconstruction systems that can be used to add a new contract to the
SiteManager system. For information on the preconstruction system that your agency uses, refer to
the documentation provided by your local support personnel.

Contract data can be loaded into SiteManager using the Preconstruction Contract data load process
(PRELOAD) or the Construction Contract data load process (CONLOAD). When contract data is
loaded into SiteManager from a preconstruction system, the SiteManager system verifies that
required data is present and acceptable. If a contract fails the verification process, SiteManager
generates error messages and displays them on the Interface Load Messages window. Some
SiteManager windows have a check box that indicates whether a preconstruction system was used to
add the selected contract. After the contract status is changed to active, the data loaded from the
preconstruction system cannot be modified.

5.1.2 Entry Directly Into SiteManager

An authorized user can add contract data to the SiteManager database through SiteManager’s
windows and data entry fields. For field definitions and detailed data entry procedures, the user can
refer to the appropriate topic. The field definitions include information about data that is subject to
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limitations or validation by the system. The agency should provide the user with any agency-defined
procedures for entering new contract data.

5.1.3 General Procedure for Adding New Contracts

To add a new contract to the SiteManager system, without using a preconstruction system, an
authorized user can follow the general procedure below. For field definitions and detailed data entry
procedures, refer to the appropriate topic.

Step 1: Saving a New Contract

Enter the data required to save the contract as follows:

1.

On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens and displays the Description folder tab.

Enter contract description data on this folder tab.
Click the Location folder tab. Enter location data on this folder tab.

Click the Primary Personnel folder tab. Enter the Project Manager and Project Engineer on
this folder tab.

Click the Prime Contractor folder tab. Enter the Prime Contractor and associated data on
this folder tab.

The following data must be entered before the contract can be saved:
= Contract ID

= Level 2 Office (the field label is user-defined)

= Federal/State/Province Project Number

= Funding Indicator

= Time Charges

= Bid Days (if time is charged as Calendar Days or Work Days)
= Description

= Contract Type

=  Work Type

= Spec Year

= Unit System (English or metric)
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Location

Project Manager

Project Engineer

Prime Contractor

At this point, if data is entered in all required fields, click the Save button. After the contract
IS saved, proceed to Step 2.

Step 2: Adding Contract Data

To finish defining the contract:

1.

Click the Payment Data folder tab. Enter contract payment data on this folder tab and save
the data.

Click the Critical Dates folder tab. Enter contract critical date data on this folder tab and
save the data.

Note: Contract activation is no longer tied to the Notice to Proceed date. The user can
now activate a contract using the Contract Status field on the Description tab. All
functions, except for the Estimate functions, are available to the user after the contract
status is changed to Active. Estimate functions are not available to the user until the
Notice To Proceed date is entered.

Click the DBE Commit folder tab. Enter DBE commitment data on this folder tab and save
the data.

Click the Training Plan folder tab. Enter training plan data on this folder tab and save the
data.

Close the Contracts window.

To add milestones, double-click the Milestones icon on the Contract Records panel. The
Milestones window opens. Enter contract milestone data and save the data. Close the
Milestones window.

To add project data, double-click the Projects icon on the Contract Records panel. The
Projects window opens. Enter Contract Project data and save the data. Close the Projects
window.

To group items under a funding category, double-click the Categories icon on the Contract
Records panel. The Categories window opens. Enter category data and save the data. Close
the Categories window.

On the Contract Records panel, double-click the Items icon. The Items window opens.
Enter items data and save the data. Close the Items window.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

On the Contract Records panel, double-click the Contract Funding icon. The Contract
Funding window opens. Enter funding source data and save the data. Close the Contract
Funding window.

On the Contract Records panel, double-click the Contract Authority icon. The Contract
Authority window opens. Enter contract authority data and save the data. Close the Contract
Authority window.

On the Contract Records panel, double-click the Key Dates icon. The Key Dates window
opens. Enter key date data and save the data. Close the Key Dates window.

On the Contract Records panel, double-click the Checklist Scheduled Events icon. The
Checklist Scheduled Events window opens. Enter checklist event data and save the data.
Close the Checklist Scheduled Events window.

On the Contract Records panel, double-click the Permits icon. The Permits window opens.
Enter permit data and save the data. Close the Permits window.

To enter invoice data for stockpiled materials, double-click the Stockpiled Materials icon on
the Contract Records panel. The Stockpiled Materials window opens. Enter stockpiled
materials data and save the data. Close the Stockpiled Materials window.

To record construction conferences, double-click the Construction Conference icon on the
Contractor Management panel. The Construction Conference window opens. Enter
construction conference data and save the data. Close the Construction Conference window.

To enter progress schedule data, on the Contractor Management panel, double-click the
Progress Schedule icon. The Progress Schedule window opens. Enter progress schedule
data and save the data. Close the Progress Schedule window.

To enter Subcontract data, on the Contractor Management panel, double-click the
Subcontracts icon. The Subcontracts window opens. Enter subcontract data and save the
data. Close the Subcontracts window.

Step 3: Activating a Contract

Contract work cannot be recorded in SiteManager until the contract status is changed from pending
to active. After all required contract data is entered, an authorized user can change the status to

active.

The following data is required for activation:
A wage decision selected on the Description folder tab.
A primary county selected on the Location folder tab.

A surety company and an insurance company entered as associates on the Prime Contractor
folder tab. If the selected contractor has no associates, enter these companies first as
associates of the contractor in the Vendor reference tables.
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Actual dates for all dates marked Required to Activate on the Key Dates and Checklist Event
Dates windows.

At least one project defined on the Projects window.
At least one item defined on the Items window.
Funding sources selected on the Contract Funding window to fully fund the contract.

Actual dates for all dates marked Required to Activate on the Critical Dates folder tab.

The user must change the contract status to Active using the Contract Status field on the Description
tab. All functions, except for the Estimate functions, are available to the user after the contract status
is changed to Active. Estimate functions are not available to the user until the Notice To Proceed
date is entered.

5.2 Contract Status Validation

SiteManager looks at the data entered for a contract to determine the contract’s status. When the
user saves a contract, the save process determines if the contract status has been changed. If it has,
the system validates the status and performs related tasks as described below. The following
contract states are possible:

Pending
Active
Complete

Archived

To change the contract’s status from pending to active, the following criteria must be met:

There must be an Execution Contract Critical Date with the Actual Date filled in.

If the contract’s price adjustment allowed indicator is Yes, the Price Adjustment Base
Contract Critical Date must have an Actual Date.

The Prime Contractor must have a surety and an insurance company.
The contract must have entries in all of the following fields:

Wage Decision

Primary County

Project Manager
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Project Engineer

Prime Contractor

Liquidated Damages Rate Amount

The contract must have at least one record for each of the following:
Project

Item

Retainage

Contract Funding (all parts fully funded)

Contract Authority for the Project Manager and Project Engineer

Note: For agencies that do not include Contract Funding in their construction
management system, a dummy Contract Funding record is added with 100 percent non-
participating no-limit funding. Funding source validation is bypassed.

When the contract’s status changes to active, the system performs the following tasks:

Personnel identified in the Primary Personnel folder are notified by an In-Box message.

All contract item status are modified from pending to active.

If a Contract Liquidated Damages Amount does not exist, this amount is obtained and
displayed from the default Liquidated Damages table.

If no project is indicated as the primary project, the Primary Project is defaulted as:
The only project, if the contract has only one project.
The project with greatest total dollar amount, if the contract has multiple projects.

All Checklist Scheduled Events that do not have Next Projected Date displayed are
automatically updated with the first logical date after the Notice To Proceed date.

To delete a contract, its status must be pending.

To change a contract’s status back to pending, the following criteria must be met.

1. Contract items cannot have:

= An associated change order

= An associated dispute

5. Contract Administration - New Contracts
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= An associated stockpiled material
2. The contract cannot have:

= An associated force account

= An associated estimate

= An associated dispute

= An associated sample

= An associated change order

= An associated plan discrepancy

= Been downloaded (checked out) to the field

= Milestones cannot have an associated change order

= The contract cannot have daily work reports associated with it
3. If a contract status change cannot be saved because the data fails validation:

= Change the contract’s status to pending.

= Delete the contract.

If the contract has been active, delete the contract’s associated record(s) or upload the contract back
to the Server (check it in).

Entering the Contract Iltems Complete Date does not change the contract status. However, it marks
the beginning of the contract completion procedure. To save the Contract Items Complete Date, all
draft and pending change orders must be either approved or not approved. When the Contract Items
Complete Date is entered, the Project Manager and Project Engineer are notified by In-Box
message, any active items are assigned final quantities and the items’ status is changed to from
Active to Final (i.e., no longer able to log work to these items).

To change a contract’s status from active to complete, the following criteria must be met.
= The Contract Items Complete Date must have an actual date.
= All critical dates and key dates marked Required to Finalize must have actual dates.
= All checklist scheduled events must have actual dates.
= All items must have approved final quantity.

= No change order can have a status of pending.
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= All progress and final estimates must be paid.
= All disputes and claims must be resolved.
= All stockpiled materials must be zero.

When the contract status changes to complete, contract authority is end-dated for all contract
personnel except the Project Manager and Project Engineer. After a contract is complete, only the
Project Manager, Project Engineer, and personnel with office-wide and update access can make
changes to a contract. When the contract status changes to complete, the system marks the contract
To Be Sent to DSS. The archived status is used to store the archived file.

5.3 Contract Records

The Contract Records panel lets the user access other windows to view, add, modify, and delete
contract records. The Contract Records panel has icons that represent the following windows:

= Contracts

= Milestones

= Projects

= Categories

»= Items

= Contract Funding

= Contract Authority

= Key Dates

= Checklist Scheduled Events
= Checklist Event Dates
= Correspondence Log
= Plan Discrepancies

= Stockpiled Materials
= Force Accounts

= Design Evaluation

= Disputes/Claims
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Fsubcontracts

Figure 5-1. The Contract Records Panel

To access the Contract Records panel:

1. On the Contract Administration panel, double-click the Contract Records icon.

5.4 Contracts

The Contracts window lets the user add new contracts, and view, add, modify, or delete basic
contract data. The following table describes the nine folder tabs on the Contracts window:

Folder Tab Name Description

Description The Description folder tab displays the contract
description data. This includes the contract’s status,
project number(s), administrative offices, funding
sources, and other descriptive information that
determines how the system processes data for this
contract.

Location The Location folder tab displays the contract location
data that can be added, modified, or deleted. This
includes the list of available counties for each state or
province and those associated with the selected
contract. Authorized users may add and remove
counties to and from the contract. A primary county
must be selected.
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Folder Tab Name Description
Payment Data The Payment Data folder tab displays the contract

payment data that can be added, modified, or deleted.
This data includes liquidated damages rate amount,
retainage, estimate generation indicators, and limit
amount.

Critical Dates The Critical Dates folder tab displays the critical dates
(letting date, notice to proceed date, etc.). These dates
are required by the system for the standard contract
status reports. The default date types cannot be deleted
or modified.

Primary Personnel | The Primary Personnel folder tab lets the user maintain
data on the contract creator, designer, Project Manager,
and Project Engineer. This folder tab also identifies the
personnel who will receive messages when the contract
becomes active or falls behind schedule.

Prime Contractor | The Prime Contractor folder tab displays the Prime
Contractor data that can be added, modified, or deleted.
This data includes the Prime Contractor, contractor
defaulted data, maximum subcontract amount, payroll
requirements, prime contacts, and prime associates.
The Prime Contractor’s surety and insurance
companies must be entered as prime associates.

DBE Commitment | The DBE Commitment folder tab lets the user add and
modify contract or DBE commitments. This folder tab
also displays system-calculated DBE amounts.

Training Plan The Training folder tab lets the user identify the Prime
Contractor’s on-the-job training commitments for a
contract (i.e., the training plan), which is then used
during estimate generation to perform automated
reimbursement. This folder tab also displays system-
calculated training hour usage.

Table 5-1. The Contracts Window Folder Tabs Table
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5 Contracts |- [O] x|
Description ~ Location | PaymentData ~ Criical Dates ~ Primary | Prime | DBE Commit | Training Plan
Personnel Contractor
ContractID:[ Fed St/Pr Prj Nbr: |
Status: IW Primary PCN: ﬂ:E
Division::E District: EE Area: ﬂ:lz o Fe'i:ll‘ler:::ng
Progress Sched:l |;| VYariance Pct: 00~ State/Province
Desc: | " Both
Time Charges: | [*] Bid Days: l— Bid Amt: |—$uuu
Contract Type: [Spaces [*] [ Fed Dversight
Work Type:|8paces E [ Local Dversight Proposal Fund Type: I—
Spec Yl:l_ Unit System: :E Suppl Spec Bk Yr: l_ Allt ID:I—
Wage Wage Decision ID Wage Decision Description Genrl Wg Dcsn ID

Decision: [

Figure 5-2. The Contracts Window
To access the Contracts window:
1. On the Contract Administration panel, double-click the Contract Records icon.

2. On the Contract Records panel, double-click the Contracts icon.

5.4.1 Contract Description

The Description folder tab displays the contract description data that can be added, modified, or
deleted. This includes the contract’s status, project number(s), administrative offices, funding type,
and other descriptive information that determines how the system processes data for this contract.

Field Name Description

Contract ID Agency-defined ID for the contract. Corresponds to the
Contract ID assigned by AASHTOWare Project or another
preconstruction system. This is a required field.

Status Indicates the current status of a contract (e.g., Pending,
Active, Complete, Archived).

Primary PCN The contract’s primary project control number. This field
lists the projects defined for this contract. If multiple
contracts are defined, the user selects the primary project in
this field.

Fed St/Pr Prj Nbr | The federal, state, or province project number for the contract,
project, or category. This is a required field.
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Field Name

Description

Level 2 Office

(user-defined
label)

The office number for the Level 2 office responsible for
administering the contract. The Level 2 office can have any
user-defined label, such as District, Division, or Region. This
is a required field. (The Level 1 office is the agency
headquarters, e.g., the Central Office or the Department of
Transportation.)

Level 3 Office

(user-defined
label)

The office number for the Level 3 office responsible for
administering the contract. The Level 3 office can have any
user-defined label. If there are only two administration levels,
this field does not display.

Level 4 Office

(user-defined
label)

The office number for the Level 4 office responsible for
administering the contract. The Level 4 office can have any
user-defined label. If there are only two or three
administration levels, this field does not display.

Progress Sched

The type of progress schedule used for the contract (i.e.,
percent complete for a time period, percent of critical items
complete for a time period, or critical path method). If Critical
Path Method is selected, no schedule is processed for this
contract in SiteManager. If the user selects a different
schedule type on the Progress Schedule window, the system
changes this field.

Variance Pct

The percentage difference between a schedule's anticipated
and actual completion percent. A message is generated when
the difference is greater than this percentage. For example, if
the Variance Pct is 10 percent, and 30 percent of the work is
anticipated to be complete by a certain date and the actual
percentage complete is 19 percent, a message notifies the
recipient(s) of the variance.

Time Charges

How time charges are assessed for the contract (i.e., work
days, calendar days, or fixed completion date). This isa
required field.

Bid Days The original number of days for the contract. This field is
required when the Time Charges entry is work days or
calendar days.

Bid Amt The original bid amount of the contract. This field is display
only.

Desc Text description of the contract. This is a required field.
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Field Name Description
Alt ID An alternate transportation agency-defined ID for the

contract. This field cannot be modified if an estimate has
been generated.

Contract Type Agency-defined classification of the contract type (e.g.,
biddable, safety, A + B, prime contract). This is a required
field.

Work Type Agency-defined classification of the major type of work being
done on the contract (e.g., bridge work, beautification). This
is a required field.

Spec Yr The Item Master specification year of the items used for the
contract. This is a required field.

Unit System Indicates that the measurement system used for the contract is
either English or metric. This is a required field.

Fed Oversight Indicates that federal authorities must receive and approve
any change orders for this contract.

Funding Indicates that the contract is funded by federal funds only,
non-federal funds only (state, province, etc.), or both. This is
a required field. If the user selects funding sources on the
Contract Funding window that do not match this field, the
system changes this field. If funding is subsequently
changed, the indicator changes with the funding assignment.

Suppl Spec Bk Yr | A supplemental Item Master specification year of the items
used for the contract.

Local Oversight | Indicates that local authorities must be copied on and approve
change orders.

Wage Decision ID | Agency-defined ID for a wage decision applicable to the
contract. The user can search this field. Wage decision data
is required during the loading of contractor payrolls and is
used to determine potential wage rate variances. The wage
decision records are maintained in the Civil Rights reference
tables.

Genrl Wg Dcsn General wage decision ID.
ID
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Field Name Description
Wage Decision Description of the wage decision (first 40 characters).
Description
Proposal Fund Type of funds used for the contract (e.g., ST1 = State Fund 1,
Type FED1 = Federal Fund 1, MUNI = Municipal Fund)

Table 5-2. The Description Folder Tab Fields Table

To add a new contract:

1.

10.

11.

12.

13.
14.

On the Contract Records panel, double-click the Contracts icon. If the user is authorized
to add contract s, the Description folder tab fields are empty and the user can add new
contract data.

To add a new contract ID, click the Contract ID field and type the new ID.
Press the Tab key.

In the Fed St/Pr Prj Nbr field, type the federal, state, or province project number for the
contract.

In the Primary PCN drop-down list, click the expand arrow and click the project’s primary
control number.

In the Level 2 Office drop-down list, click the expand arrow and click the office ID.

If a Level 3 or 4 office administers the contract, click the expand arrow and click the office
ID in the Level 3 Office drop-down list.

If a Level 4 office administers the contract, click the expand arrow and click the office ID in
the Level 4 Office drop-down list.

In the Progress Schedule drop-down list, click the expand arrow and click the schedule type.

To change the default variance percentage, tab to the VVariance Pct field and type the
percentage.

In the Time Charges drop-down list, click the expand arrow to the right of the current
selection and click the time charges type.

If the Time Charges entry is Work Days or Calendar Days, tab to the Bid Days field and type
the original number of days for the contract.

Press the Tab key.

In the Desc field, type a description of the contract.
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15.
16.
17.
18.
19.
20.
21.
22.
23.
24,
25.
26.
27.
28.

In the Contract Type drop-down list, click the expand arrow and click the contract type.
If federal oversight is required, select the Fed Oversight check box (ON).

In the Work Type drop-down list, click the expand arrow and click the work type.

If Local Oversight is required, select the Local Oversight check box (ON).

Press the Tab key.

In the Spec YT field, type the Item Master specification year.

Press the Tab key.

In the Unit System drop-down list, click the expand arrow and click either English or metric.
Press the Tab key.

If required, in the Suppl Spec Bk YT field, type a supplemental Item Master spec year.
Press the Tab key.

In the Alt ID field, type an alternate ID for the contract.

To select a Funding type, click the radio button for Federal, State/Province, or Both.

A new contract ID cannot be saved until the following data is entered: the Location, the
Primary Personnel, and the Prime Contractor. Click the Location folder tab and continue
adding data (refer to the Location topic).

To modify a pending contract’s description:

1.
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On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

In the Fed St/Pr Prj Nbr field, type the federal, state, or province project number for the
contract.

In the Primary PCN drop-down list, click the expand arrow and click the project’s primary
control number.

In the Level 2 Office drop-down list, click the expand arrow and click the office ID.

If a Level 3 or 4 office administers the contract, in the Level 3 Office drop-down list, click
the expand arrow and click the office ID.



AASHTOWare Project SiteManager™

5.4 Contracts 5. Contract Administration - New Contracts

10.

11.

12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24,
25.
26.
27.

If a Level 4 office administers the contract, in the Level 4 Office drop-down list, click the
expand arrow and click the office ID.

To change the default variance percentage, tab to the Variance Pct field and type the
percentage.

In the Time Charges drop-down list, click the expand arrow to the right of the current
selection and click the time charges type.

If the Time Charges entry is work days or calendar days, tab to the Bid Days field and type
the original number of days for the contract.

Press the Tab key.

In the Desc field, type a description of the contract.

In the Contract Type drop-down list, click the expand arrow and click the contract type.
If Federal Oversight is required, select the Fed Oversight check box (ON).

In the Work Type drop-down list, click the expand arrow and click the work type.

If Local Oversight is required, select the Local Oversight check box (ON).

Press the Tab key.

In the Spec YT field, type the Item Master specification year.

Press the Tab key.

In the Unit System drop-down list, click the expand arrow and click either English or metric.
Press the Tab key.

If required, in the Suppl Spec Bk YT field, type a supplemental Item Master spec year.
Press the Tab key.

In the Alt ID field, type an alternate ID for the contract.

To select a Funding type, click the radio button for Federal, State/Province, or Both.

Click the Save button.

The wage decision records are maintained in the Civil Rights reference tables. To add a Wage
Decision to a contract:

1.

On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

5-17



AASHTOWare Project SiteManager™
5. Contract Administration - New Contracts 5.4 Contracts

2. Click the Open button. The Select Contract list displays.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

4. Click the Wage Decision ID list box and click the New button. An empty row is added to
the list.

5. In the Wage Decision ID field, type a wage decision ID or click the right mouse button and
perform a Search.

6. Click the Save button.

When the user saves a contract status change, the system runs a validation process. If the contract
data passes validation, the status change is saved in the database. To change a contract’s status:

1. On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

2. Click the Open button. The Select Contract list displays.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

4. In the Status drop-down list, click the expand arrow to the right of the current selection and
click the status.

5. Click the Save button.
To delete a pending contract:

1. On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

2. Click the Open button. The Select Contract list displays.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

4. Click the Delete button.
5. Click the Yes button (to confirm the deletion).
6. Click the Yes button (to confirm deletion of associated records).

7. Click the Save button.
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5.4.2 Contract Location

The Location folder tab lets the user add, modify, and delete Contract location data, and add or
remove counties. Each contract must have one county selected as the primary county. The user

cannot remove a county that is currently associated with one of the contract’s projects.

Description Location Payment Data ~ Critical Dates Primary Prime DBE Commit — Training Plan
Personnel Contractor
Contract ID: I— ﬂ
Location: |
|
Beg Sta Nbr: l— Beg Termini: I— Route Nbr: I—
End Sta Nbr: I— End Termini: I— Highway Mbr: I—
Road System: Highway Type:
LI_I Town- | -
| Contract County Primary County
i |
Figure 5-3. The Location Folder Tab
Field Name Description
Location Description of the contract location. This is a required field.
Two lines are provided.
Beg Sta Nbr Precisely defines the station number where the work begins.
Beg Termini Precisely defines the termini where the work begins.
Route Nbr Route number where the primary work is done.
End Sta Nbr Precisely defines the station number where the work ends.
End Termini Precisely defines the termini where the work ends.
Highway Nbr | Highway number where the primary work is done.
Road System Type of road system where the primary work is done (e.qg.,
interstate, state highway, county road).
Highway Type | Type of highway where the primary work is done (e.qg.,
asphalt, concrete, gravel).
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Field Name Description
Contract Name of a county in which the work is done. The user can
County search this field.
Primary Indicates the primary county in which the work is done. At
County least one and only one county must be indicated as the
primary county.

Table 5-3. The Location Folder Tab Fields Table

To modify the contract location:

1.

10.
11.
12.
13.
14.
15.
16.
17.
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On the Contract Records panel, double-click the Contracts icon. The Contracts window

opens.

Click the Open button. The Select Contract list displays.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

Click the Location folder tab.

In the Location field, type a description of the construction location.

second line and enter more text.

Press the Tab key.

In the Beg Sta field, type the Station number where the work begins.

Press the Tab key.

In the Beg Termini field, type the Termini where the work begins.
Press the Tab key.

In the Route Nbr field, type affected route number.

Press the Tab key.

In the End Sta field, type the Station number where the work ends.
In the End Termini field, type the Termini where the work ends.

In the Highway Nbr, type the primary work roadway number.

If necessary, tab to the

In the Road System drop-down list, click the expand arrow and click the road system.

In the Highway Type drop-down list, click the expand arrow and click the highway type.



AASHTOWare Project SiteManager™

5.4 Contracts 5. Contract Administration - New Contracts

18.
19.
20.

21.
22.
23.

24,

Press the Tab key.
In the Town field, type the name of the town.

Click the Contract County datawindow and click the New button. An empty row is added
to the datawindow.

In the Contract County field, type the name of the county or perform a Search.
To add another county, click the New button and repeat Step 21.

In the Contract County list box, scroll to the primary county and select the Primary
County indicator (ON).

Click the Save button.

The user cannot remove a county that is currently associated with one of the contract’s projects. To
delete a county from a contract:

1.

543

On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

Click the Open button. The Select Contract list displays.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

Click the Location folder tab.

In the Contract County list box, scroll to and click the county (select the Primary County
indicator).

Click the Delete button.

In the Contract County list box, scroll to the primary county and select the Primary
County indicator (ON).

Click the Save button.

Contract Payment Data

The Payment Data folder tab lets the user add, modify, or delete contract payment data such as the
liquidated damages rate amount, the day of the month to generate estimates, contract payment
amount limits, and retainage data. The retainage data includes the type of retainage allowed and the
values that determine how retainage is to be applied to the contract.
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5 Contracts M= E3

Description Location Payment Critical Dates Primary Prime DBE Commit — Training Plan
Data Personnel Contractor

Contract ID:| Current Contract Amt: | $0.00
Generate Estl Day: I_l Contract Limit Amt:l $.00 Liguidated Dam Rate Amt:l $.00

Generate Est2 Day: l_ Contract Limit Pct:l 0o [v Auto Liquidated Dam
[~ Price Adjmnt Ind

RETAINAGE
[~ Securities Allowed [ Retain Stkpiled Ind [ Unlimited Escrow  Max Escrow Am!:l $.00 |

Retainage Changes:

Work Compl Basis |Effect Date, Pct Pct Base Max Pct| Max Amt Lump Amt |Trgr Pct Trgr Base
[=1 00/00/00 00| [= .00 $.00 .00 .00 [:

Figure 5-4. The Payment Data Folder Tab

Field Name Description

Current Contract | The current amount of the contract (original bid amount
Amt plus approved change orders). This field is display
only.

Generate Estl Day | The day of the month, 1 - 30, that the contract’s first
monthly estimate should be generated. Three days
before this day, the system notifies the Project Manager
that estimate generation is approaching.

Contract Limit The amount over the original bid amount that is allowed
Amt for the contract. The limit amount is added to the bid
amount to calculate the maximum amount that can be
paid for the contract. If a value is entered in this field,
the Contract Limit Pct field is protected.

Liquidated Dam The liquidated damages rate amount for the contract.
Rate Amt

Generate Est2 Day | The day of the month, 2 - 30, that the contract’s second
monthly estimate should be generated. Three days
before this day, the system notifies the Project Manager
that estimate generation is approaching. The value in
this field must be greater than the Generate Estl Day.
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Field Name

Description

Contract Limit Pct

The percent over the original bid amount that is allowed
for the contract. The total of the limit percent multiplied
by the bid amount is added to the bid amount to
calculate the maximum amount that can be paid for this
contract. If a value is entered in this field, the Contract
Limit Amt field is protected.

Auto Liquidated
Dam

Indicates that liquidated damage values are generated
automatically.

Price Adjmnt Ind

Indicates that price adjustments are allowed for the
contract’s items.

Retainage

Retainage
Securities Allowed

Indicates whether securities are allowed in lieu of
retainage for the contract.

Retainage Stkpiled
Ind

Indicates that retainage includes stockpiled materials in
the earnings calculation.

Retainage Max
Escrow Amt

Maximum amount that can be encumbered in an escrow
account used in lieu of retainage.

Retainage
Unlimited Escrow
Ind

Indicates that there is no limit to how much retainage
can be covered by the escrow account.

Retainage Changes

Retainage Changes
Work Compl Basis

Method for calculating retainage (i.e., Work Reported
Per Period, Work Remaining, or Work In Place).

Retainage Changes
Effect Date

Effective date of retainage. The effective date cannot be
duplicated on different retainage records.

Retainage Changes
Pct

The retainage percentage to be applied to the contract.
Must be less than or equal to the maximum retainage
percentage. This field is required if a lump sum amount
is not entered.

Retainage Changes
Pct Base

Indicates that retainage should be calculated as a
percentage of the bid amount or the current amount.
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Field Name Description

Retainage Changes | The maximum retainage percentage allowed for the
Max Pct contract.

Retainage Changes | The maximum retainage amount allowed for the
Max Amt contract.

Retainage Changes | The lump sum amount of retainage. If a retainage
Lump Amt percentage is not entered, a value must be entered here.

Retainage Changes | The percentage of contract completion at which the
Trgr Pct retainage change is to occur.

Retainage Changes | Indicates that the trigger percentage should be a
Trgr Base percentage of the bid amount or current amount.

Table 5-4. The Payment Data Folder Tab Fields Table
To modify a pending contract’s payment data:

1. On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

2. Click the Open button. The Select Contract list displays.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

4. Click the Payment Data folder tab.

5. Inthe Generate Est 1 field, select the current entry and type the day of the month the
contract’s first monthly estimate should be generated.

6. Press the Tab key.
7. Inthe Contract Limit Amt field, type the payment limit amount.
8. Press the Tab key.

9. To enter a Liquidated Damages Rate Amount or overwrite the default value in the
Liquidated Dam Rate Amt field, select the current entry and type the rate.

10. Press the Tab key.

11. In the Generate Est 1 field, select the current entry and type the day of the month the
contract’s second monthly estimate should be generated.

12. Press the Tab key.
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13.

14.

15.
16.

17.

18.

19.

20.

In the Contract Limit Pct field, select the current entry and type the contract’s limit
percentage.

To turn off automated liquidated damage generation, select the Auto Liquidated Dam check
box (OFF).

To allow item price adjustments, select the Price Adjmnt Ind check box (ON).

To allow securities to be used in lieu of retainage, select the Securities Allowed check box
(ON).

To include stockpiled materials in earnings calculations, select the Retain Stkpiled Ind
check box (ON).

To allow unlimited retainage coverage by the escrow account, select the Unlimited Escrow
check box (ON).

In the Max Escrow Amt field, select the current entry and type the maximum amount to be
encumbered in an escrow account.

Click the Save button.

If a retainage record is effective when an estimate is generated, the record cannot be deleted.
Therefore, the user cannot delete a retainage record when:

The Retainage Effective Date is less than or equal to the current date, and an estimate has
been generated.

The Estimate Generate date is greater than or equal to the Retainage Effective Date.

To add data that determines how retainage is to be applied to the contract:

1.

On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

Click the Open button. The Select Contract list displays.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

Click the Payment Data folder tab.

In the Retainage Changes area, click the Work Compl Basis field and click the New
button. An empty row is added.

In the Work Compl Basis drop-down list, click the expand arrow to the right of the current
selection and click the method for calculating retainage.

Press the Tab key.
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8. Inthe Effect Date field, select the current entry and type the effective date of retainage.
9. Press the Tab key.
10. In the Pct field, select the current entry and type the retainage percent to be applied.

11. In the Pct Base drop-down list, click the expand arrow to the right of the current selection
and click either Bid Amount or Current Amount.

12. Press the Tab key.

13. In the Max Pct field, select the current entry and type the maximum retainage percentage
allowed.

14. Press the Tab key.

15. In the Max Amt field, select the current entry and type the maximum retainage amount
allowed.

16. Press the Tab key.
17. In the Lump Amt field, select the current entry and type the lump sum amount of retainage.
18. Press the Tab key.

19. In the Trgr Pct field, select the current entry and type the trigger percentage (percentage of
contract completion at which the retainage change is to occur).

20. Press the Tab key.

21. In the Trgr Base drop-down list, click the expand arrow to the right of the current selection
and click either Bid Amount or Current Amount.

22. Click the Save button.

5.4.4 Contract Critical Dates

The Critical Dates folder tab lets the user view and record the occurrence of Critical Dates. The user
can also add or modify related data. The actual occurrence of a Critical Date event is recorded as the
Actual Date of the event. Some Actual Dates are entered by the system and some are entered by an
authorized user. The Critical Date types are defined during system development and cannot be
added or deleted. These dates are considered critical because SiteManager includes them in the
standard contract record reports. When a new contract is added, either manually or from a
preconstruction system, SiteManager includes the Critical Date types defined in the Default Critical
Date reference table. Therefore, every contract has the same Critical Date types.
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Critical Date Type

Requirements for Entering the Actual Date

Accepted Date

This date cannot be required to activate the contract.

Adjusted Completion
Date

The system enters this date and the user cannot modify
it. This date is entered by the Change Order process.

Award Date

This date cannot be modified when the contract is from
the preconstruction system.

Checked Out to Field
Date

The system enters this date and the user cannot modify
it. This date is entered by Pipeline when the contract is
checked out. This date cannot be required to activate
the contract.

Contract Archived Date

The system enters this date and the user cannot modify

it. This date is entered by the contract archival process.

This date cannot be required to finalize or activate the
contract.

Contractor Bankruptcy
Date

This date cannot be required to finalize or activate the
contract.

Contractor Default Date

This date cannot be required to finalize or activate the
contract.

Contractor Final
Release Date

This date cannot be required to activate the contract.

Execution Date

This date can be modified only when the contract is
pending.

Letting Date

The user cannot modify this date if the contract was
transferred from a preconstruction system.

Notice to Proceed Date

The user cannot modify this date until the contract’s
status is changed to Active.

Open to Traffic Date

This date cannot be required to activate the contract.

Original Completion
Date

If time is charged as Calendar Days, the system enters
this date and the user cannot modify it. If time is
charged as a Fixed Completion Date, this date can be
modified while the contract is pending. If time is
charged as Available Work Days, this date should not
be entered.
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Critical Date Type

Requirements for Entering the Actual Date

Contract Items
Complete Date

This date cannot be required to activate the contract.
This date can be modified only when the contract is
active. Before entering this date, all change orders must
be approved or denied. When this date is entered, the
system notifies personnel and enters final quantities for
active items and moves all active items to final status.

When this date is entered, the user is notified that all
items will be moved to Final status upon entering and
saving this date, and is prompted to continue the
operation. Once this date has been entered and saved,
the user will no longer be able to post DWRs on items
moved to the Final status.

Physical Work
Complete Date

This date cannot be required to finalize or activate the
contract.

Price Adjustments Base
Date

This date can be modified only when the contract is
pending.

Signed Date

This date cannot be modified when the contract is from
a preconstruction system.

Substantial Work
Complete Date

This date cannot be required to activate the contract.
This date can be modified only when the contract is
active.

Work Begin Date

This date cannot be required to activate the contract.

Table 5-5. The Critical Date Type Requirements Table

5.4 Contracts
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Description Location Payment D ata Critical Primary Prime DBE Commit ~ Training Plan
Dates Personnel Contractor

Contract ID: I

Critical Date Description Actual Date Required to Activate | Required to Finalize ii
Accepted Date 00400400 M M
Adjusted Completion Date 00400400 M M
Contract Archived D ate 0000400 N M
Award Date 00./00/00 N M
Contractor Bankruptcy Date 00/00/00 M M
Checked Dut to Field Date 00/00400 N N
Contractor Default Date 00400400 N 8]

Eil o

Critical Date Description: lﬁccepted Date

Actual Occurrence Date: [~ Required to Activate [ Required to Finalize

Distribution List: I Recipient ID: I

Message Text: |

Figure 5-5. The Critical Dates Folder Tab

Field Name Description
Critical Date System-defined critical date type. All contracts have the default
Description critical date types. The critical date types cannot be added,

modified, or deleted.

Actual Date The date the event actually occurred. In most cases, the date
must be current or in the past. If time is charged as Fixed
Completion Date, the Original Completion Date can be in the
future. When an Actual Date is entered, the system notifies the
selected recipient(s). When an Actual Date is entered for the
Contract Items Complete Date, the system notifies Level 1
office personnel and enters final quantities for any active items
and changes their status to final (i.e., no longer able to log work
to these items).

Rqrd to Activate | Indicates that the event must occur before the contract status can
be changed from pending to active (e.g., Letting Date, Award
Date, Execution Date).

Rqgrd to Finalize | Indicates that the event must occur before the contract status can
be changed to complete.

Distribution List | Group of users to be notified that the event has occurred. Either
a Distribution List or Recipient must be entered. After valid
entry of either, the other is unavailable. The user can search this
field.
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Field Name Description
Recipient ID User ID of the person to be notified that the event has occurred.

Either a Distribution list or recipient must be entered. After
valid entry of either, the other is unavailable. The user can
search this field.

Message Text Standard message to be sent to the recipient(s).

Table 5-6. The Critical Dates Folder Tab Fields Table

The Notice to Proceed Date can only be entered when the contract status is Active. Before the
Contract Items Complete Date is entered, item final quantities should be approved and all change
orders must be approved or denied.

If an Original Completion Date is entered for an Available Work Days contract, the date will be
removed when the contract is activated.

To enter the Actual Date of a Contract Critical Date:

1. On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

2. Click the Open button. The Select Contract list displays.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

4. Click the Critical Dates folder tab.

5. In the Critical Date Description list box, scroll to and click the date. The data for the
selected date displays below the list.

6. Inthe Actual Date field, click in front of the current entry and type the date when the
Critical Date event occurred.

7. To make this date Required to Activate, select the Rqrd to Activate check box (ON).
8. To make this date Required to Finalize, select the Rqrd to Finalize check box (ON).

9. To select a recipient for notification, perform a Search in either the Distribution List field
or the Recipient ID field.

10. In the Message Text field, type a message to include with the notification.

11. Click the Save button.
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5.4.5 Contract Primary Personnel

The Primary Personnel folder tab lets the user add, modify, and delete the contract’s primary
personnel. Every contract must have a Project Manager and a Project Engineer. When an
authorized user adds the Project Manager and Project Engineer to the contract, SiteManager

automatically adds them to Contract Authority. If primary personnel are later replaced, SiteManager
starts authority for the new personnel and ends authority for the previous personnel.

The user can also select an individual or a group to be notified of certain conditions. Personnel can

be notified when the contract status is changed to active, when the contract work falls behind

schedule, or when civil rights data fails validation.

¥4 Contracts H=1E3
Description Location Payment Data  Critical Dates Primary Prime DBE Commit  Training Plan
Personnel Contractor

Contract ID: |

Project Manager: | |
Project Engineer: | |
Contract Designer: |

Contract Created By: |S_I,Jstem Administrator 1

— Notificati

— Contract Status Changed to Active:

User ID: I Distribution List: |

Recipients

—Work Progress Behind Schedule

User ID: I Distribution List: |

— Civil Rights Exception Report Generated:

User ID: I Distiibution List: |

Figure 5-6. The Primary Personnel Folder Tab

Field Name

Description

Project Manager

Name of the Project Manager for the contract.
Specific messages and reports are sent to this person.

The user can search this field. This is a required field.

Project Engineer

Name of the Project Engineer for the contract.
Specific messages and reports are sent to this person.

The user can search this field. This is a required field.

Contract Designer

Name of the person or firm that designed the contract.

Contract Created
By

Name of the user who added the contract, or a system
indicator for contracts built by the system.

Recipient Notified when Contract Status Changed to Active
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Field Name Description
User ID User ID of the person to be notified when the

contract’s status changes from pending to active. The
value is protected if a Distribution List is entered.
Either a User ID or Distribution List must be entered.
The user can search this field.

Distribution List Name of the Distribution List to be notified when the
contract’s status changes from pending to active. The
value is protected if a User ID is entered. Either a
User ID or Distribution List must be entered. The user
can search this field.

Recipient Notified when Work Progress Behind Schedule

User ID User ID of person to be notified when the contract’s
progress falls behind schedule equal to or greater than
the variance percentage. This message is generated
only if the Variance Pct is entered and the contract
work is tracked by a Progress Schedule. The value is
protected if a Distribution List is entered. Either a
User ID or Distribution List must be entered. The user
can search this field.

Distribution List Name of the Distribution List to be notified when the
contract’s progress falls behind schedule equal to or
greater than the variance percentage. This message is
generated only if the Variance Pct is entered and the
contract work is tracked by a Progress Schedule. The
value is protected if a User ID is entered. Either a
User ID or Distribution List must be entered. The user
can search this field.

Recipient Notified when Civil Rights Exception Report Generated

User ID User ID of the person to be notified when the
contract’s civil rights monitoring generates an
exception report. This field is protected if a
Distribution List is entered. Either a User ID or
Distribution List must be entered. The user can search
this field.
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Field Name Description

Distribution List Name of the Distribution List to be notified when the
contract’s civil rights monitoring generates an
exception report. This field is protected if a User ID is
entered. Either a User ID or Distribution List must be
entered. The user can search this field.

Table 5-7. The Primary Personnel Folder Tab Fields Table

To add Primary Personnel to a pending contract:

1.

10.

11.

12.

13.

On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

Click the Open button. The Select Contract list displays.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

Click the Primary Personnel folder tab.

In the Project Manager field, type the User ID of the contract’s Project Manager or perform
a Search.

Press the Tab key.

In the Project Engineer field, type the User ID of the contract’s Project Engineer or perform
a Search.

Press the Tab key.
In the Contract Designer field, type the name of the contract’s Designer.

To select a recipient to be notified when a contract’s status changes from pending to active,
tab to the appropriate field and type the User ID or Distribution List name or perform a
Search.

To select a recipient to be notified when a contract’s progress falls behind schedule, tab to
the appropriate field and type the User ID or Distribution List name or perform a Search.

To select a recipient to be notified when a contract’s civil rights monitoring generates an
exception report, tab to the appropriate field and type the User ID or Distribution List name
or perform a Search.

Click the Save button.
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5.4.6 Prime Contractor, Contacts, and Associates

The Prime Contractors folder tab lets the user add and delete the Prime Contractor, the Prime
Contacts, and the Prime Associates. The user can also specify the Prime Contractor’s payroll
frequency and the maximum percentage of the contract work that can be subcontracted. If the Prime
Contractor is in default, the user can record the defaulted date and reason. The Prime Contractor
entities are defined as follows:

Prime Contractor | Tha prime Contractor is the contractor who is awarded the

contract.

Prime Contacts | The prime Contacts are the Prime Contractor’s personnel

who are contact persons for the contract. This includes
safety officers, contractor supervisors, and EEO
compliance officers.

Prime

) The Prime Associates are vendors who have a contract-
Associates

specific relationship with the Prime Contractor. This
includes the surety and insurance companies that are
supplying business services to the Prime Contractor for the

contract.
[Bcontacts | || | | [ ][ [ | ] [Nt =k
" Description = Location  Payment Data  Critical Dates ~ Primary Prime ~ DBE Commit ~ Training Plan
Personnel Contractor
Contract ID: |
Current Prime: [~ Joint Yenture
Payroll
’TV' Required Freq in Weeks: ID 'I Max Subcontract Pct: .00 [V Subcontractors Paid
Bankruptcy Date: |DE|3’DDJDEI Bankruptcy Type Desc: [Spaces
Defaulted
[ Indicator Reason: |Spaces Date: |DEI/DE|/DD
Original Prime Contractor: | |
Prime Contacts: Contact Name Contact Type l User Id l

L 6 Eora G Assoc Yendor ID Associate Short Name Associate Type ‘

Figure 5-7. The Prime Contractor Folder Tab
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Field Name Description
Current Prime Agency-defined Vendor ID and short name for the

current Prime Contractor. The user can search this
field. This is a required field. If the user changes the
current Prime Contractor, the data in the other fields
is deleted.

Defaulted Original | Agency-defined Vendor ID and short name for the
Prime Contractor original Prime Contractor who was awarded the
contract and then defaulted.

Joint Venture Indicates that the contract was awarded to a joint
venture.

Subcontractors Paid | Indicates whether the Prime Contractor has paid all of
the subcontractors. This indicator is selected (ON) by
default.

Payroll Required Indicates that certified payrolls are required for the
contract. Must be selected (ON) for federal contract.
Must be selected (ON) to process payrolls in
SiteManager. If this indicator is selected, a Payroll
Frequency in Weeks must be entered.

Payroll Freq in Weekly frequency that certified payrolls are required
Weeks to be received for the contract. This field is required
if the Payroll Required indicator is selected. This
value must be entered before the contract status is
changed to active.

Max Subcontract Maximum percentage of the total contract amount
Pct that the Prime Contractor is allowed to subcontract
(excluding specialty items).

Bankruptcy Date Date the Prime Contractor filed for bankruptcy.

Bankruptcy Type Type of bankruptcy filed (e.g., Chapter 11 or Chapter
Desc 13).

Defaulted Indicator | When selected (ON), the Defaulted Indicator
indicates that the Prime Contractor is in default and
another contractor or surety has taken over
responsibility for the contract.

Defaulted Date The date the Prime Contractor defaulted. This field is
required if the Defaulted Indicator is selected (ON).
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Field Name

Description

Defaulted Reason

Reason the Original Prime Contractor defaulted (e.g.,
performance or bankruptcy). This field is required if
the Defaulted Indicator is selected (ON).

Defaulted Reason

Reason the Original Prime Contractor defaulted (e.g.,
performance or bankruptcy). This field is required if
the Defaulted Indicator is selected (ON).

Prime Contact
Name

The name of the contact person for the Prime
Contractor. The user can search this field.

Prime Contact Type

Title of the contact person for the Prime Contractor
(e.g., EEO).

Prime Contact User
ID

The agency-defined user ID for the Prime Contact, if
one has been assigned.

Prime Assoc
Vendor ID

Agency-defined ID for the Prime Contractor’s
Associate. Usually the Federal Tax ID. The user can
search this field.

Associate Short
Name

Short name for the Prime Contractor’s Associate.

Associate Type

Type of Prime Contractor Associate (i.e., Surety,
Insurance, Escrow, Banking, Surety Agent, Escrow
Agent, Other Payee, Other).

Table 5-8. The Prime Contractor Folder Tab Fields Table

To be selected as a Current Prime, a contractor must first be entered as a vendor in the VVendor
reference tables. To save a contract, the Prime Contractor must have a Payment Address selected via
the Services menu.

To add a Prime Contractor to a pending contract:

1.
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10.

11.
12.
13.

14.

In the Current Prime field, type the name of the contract’s Current Prime Contractor or
perform a Search.

If a joint venture won the award, select the Joint Venture check box (ON). The Prime
Contractor must have affiliates defined in the VVendor reference table.

If the payrolls will be processed in SiteManager, select the frequency of receipt in weeks in
the Freq in Weeks drop-down field.

Or

If the payrolls will not be processed in SiteManager, select the Payroll Required check box
(OFF).

Press the Tab key.

In the Max Subcontract Pct field, type the maximum percentage of the total contract
amount that the Prime Contractor is allowed to subcontract.

Click the Services menu and select Address.
Choose the Address that will be used as the Prime Contractor’s Payment Address.

Click the Services menu (or click the Address button on the Toolbar)and choose Select
Address.

Click the Save button.

To be selected as a Prime Contact, a contact person must first be entered as personnel of the Prime
Contractor on the Vendor Personnel folder tab.

To add a Prime Contractor to a contract:

1.

On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

Click the Open button. The Select Contract list displays.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a
Find.

Click the Prime Contractor folder tab.

To add a contact, click the Prime Contact Name field and click the New button. An empty
row is added to the list.

In the Prime Contact Name field, perform a Search and select a name. The system enters
the User ID.
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7. Inthe Contact Type drop-down list, click the contact type.
8. Click the Save button.

To be selected as a Prime Associate, a vendor must first be selected as an associate of the Prime
Contractor on the Vendor Associates folder tab. Every contract requires two Associates: a surety
company and an insurance company.

To add a Prime Associate to a contract:

1. On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

2. Click the Open button. The Select Contract list displays.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find.

4. Click the Prime Contractor folder tab.

5. To add an associate, click the Prime Assoc Vendor ID field and click the New button. An
empty row is added.

6. Inthe Prime Assoc Vendor ID field, perform a Search and select n ID. The system enters
the Associate Short Name and the Associate Type.

7. Click the Save button.

When the user places the Current Prime in defaulted status, the user must also select a new Current
Prime and Prime Associates. For example, the Original Prime Contractor’s surety company can be
selected as the Current Prime.

To record a Prime Contractor’s defaulted status:

1. On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

2. Click the Open button. The Select Contract list is displayed.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find.

4. Click the Prime Contractor folder tab.

5. If the Prime Contractor has filed for bankruptcy, type the date the bankruptcy was filed in the
Bankruptcy Date field.

6. If the Prime Contractor has filed for bankruptcy, click the bankruptcy type in the
Bankruptcy Type Desc drop-down list.
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10.
11.

12.

13.

14.

5.4.7

Click the Defaulted indicator. A popup message appears saying that defaulting the Current
Prime also removes the Prime Contacts and Associates.

Click Yes to continue. The system removes the Prime Contacts and Associates and enters
the defaulted Prime Contractor in the Original Prime Contractor field.

In the Reason drop-down list, click the reason for defaulting.
In the Date field, type the date the Prime Contractor defaulted.

In the Current Prime field, type the name of the contract’s new Current Prime Contractor or
perform a Search.

To add an Associate, click the Prime Assoc Vendor ID field and click the New button. An
empty row is added.

In the Prime Assoc Vendor ID field, perform a Search. After the user selects an ID, the
system enters the Associate Short Name and the Associate Type.

Click the Save button.

DBE Commitments

The DBE Commit folder tab lets the user add and modify the DBE goal percentage and view the
DBE commitments for a contract. If the Prime Contractor is a DBE, the user can also enter the DBE
Work Class on this folder tab. The system calculates the DBE commitment amounts displayed on
this folder tab using values entered on the Subcontracts window.

Eﬁnntlacts M= E3
Description Location Payment Data  Critical Dates Primary Prime DBE Commit  Training Plan
Personnel Contractor

Contract ID: I DBE Work Class: |Spaces
DBE Goal Percent: I II]D DBE Goal Yalue: I$.UD

— DBE Cc
Original Amount: I $.00
Total Current Pct: I .00

Total Current Amount: I $.00
—Total DBE Subcontracts

Installed to Date: I $.00

Towards Goal: $.00
Mot Towards Goal: $.00
Amount: I $.00

Figure 5-8. The DBE Commit Folder Tab
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Field Name Description

DBE Work Class The Prime Contractor’s DBE Work Class for the contract.
This value can only be entered if the Prime Contractor is a
DBE.

DBE Goal Percent | DBE goal percentage for the contract. This value can be
modified.

DBE Goal Value DBE goal amount for the contract. The system calculates
this field by multiplying the contract bid amount by the
DBE goal percentage.

DBE Commitment

DBE Commitment | DBE commitment amount at award of the contract.
Original Amount

DBE Commitment | Percentage of the current DBE commitment on the

Total Current Pct | contract. The system calculates this value by dividing the
total current amount of the DBE commitment by the
contract bid amount.

DBE Commitment | Sum of the current DBE commitments for all subcontracts
Total Current to date. Calculated by the system.
Amount

Total DBE Subcontracts

Installed to Date Installed to Date amount for all DBE subcontracts in the
contract. The sum of all DBE subcontract-reported item
quantities multiplied by the item prices.

Towards Goal Subcontract amount counted towards the DBE
commitment goal. The sum of the DBE subcontract
amounts multiplied by the DBE goal percentage.

Not towards Goal Subcontract amount not counted towards the DBE
commitment goal. The sum of the DBE subcontract
amounts minus the amount counted towards the DBE
commitment goal.

Amount Sum of all the DBE subcontract amounts for the contract.

Table 5-9. The DBE Commitments Folder Tab Fields Table
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To modify the DBE goal percentage for a contract:

1. On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

2. Click the Open button. The Select Contract list displays.

3. Inthe Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

4. Click the DBE Commitments folder tab.

5. If the Prime Contractor is a DBE, in the DBE Work Class drop-down list, click the expand
arrow to the right of the current selection and click the DBE Work Class.

6. Inthe DBE Goal Percent field, type the DBE goal percentage for the contract. The
remaining fields are calculated by the system.

7. Click the Save button.

5.4.8 Training Plan

The Training Plan folder tab lets the user view, add, and modify the Prime Contractor’s on-the-job-
training commitments for a contract. If the contract includes the training plan as a line item, the
system enters the training plan and the user cannot modify it. If training is not a line item, the user
can enter the plan. The plan consists of the total training hours for the contract, the hourly (unit)
price to be used for reimbursement, and the approximate number of trainees. This data is used by
the estimate process to reimburse the Prime Contractor.

If a training plan is specified, the trainees must be entered on the Trainees window in Civil Rights.
The training plan hour usage is typically entered through certified payrolls. To accrue training plan
hours, the trainee data (names, SSN/SIN numbers, and training program) must match the payroll
employee data. The Total Hours Used to Date field is updated automatically via the Accrue
Training Experience batch process. The hours are accrued from certified payrolls that include
trainee data. The Total Hours Paid to Date field is calculated during the estimate generation process.
For more information, refer to the Civil Rights, Contractor Payroll, and Contract Adjustment topics.

If the training plan is a line item, it must be a single line item. The Training Plan folder tab retrieves
only the first item code of the type (metric or English) specified in the system operational parameter
table.
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¥4 Contracts [_ [O] x|
Deszcription Location Payment Data ~ Critical Dates Prirnary Prime DEE Commit Training
Personnel Contractor Plan
Contract ID: |

Planned Training HDI.IISZE iDEE Total Hours Used To Date:l 0

Training Unit Plice:l $.00 Total Hours Paid To Date:l i]

Planned Number of Tlainees:l Actual Number of Trainees:l a

Figure 5-9. The Training Plan Folder Tab

Field Name Description
Planned Training Specifies the planned number of training hours
Hours committed by the Prime Contractor. If specified by a

training item code, this field defaults to the item’s bid
quantity and cannot be modified.

Planned Number of | Specifies the planned number of trainees committed by
Trainees the Prime Contractor. If specified by a training item
code, this field defaults to the item’s bid quantity divided
by the system operational parameter‘s average training
program hours and cannot be modified.

Training Unit Price | Specifies the hourly (unit) price to reimburse a Prime
Contractor for training hours logged via Contractor
Payrolls. If specified by a training item code, this field
defaults to the item’s bid unit price and cannot be
modified.

Total Hours Used To | Total number of hours used by the trainees on the

Date contract to date. This value is calculated by a batch
process using data from Contractor Payrolls and Civil
Rights. The user can modify this value by entering DOT
Hours on the Trainee window.

Actual Number of Actual number of trainees allocated to the contract. This
Trainees value is calculated by a batch process using Trainee data
from Civil Rights.
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Field Name Description

Total Hours Paid To | Total number of hours used by the trainees on the
Date contract after the last paid date. This value is calculated
during estimate generation.

Table 5-10. The Training Plan Folder Tab Fields Table

To add a Training Plan to a contract:

1.

8.
9.

On the Contract Records panel, double-click the Contracts icon. The Contracts window
opens.

Click the Open button. The Select Contract list displays.

In the Select Contract list box, scroll to and double-click the Contract ID or perform a
Find. The Select Contract list closes and the Description folder tab displays.

Click the Training Plan folder tab.
In the Planned Training Hours field, type the number of planned training hours.
Press the Tab key.

In the Training Unit Price field, type the unit price (hourly) that the contractor will be
reimbursed for training.

Press the Tab key.

In the Planned Number of Trainees field, type the number of trainees.

10. Click the Save button.

5.4.9 Custom Records

The Custom Template (List & Record) window lets the user create custom templates to collect
contract records and PCC and SUPERPAVE Mix Design records and custom templates to list
records not related to specific contracts. Custom templates are sometimes needed to collect data that
cannot be entered on the standard windows provided with SiteManager. The user creates the
template by defining the required window elements. The user can then preview the template design
before making the template accessible to end users. Multiple detail records can be associated with
each Custom Contract Record, Custom List, Custom PCC and SUPERPAVE Mix Design custom
template that has been defined.

These four types of templates are defined as follows.

Custom Contract Record template
Collects contract data not currently associated to any SiteManager window.
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= Custom List template

Maintains lists not currently associated to any SiteManager window. For example, phone
and address lists for welders, carpenters, and other non-contract personnel.

= Custom PCC Mix Design Record template
Collects PCC Mix Design data not currently associated to any SiteManager window.

= Custom SUPERPAVE Mix Design Record template
Collects SUPERPAVE Mix Design data not currently associated to any SiteManager

window.
Contract: | Template 1d:| CrAMutDt
Template Hame:
| |
Row 1 of 1
Fiow 1of 2 =
Field 1 : fl9033
Field 2 : aaab
Figure 5-10. The Custom Contract Record Usage Window
Field Name Description
Contract Agency-defined ID for the selected contract.
Template ID Templates available for selection. The user can
search this field.
Template Name Name of the template selected on the window.

Table 5-11. The Custom Contract Record Usage Window Fields Table

To modify custom contract records:

1. On the Contract Records panel, double-click the Contracts icon. The Contract Description
folder tab displays.

2. Click the Open button. The Select Contract window opens.

3. Inthe Contract list box, scroll to and double-click the Contract ID.
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Record Usage window opens.

In the Template ID field, type the template ID or perform a Search. The window displays

the template.

Add or modify the data.

Click the Save button.

Mix 1D: | Template |d3|CSHMuItiDt
Template Hame:
| |
Row 1 of 1
Fow 1 of 2 a
Field 1 : e
Field 2 : Apdrew's Consulting
Figure 5-11. The Custom SUPERPAVE Mix Design Record Usage Window
Field Name Description
Mix ID The Mix ID for the current Mix Design.
Template ID This column is editable and standard search lens feature is

provided to select from the list of available Custom
SUPERPAVE Mix Design Record templates. The list
displays Template ID and Template Description in the
datawindow.

This column is editable and the user can enter the partial
Template ID and use the search or filter search facility.

Template Name

The description of the template chosen by the user. This field
is protected.

Template Content

This area contains the fields that are included in the Template.
This field is editable unless the Mix Design is Approved.

Table 5-12. The Custom SUPERPAVE Mix Design Record Usage Window Fields Table
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To modify custom SUPERPAVE Mix Design records:

1. On the Contract Records panel, double-click the Contracts icon. The Contract Description
folder tab is displayed.

2. Click the Open button. The Select Contract window opens.
3. Inthe Contract list box, scroll to and double-click the Contract ID.

4. Click the Services menu and click the Custom SUPERPAVE Mix Design Record choice.
The Custom Contract Record Usage window opens.

5. Inthe Template ID field, type the template 1D or perform a Search. The window displays
the template.

6. Add or modify the data.

7. Click the Save button.

5.5 Contract Milestones

The Milestone window lets the user add, modify, and delete contract milestones. The user can enter
an incentive or disincentive rate for each milestone and specify either days or hours to be used in
calculating the amount to be paid or withheld. The user also enters the dates the milestone work was
started and completed.

E Milestones |_ O] x|
Contract ID: SITEMGR_30
Mistn Description Time Cur Mistn =
Mbr Used(%) | Cmpl Date
00700400
<] ;IJ
e l_ .
Time Charges: |:E Bid Days: I Charged: I 0 Adjusted: 0
Rate Time Period: |:E Bid Hours: | Remaining: | 0 Credit Days: 0
Date — Time [T A Disi tind [ Preconstruction Ind
Work Start:|  00/00/00 [ 0000 | [T Aut tiveInd [ Milestone Compl Ind
Original Milestone Compl:l 0000400 | 0000 Incentive Rate Amt: $.00
Current Milestone Compl: | 00/00/00 I 0000 Disi tive Rate Amt: $.00
Actual Completion: | 00/00/00 [ 00:00 Incentive Cap Amt[ 1

Figure 5-12. The Milestones Window

Field Name Description
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Field Name

Description

Milestone Nbr

System-generated sequential number of the milestone.
This value cannot be modified.

Description

Text description of the milestone.

Time Charges

How time charges are assessed for the contract. Can be
Available Work Days, Calendar Days, or Fixed
Completion Date.

Bid Days

The original number of days bid for the milestone. This
field is required if the Time Charges value is Available
Work Days or Calendar Days and the Rate Time Period
value is Days. A value cannot be entered if the Time
Charges value is Fixed Completion Date.

Charged

The total number of days charged to the milestone to
date. Calculated by the system. Can be Available Work
Days or Calendar Days, depending on the Time Charges
entry. This field is empty if the Time Charges value is
Fixed Completion Date.

Adjusted

Adjustment to the days charged for a milestone. This
value is provided by the Change Order function.

Remaining

Total days remaining to complete the milestone work on
time. This value is calculated by the system
[(Bid Days + Adjusted Days) - Charged Days].

Credit Days

The total number of credit days recorded for the
milestone to date. Calculated by the system.

Bid Hours

The original number of hours for the milestone. This
field is required if the Time Charges value is Available
Work Days or Calendar Days and the Rate Time Period
value is Hours. The Bid Hours value must be evenly
divisible by 12. A value cannot be entered if the Time
Charges value is Fixed Completion Date.

Original Milestone
Compl Date

Original date the milestone is to be completed. If the
Time Charges entry is Calendar Days, the system
calculates this value (Work Start Date + Bid Days). This
field is required if the Time Charges entry is Fixed
Completion Date.
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Field Name

Description

Original Milestone
Compl Time

Original time the milestone is to be completed.
Calculated from the Work Start Time if the Time Charges
entry is Calendar Days (Work Start Time + Hours).

Current Milestone
Compl Date

Current expected date of completion. Calculated by the
system. The Change Order function enters this date when
time adjustments for milestones are approved. For new
milestones, this field defaults to the milestone’s original
completion date.

Current Milestone
Compl Time

Current expected time of completion. Always calculated
from the Work Start Time if the Time Charges entry is
Available Work Days or Calendar Days

(Work Start Time + Hours).

Actual Completion
Date

The date the work was completed for the milestone.
Must be greater than or equal to the Work Start Date.

Actual Completion
Time

The time the work was completed for the milestone.

Work Start Date

The date the work is expected to begin and time is
charged against the milestone. Must be less than or equal
to the Current Milestone Completion Date.

Work Start Time

The time the work is expected to begin and time is
charged against the milestone.

Incentive Rate Amt

Rate in dollars paid to the contractor if the milestone
work has progressed beyond expectations.

Disincentive Rate
Amt

Rate in dollars the contractor is to be penalized if the
milestone work has not progressed to expectations.

Incentive Cap Amt

Maximum incentive amount allowed for this milestone.

Rate Time Period

The rate time period (days or hours) used to calculate the
incentive or disincentive for the milestone.

Autogen Disincent
Ind

Indicates whether a disincentive is automatically
generated for the milestone.

Autogen Incentive
Ind

Indicates whether an Incentive is automatically generated
for the milestone.

5.5 Contract Milestones
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Field Name Description

Preconstruction Ind | Indicates the data was entered from a preconstruction
system and cannot be modified.

Milestone Compl Indicates that the Milestone work is completed.
Ind

Table 5-13. The Milestones Window Fields Table

To add a milestone with time charges of Available Work Days or Calendar Days:

1.

10.
11.

12.
13.

14.
15.

On the Contract Records panel, double-click the Milestones icon. The Milestone window
opens and a contract select list displays.

In the Contract ID list box, scroll to and double-click the contract. The Milestones for the
selected contract display.

Click the New button. An empty row is inserted in the Milestone list box.
In the Description field, type a description of the Milestone.

In the Time Charges drop-down list, click the expand arrow and select Available Work Days
or Calendar Days.

In the Rate Time Period drop-down list, click the expand arrow and select either Hours or
Days to be used for the incentive or disincentive calculation.

If the Rate Time Period is days, type the number of days bid for the milestone in the Bid
Days field.

If the Rate Time Period is hours, type the number of hours bid for the milestone in the Bid
Hours field.

To generate a disincentive automatically, select the Autogen Disincent Ind check box (ON).
To generate an incentive automatically, select the Autogen Incentive Ind check box (ON).

In the Incentive Rate Amt field, type the rate in dollars a contractor is to be compensated if
work has progressed beyond expectations.

Press the Tab key.

In the Disincentive Rate Amt field, type the rate in dollars a contractor is to be penalized if
work has not progressed to expectations.

Press the Tab key.

In the Incentive Cap Amt field, type the maximum incentive amount for this milestone.
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16.

Click the Save button. The system enters the next sequential milestone number for the new
milestone.

To add a milestone with a Fixed Completion Date:

1.

10.
11.

12.
13.

14.
15.
16.

On the Contract Records panel, double-click the Milestones icon. The Milestone window
opens and a contract select list displays.

In the Contract ID list box, scroll to and double-click the contract. The milestones for the
selected contract display.

Click the New button. An empty row is inserted in the Milestone list box.
In the Description field, type a description of the milestone.

In the Time Charges drop-down list, click the expand arrow and select Fixed Completion
Date.

In the Rate Time Period drop-down list, click the expand arrow and select either Hours or
Days to be used for the incentive or disincentive calculation.

In the Original Milestone Compl Date field, type the date the milestone is to be completed.

In the Original Milestone Compl Time field, type the time the milestone is to be completed.
To generate a disincentive automatically, select the Autogen Disincent Ind check box (ON).
To generate an incentive automatically, select the Autogen Incentive Ind check box (ON).

In the Incentive Rate Amt field, type the rate in dollars a contractor is to be compensated if
work has progressed beyond expectations.

Press the Tab key.

In the Disincentive Rate Amt field, type the rate in dollars a contractor is to be penalized if
work has not progressed to expectations.

Press the Tab key.
In the Incentive Cap Amt field, type the maximum incentive amount for this milestone.

Click the Save button. The system enters the next sequential milestone number for the new
milestone.

To record a Milestone Actual Completion date:

1.
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On the Contract Records panel, double-click the Milestones icon. The Milestone window
opens and a contract select list displays.
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2. Inthe Contract ID list box, scroll to and double-click the contract. The milestones for the
selected contract display.

3. In the Milestone list box, scroll to and click the milestone. Data for the selected milestone is
displayed in the fields.

4. Inthe Actual Completion Date field, type the date of completion.

5. Press the Tab key.

6. Inthe Actual Completion Time field, type the time of completion.

7. Click the Save button.

A milestone cannot be deleted if it has an associated record, such as a change order or an estimate
adjustment, or if the contract is checked out to the field.

To delete a Milestone:

1.

On the Contract Records panel, double-click the Milestones icon. The Milestone window
opens and a contract select list displays.

In the Contract ID list box, scroll to and double-click the contract. The milestones for the
selected contract display.

In the Milestone list box, scroll to and click the milestone. Data for the selected Milestone is
displayed in the fields.

Click the Delete button. The system asks the user to confirm the deletion.
Click Yes.

Click the Save button.

5.6 Projects

The Projects window contains descriptions of the contract projects. Every contract must have at
least one project. The Projects window folder tabs are described in the following table:

Description The Description folder tab displays the project description.

The user can add, modify, and delete the project data.

Counties The Counties folder tab displays a list of available counties

and a list of those associated with the selected project. The
user can add and remove counties to and from the project.
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ﬁfgi‘ésetsmem The Adjustment Indices folder tab displays a list of available

price adjustment indices and a list of those associated with the
selected project. The user can add and remove price
adjustment indices to and from the project.

Table 5-14. The Projects Window Folder Tab Fields Table
E Projects [ [O] x]
Description Counties Adjustrment Indices
Contract I1D: ISITEMGH_EU

Project Nbr: § | Fed St Prj Nbi: | ARPqID:[
Description: | Spec Yr: |1 391

Description: | Unit Sys: IEninsh

Status: |Spaces [l T complete Auth Pay Limit: |$D.DD

Pri Type: Work Type: Surface Type:
Route Nbr: I Sect Nbr: I Road System:

[~ Release Retainage Acct Pij Nbr: |

Road Name: |

Location: |

Engr Pct: IU. 0000

Location: |

Beg Sta: I Beg Termini: I Latitude: IU
End Sta: I End Termini: I Longitude: ID

Work Site:

Figure 5-13. The Project Description Window

To access the Project Description folder tab:

1. On the Contract Records panel, double-click the Projects icon. The Project window opens
with the Description folder tab selected by default.

5.6.1 Project Description

The Project Description folder tab lets the user add, modify, and delete projects. New projects can
be added while the contract is in pending or active status. To add a projects to an active contract, an

authorized user may create th
Before any items may be add
be associated to that project.

e projects on the Project Description folder tab of the Project window.
ed to a new project, at least one category and one funding source must
A projects with dependent data, such as categories or items, cannot be

deleted. When a contract has multiple projects, the user must select the primary projects on the
Contract Description folder tab.

Field Name

Description

PCN

Agency-defined project control number. This field is
required.
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Field Name Description
Fed St Prj Nbr The federal/state number for the project. Must be unique

within a contract. Cannot be modified after an estimate
has been generated. This field is required.

Alt Prj ID Alternate agency-defined ID for the project. Cannot be
modified after an estimate has been generated.

Auth Pay Limit The Authorized Payment Limit is used to determine if a
voucher will be processed. If the total payments exceed
this amount, the voucher will not be processed. Leaving
this field blank indicates that no cap exists for total
payments. The Authorized Payment Limit cannot be
modified after an estimate has been generated.

Status Indicates the current status of a project (e.g., Complete,
Construction, Active Construction, Awaiting Award).

Acct Prj Nbr An accounting department-defined project number.
Cannot be modified if an estimate has been generated.

Engr Pct The engineering construction percentage represents the
state or province’s cost of managing a project. This
percentage of the total project item amounts can be used
to compute the total project estimated cost as follows:
[total Project Item amount x (100 + Engr Pct)]

Description Text description of the project. This field is required.
Two lines are provided.

Prj Type Identifies the type of project (e.g., Federal). This field is
required.

Work Type Agency-defined code that identifies the major type of

work being done in the project (e.g., Grading, Widening,
Overlay, Construction). This field is required.

Surface Type Type of surface grading used in the project (e.g.,
Asphalt).

Road Name Name of the road where the project work is done.

Route Nbr Route number where the project work is done.
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Field Name Description

Road System Type of road system where the project work is done (e.g.,
interstate, federal highway, state highway, or county
highway).

Sect Nbr Road section number where the project work is done.

Location Description of the physical location of the project. This
field is required. Two lines are provided.

Work Site Identifies the landscape of the project work site (e.g.,
Urban).

Beg Sta Precisely defines the station number where the project
work begins.

Beg Termini Precisely defines the termini where the project work
begins.

Latitude The midpoint latitude of the project location.

End Sta Precisely defines the station number where the project
work ends.

End Termini Precisely defines the termini where the project work ends.

Longitude The midpoint longitude of the project location.

Complete Indicates that the project work is complete.

Release Retainage | Indicates that the project retainage is to be automatically
released when the project status is changed to complete.

Table 5-15. The Projects Description Folder Tab Fields Table
To add a project to a contract:

1. On the Contract Records panel, double-click the Projects icon. The Projects window
opens.

2. To select a contract, click the Services menu and click the Choose Keys choice. The Select
Contract 1D window opens.

3. Inthe Contract ID list box, scroll to and click the contract.

4. Click OK. The Project window opens with the selected contract ID displayed in the Contract
ID field.
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5. Inthe PCN field, click the Open button, highlight the desired PCN and click OK.

6. Press the Tab key.

7. Inthe Fed St Prj Nbr field, select the current entry and type the federal or state project
number.

8. Press the Tab key.

9. Inthe Alt Prj ID field, select the current entry and type an alternate 1D.

10. Press the Tab key.

11. In the Description field, type a description of the project. If necessary, tab to the next line
and add to the description.

12. In the Status drop-down list, click the expand arrow and click the current status of the
project.

13. To indicate that the project is complete, select the Complete check box (ON).

14. In the Auth Pay Limit field, select the current entry and type a limit value for payment.

15. To automatically release retainage when the project is completed, select the Release
Retainage check box (ON).

16. In the Acct Prj Nbr field, select the current entry and type an accounting project number.

17. In the Prj Type drop-down list, click the expand arrow to the right of the current selection
and click the project type.

18. In the Work Type drop-down list, click the expand arrow to the right of the current selection
and click the work type.

19. In the Surface Type drop-down list, click the expand arrow to the right of the current
selection and click the surface type.

20. In the Route Nbr field, select the current entry and type the affected route number.

21. Press the Tab key.

22. In the Sect Nbr field, select the current entry and type the affected section number.

23. In the Road System field, select the current entry and type the road system type.

24. In the Road Name field, select the current entry and type the name of the road affected by
the project.

25. In the Location field, type a description of the location. If necessary, tab to the next line and

add to the description.
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26.
217.

28.
29.
30.
31.
32.
33.
34.
35.
36.
37.
38.
39.
40.

Press the Tab key.

In the Engr Pct field, select the current entry and type the percentage of the project cost
charged to the state or province.

In the Urb/Rural drop-down list, click the expand arrow and click Urban or Rural.

In the Beg Sta field, select the current entry and type the station where the work begins.
Press the Tab key.

In the End Sta field, select the current entry and type the station where the work ends.

Press the Tab key.

In the Beg Termini field, select the current entry and type the termini where the work begins.
Press the Tab key.

In the End Termini field, select the current entry and type the termini where the work ends.
Press the Tab key.

In the Latitude field, select the current entry and type the midpoint latitude of the job.
Press the Tab key.

In the Longitude field, select the current entry and type the midpoint longitude of the job.

Click the Save button.

If the selected project has dependent data such as categories or items associated to it, the project
cannot be deleted.

To delete a project:

1.
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On the Contract Records panel, double-click the Projects icon. The Projects window
opens.

To select both a contract and a project, click the Open button. The Select Contract ID
window opens.

In the Contract ID list box, scroll to and double-click the contract. The Project List for the
selected contract is displayed.

In the Project list box, scroll to and click the project.
Click OK. The Projects window displays data for the selected project.

Click the Delete button. The system asks the user to confirm the deletion.
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7. Click Yes. When the project is deleted, the corresponding project counties and adjustment
indices are also deleted.

5.6.2 Project Counties

The Counties folder tab lets the user add and remove counties to and from the project. For every
county included in the project, the user must enter the percentage of the project work to be done in
the county. The percentages for all counties must add up to 100 percent.

To select the Counties folder tab, the user must open or create a project record on the Description
folder tab.

! '— Projects _ O]
— = . . - e L
Description Counties Adjustment Indices

Contract ID: |SITEMGR_30

Project Nbr: |F'F|DJ-D1 Fed State Project Nbr: |NDNE
Description: IJUB DESCRIPTION WO. 233-059-503
Location: |FFIDM: FOUTE 1 TO:ROUT 99

‘ Proj Len %
100,003

Project County
uLE EMARLE

Available Counties

j Add > |
Add All ->> I
<- Remove |
<<- Rem All I

o o

Figure 5-14. The Project Counties Folder Tab

Field Name Description

Fed State Project The federal or state project number for the contract or

Number project.

PCN Agency-defined project control number.
Description Description of the project.

Location Description of the project location.

Available Counties | Counties included in the contract that have not been
associated with this project.

Project Counties Counties that have been associated with this project.

5-57



AASHTOWare Project SiteManager™

5. Contract Administration - New Contracts 5.6 Projects
Field Name Description
Proj Len % Percentage of the total length of the work to be done in

each county. This field is required for every project
county. The percentages for all counties must add up to
100 percent.

Table 5-16. The Project Counties Folder Tab Fields Table

Button Description
Add The Add button adds a county to the project. If all available
counties have been associated with the project, this button is
disabled.
Add All The Add All button adds all the counties to the project. If all

available counties have been associated with the project, this
button is disabled.

Remove The Remove button removes a county from the project. There is
no message confirming the removal.

Remove All The Remove All button removes all the counties from the
project. There is no message confirming the removal.

Table 5-17. The Project Counties Folder Tab Buttons Table
To add a Project County:

1. On the Contract Records panel, double-click the Projects icon. The Projects window
opens.

2. To select both a contract and a project, click the Open button. The Select Contract ID
window opens.

3. Inthe Contract ID list box, scroll to and double-click the contract. The project for the
selected contract are listed.

4. In the Project list box, scroll to and click the project.

5. Click OK. The Projects window opens with the Description folder tab displayed with data
for the selected project.

6. Click the Project Counties folder tab.

7. Inthe Available Counties list box, scroll to and click the county or use the CTRL key to
select multiple counties. To clear a county, click it again.
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8. Click the Add button. The selection is added to the Project County list on the right.
9. Ineach Proj Len % field, type the percentage of the project work to be done in the county.

10. Click the Save button.

5.6.3 Project Price Adjustment Indices

The Adjustment Indices folder tab lets the user add or delete a Price Adjustment Index to or from a
project. Price Adjustment Indices are used to adjust the cost of items that are known to have
fluctuating prices, such as gas and oil products. If the user adds an item’s Price Adjustment Index to
a project, the index is used during estimate generation to calculate the cost of the item.

To select the Adjustment Indices folder tab, the user must open or create a project record on the
Description folder tab.

E Projects _ O] %]
Description Counties Adjustment Indices

Contract ID: |SITEMGF|_3EI

Project Mbr: |F'F|DJ-EI1 Fed State Project Nbr: |NDNE
Description: [J0B DESCRIFTION NO. 233-053-503
Location: [FROM: FOUTE 1 TO:ROUT 99

Available Price Indices * Indx Type Project Pay Adjmnt Indices

FUEL 0.23 GAL/CY Add > | 5001 Fuel Adjustment

Foog FUEL 0.20 GAL/TON

F201 FUEL 1.44 L/CU M Add All ->> |
Fan2 FUEL 0.83 L/MTON

<- Hemove
PO01 4|

powder fill adjustment

P02 ASPHALT 5.8% <<- Rem All |

=
o | »

Figure 5-15. The Adjustment Indices Folder Tab

Field Name Description

Fed State Project Number | Federal or state project number for the project.

PCN Agency-defined project control number.
Description Description of the project.

Location Description of the project location.

Indx Type Identifying code of a Price Adjustment Index.
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5.6 Projects

Field Name

Description

Available Price Indices

project.

Price Adjustment Indices that can be associated with this

Project Pay Adjmnt
Indices

project.

Price Adjustment Indices that have been selected for this

Table 5-18. The Adjustment Indices Folder Tab Fields Table

Button

Description

Add

The Add button adds the selected price adjustment index to
the project. If all available indices have been associated with
the project, this button is disabled.

Add All

The Add All button adds all the price adjustment indices to
the project. If all available indices have been associated with
the project, this button is disabled.

Remove

The Remove button removes the price adjustment index from
the project. There will be no message confirming the
removal. If no indices are associated with the project, this
button is disabled.

Remove All

The Remove All button removes all the price adjustment
indices from the project. There will be no message
confirming the removal. If no indices are associated with the
project, this button is disabled.

Table 5-19. The Adjustment Indices Folder Tab Buttons Table

To add a project Price Adjustment Index:

1.
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On the Contract Records panel, double-click the Projects icon. The Projects window

opens.

To select both a contract and a project, click the Open button. The Select Contract ID

window opens.

In the Contract ID list box, scroll to and double-click the contract. The projects for the
selected contract are listed.

In the Project list box, scroll to and click the project.
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5. Click OK. The Projects window opens with the Description folder tab displayed with data
for the selected project displayed.

6. On the Projects window, click the Adjustment Indices folder tab.

7. Inthe Available Price Indices list box, scroll to and click the index or use the CTRL key to
select multiple indices. To clear an index, click it again.

8. Click the Add button. The selection is added to the Project Pay Adjmnt Indices list on the
right.

9. Click the Save button.

5.7 Categories

The Categories window lets the user add, modify, and delete categories. Categories are typically
used to group items funded by the same source within a project. To do this, the user can create a
category, associate items with the category, and select a funding source for the category. Each
category in a project can have a different funding source. A category with associated items cannot
be deleted.

The Categories window lists the categories for the selected contract and project. The window
displays detailed data for the selected category below the list. After a category is saved, the project
control number (PCN) and category number cannot be modified. The project number cannot be
modified after an estimate has been generated. When a new project is added to a contract, it must be
associated with at least one category.

5 Categories _ 3] x]
Contract ID: |SITEMGFI_IJ‘I PCN: |LT18584BDBS—‘I
Category HNumber Description Work Class Type
0005 REGULAR BID ITEMS RECOMDITIONING
| ;I_I
Catg Nbr: |UUEI5 Fed St/Pr Pri Nbr: [NH-435-5(031)/0435029F 28
Desc: |F!EI3LILAH BID ITEMS Length: |.DDS‘I
| Width: [50.0000
Catg Wik Cls Type: I:lz Bridge ID:| Engr Pct: |.EIEI

Brdg Type: |Spaces
Fed Wik Catg Type: Brdg Span Mbr: I_ Rd Sect Nbr: I—
Fed Wik Cls Type: Brdg Length: IW Hwy Nbr: l—
Suppl Wik Cls Type: Brdg Width: IW Hwy Type:
Beg Sta Mbr: l— Beg Termini: l— Unit Mbr: W
End Sta Nbr: l— End Termini: l— Desc:l

Figure 5-16. The Category Window
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Field Name Description
Catg Nbr Category number assigned to items during preconstruction.
Items can be grouped in categories, primarily for funding.
This number must be unique within a project. The Category
Number cannot be modified. Categories created in error
must be deleted.
PCN Agency-defined Project Control Number.

Fed St/Pr Prj Nbr

Federal, state, or province project number for the category.
If not entered, defaults to the Fed St/Pr Prj Nbr for the
project. The user can find, filter, and sort this field.

Desc

Description of the category. Two lines are provided. The
user can find, filter, and sort these fields.

Length

The length of road represented by this category. If more
than one category contains work for the same portion of

road, the length is split between them. The user can find,
filter, and sort this field.

Width

The width of road represented by this category. If more
than one category contains work for the same portion of
road, the width is split between them. The user can find,
filter, and sort this field.

Catg Wk Cls Type

Classification of work for a category within a project (e.g.,
Roadway Construction, Bridge Construction,
Beautification, Furnished Materials, Utilities).

Bridge ID

Agency-defined value that identifies a bridge or other
structure. This field is empty if the category does not
represent structure work. The user can find, filter, and sort
this field.

Engr Pct

Engineering construction percentage that represents the
state or province’s cost of managing a category. This
percentage of the total category item amounts can be used to
compute the total category estimated cost as follows: [total
Category Item amount x (100 + Engr Pct)]. The user can
find, filter, and sort this field.

Brdg Type

Type of bridge represented by this category (e.g., Concrete
Bridge, Steel Bridge, First Tier Overpass, Second Tier
Overpass). This value cannot be modified if the Bridge ID
field is empty.

5.7 Categories
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Field Name Description
Fed Wrk Catg Identifies the type of work for the category (e.g., General,
Type Roadway, Construction & Engineering, Alternates).

Bridge Span Nbr

Number of spans within the bridge structure. Protected if
the Bridge ID field is empty.

Rd Sect Nbr Road section number where the category work is done. The
user can find, filter, and sort this field.

Fed Wrk Cls Type | Class of construction used for the category (e.g., General,
Roadway, Construction & Engineering, Alternates).

Brdg Lth Length of the structure represented by this category.
Protected if the Bridge ID field is empty.

Hwy Nbr Highway number where the primary category work is done.
The user can find, filter, and sort this field.

Suppl Wrk Cls Federal supplementary work class for a category (e.g.,

Type Emergency Evacuation Routing, Rest Areas, Safety
Improvements).

Brdg Wth The width of the structure represented by this category.
Protected if the Bridge ID field is empty.

Hwy Type Highway type where the primary category work is done.
Agency-defined values such as interstate, state route, county
route, and rest area.

Beg Sta Nbr Precisely defines the station number where the category
work begins. The user can find, filter, and sort this field.

Beg Termini Precisely defines the termini where the category work
begins. The user can find, filter, and sort this field.

End Sta Nbr Precisely defines the station number where the category
work ends. The user can find, filter, and sort this field.

End Termini Precisely defines the termini where the category work ends.

Unit Nbr Unit number under which the category is grouped.

Categories can be grouped under a unit number for
reporting purposes. The user can find, filter, and sort this
field.
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Field Name Description
Desc Description of the unit number under which the category is

grouped. Categories can be grouped under a unit number
for reporting purposes. The user can find, filter, and sort
this field.

Table 5-20. The Category Window Fields Table

To add a category to a project:

1.

10.
11.
12.
13.

14.
15.
16.
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On the Contract Records panel, double-click the Categories icon. The Categories window
opens.

To select both a contract and a project, click the Open button. The Select Contract Project
window opens.

In the Contract ID list box, scroll to and double-click the contract. The projects for the
selected contract are listed.

In the Project list box, scroll to and click the project.

Click OK. The Categories window opens with data for the first category on the list
displayed in the fields below the list.

Click the New button.
In the Catg Nbr field, type the Category Number.
Press the Tab key.

To change the default Project Number in the Fed St/Pr Prj Nbr field, select the current entry
and type the Project Number for the category.

Press the Tab key.
In the Desc field, type a description of the category.
Press the Tab key.

In the Length field, type the length of road represented by this category for the selected
project.

Press the Tab key.
If necessary, in the second Desc field, add a second line to the description of the category.

Press the Tab key.
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17. In the Width field, type the width of road represented by this category for the selected
project.

18. In the Catg WKk Cls Type drop-down list, click the expand arrow click the work class type.

19. Press the Tab key.

20. To identify a structure, in the Bridge ID field, type an agency-defined value to identify the
structure.

21. Press the Tab key.

22. In the Engr Pct field, type the engineering construction percentage.

23. Press the Tab key.

24. If a structure has been entered in the Bridge ID field, in the Brdg Type drop-down list, click
the expand arrow and click the bridge type.

25. In the Fed Wrk Catg Type drop-down list, click expand and click the work category type.

26. Press the Tab key.

27. If a structure has been entered in the Bridge ID field, in the Bridge Span Nbr field, type the
number of spans.

28. Press the Tab key.

29. In the Rd Sect Nbr field, type the road section number where construction will take place.

30. In the Fed Wrk Cls Type drop-down list, click the expand arrow and click the work class
type.

31. Press the Tab key.

32. If a structure has been entered in the Bridge ID field, in the Brdg Lth field, type the length
of the structure.

33. Press the Tab key.

34. In the Hwy Nbr field, type the primary work roadway number.

35. In the Suppl Wrk Cls Type drop-down list, click the expand arrow and click the federal
supplementary work type for the category.

36. If a structure has been entered in the Bridge ID field, in the Brdg Wth field, type the width
of the structure.

37. In the Hwy Type drop-down list, click the expand arrow and click the type of the primary

work roadway.
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38. Press the Tab key.

39. In the Beg Sta Nbr field, type the station number where the work begins.
40. Press the Tab key.

41. In the Beg Termini field, type the termini where the work begins.

42. Press the Tab key.

43. To group this category in a Unit with other categories, in the Unit Nbr field, type the unit
number.

44. Press the Tab key.

45. In the End Sta Nbr field, type the station number where the work ends.
46. Press the Tab key.

47. In the End Termini field, type the termini where the work ends.

48. Press the Tab key.

49. If a Unit number has been entered in the Unit Nbr field, in the Desc field, type a description
of the Unit.

50. Click the Save button.
A category can only be deleted if there are no items associated to it.
To delete a category:

1. On the Contract Records panel, double-click the Categories icon. The Categories window
opens.

2. To select both a contract and a project, click the Open button. The Select Contract Project
window opens.

3. Inthe Contract ID list box, scroll to and double-click the contract. The projects for the
selected contract are listed.

4. In the Project list box, scroll to and click the project.

5. Click OK. The Categories window opens with data for the first category on the list
displayed.

6. Inthe Category list box, scroll to and click the category. The fields display data for the
selected category.
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5.8 Items

The Items window lets the user add, modify, and delete items on the selected contract and project.
The agency defines standard items and lists them on the Item Master. The user can add an item to a
contract by selecting the item from the Item Master. While the contract is pending, this can be done
on the Items window. After the contract is active, items are added through change orders. The
Items window fields have specific display, protection, and calculation requirements depending on
whether the data was added through a change order. These requirements are included in the field
definitions.

1ol x|
Contract 1D
Line ltem Mbr: || | Category Nbr: | vl
Item Code: ; LInits Type: ; Spec Year: ;
Description: |
Major ltem: [ Specialty: [ Status Type: i
Unit Price: | $.00000  Bid Qty: ; 000 Bid Amt. | $.00
Proposal Line Mbr: | Related Item: | -]
Criticak | Pay Plan Qty: [ Suppl Dese Hegd: | Material Dizcrepancy Adp: [v
Supplemental Descriptions:
|
Co Nhl:i Pend CO Qty: {0 Pend CO Amt:i[l Net EO0 Qty: iD

Figure 5-17. The Items Window

Field Name Description

Line Item Nbr The Contract Line Item number that identifies each item
as it appears on the contract. The user supplies this value
for all items added to the contract after construction
begins and all contracts entered online. When entered,
must be unique within the contract. Once saved, this
value cannot be modified. Items added with wrong line
item numbers must be deleted and added again.

Project Nbr Agency-defined ID for the project. There can be multiple
project Control Numbers per contract. After a value is
entered and saved, it cannot be modified. Items added to
wrong projects must be deleted and added again.
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5.8 Items

Field Name

Description

Category Nbr

Category number under which items are grouped for
funding or other various reasons. After a category
number is saved, it cannot be modified. Items added to
wrong categories must be deleted and added again.

Status Type

Code indicating the current status of an item.

Pending. Status defaults to pending when the item is
added.

Active. When a contract’s status is changed to active, the
status of all of the contract’s items is changed to active.
An active item cannot be deleted.

Final. When a Final Item Quantity Change Order is
approved, the status of all of the change order’s items is
changed to Final.

Audited. When an item has been approved or accepted
through an audit, the user must indicate its status as
Audited.

Complete. When a contract’s status is changed to
complete, the status of all of the contract’s items is
changed to complete.

Item Code

Agency-defined code used to identify an item. This value
is supplied by the Item Master list. The user can search
this field. This value is protected from modification once
the contract status is changed from pending to active.

Description

Text description of the item. This value is supplied by the
Item Master list. An Item Description cannot be
modified.

Units Type

The unit of measure for this item. This value is supplied
by the Item Master list and cannot be modified.

Unit Price

Unit price of the item, identified on the invoice and
contract documents. Protected from modification once
the contract status is changed from pending to active.

Spec Year

Specification year from the ltem Master record.
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Field Name

Description

Bid Quantity

This is the original quantity of the line item, as indicated
on the proposal or contract. Must be greater than zero.
Must be equal to one, if the item’s unit of measure is
Lump Sum. Protected from modification once the
contract status is changed from pending to active.
Protected from entry if item is being added through a
change order. If the bid quantity is zero, the item was
added through a change order and its quantity is obtained
through the Change Order Item quantity amount and not
the item bid amount.

Bid Amount

Total dollar amount of item at bid. Protected and is
derived from the formula [Bid Qty * Unit Price].

Proposal Line
Nbr

The line number that identifies the item as it appears on
the proposal. This field is populated by a preconstruction
system and is for display only.

Specialty

Indicates if the line item is a specialty item. Specialty
items are excluded from the calculation to determine the
amount of the contract which can be sublet. Protected
from modification if the contract has an associated
estimate or if the item has any of the following:

An associated Change Order
An associated dispute
An associated plan discrepancy (through a Change Order)

An associated stockpiled material

Major

Indicates that the item is considered major rather than
minor. Major items can have different overrun limits and
parameters for change order approvals. Protected from
modification if the contract has an associated estimate, or
if the item has any of the following:

An associated Change Order
An associated dispute
An associated plan discrepancy (through Change Order)

An associated stockpiled material
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5.8 Items

Field Name

Description

Critical

Indicates that the item is considered critical. Used for
tracking the progress of contracts with the Critical Items
Installed progress schedule type. Non-critical items such
as landscaping are not included in progress tracking.

If the Allow Critical Item Indicator Update System
Operational Parameter is set to No., the indicator is
protected from modification if the contract has an

associated estimate or if the item has any of the following:

An associated Change Order

An associated dispute

An associated plan discrepancy (through a Change Order)
An associated stockpiled material

An associated Subcontract

If the Allow Critical Item Indicator Update System
Operator Parameter is set to Yes, the indicator is available
at all times until the item has a Final status.

Pay Plan Qty

Indicates if the line item is paid to plan quantity. If this
indicator is ON, an in-box message indicating that the
item has exceeded the notified quantity is issued to the
user who generated the estimate. Protected from
modification if the contract has an associated estimate or
if the item has any of the following:

An associated Change Order
An associated dispute
An associated plan discrepancy (through a Change Order)

An associated stockpiled material
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Field Name Description
Related Item Allows grouping of line items (e.g., all traffic control

items or all items for a structure) for reporting and
funding purposes. To report items together, the user may
create a related item code such as RPT1 = Report #1 and
then develop a report which selects and groups these items
together. Similarly, to fund a group of items the same but
not within the same category, the user may create a related
item code such as FND1 = Funding Source #1 and select
those items with this code in the funding process, thereby
funding all these items with the same source and
participation percentages. Protected from modification if
the contract has an associated estimate or if the item has
any of the following:

An associated Change Order
An associated dispute
An associated plan discrepancy (through a Change Order)

An associated stockpiled material

Supplemental User-entered description that is supplemental to the item's
Description description from the Item Master. Two lines are provided.
Material When an authorized user adds contract items online in
Discrepancy SiteManager, the item’s adjustment flag is set according
Adjustment to the settings in System Operational Parameters. This

flag’s check box defaults to On if system-wide
discrepancy adjustments flag is selected and if the default
calculation for all items flag is turned on. The default
setting for the item may be changed at any time during the
course of a contract. The item’s check box isdisabled if
the system setting for the discrepancy adjustments flag is
cleared.

Table 5-21. The Item Window Fields Table

A Contract Line Item can be deleted only if the contract status is pending. A supplemental
description is required if the Require Supplemental Description indicator is turned on in an item’s
Master List entry.

To view or modify a contract line item:

1. On the Contract Records panel, double-click the Items icon. The Items window opens.
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8.

To select a contract, project, and contract item, click the Open button. The Select Contract
ID window opens.

In the Contract ID list box, scroll to and double-click the contract. The projects for the
selected contract are listed.

In the Project list box, scroll to and click the project. The contract items for the selected
project are listed.

In the Items list box, scroll to and click the item.
Click OK. The Items window opens and displays data for the selected item.

To change the item’s status, click the expand arrow to the right of the current selection and
click the status type in the Status Type drop-down list,.

To save modifications, click the Save button.

Items that are not on the Item Master cannot be added to a contract through the Items window. To
add an item to an active contract, refer to the change order topic.

To add an item to a pending contract:

1.
2.

On the Contract Records panel, double-click the Items icon. The Items window opens.

To select both a contract and a project, click the Services menu and click the Choose Keys
choice. The Select Contract ID window opens.

In the Contract ID list box, scroll to and double-click the contract. The projects for the
selected contract are listed.

In the Project list box, scroll to and click the project.
Click OK. The Items window opens and displays data for the selected item.

In the Line Item Nbr field, type a unique contract line item to identify the item on the
contract.

Press the Tab key.

To group this item under a category, click the expand arrow and click the category in the
Category drop-down list.

In the Item Code field, perform a Search. After an item is selected from the Item Master,
the system fills in some of the data on the Items window.

10. To indicate that the item is considered major, select the Major check box (ON).

11. To indicate that the item is considered a specialty item, select the Specialty check box (ON).
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12. Press the Tab key.

13. In the Unit Price field, type the unit price of the item.

14. Press the Tab key.

15. In the Bid Quantity field, type the original quantity of the Line item.

16. To group this item with other Line items, click the expand arrow and click the related item
code in the Related Item drop-down list.

17. To indicate that the item is considered critical, select the Critical check box (ON).
18. To indicate that the item is paid to plan quantity, select the Pay Plan Qty check box (ON).
19. If desired, tab to the Supplemental Description field(s) and type a description.

20. Click the Save button.

5.9 Contract Funding

The Contract Funding window lets the user specify funding for the whole contract, and for the
contract’s projects, categories, and line items. The Contract Funding window lists the current
funding specifications in the top datawindow. Data for the selected funding record is displayed in
the bottom datawindow. If the user adds funding that does not match the funding selection on the
Contract Description folder tab (i.e., Federal, State/Province, or Both), SiteManager automatically
updates the Contract Description folder tab.

Active contracts must be fully funded. For any part of the contract funded by multiple sources, the
combined funding must equal 100 percent. If more than one priority level is assigned, the combined
funding for each priority level must equal 100 percent. In addition, each funding source can be
assigned a cap amount. When the highest priority funding source reaches its cap amount, the
funding source with the next highest priority continues the funding. If the lowest priority level fund
has a cap amount, the cap amount is ignored until a lower level fund is added.

When adding a project to an existing active contract, the project must have funding associated with it
prior to creating the change order that adds items to the project. Change orders cannot be approved
without a funding source for line items associated with the project or category.

5.9.1 Related Item Codes

Line items with the same Proposal Line Number or Related Item Code can be funded together.
Related Item Codes can be created specifically to group line items (e.g., all traffic control items) for
funding purposes. To do this, the user creates a Related Item Code in the system code tables and
associates Line items with this code on the Items window. The user can then select a funding source
for Related Items on the Contract Funding window.
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Funding sources are defined in the Contract Administration reference tables.

E Contract Funding _ O]
Contract ID: ISITEMG R_01

Contract ID | Project Number | Category | Line Item Funding Source Code Priority | Source Parti_
Mumber | Humber Order | pation Perce

SITEMGR_O LT18594BC01-1 INTERSTATE FUMDS 100.00
SITEMGR_O1 LT18534BC01-1 0005 COMVERSION FEDERAL FUMDINA 100.00
]| _>I_I
Project Number: ILT18594BCD1 -1 Funding Source Code: IINTEF!ST.-’-\TE FUMDS
Category Humber: I Source Participation Pelcent:l 100.00  Priority Order: I_‘I
Line Item Number: Combine: | () [l [lem Code
Local Agreement Nbr: o (O Propasal Mum
Fed/State Project Nbr: | ® None
State Accounting Code: ISTP-DD1 Related Item: I
State Funding Code: I Proposal Line Mbr: I
Original Cap Amt: I 0.00 Prev Estimates Amt Used: 0.00
Current Cap Amt: I 0.00 Current Estimate Amt Used: 0.00

Figure 5-18. The Contract Funding Window

Field Name Description
Funding Source Identifies a particular source of funding (e.g., federal grant,
Code federal fuel tax, state general fund). This is a required field.

After a record is saved, this field is protected. To change
the Funding Source Code, delete the record and add it again.

Project Number Agency-defined ID for the project. Lists projects within the
contract.

Fed/State Project | The federal or state project number for the project.
Nbr

Category Number | A grouping of items assigned during preconstruction. Items
can be grouped within categories for various reasons,
primarily for funding. Lists categories within the contract
and project.

Priority Order Indicates the order in which funds are appropriated to the
contract. The valid range is between 1 and 9.
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Field Name

Description

Line Item Number

The Contract Line Item Number that identifies each item as
it appears on the contract. All bid Line Item Numbers are
assigned by the preconstruction function. Line Item
Numbers added to the contract after construction begins are
assigned by the user.

Local Agreement
Nbr

Number used to identify an agreement between a local
authority and the agency. The agreement defines the
funding provided by the local authority with regard to a
particular job.

Source The percentage of the total amount in the project or

Participation category provided by the Funding Source. (For example,

Percent many federal aid funding sources provide 80 percent of the
funding for the project or category.). This is a required
field; a valid percentage is between 1 and 100.

Combine This field indicates whether items are combined by Related

Item Code or Proposal Line Number for funding purposes.
This is a required field. Select None to combine no items.
To combine items under the same funding source, the user
selects either Like Item Code or Proposal Number. When
Like Item Code is selected, an entry in the Related Item
field is required. When Proposal Number is selected, an
entry in the Proposal Line Nbr field is required.

Proposal Line Nbr

The line number that identifies the item as it appears on the
proposal. This is a required field when the user selects the
Proposal Number radio button.

Related Item

Related item codes allow grouping of items (e.g., all traffic
control items) for reporting and funding purposes. To group
items for funding by the same source and percentage, if the
items are not in the same category, the user creates a
Related Item code and selects items with this code in the
funding process. To report Items together, the user creates a
Related Item code, such as RPT1 = Report 1, and then
creates a report that selects and groups these items together.
This is a required field when the user selects the Like Item
Code radio button. The Related Item codes are defined in
the system code tables.

State Funding
Code

Agency-defined code needed by financial system.
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Field Name Description

State Accounting | Agency-defined code needed by financial system.
Code

Original Cap Amt | Original funding limit.

Current Cap Amt | Current funding limit.

Total Amt Used Amount used up to the last paid estimate.

Current Amt Used | Amount used in the current estimate.

Table 5-22. The Funding Source Window Fields Table

To add funding to a contract:

1.

10.
11.
12.
13.
14.
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On the Contract Records panel, double-click the Contract Funding icon. The Contract
Select List opens.

In the Contract ID list box, scroll to and click the contract.
Click OK. The Contract Funding window opens.
Click the New button.

To select a project number, click the expand arrow and click the project number in the
Project Number drop-down list.

To select a Category Number, in the Category Number drop-down list, click the expand
arrow and click the Category Number.

To select a Line Item Number, click the expand arrow and click the Line Item Number in the
Line Item Number drop-down list.

Press the Tab key.

In the Local Agreement Nbr field, type the number used to identify an agreement between a
local authority and the transportation agency.

Press the Tab key.

In the Fed/State Project Nbr field, type the federal or state project number.
Press the Tab key.

In the State Accounting Code field, type the state accounting code.

Press the Tab key.
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15. In the State Funding Code field, type the state funding code.

16. Press the Tab key.

17. In the Original Cap Amt field, type the original funding limit.

18. Press the Tab key.

19. In the Current Cap Amt field, type the current funding limit.

20. In the Funding Source Code drop-down list, click the expand arrow and click the source of
funding (e.g., Federal grant, Federal fuel tax, State general fund).

21. In the Source Participation Percent field, type the percentage of the selected project,
category, or line item provided by the source.

22. Press the Tab key.

23. In the Priority field, type a value between one and nine that indicates the order in which the
fund is appropriated to the contract.

24. To apply funding to combined Line items, click the Like Item Code or Proposal Number
radio button in the Combine field.

25. If Like Item Code is selected, tab to the Related Item field, click the expand arrow and click
the Related Item Code.
Or

26. If Proposal Number is selected, tab to the Proposal Line Nbr field, click the expand arrow
and click the Proposal Line Number.

27. Press the Tab key.

28. In the Total Amt Used field, type the amount of funding used, up to the last paid estimate.

29. Press the Tab key.

30. In the Current Amt Used field, type the amount of funding used in the current estimate.

31. Click the Save button.

Active contracts must be fully funded. The system prompts the user to fully fund the contract if any
part of the contract is not funded 100 percent.

To modify contract funding:

1.

On the Contract Records panel, double-click the Contract Funding icon. The Contract
Select List opens.
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2. Inthe Contract ID list box, scroll to and click the contract.

3. Click OK. The Contract Funding window opens.

4. In the Contract Funding list box, scroll to and click the funding record.
5. In the bottom datawindow, tab to the fields to be modified and enter data.

6. Click the Save button.

5.10 Contract Group Authority

Contract Group Authority works in conjunction with other security features to give users the
authority to access and modify contracts. The user’s ability to add, modify, or delete contract data
also depends on the user group window access rights, the office level assignment, and whether or not
the user is assigned to a group that has Office-wide contract Access. This section includes a brief
summary of Contract Authority and the following three security features:

= Window Access Rights
= Office-wide Contract Access

= Contract Authority (Contract-specific)

5.10.1 Window Access Rights

Window security is the highest security level in SiteManager. Window access rights determine the
user’s ability to view and modify SiteManager windows. To view or modify a specific type of
window, the user must belong to a user group that has been assigned inquiry or update access rights
for that window. Inquiry access rights let the user view the window. Update access rights let the
user add and delete data on a window. The states and provinces assign user groups and window
access rights to meet their specific needs. To be given Contract Authority, a user must first be
assigned to a user group with window access rights to the Contract windows.

5.10.2 Office-Wide Contract Access

Office-Wide Contract Access for a group gives a user the authority to view or modify any contract
delegated to the office to which the user is assigned when the user is logged on under that group.
Most states and provinces have three office levels. In SiteManager, the office labels are user-
defined. The Level 1 office is always the transportation agency headquarters.

= Level 1 Office (Central office or DOT)
= Level 2 Offices

= Level 3 Offices
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= Level 4 Offices
Each user is assigned to an office level.

For example, a user is assigned to the Level 1 office and the user has office-wide contract access for
the Project Manager group. When the user is logged on under the Project Manager group, the user
can view, add, modify, or delete any contract delegated to the user’s state or province.

A user who is assigned to the Level 2 office and who has been assigned to the office-wide contract
access Project Manager group can view, add, modify, or delete any contract within the user’s Level
2 office. A user must have at least Level 2 Office-Wide Contract Access to add or delete contracts,
milestones, projects, categories, and items.

5.10.3 Contract Authority Examples

Window security can give the user window access rights to contract panels. Contract Authority can
only give the user access to specific contracts. The assignment of Office-Wide Contract Access
groups to a user allows the user to access all the contracts administered by their respective office
when the user is logged on under those groups. All states and provinces require a Project Manager
and Project Engineer for all contracts. To give a user the authority to view, modify, or add and
delete contract data, the following assignments are required:

To view contract data, the user must

Belong to a user group with inquiry access rights to the contract panels, and have one of the
following:

= Contract Authority and group access assignment specific to the contract
OR
= Office-Wide Access with group assignment

To modify contract data, the user must

Belong to a user group with update access rights to the contract panels, and have one of the
following:

= Contract Authority and group access assignment specific to the contract
OR
= Office-Wide Access with group assignment
To add or delete a contract, the user must
= Belong to a user group with update access rights to the contract panels

= Have at least Level 2 Office-Wide Contract Access
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= Belong to the office that administers the contract

Contract Authority Example 1

The state or province needs personnel authorized to view and modify all state or province-wide
contracts, add new contracts online, and delete contracts that are incorrectly built.

1. Assign specific users to the Level 1 office.

2. Create a user group, e.g. Contract Administrators, with window update access to all contract
windows.

3. Assign Level 1 office users to the Contract Administrators user group with office-wide
contract access.

To implement Example 1, the Contract Administrators user group would be assigned update access
rights for all contract windows except Daily Work Reports, which would be inquiry access only.
Additionally, the user’s assigned office would be Level 1. The user would be assigned to the
Contract Administrator group and the office-wide check box would be selected ON. If a Contract
Administrator attempts to open a Contract window, the window will first look at the user’s window
access rights. Since the user has window access rights, the window will next look at the user’s
Contract Access, and permit or deny access accordingly. In the case of the Daily Work Report
window, the system would discover that the user has inquiry rights. The system would permit the
user to view the Daily Work Report window but not add, update, or delete a Daily Work Report.

Contract Authority Example 2

The state or province needs personnel authorized to view and modify all Level 2 office contracts.
These users would not be able to view or modify any contracts not assigned to their office.

1. Assign specific users to the Level 2 office.

2. Create a user group, e.g., District Project Engineers, with window update access to all
Contract windows except:

=  Windows relevant to an inspector’s Daily Work Reports (inquiry only)
= Daily Work Report approval window (inquiry only)

3. Assign Level 2 office users to the District Project Engineers user group with office-wide
contract access.

If a user in Example 2 needs to view or update a contract out of the office’s jurisdiction, the user will
need Contract Authority for that contract. Because the user group has window update access, the
user would be able to modify any contract he is assigned to through Contract Authority. The user
would not be limited to view-only access for this contract.
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Contract Authority Example 3

The state or province needs Level 3 office personnel assigned as Daily Work Report Inspectors who
can view and modify specific contracts only.

1. Assign users to the Level 3 office.
2. Create a user group, e.g., Project Inspectors, with the following window access rights:

= |nquiry access to specific Contract windows, such as those related to daily work items
and reporting.

= Update access to windows relevant to an inspector’s Daily Work Reports.
3. Assign the Level 3 office users to the Project Inspectors user group.

4. Assign Contract Authority for specific contracts to individual Project Inspector users.

5.10.4 Contract Authority

The Contract Authority window displays the users, office level assignments, and group assignments
for each individual user. When the Project Manager and Project Engineer are added to the contract,
the system automatically adds a row for each user’s group assignment to the Contract Authority
window. An authorized user can end Contract Authority for personnel no longer needed to work on
the contract.

¥ Contract Authority
User Identification

User ID User Hame Cen Reg FRes ~
ABBOTTR Rodney Abbott, Region 2 Project Engineer Mo 2 250
ABEYTAR Richard Abeyta, Parzons Brink erhoff Mo B 211
ADAMSOME Barbara Adamson, Fegion 3 Mo 3 410
AGUILARS John Aguilar, Region 2 Mo 2 220
ALDORFEB Bill Aldarfer. Region 4 Mo 4 240
ANDERSEE Bary Andersen, Region 3 Mo 3 130
ARCHULEE Edward Archuleta, Region 3 Mo 3 130
ARTZERD Darrel Artzer, Region 4 Mo 4 340
ASHOURYK. Kevin Ashoury, HE Resident Engineer Mo 1] 164
ATEINSR Ralph Atking, Region 2 Mo 2 220 “
Contract Authority Assignment

Group Description Office-wide  Contract Id Contract Description Authority Authority
Access Start Date End Dt

Administrative Assistant v
Cost Estimates v
Finale Engineer W
Inspector Standalone v
Field Inzpector/Tester [
Field Inspector/Tester - Standalone v
WManager - Inguiry Onhy v
Project M W

Figure 5-19. The Contract Authority Window

Field Name Description
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Field Name Description
User ID Agency-defined ID of the user.
User Name Name of the user with this ID.
Cen Central Office Assignment. Indicates whether the user is
assigned to the central office.
Reg Region. The user’s level 2 region assignment.
Res Residency. The user’s level 3 office assignment.

Group Description

Drop-down list containing all the current user’s active
group assignments. The administrator selects from
among these groups to assign the user office-wide or
specific contract authority. Upon selecting a new value,
the office-wide access and contract ID fields are cleared.
Required field.

Office-wide Access

This field indicates whether the user has been assigned
group access rights to all contracts within the user’s
assigned office. This field is protected if the user already
has current, non-end-dated, office-wide contract authority
for the specified group. Once this field is selected, the
contract field is cleared and protected.

Contract ID This field is required if Office-wide Access is not
selected. ldentifies the contract to which the user is
assigned group access rights. The search capability for
this field is limited to contracts on which the user is not
currently assigned authority.

Contract Protected field. Describes the contract to which the user

Description is assigned group access rights.

Authority Start The date Contract Authority begins for this user. The

Date value defaults to the current date when a save is

performed. This field is only populated for contract-
specific rows. It is not used for office-wide contract
authority.

5.10 Contract Group Authority
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Field Name Description

Authority End Date | The date Contract Authority ends for this user. Upon
choosing End Contract Authority from the window’s
Services menu, a popup window displays, allowing the
end user to enter the desired Contract Authority ending
date. This date can be the current or future date. The
current date is the default date. This field is only
populated for contract-specific rows. It is not used for
office-wide contract authority.

Table 5-23. The Contract Authority Window Fields Table

To grant a user Contract Authority:

1.

5.
6.

On the Contract Records panel, double-click the Contract Authority icon. The Contract
Authority window opens.

Select and click the desired user ID.
Click the New button. The New Contract Group Authority window opens.

In the Group Description field, click the down arrow to the right of the field, and select the
desired group.

If desired, use the Search function to select a specific contract.

Click the Save button.

To end a user’s Contract Authority:

1.

On the Contract Records panel, double-click the Contract Authority icon. The Contract
Authority window opens.

Select and click the desired user ID.
Select and click the desired group in the lower datawindow.

If the authority is specific to a contract, click the Services menu and select the End Contract
Authority choice. In the Contract Authority End Date popup window, enter a valid date and
click the OK button. Valid dates that can be entered in this field are the current date or a
date in the future.

If the authority is office-wide access, click the Delete button.

Click the Save button.
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5.11 Key Dates and Checklist Events

Key Dates and Checklist Events allow the user to establish, monitor, and maintain a series of key
dates and scheduled events specifically related to the administration of the contract. The messages
and discrepancy tracking associated with Key Dates and Checklist Events enhance the ability of the
user to administer the contract. For more information, refer to the Key Dates, Checklist Scheduled
Events, and Checklist Event Dates topics.

5.12 Progress Schedule

The Progress Schedule window lets the user add, modify, and view a contract’s Progress Schedule.
The user selects a schedule type, enters time periods, and enters the percentage of contract work to
be completed in each time period. The time periods are measured in either days or dates, depending
on the Time Charges Type of the contract. If the Critical Path Method schedule type is selected,
only the final day or date can be tracked. If a schedule type is not selected, SiteManager does not
track the contract’s progress.

A daily batch process calculates the actual percentages of the contract time and work completed in
each time period. If the work falls behind schedule by an amount that exceeds the Variance
Percentage, the batch process notifies contract personnel. The user can override the percentages
calculated by the batch process and enter new values. If the user changes the schedule type, any
time period with an actual percentage value is deleted and the user can enter new time periods.

The Progress Schedule window displays a column graph corresponding to the schedule data. The
graph displays the actual percentage completed (amount and time) versus the schedule. The user can
maximize the graph by clicking the maximize box and return it to original size by clicking the
original box.
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E Progress Schedule

Fed/State/Prov Prj Nbr: INH-495-5[DB1]
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Figure 5-20. The Progress Schedule Window

Field Name

Description

Nbr

Fed/State/Prov Prj

Federal, state, or province project number for the
contract, project, or category.

Current Days

The current number of days required to complete the
contract. This is the sum of the bid days and the total
adjustment days for the contract.

Description

Text description of the contract.

Location

Text describing the physical location of the contract
work site.

Prime Contractor

Short name for the Prime Contractor for the contract.

Time Charges Type

Indicates how time charges are assessed for the contract
(i.e., Available Work Days, Calendar Days, Fixed
Completion Date).

Type

Progress Schedule

Type of Progress Schedule used for the contract (i.e.,
Percent Complete for a Time Period, Percent of Critical
Items Complete for a Time Period, and Critical Path
Method). If the Progress Schedule type is changed, the
data is deleted and the user can enter a new Progress
Schedule. If the selected schedule type is Critical Path

Method, only the final day or date is tracked.
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Field Name Description
Sched Days/Date Number of days or date in which the work is expected to

be done. Either Schedule Days or Schedule Date is
displayed, depending on the time charges type of the
contract. If the time charges type is Available Work
Days or Calendar Days, only days are tracked. If the
time charges type is Fixed Completion Date, only dates
are tracked.

Anticp Pct Compl Anticipated Percentage Completion of the Contract’s
Amt scheduled dollar amount by the end of the scheduled
period. The sum of the percentages for all time periods
in the schedule must equal 100.

Actual Pct Compl Actual Percentage Completion of the Contract’s dollar
Amt amount by the end of the scheduled period. A daily
batch process calculates this value. The user can
override this value. Actual percentages cannot be
entered for future days. The formula for computation of
this field is as follows: Earnings to date / Contract
amount * 100

Actual Pct Compl Actual Percentage Completion of the contract’s

Time scheduled time by the end of the scheduled period. A
daily batch process calculates this value. The user can
override this value. Actual percentages cannot be
entered for future days.

Table 5-24. The Progress Schedule Window Fields Table

A daily batch process calculates the actual percentages of the contract time and work completed in
each time period.

To create a Progress Schedule:

1. On the Contractor Management panel, double-click the Progress Schedule icon. The
Contract Select list opens.

2. Inthe Contract ID list box, scroll to and click the contract.
3. Click OK. The top datawindow displays information about the selected contract.

4. Inthe Progress Schedule Type drop-down list, click the expand arrow and click the progress
schedule type. (If Critical Path Method is selected, the schedule can be saved at this point
because only the final day or date can be tracked.)
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5. Click the New button. An empty row is added to the schedule.

6. If the Time Charges Type is Fixed Completion Date, type the date on which the scheduled
work is expected to be complete in the Schedule Date field.

Or

7. If the Time Charges Type is Available Work Days or Calendar Days, type the number of
days in which the scheduled work is expected to be complete in the Schedule Days field.

8. Press the Tab key.

9. Inthe Anticp Pct Compl Amount field, type the percentage of the total contract expected to
be completed in this time period.

10. To add another time period, repeat Steps 5 through 9.

11. Click the Save button. The Progress Schedule graph is updated immediately.

5.13 Permits

The Permits window lets the user add, modify, and delete contract permit data. This is a record of
the permits obtained for the contract, including the permit type, the person who requested the permit,

and the date the request was submitted. The top datawindow lists the permits for the selected
contract. The data for the selected record is displayed in the bottom datawindow.

E Permits

Contract ID: ISITEMGH_SD

P[] S

Permit Type

Date Submitted

Date Obtained

Requester

EPA

00400400

00/00/00

-

-

00/00./00
0040000

Permit Type - |{: A—————————————| ~ |

Date Submitted :
Date Obtained :

Requester : |

Permit Number : |

Figure 5-21. The Permits Window
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Field Name Description
Permit Type Agency-defined value for the type of permit (e.g., EPA,

Water, Environmental, Hazardous Waste, and
Electrical). This is a required field.

Date Submitted The date the permit was requested. This is a required
field. When entered, the date should not be in the future.

Date Obtained The date the permit was received. When entered the
date should not be in the future.

Requester The person who requested the permit. This is a required
field.
Permit Number The number associated with the permit (if available).

Table 5-25. The Permits Window Fields Table
To add a Permit record to a contract:

1. On the Contract Records panel, double-click the Permits icon. The Contract Select List
opens.

2. Inthe Contract ID list box, scroll to and click the contract.

3. Click OK. The Permits window displays the permits for the selected contract. Data for the
selected permit is shown in the fields below the list.

4. Click the New button. An empty row is added to the Permit list.

5. In the Permit Type drop-down list, click the expand arrow and click the permit type.
6. Pressthe Tab key.

7. Inthe Date Submitted field, type the date the permit was requested.

8. Press the Tab key.

9. Inthe Date Obtained field, type the date the permit was obtained.

10. Press the Tab key.

11. In the Requester field, type the name of the person who requested the permit.

12. Press the Tab key.

13. In the Permit Number field, type the permit number.
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14. Click the Save button.

5.14 Stockpiled Materials

The Stockpiled Materials window allows the user to select materials to stockpile for the contract and
enter invoice data for the materials. The window also allows the user to replenish depleted material
stockpiles as needed. Contract line item data is displayed in the top datawindow and stockpiled
material data in the bottom datawindow. This data is used during estimate generation to determine
the amount to be paid for the items installed. When using Choose Keys in the Stockpiled Materials
window, only Active contract items appear in the Stockpiled Material Select list. The estimate
process enters the installed quantity and the amount paid to date on the Stockpiled Materials
window.

When the user closes out a stockpile, the estimate process also generates a line item adjustment that
retains any of the initial payment amount indicated on the stockpile that has not been recouped
during usage of the stockpile. The system automatically closes a stockpiled material record when
the remaining quantity reaches zero, or the user can manually close out the balance of a stockpiled
material and transfer it to another contract.

The stockpiled material data is downloaded with the Basic Contract Data for viewing by the
inspector while posting the Daily Work Reports. It can also be viewed in Contractor Payments.

The Stockpile Materials window allows updates of the conversion factor of active stockpiles
when the Allow Editable Active Stockpile Material conversion factor option on the System
Operational Parameters window is setto Y (Yes). The Stockpile Materials window allows a
zero conversion factor when the Allow Stockpile Material zero conversion factor on the
System Operational Parameter window is setto Y (Yes).

Changing the Conversion Factor gives the user the ability to change payment item
adjustments based on how stockpile materials are used during a given estimate period.
When the Conversion Factor is set to zero, line item adjustments are not calculated during
the estimate process.

Note: The Attachments functionality is available in the Stockpiled Materials window. [f
the Attachment icon appears with a paperclip, there is an attachment associated with the
record.
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Figure 5-22. The Stockpiled Materials Window
Field Name Description

Contract ID

Agency-defined ID for the contract.

Project Nbr

Agency-defined ID for the project.

Catg Nbr

Category number assigned to the line item.

Line Item Nbr

Contract line item number that identifies each item as it
appears on the contract.

Units

Description of the unit of measurement for the line item.

Unit Price

Unit price of the line item, as indicated on the proposal or
contract.

Bid Quantity

The quantity of the line item, as indicated on the proposal
or contract.

Item Description

Short text explanation of the item.

Material Code

Agency-defined ID for the material. The search lens
displays the materials for the selected contract line item. If
the user selects a material code using the search lens, the
stockpiled description is entered by the system. If the user
types a description, the Material Code field is protected.

Stockpiled
Description

Description of the material (or item) being stockpiled. If
the user selects a material code using the search lens, the
stockpiled description is entered by the system. If the user
types a description, the Material Code field is protected.
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Field Name Description
Status The status of a stockpiled material is either Open, Active,

or Closed. New materials are given an open status.
Materials included in an estimate are given an active status.
When a balance is closed out, the material is given closed
status. Open and active materials can be modified unless
an estimate is pending. Only open materials can be

deleted.
Invoice Date Date of the invoice.
Invoice Number Identifies the invoice with which the material was

received. This field is required.

Quantity Number of units received. This field is required. When
modified, this value cannot be less than Installed Qty To
Date.

Units Description of the unit of measure for the material.

Unit Price Unit price of the material; identified on the invoice. This

field is required.

Conv Factor The Conversion Factor is derived from the contract line
item information. It is the number of units of the material
used in one unit of the line item. The user can modify the
default value.

The Conversion Factor can be set to zero if the system
parameter Allow Stockpile Material zero conversion factor
issetto Y (Yes).

The Conversion Factor can be changed while the
stockpiled record is active if the system parameter All
Editable Stockpile Material conversion factor is setto Y
(Yes).

When the Conversion Factor is set to zero, line item
adjustments are not calculated during the estimate process.

Conv Unit Price Unit price of the material multiplied by the Conversion
Factor. This field is display only.

Invoice Amount System-calculated product of the material quantity and unit
price.
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Field Name

Description

Matl Sn

The stockpile material sequence number. A stockpiled
material record receives a Material Sequence number when
it is created. The first stockpile material record is assigned
the number 1 for the Material Sequence number and
subsequent Material Sequence numbers (for each newly
created stockpile record) increase by increments of 1.

Replenish Sn

The replenishment sequence number. Each time the user
replenishes a stockpile, SiteManager copies the existing
stockpile information to a new stockpile record which the
user can modify. When the new stockpile record is saved,
it is assigned the same Material Sequence Number as the
original stockpile. The first replenishment stockpile is
assigned the number O for the Replenish Sequence number
and subsequent Replenish Sequence numbers increase by
increments of 1.

Initial Invoice
Payment

The initial payment to be applied to the invoice upon
generation of the first estimate for the stockpiled material.
This value cannot be more than the Invoice Amount.

Remaining Qty

The quantity of the material that remains. Calculated as
the difference between Quantity and Installed Quantity To
Date. May be zero if the project is closed or the contract is
ended.

Installed Qty To
Date

The quantity of the material installed to date. This value is
calculated by the estimate generation process. This is a
protected field.

Paid To Date

The amount that has been paid for the stockpiled material
to date. This value is calculated by the estimate generation
process. This is a protected field.

Supp Description 1

This field contains a textual description that is
supplemental to the item's description and may be required
by the transportation agency.

Supp Description 2

This field contains a second textual description that is
supplemental to the item's description and may be required
by the transportation agency.

Table 5-26. The Stockpiled Materials Window Fields Table

5.14 Stockpiled Materials
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5.14.1 Before Adding Data

SiteManager calculates payments for stockpiled materials based on the quantity of material used per
contract item. SiteManager does not automatically apply portions of the invoiced material quantity
and payment amount to different contract items. This means the user must decide how to allocate
the invoiced amounts for a stockpiled material. Before adding invoice data to SiteManager, the user
must determine the following:

= Which items include the invoiced material

=  Which contracts include these items

= How much of the total invoiced material quantity to allocate to each item

= |f an initial payment amount is due, which contracts or contract items pay this amount

From these numbers, the user can calculate the values to enter in the Quantity field of the Stockpiled
Materials window

Example

The user receives an invoice for 100,000 bolts. The total amount due on the bolts is $8,000.00.
These bolts are stockpiled for use on retaining walls and bridges. Contracts A, B, and C are active
contracts that include either retaining walls or bridges or both as line items. The user splits the total
invoiced quantity as follows:

Contract A Contract B Contract C
ltem Retaining Wall Bridge | Retaining Wall | Retaining Wall | Bridge

Description
Stockpiled | gojt Bolt Bolt Bolt Bolt
Description

Quantity 5,000 1,000 29,000 15,000 50,000

Invoice $400.00 $80.00 | $2,320.00 $1,200.00 $4,000.00

Amount

To add the invoice data, the user must enter the quantity values per contract item. To do this, the
user enters new invoice data on the Stockpiled Materials window five times, selecting the stockpiled
material (i.e., Bolt) under a different contract item each time. The system calculates the Invoice
Amount by multiplying the quantity by the unit rice of the material.
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Conversion Factor

The conversion factor is derived from the contract information. It indicates how many units
of the stockpiled material are used in one unit of the contract line item. The conversion
factor defaults to 1.0. This value indicates that one unit of the material is used in each unit
of the item. The user should verify that the conversion factor is correct and, if not, enter the
correct value. For example, if each linear foot of retaining wall requires three bolts, the
user enters a conversion factor of three 3.0 for the bolts.

The payment conversion factor for a stockpiled material may be changed during the
stockpile lifecycle if the Allow Editable Active Stockpile Material conversion factor System
Operational Parameter is set to Yes. This means that while the stockpile is in active use
(i.e., payment of some form has been made for the stockpile by the estimate process),
instead of all fields on the stockpile being protected, the conversion factor remains editable.
If an agency does not want its users to have this capability, the parameter can be set to No.
Once the stockpile is closed, all fields are protected.

The conversion factor may be zero if the Allow Stockpile Material zero conversion factor
System Operational Parameter is set to Yes. When the conversion factor is set to zero,
line item adjustments are not calculated during the estimate process.

To view a stockpiled materials record:

1. On the Contract Records panel, double-click the Stockpiled Materials icon. The
Stockpiled Materials window opens.

2. Click the Open button. The Stockpiled Material Select window opens.

3. Inthe Contract ID list box, scroll to and double-click the contract.

4. In the Stockpiled Materials list box, scroll to and click the stockpiled material.

5. Click OK. The Stockpiled Materials window displays data for the selected material.
To add stockpiled materials to a contract:

1. Read and understand the Before Adding Data topic. Calculate the invoiced quantity to add
to each contract.

2. On the Contract Records panel, double-click the Stockpiled Materials icon. The
Stockpiled Materials window opens.

3. Click the Services menu and click the Choose Keys choice.
4. Inthe Contract ID list box, scroll to and double-click the contract.

5. Inthe Contract Project list box, scroll to and double-click the project.
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6.

10.
11.
12.
13.
14.

15.

16.

17.

18.

19.

20.

In the Contract Item list box, scroll to and click the Contract Line Item that uses the
material.

Click OK. The Stockpiled Materials window displays the Contract Line Item data.
In the Material Code field, perform a Search and select the material.

Or

In the Stockpiled Description field, type a description of the material.

In the Invoice Date field, type the date of the invoice.

Press the Tab key.

In the Invoice Number field, type the number of the invoice.

Press the Tab key.

In the Quantity field, type a previously determined quantity of the stockpiled material to be
applied to this item and this contract.

In the Units drop-down list, click the expand arrow and click the unit of measurement in
which the material is sold.

In the Unit Price field, type the price per unit from the invoice.
In the Conv Factor field, select the current value and type the conversion factor.

If the invoice requires only an initial payment, in the Initial Invoice Payment field, type the
previously determined dollar amount of the initial payment to be applied to this item and this
contract.

To add another stockpiled material to the selected Item, click the New button and repeat
Steps 8 through 18.

Click the Save button.

To replenish a stockpiled material:

1.

On the Contract Records panel, double-click the Stockpiled Materials icon. The
Stockpiled Materials window opens.

Click the Services menu and click the Choose Keys choice.
In the Contract ID list box, scroll to and double-click the contract.

In the Contract Project list box, scroll to and double-click the project.
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5.

10.
11.
12.
13.

14.

In the Contract Item list box, scroll to and click the Contract Line Item that uses the
material.

Click OK. The Stockpiled Materials window displays the contract line item data.

Click the Services menu and click the Replenish Material choice. SiteManager copies the
existing stockpile information to a new stockpile record and assigns a new Replenish
Sequence number.

In the Invoice Date field, type the date of the invoice.

Press the Tab key.

In the Invoice Number field, type the number of the invoice.

Press the Tab key.

In the Quantity field, type the replenishment quantity of the stockpiled material.

If the invoice requires an initial payment, in the Initial Invoice Payment field, type the
previously determined dollar amount of the initial payment to be applied to the current item
and contract.

Click the Save button.

To close out the balance of a stockpiled material:

1.
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On the Contract Records panel, double-click the Stockpiled Materials icon. The
Stockpiled Materials window opens.

Click the Open button. The Stockpiled Material Select window opens.

In the Contract ID list box, scroll to and double-click the contract.

In the Stockpiled Materials list box, scroll to and click the stockpiled material.
Click OK. The Stockpiled Materials window displays data for the selected material.

Click the File menu and click the Print choice to produce a copy of the data (or copy the
data by hand).

Click the Services menu and click the Close Out Balance choice. Zero is entered in the
Remaining Quantity field. The status changes to closed. All fields are protected.

Click the Save button.
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The user cannot delete a stockpiled material with active or closed status.
To delete a stockpiled material from a contract:

1. On the Contract Records panel, double-click the Stockpiled Materials icon. The
Stockpiled Materials window opens.

2. Click the Open button. The Stockpiled Material Select window opens.

3. Inthe Contract ID list box, scroll to and double-click the contract.
4. In the Stockpiled Materials list box, scroll to and click the stockpiled material.
5. Click OK. The Stockpiled Materials window displays data for the selected material.

6. Click the Delete button. The system asks the user to confirm the deletion.

7. Click OK.

5.15 Construction Conferences

The Construction Conference window lets the user view and add construction conference data. The
user typically adds conference data after the conference occurs. This window is used to record the
conference title, date, attendees, and notes on the directives, issues, and major topics discussed at the
conference. The system assigns a serial number to the conference record. If attendees are listed on
the window, the conference record cannot be deleted.

Note: The standard attachment functionality will be available on the Construction
Conference window. If the Attachment icon appears with a paperclip, there is an
attachment associated with the record.
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File Edit 3Services ‘window Help
BiE? DEesagdF

E Construction Conference Data

Contract: |030330 Conference 5_No: |2
Conference Date: |17/16/07 C Title: [First Meeting

Directives Mext meeting scheduled Feb. 14, 2008
Issues

Major Details

Attendee Names

Figure 5-23. The Construction Conference Window
File Edit Services ‘Window Help

= e e ' HF BEHRE g

ﬂ Construction Conference Data

Contract: 030330 Conference 5.No: |2
Conference Date: [11/16/07 Conference Title: [First Meeting

[Mewt meeting scheduled Feh 14 2003
Hame Type Descrption Autorun

lssues

Major Details

Figure 5-24. The Construction Conference - Attachments

Field Name Description
Contract Agency-defined ID of the selected contract.
Conference S No Conference Serial Number that the system assigns when
the user adds the conference.
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Field Name Description
Conference Date Date that the conference was held. For new conference

data, the value defaults to the system date. This date
cannot be in the future. The user cannot modify the date
after saving the conference data.

Conference Title The title of the conference.

Major Topics The topics of the conference. This is stored as a remark
on the window. If this field has a check mark next to it,
click the field once to see the remark in the box to the
right.

Directives The directives issued to the contractor. This is stored as
a remark on the window. If this field has a check mark
next to it, click the field once to see the remark in the
box to the right.

Issues The issues that were discussed in the conference. This is
stored as a remark on the window. If this field has a
check mark next to it, click the field once to see the
remark in the box to the right.

Attendee Names The names and affiliations of the attendees.

Table 5-27. The Construction Conference Window Fields Table

To view a Construction Conference record:

1.

On the Contractor Management panel, double-click the Construction Conference icon.
The Construction Conference window opens.

Click the Open button. The Select Construction Conference window opens.
In the Contract ID list box, scroll to and double-click the contract.

In the Construction Conference list box, scroll to and click the conference.
Click OK. The Construction Conference window displays data.

To view Major Topics, Directives, or Issues, click the field and read the notes in the box to
the right.

To add Construction Conference records:

1.

On the Contractor Management panel, double-click the Construction Conference icon.
The Construction Conference window opens.
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10.

11.
12.

13.
14.
15.

5.16

Click the Services menu and click the Choose Keys choice. The Contract Select window
opens.

In the Contract ID list box, scroll to and click the contract.

Click OK. The Construction Conference window displays the Contract ID.
In the Conference Date field, type the date the conference was held.

Press the Tab key.

In the Conference Title field, type the title of the conference.

Press the Tab key.

To add a remark, select either the Major Topics, Directives, or Issues check box (ON), and
type the remark.

To add an attachment, click on the Attachments icon and select either the Plug-in, URL or
Ole attachment type.

Click the Save button. The system enters the conference serial number.

To add an attendee, click the Attendee Names datawindow and click the New button. An
empty row is added to the datawindow.

In the Attendee Names field, type the attendee’s name.
Click the Save button.

To add another conference record for the same contract, click the New button and repeat
Steps 5 through 13.

Subcontracts

The Subcontract window lets the user add, modify, and delete subcontracts and subcontract data.
The window also displays calculated DBE commitment amounts. The user can define both parent
subcontracts and lower level subcontracts. The Subcontract window has two folder tabs:

Descriptions

Items

If the subcontractor is not a supplier or hauler, items must be added to the subcontract.
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5.16.1 Subcontract Descriptions

The user enters the subcontractor and DBE commitments on the Description folder tab. To be
selected as a subcontractor, a contractor must first be entered as a vendor in the Vendor reference
tables. When a new subcontract is saved, the system adds the subcontract amount to the total
amount of uncompleted work for the subcontractor. This value is displayed on the Vendors window
in Reference Tables (CA). The contract’s Prime Contractor cannot be selected as a subcontractor on
the contract.

The percentage of the subcontract that can be counted towards the contract’s DBE goal depends on
the subcontract’s level, the subcontractor’s DBE status, and whether the subcontract includes items.
A parent subcontract with a DBE subcontractor and items is always counted 100 percent towards the
contract’s DBE goal. If the subcontract has no items (i.e., the subcontractor is a supplier/hauler), the
user enters the percentage counted towards the DBE goal. For nested subcontracts, if a higher-level
DBE subcontract is counted 100 percent towards the DBE goal, the percentage of the nested
subcontract is always zero.

i
i Description Itemsz 1 Contract ID -

SubCont Nbi: | Parent Subcont Nbr: | Supp/Hauler Ind [
Subcontractor: | Contract DBE Goal Pct: IﬂD—
Effective Date: IW Expiration Date: lm Status: INACTIVE
SubCont Type: I— DBE Type: ISDaces— Verified Payment Amt

Wok Type: [ CetType:| ’VLast: |00 Total: [00
Approval Date: Im Pct Twids DBE Goal: |00 Fed Supp/Haul Fund Pet: IUU
Amounts  Pct of Total Sub’'d  Pct of Total Contract
This SubContract: | oo | 0 | 1]
Thiz Driginal Commitment : | .00 | 1] | an
This Current Commitment: | 0.0 | [1} | [il1)
" TotalOriginal Commitment: | 00 [ ®&
Total Current Commitment: l—UD I—UU
Total Allowable Max [non-spclty): l—UD I—UU
Total Towards Max [non-spcity]: I—UD I—UU
Total Spclty Subcontracted: I—UD Pct of Original Contract I—UU
Total Subcontracted: | 0o | 0 | ]
Subcontract History
Effective Date  Expiration Date Active Indicator Last Modified User ID  Last Modified Date

Figure 5-25. The Subcontract Description Folder Tab

Field Name Description
Contract ID The agency-defined ID for the contract.
Subcont Nbr User-entered number associated with each subcontract. After

saving, it cannot be modified. This field is required.
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Field Name Description
Parent Subcont Nbr Subcontract number for the parent subcontract. After saving, it

cannot be modified. The user can search this field.

Subcontractor Short name for the subcontractor. The user can search this
field. This field is required.

Effective Date Used in conjunction with the Approval Date:

Date that a subcontractor may begin working on the contract.
This date must be the same as or after the Approval Date.

If the Effective Date is not prior to or equal to the DWR Date,
SiteManager will not display the subcontractor name in the
Contractor drop down list on the Contractors tabs in the DWR
window.

Expiration Date Used in conjunction with the Approval and Effective Dates:

After this date a subcontractor can no longer work on the
contract; this date must be after the Effective Date.

If an Expiration Date is not entered, SiteManager will display the
subcontractor name in the Contractor drop down list on the

Contractors tabs in the DWR window (based on Effective Date).
Subcont Type Agency-defined subcontract type. This field is required.

Work Type Agency-defined code of work class. A warning is displayed if the
work class selected does not match one of the work classes
associated to the vendor. This field is required.

Approval Date The date the approval was given for this Subcontract. Must be
equal to or later than the contract award date. If the sum of the
subcontractor’s uncompleted work amount for all contracts
(including the total amount of the new subcontract) exceeds the
sum of the subcontractor’s work class qualification amounts, a
warning message displays.

If an Approval Date is not entered, SiteManager will not display
the subcontractor name in the Contractor drop down list on the
Contractors and Record Work Items tabs in DWR.

DBE Type Agency-defined code for the subcontractor’'s DBE type. Defaults
to the DBE type in the vendor reference table.

The DBE Type can be changed on the Subcontracts window. If

the selected DBE Type does not match the reference table data,
a message is displayed, but the change can be saved.

Cert Type System-defined code for whether the subcontractor is certified
as a DBE by the State or Federal government, or Both. This
value is from the DBE Cert Type on the Vendor reference table
and cannot be changed.

Supp/Hauler Ind Indicates that the subcontractor is a supplier or hauler only. If
so, the subcontract cannot have items. The user must enter the
Total Subcontract Amount manually. This field cannot be
modified when there are existing items on the subcontract.
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Field Name

Description

Contract DBE Goal Pct

DBE goal percent for the contract.

Pct Twrds DBE Goal

Percentage of the subcontract amount counted towards the DBE
commitment goal. For nested subcontracts, if any higher-level
DBE subcontract has counted the item towards the DBE goal,
then this field defaults to O percent and cannot be modified. For
non-nested DBE subcontracts with no line items (i.e., a supplier
or hauler), the field defaults to 100 percent and can be modified.
For other non-nested DBE subcontracts, the field defaults to 100
percent and cannot be modified.

Fed Supp/Haul Fund
Pct

Percentage of the subcontract DBE commitment goal that is
covered by federal funding for a DBE supplier or hauler.
Defaults to 100 when Contract Funding is Federal. Defaults to
zero when Contract Funding is State. Entered by the user when
Contract Funding is Both.

Last Verified Payment
Amt

Last verified amount that has been paid to the subcontractor.
Positive or negative values may be entered.

Total Verified Payment
Amt

Total verified amount that has been paid to the subcontractor.
Must be a positive number.

Amounts

This Subcontract

Quantity multiplied by subcontract line item unit price for all

Amount subcontract items. Must be entered manually if a subcontract
without any items is entered (i.e., a supplier or hauler).
This Original Original amount that the Prime Contractor committed to

Commitment Amount

subcontract to the DBE. Cannot be modified if this data is from
a preconstruction system or if the contract’s status is active.
Must be a positive number.

This Current
Commitment Amount

For subcontracts where DBE type is indicated. This is
calculated by multiplying the Subcontract Amount by the Pct
Towards DBE Goal.

Total Original
Commitment Amount

Sum of the original commitment amounts for all the DBE
subcontracts for a contract.

Total Current
commitment Amount

Sum of current commitment amounts for all the DBE
subcontracts for a contract.

Total Allowable Max
Amount

(non-spclty)

Maximum allowed amount (excluding specialty items) for all
subcontracts in a contract. This is the Max Allowed Subcontract
Percent in the System Operational Parameter table multiplied by
the difference of the total contract amount minus the specialty
items amount.

Total Towards Max
Amount

(non-spclty)

Current amount of all subcontracts that contribute towards the
Max Allowable Amount (non-spclty). This is the sum of all of the
non-line item subcontract amounts plus all of the non-specialty
subcontract line item amounts.

Total Spclty
Subcontracted Amount

Sum of all specialty item amounts for all first-tier subcontracts in
the contract.

Total Subcontracted
Amount

Sum of all parent subcontract amounts for the contract.
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Field Name Description

Pct of Total Subcontracted

Percentage of Total Percentage of the sum of the parent subcontract amounts
Subcontracted This covered by this subcontract.

Subcontract

Percentage of Total Percentage of the sum of the subcontract original commitment
Subcontracted This amounts covered by this subcontract.

Original Commitment

Percentage of Total Percentage of the sum of the subcontract current commitment
Subcontracted This amounts covered by this subcontract current commitment
Current Commitment amount.

Pct of Original Contract | Total amount subcontracted as a percentage.

Pct of Total Contract

Percentage of Total Percentage of the contract’s current amount covered by this
Contract This subcontractor’s total amount.

Subcontract

Percentage of Total Percentage of the contract’s current amount covered by this
Contract This Original subcontract’s original commitment amount.

Commitment

Percentage of Total Percentage of the contract’s current amount covered by this
Contract This Current subcontract’s current commitment amount.

Commitment

Percentage of Total Percentage of the contract’s current amount covered by the total
Contract Total Original | original commitment amount.
Commitment

Percentage of Total Percentage of the contract’s current amount covered by the total
Contract Total Current current commitment amount.
Commitment

Percentage of Total Percentage of the contract’s current amount covered by the total
Contract Total allowable max (non-spclty) amount.

Allowable Max (non-

spclty)

Percentage of Total Percentage of the contract’s current amount covered by the total

Contract Total Towards | towards max (non-spclty) amount.
Max (non-spclty)

Percentage of Total Percentage of the contract’s current amount covered by the total
Contract Total Spclty spclty subcontracted amount.

Subcontracted

Percentage of Total Percentage of the contract’s current amount covered by the sum
Contract Total of the entire parent subcontract amounts.

Subcontracted

Table 5-28. The Subcontract Description Folder Tab Fields Table

To add a subcontract with a non-DBE subcontractor:
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10.

11.

12.

On the Contractor Management panel, double-click the Subcontracts icon. The
Subcontracts window opens.

Click the Services menu and click the Choose Keys choice. The Select Contract window
opens.

In the Contract ID list box, scroll to and click the contract.

Click OK. The window displays the Contract ID.

In the Subcontract Nbr field, type the ID number of the new subcontract.
Press the Tab key.

If this subcontract is not a parent subcontract, type the ID number of the parent subcontract in
the Parent Subcontract Nbr field or perform a Search.

In the Subcontractor field, type the short name of the subcontractor or perform a Search.
In the Subcont Type drop-down list, click the expand arrow and click the subcontract type.

In the Work Type drop-down list, click the expand arrow to the right of the current selection
and click the Work Class type. (If the selected Work Type does not match the reference table
data, a message is displayed. To acknowledge the message, click OK.)

In the Last Verified Payment Amt field, type the last verified amount that was paid to the
subcontractor.

Click the Save button.

To add a subcontract with a DBE subcontractor (non-hauler/supplier):

1.

o >~ w

On the Contractor Management panel, double-click the Subcontracts icon. The
Subcontracts window opens.

Click the Services menu and click the Choose Keys choice. The Select Contract window
opens.

In the Contract ID list box, scroll to and click the contract.

Click OK. The window displays the Contract ID.

In the Subcontract Nbr field, type the ID number of the new subcontract.
Press the Tab key.

If this subcontract is not a parent subcontract, type the ID number of the parent subcontract in
the Parent Subcontract Nbr field or perform a Search.
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10.

11.

12.

In the Subcontractor field, type the short name of the subcontractor or perform a Search.
The DBE Type is entered on the Subcontracts window.

In the Subcont Type drop-down list, click the expand arrow and click the subcontract type.

In the Work Type drop-down list, click the expand arrow to the right of the current selection
and click the Work Class type. (If the selected Work Type does not match the reference table
data, a message is displayed. To acknowledge the message, click OK.)

In the Last Verified Payment Amt field, type the last verified amount that was paid to the
subcontractor.

Click the Save button.

A message is displayed if the subcontractor’s work class qualification amount has been exceeded.

To add a subcontract with a supplier or hauler as subcontractor:

1.

10.
11.

12.
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On the Contractor Management panel, double-click the Subcontracts icon. The
Subcontracts window opens.

Click the Services menu and click the Choose Keys choice. The Select Contract window
opens.

In the Contract ID list box, scroll to and click the contract.

Click OK. The window displays the Contract ID.

In the Subcontract Nbr field, type the ID number of the new subcontract.
Press the Tab key.

If this subcontract is not a parent subcontract, type the ID number of the parent subcontract in
the Parent Subcontract Nbr field or perform a Search.

Select the Supp/Hauler Ind check box (ON).

In the Subcontractor field, type the short name of the subcontractor or perform a Search. If
the subcontractor is a DBE, the DBE Type is entered on the Subcontracts window.

In the Subcont Type drop-down list, click the expand arrow and click the subcontract type.

In the Work Type drop-down list, click the expand arrow to the right of the current selection
and click the Work Class type. (If the selected Work Type does not match the reference table
data, a message is displayed. To acknowledge the message, click OK.)

In the Last Verified Payment Amt field, type the last verified amount that was paid to the
subcontractor.
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13. In the Pct Towards DBE Goal field, type the percentage of the subcontract amount that

counts towards DBE goals.

14. If the contract has both Federal and State funding, in the Fed Supp/Haul Fund Pct field,

type the percentage of the subcontract amount that is paid by Federal funds.

15. In the This Subcontract Amount field, type the dollar amount of the subcontract.

16. Click the Save button.

Items cannot be entered on a subcontract with a supplier or hauler. Enter the subcontract items (or
Subcontract Amount for a supplier/hauler) before approving the subcontract. Then the amount of
the new subcontract is included in the subcontractor’s Uncompleted Work Amount when the
approval is saved.

To approve a subcontract:

1.

W

8.

On the Contractor Management panel, double-click the Subcontracts icon. The
Subcontracts window opens.

Click the Open button. The Select Contract window opens.

In the Contract ID list box, scroll to and click the contract.

Click OK. The window displays a list of subcontracts for the selected contract.
In the Subcontract list box, scroll to and click the subcontract.

Click OK. The window displays data for the selected subcontract.

In the Approval Date field, type the date approval was given for this subcontract. (If the
subcontractor’s total uncompleted work amount exceeds the subcontractor’s work class
qualification amount, a message is displayed. To acknowledge the message, click OK.)

Click the Save button.

A subcontract cannot be deleted if there is work recorded against it, or if the subcontract was part of
the contract award.

To delete a subcontract:

1.

On the Contractor Management panel, double-click the Subcontracts icon. The
Subcontracts window opens.

Click the Open button. The Select Contract window opens.
In the Contract ID list box, scroll to and click the contract.

Click OK. The window displays a list of subcontracts for the selected contract.
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5.
6.

5.16.2 Subcontract Items

In the Subcontract list box, scroll to and click the subcontract.

Click OK. The window displays data for the selected subcontract.

Click the Delete button. The system asks the user to confirm the deletion.

Click Yes. When the subcontract is deleted, the corresponding items are also deleted.

Click the Save button.

The Subcontract Items folder tab lets the user add, modify, and delete subcontract items. Items that
appear on an authorized DWR cannot be deleted. If the subcontractor is a hauler or supplier only,
the subcontract will not have items. If the subcontract has no items, the user must enter the
subcontract amount manually. If the subcontract has items, the subcontract amount is the sum of all
of the item amounts and the user cannot modify it.

Msubcontracts

Figure 5-26. The Subcontract Items Window

Field Name

Description

Contract ID

Agency-defined ID for the contract

Subcontract Nbr

User-entered number associated with each subcontract.

Project Number

Agency -defined ID for the project.
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Field Name Description
Line Item Contract line item to be worked on by the subcontractor.
The user can search this field.
Item Code Agency -defined code that identifies a particular item.
Unit Type Unit of measure for the subcontract line item.
Specialty Indicates if the line item is a specialty item. Specialty items

are excluded from the calculation to determine the
maximum amount of the contract that can be subcontracted.

Short Description

Text description of the line item.

Line Item Nbr

The user can search this field. For a parent subcontract, the
line item is selected from the Contract Item list. For lower

level subcontracts, the line item is selected from the parent

subcontract line item drop-down list.

Supp Description 1

This field contains a textual description that is supplemental
to the item’s description and may be required by the agency.

Supp Description 2

This field contains a secondary textual description that is
supplemental to the item’s description and may be required

by the agency.

Quantity

Contract Bid
Quantity

Contract bid quantity of the contract line item.

Current Contract
Quantity

Current quantity of the contract line item including any
change orders. Current quantity is calculated by the sum of
bid guantity and the net change order quantity

Parent Subcontract
Quantity

The quantity of the line item that is subcontracted to the
parent subcontract. If this is a parent subcontract, this field
is empty.
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Field Name

Description

This Subcontract
Quantity

The quantity of the line item subcontracted to this
subcontract. The Subcontract Quantity must be a positive
value. It must be less than or equal to the parent
Subcontract Quantity for a lower level subcontract. For a
parent subcontract, it must be less than or equal to the
current quantity minus all other parent subcontract
quantities for this item. The quantity edit will not be
performed if the unit on this subcontract or the parent
subcontract is changed.

Unit

Contract Bid Unit

Unit of the item identified on the invoice.

Current Contract
Unit

Unit of the item identified on the invoice.

Parent Subcontract
Unit

Unit of the parent subcontract line item.

This Subcontract
Unit

Unit of this subcontract line item. Defaults to the unit on
the contract bid item.

Price

Contract Bid Price

Unit price of the item identified on the invoice.

Current Contract
Price

Unit price of the item identified on the invoice

Parent Subcontract
Price

Unit price of the item for parent subcontract. If thisis a
parent subcontract, it will be blank.

This Subcontract
Price

Unit price of the item for this subcontract.

Amount

Contract Bid
Amount

Total amount of the bid item available for subcontract.
Contract Bid Amount item amount is calculated by the
contract bid unit price of the item multiplied by the contract
bid quantity.
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Field Name Description

Current Contract | Total amount of the current item available for subcontract.
Amount Current contract amount is calculated by the contract bid
unit price of the item multiplied by the current contract
quantity.

Parent Subcontract | Total amount of the item available for lower level
Amount subcontract. Parent subcontract item amount is calculated
by multiplying the parent subcontract unit price of the item
times the parent subcontract quantity.

This Subcontract Total amount of the subcontract item. Sub item amount is
Amount calculated by multiplying the subcontract unit price of this
subcontract item times the subcontract quantity. If this
amount exceeds the current contract amount (for level one
subcontract), or the parent subcontract amount (for lower
level subcontract), a warning will be displayed.

Subcontract The sum of quantity times the unit price for all subcontract
Amount items, or the value entered directly if the subcontract has no
line items (i.e., a supplier or hauler).

Shared Level 1 Indicates whether this item is included on any other Level 1

Item Ind subcontract for this contract.

Table 5-29. The Subcontract Item Folder Tab Fields Table
To add an item to a Subcontract:

1. On the Contractor Management panel, double-click the Subcontracts icon. The
Subcontracts window opens.

2. Click the Open button. The Select Contract window opens.

3. Inthe Contract ID list box, scroll to and click the contract.

4. Click OK. The window displays a list of subcontracts.

5. In the Subcontract list box, scroll to and click the subcontract.

6. Click OK. The window displays data for the selected subcontract.
7. Click the Items folder tab.

8. Click the New button.

9. Inthe Line Item Nbr field, perform a Search.
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10. Press the Tab key.

11. In the This Subcontract Quantity field, type the quantity of the line item subcontracted to
this subcontract.

12. To change the unit type for the item, click the expand arrow to the right of the current
selection in the This Subcontract Unit drop-down list and click the unit type.

13. In the This Subcontract Price field, type the unit price of the line item.
14. Click the Save button.

To delete an item from a Subcontract:

Note: You cannot delete items that that exist on an authorized DWR.

1. On the Contractor Management panel, double-click the Subcontracts icon. The
Subcontracts window opens.

2. Click the Open button. The Select Contract window opens.

w

In the Contract ID list box, scroll to and click the contract.

&

Click OK. The window displays a list of subcontracts.

In the Subcontract list box, scroll to and click the subcontract.

6. Click OK. The window displays data for the selected subcontract.

7. Click the Items folder tab.

8. Inthe Items list box, scroll to and click the item.

9. Click the Delete button. The system asks the user to confirm the deletion.
10. Click Yes.

11. Click the Save button.
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6.1 Correspondence Log

The Correspondence Log window lets the user add and modify records of correspondence related to
a specific contract. A correspondence record describes a document that has been either sent or
received by a user. The user can describe the document, identify related records and disputes, attach

and view URLSs, plug-ins and OLE documents, and forward the correspondence record to other
users.

Note: The Attachment icon appears with a paperclip if attachments are associated with
the record in the currently opened window.

=3 Correspondence Log

Contract 1D: I Contract Commrespondence Senal HNumber: I
Comrespondence Type: [SNGIRG_G_—__—— _~ |

| On: |00/00/00 Comrespondence 1D: |

Sent From: |

Sent To: |

Document Category: | |

Document Location: I

Major Topics:

Helated Comespondence: |EI |

Required Response Text: |

Dispute: IEI
Figure 6-1. The Correspondence Log Window
Field Name Description

Contract ID Transportation agency-defined ID of the contract
associated with the correspondence.

Contract System-generated serial number for the correspondence

Correspondence record.

Serial Number

Received/Sent Field in which the user can select Received or Sent from a
drop-down list to identify the correspondence as received
or sent.
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Field Name Description
On Date on which the correspondence was received or sent.
This date cannot be in the future. Defaults to the system
date.
Correspondence Transportation agency-defined type of correspondence.
Type

Correspondence ID | User-defined alphanumeric field to identify the
correspondence (e.g., USRTE-47-8).

Sent From Name of the person or agency sending the document.

Sent To Name of the person or agency receiving the document.

Document Category | Transportation agency-defined category of
correspondence used for retrieval and analysis.

Document Location | Physical location of the correspondence.

Major Topics Major topics associated with the correspondence.
Related Serial number and type of a related correspondence
Correspondence record. The user can search this field.

Required Response | Description of the response to the correspondence that is
Text required.

Dispute ID of a dispute associated with this correspondence. This
field can be searched.

Table 6-1. The Correspondence Log Window Fields Table

To add a correspondence record:

1.

> w

On the Contract Records panel, double-click the Correspondence Log icon.

Click the Services menu and click the Choose Keys choice. The Select Contract list opens.
In the Select Contract list box, scroll to and double-click the contract.

In the Document Type drop-down list, click the expand arrow and click the document type.

In the Received/Sent drop-down list, click the expand arrow and click either Received or
Sent to indicate the direction of the correspondence.

In the Date field, type the date the correspondence was received or sent.
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7. Inthe Correspondence ID field, type the ID of the document.
8. Inthe Sent From field, type the name of the person or agency that sent the correspondence.

9. Inthe Sent To field, type the name of the person or agency to whom the correspondence was
sent.

10. In the Document Category drop-down list, click the expand arrow and click the document
category.

11. In the Major Topics field, type the major topics associated with the correspondence.

12. To assign related correspondence, in the Related Correspondence field, type the document
serial number or perform a Search.

13. In the Required Response Text field, type the response required to the correspondence.
To assign a related dispute:

1. Inthe Dispute field, type the Dispute ID, or perform a Search.

2. Click the Save button.
To forward a correspondence record:

1. On the Contract Records panel, double-click the Correspondence Log icon.

2. Click the Open button.

In the Select Contract list box, scroll to and double-click the contract.

> w

In the Select Correspondence list box, scroll to and double-click the document.

5. Click the Services menu and click the Forward to choice. The Forward to Selected User
window opens.

6. Inthe Forward to Selected User list box, scroll to and click or shift-click the user(s).

7. Click OK. SiteManager sends In-Box messages to the selected users and the window
displays a Mail sent message.

8. Click OK.

9. Click the Save button.
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6.2 Force Accounts

The purpose of a force account is to record unexpected and unplanned expenses. A new force
account describes the work to be done and lists the equipment, labor, and materials to be used,
including rates per hour and costs per unit. To expedite the work, the equipment, labor, and
materials can be listed generically (e.g., Equipment 1 and Equipment 2) when the account is created.
Force accounts are created on the Force Accounts window, which has the following folder tabs:

= Equipment
= Labor

= Materials

= Summary

After the office creates the account, the inspector can download the force account data and begin
recording the actual usage values (hours and quantities) in Daily Work Reports. The Force Account
Summary folder tab calculates and displays the total actual force account costs. The user can adjust
the actual costs by entering a lump sum adjustment to the whole account, and by entering adjustment
percentages to the labor, equipment, and materials costs. To determine adjustment amounts, the user
can create or view OLE, URL or plug-in attachments.

The system does not automatically include force account data in estimates. To pay for force account
work, the user creates a force account change order for each item (equipment, labor, and materials)
used on the force account. After approval of the change order(s), the inspector reports the item(s) as
installed in Daily Work Reports. The installed items are then included in estimates and paid for
along with other contract items.

A=k
( Equipment Labor © Material  © Summary
Contract ID: JAnand Force Account ID: |1
Description: Equipment: [$.00 Adj: .00 4
Purpose: Labor: [$.00 Adj: |00 4
Materials: [$.00 Adj: .00 4
Subtotal: [$.00
Other Adjustment: [$.00
Total: I$,UU
Force Account Equipment Description Uszed Rate | Idle Rate | Dwned or Rented Type

Figure 6-2. The Force Account Window
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Field Name Description

Contract ID Transportation agency-defined ID for the contract that
includes the force account.

Force Acct System-generated ID for the force account.

Description Work the force account is intended to cover. This field is
required.

Purpose Reason for the force account. This field is required.

Equipment Total amount of force account equipment costs derived

from the usage reported by daily inspectors and the
adjustment percentage. This field is display only.

Equipment Adj %

Percentage of the equipment cost added as an adjustment
to the equipment cost. This is an optional field.

Labor

Total amount of force account labor costs derived from
the usage reported by daily inspectors and the adjustment
percentage. This field is display only.

Labor Adj %

Percentage of the labor cost added as an adjustment to the
labor cost. This is an optional field.

Materials

Total amount for force account material costs derived
from the daily usage reported by inspectors and the
adjustment percentage. This field is display only.

Materials Adj %

Percentage of the material cost added as an adjustment to
the material cost. This is an optional field.

Subtotal Sum of the equipment, labor, and material costs after
adjustment. This field is display only.

Other Adjustment | Additional lump sum cost incurred by the force account.
This is an optional field.

Total Sum of the Subtotal and Other Adjustment amounts.

This field is display only.

Table 6-2. The Force Account Window Header Fields Table

To add a force account to a contract:
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1. On the Contract Records panel, double-click the Force Account icon.

2. Click the Services menu and click the Choose Keys choice. The Select Contract list opens.

6.2 Force Accounts
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3. Inthe Select Contract list box, scroll to and click the contract.

4. Click OK.
In the Description field, type a description of the work covered by the force account.

6. Pressthe Tab key.

7. Inthe Purpose field, type the reason for the force account.

8. Click the Save button.

9. Click the bottom datawindow and click the New button.

10.In tr_]e Force Account Equipment Description field, type a description of the piece of
equipment.

11. Press the Tab key.

12. In the Used Rate field, type the used rate for the equipment.

13. Press the Tab key.

14. In the Idle Rate field, type the idle rate for the equipment.

15. In the Owned or Rented Type drop-down list, click the expand arrow and click the
ownership type.

16. Click the Save button.

17. Click the Labor folder tab.

18. Click the New button.

19. In the Worker Name field, type the worker’s name.

20. In the Class drop-down list, click the expand arrow and click the job classification of the
worker.

21. Press the Tab key.

22. In the Regular Rate field, type the regular hourly rate for the worker.

23. Press the Tab key.

24. In the Fringe Rate field, type the fringe hourly rate for the worker.

25. Press the Tab key.

26. In the Overtime Rate field, type the overtime hourly rate for the worker.
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27,
28.
29.
30.
31.
32.
33.
34.
35.

36.
37.
38.

Click the Save button.

Click the Material folder tab.

Click the New button.

In the Invoice ID field, type the invoice for the material.

In the Invoice Date field, type the date of the invoice.

In the Contract FA Material Description field, type a description of the material.
Press the Tab key.

In the Delivered Qty field, type the invoice quantity of the delivered material.

In the Units Type drop-down list, click the expand arrow and click the unit of measure to be
used in installing the material.

Press the Tab key.
In the Unit Price field, type the unit price of the material.

Click the Save button.

When a new force account is created, the equipment, labor, and materials can be listed generically so
that the inspector can begin recording usage data in Daily Work Reports.

To adjust force account actual costs:

6-8

1.
2.

On the Contract Records panel, double-click the Force Account icon.

Click the Open button. The Force Account Select window opens. The Select Contract list is
displayed.

In the Select Contract list box, scroll to and double-click the contract. The window displays
a list of force accounts.

In the Force Account list box, scroll to and click the force account.
Click OK.

In the Equipment Adj%o field, type the percentage of the equipment cost added as an
adjustment to the equipment cost.

Press the Tab key.

In the Labor Adj% field, type the percentage of the labor cost added as an adjustment to the
labor cost.
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9.

10.

11.
12.

13.
14.
15.
16.

17.

18.
19.
20.
21.
22.

Press the Tab key.

In the Materials Adj% field, type the percentage of the materials cost added as an
adjustment to the materials cost.

Press the Tab key.

In the Other Adjustment field, type the lump sum amount of other costs to be added to this
force account.

Click the Save button.
To delete a force account:
On the Contract Records panel, double-click the Force Account icon.

Click the Open button. The Force Account Select window opens. The Select Contract list is
displayed.

In the Select Contract list box, scroll to and double-click the contract. The window displays
a list of force accounts.

In the Force Account list box, scroll to and click the force account.

Click OK.

Click the Delete button. The system asks the user to confirm the deletion.
Click Yes.

Click the Save button.

If any Items are paid for, the force account cannot be deleted.

6.2.1

Force Account Equipment

The Force Account Equipment folder tab lets the user create and maintain a list of equipment and
usage rates for the selected force account.
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Rk
( Equipment Labor "~ Material * Summary
Contract ID: |Anand Force Account ID: |1
Descrption: Equipment: [$.00 Adj: .00 %
Purpose: Labor: [$.00 Adj: .00 %
Materials: [$.00 Adj: .00 %

Subtotal: [$.00
Other Adjustment: |[$.00
Total: $.00

Force Account Equipment Description Used Rate | Idle Hate | Dwned or Hented Type

Figure 6-3. The Force Account Equipment Folder Tab

Field Name Description

Force Account Text description of the piece of equipment or a type of

Equipment equipment. This is a required field. This field scrolls

Description horizontally.

Used Rate Used rate for the equipment. This is a required field.

Idle Rate Idle rate for the equipment. This is a required field.

Owned or Rented Indicates if the equipment is owned by the contractor

Type and kept on the site, owned by the contractor and
brought to the site, or rented. This is a required field.

Table 6-3. The Force Equipment Fields Table
To add equipment to a force account:
1. On the Contract Records panel, double-click the Force Account icon.

2. Click the Open button. The Force Account Select window opens. The Select Contract list is
displayed.

3. Inthe Select Contract list box, scroll to and double-click the contract. The window displays
a list of force accounts.

4. In the Force Account list box, scroll to and click the force account. The Force Account
window opens with the Equipment folder tab displayed.
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5. Click the New button.

6. Inthe Force Account Equipment Description field, type a description of the piece of
equipment.

7. Press the Tab key.

8. Inthe Used Rate field, type the used rate for the equipment.
9. Press the Tab key.

10. In the Idle Rate field, type the idle rate for the equipment.

11. In the Owned or Rented Type drop-down list, click the expand arrow and click the
ownership type.

12. Click the Save button.

6.2.2 Force Account Labor

The Force Account Labor folder tab lets the user create and maintain a list of force account workers
and their wage rates.

i3
" Eguipment Labor T Material * Summary
Contract ID: |C10785 Force Account ID: |1
Description: [F4 65726 Equipment: [$.00 Ady: |00 %
Purpose: | Labor: [$.00 Ady: |00 %
Materials: [$.00 Adj: |00 b 4

Subtotal: [$.00
Other Adjustment: |$.00

Total: [$.00
Worker Class Regular Fringe Overtime
Name Hate Hate Hate
JB3$.00 $.00 $.00

Figure 6-4. The Force Account Labor Folder Tab
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Field Name Description
Worker Name Name of the worker for the force account work. This is

a required field.

Class Job classification of the worker for the force account
work. The user can search this field. This is a required
field.

Regular Rate Regular hourly rate of the worker for the force account

work. This is a required field.

Fringe Rate Fringe hourly rate of the worker for the force account
work. This is an optional field.

Overtime Rate Overtime hourly rate of the worker for the force account
work. This is a required field.

Table 6-4. The Force Account Labor Fields Table

To add a force account labor record:

9.

On the Contract Records panel, double-click the Force Account icon.

Click the Open button. The Force Account Select window opens. The Select Contract list is
displayed.

In the Select Contract list box, scroll to and double-click the contract. The window displays
a list of force accounts.

In the Force Account list box, scroll to and click the force account. The Force Account
window opens with the Equipment folder tab displayed.

Click the Labor folder tab.
Click the New button.
In the Worker Name field, type the worker’s name.

In the Class drop-down list, click the expand arrow and click the job classification of the
worker.

Press the Tab key.

10. In the Regular Rate field, type the regular hourly rate for the worker.

11. Press the Tab key.

12. In the Fringe Rate field, type the fringe hourly rate for the worker.
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13. Press the Tab key.
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14. In the Overtime Rate field, type the overtime hourly rate for the worker.

15. Click the Save button.

6.2.3 Force Account Materials

The Force Account Material folder tab lets the user create and maintain a list of force account

materials and related invoice quantities and costs.

Bl
" Equipment Labor " Material Summary

Contract ID: |C10785

Force Account ID: |1

Description: |FA 65726

Purpose: |

Equipment: [$.00 Adj: |00 z
Labor: [$.00 Adj: |00 4
Matenals: [$.00 Adj: |00 k4

Subtotal: [$.00
Other Adjustment: |$.00
Total: [$.00

Invoice ID|Invoice Dt

I 17/00/00

Contract FA Material D iption Deli d Oty Units Type | Unit Price
0.000 B3| +.00000

Figure 6-5. The Force Account Materials Folder Tab

Field Name Description
Invoice ID Invoice received with the material used for the force
account. This is an optional field.
Invoice Dt Date of the invoice received with the material used for

the force account. This is an optional field.

Contract FA
Material Description

Description of the material used for the force account.
This is a required field.

Delivered Qty

Invoiced quantity of the delivered material used for the
force account. This is a required field.

Units Type

Unit of measurement of the material used for the force
account. This is a required field.
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Field Name Description
Unit Price Unit price of the material used for the force account.
This is a required field.

Table 6-5. The Force Account Materials Fields Table

To add force account materials:

10.
11.
12.

13.
14.
15.

On the Contract Records panel, double-click the Force Account icon.

Click the Open button. The Force Account Select window opens. The Select Contract list is
displayed.

In the Select Contract list box, scroll to and double-click the contract. The window displays
a list of force accounts.

In the Force Account list box, scroll to and click the force account. The Force Account
window opens with the Equipment folder tab displayed.

Click the Material folder tab.

Click the New button.

In the Invoice ID field, type the invoice for the material.

In the Invoice Date field, type the date of the invoice.

In the Contract FA Material Description field, type a description of the material.
Press the Tab key.

In the Delivered Qty field, type the invoice quantity of the delivered material.

In the Units Type drop-down list, click the expand arrow and click the unit of measure to be
used in installing the material.

Press the Tab key.
In the Unit Price field, type the unit price of the material.

Click the Save button.

6.2.4 Force Account Summary

The Force Account Summary folder tab calculates and displays the total actual cost of the force
account and the actual costs per type and per day. This is a view-only window. The total actual
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costs are derived from the hours and quantities reported on Daily Work Reports. The user can

AASHTOWare Project SiteManager
6. Contract Administration - Maintenance

access the Daily Work Reports from this window.

(=1
" Equipment Labor © Material [ Summary
Contract ID: [C10785 Force Account ID: |1
Description: |FA B5726 Equipment: [$.00 Adj: .00 %
Purpose: | Labor: |$.00 Adj: .00 4
Materials: [$.00 Adj: .00 4

Subtotal: [$.00
Other Adjustment: [$.00

Total: |$_UD

Daily 1D

A0000 | $. IZIIZ 3. I]IZ 3. IIIIZ 3. I]II $0. IZIII

Daily ID Totals: | $0.00 I $0.00 I $0.00 I $0.00 | $0.00

Daily ID Adjustments: | $0.00 | $0.00 | $0.00 | $0.00

|»

Costs

Labor Fringe Equipment Material Total

Force Account Adjustment: | $0.00 |

Total Cost: $0.00 j

Figure 6-6. The Force Account Summary Folder Tab

Field Name Description
Daily ID Date and user ID of the Daily Work Report that includes
the force account information.
Labor Costs Accumulated amount of regular and overtime labor costs

for the force account.

Fringe Costs

Accumulated amount of regular and overtime fringe
labor costs for the force account.

Equipment Costs

Accumulated amount of used and idle equipment costs
for the force account.

Material Costs

Accumulated amount of material costs for the force

account.

Total Costs Total labor, fringe, equipment, and material costs on one
Daily ID for the force account.

Daily ID Totals Total labor, fringe, equipment, and material costs on all

Daily IDs for the force account.
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Field Name Description
Daily ID Adjusted labor, equipment, and material costs computed
Adjustments with the adjustment percentage entered for each. The

Total Daily ID Adjustment is the total of the adjusted
labor, equipment, and material costs for the force

account.

Force Account Additional lump sum cost adjustment to the force

Adjustment account.

Total Cost Sum of the Daily ID Totals, Total Daily ID
Adjustments, and force account adjustment for the force
account.

Table 6-6. The Force Account Summary Fields Table

To view a Daily Work Report related to a force account:

1.
2.

6-16

On the Contract Records panel, double-click the Force Account icon.

Click the Open button. The Force Account Select window opens. The Select Contract list is
displayed.

In the Select Contract list box, scroll to and double-click the contract. The window displays
a list of force accounts.

In the Force Account list box, scroll to and click the force account.

Click OK.

Click the Summary folder tab.

In the Daily Work Report list box, scroll to and click the Daily Work Report.
Click the Services menu and click the Daily Work Report choice.

Click the Close button to return to the Force Accounts window.
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6.3 Design Evaluation

The Design Evaluation window lets the user rate contract designs by design category. The user can
add, modify, or delete a design evaluation. The contract can be evaluated for any of the design
categories in the system. Only one evaluation can be made for a design category per evaluator. The
numeric rating is required.

Contract 1D: IW d
L
Design Category Rating |Evaluation Date Evaluator Position
>0 05/04/93 System Administrator 1 System Administ
Ll u |
1=

Figure 6-7. The Design Evaluation Window

Field Name Description
Design User-defined design category description. Only one rating
Category allowed for a design category. This is a required field.
Rating Numeric rating assigned to an evaluation. This is a required
field. Valid values are on a scale from 1 to 10.
Evaluation Date on which the design category was evaluated. Cannot be
Date in the future. Defaults to the date on which the evaluation is

entered in the system.

Evaluator User ID of the individual entering the evaluation data.
Defaults to the current user name. This value cannot be
modified after it is saved.

Position Designation of the evaluator. Defaults to the current user.
This value cannot be modified after it is saved.

Table 6-7. The Design Evaluation Window Fields Table
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To add a design evaluation:

1. On the Contract Records panel, double-click the Design Evaluation icon. The Contract
Select window opens.

2. Inthe Contract ID list box, scroll to and click the contract.

3. Click OK. The Design Evaluation window lists design evaluations.

4. Click the New button. An empty row is added to the list.

5. In the Design Category drop-down list, click the expand arrow and click the design category.
6. Pressthe Tab key.

7. In the Rating field, type the numeric rating for the evaluation.

8. Press the Tab key.

9. Inthe Evaluation Date field, type the date of the evaluation.

10. Click the Save button.

6.4 Plan Discrepancy

The Plan Discrepancies window lets the user record discrepancies to the contract plan. The
discrepancy types are defined by the transportation agency.

¥4 Plan Discrepancies
Cont I1D: ISITEMGH_EH Discrepancy Serial No: l—

Entry Date: IDB£2D!9? Discrepancy Entered By: |Central Dffice 1

Discovered By: m Discovery Date: |00/00/00
Discrepancy Type: | [x] Plan Page Number: I

Discrepancy Description:

Correction Date: IDD,-"EID;"DD

Discrepancy Comrection:

Designer Information:

ence to

Change Order Numbel:l DWFI:| 00/00,/00 Dispute: |0

Figure 6-8. The Plan Discrepancies Window

6-18



6.4 Plan Discrepancy

AASHTOWare Project SiteManager
6. Contract Administration - Maintenance

Field Name

Description

Cont ID

Transportation agency-defined ID for the contract.

Discrepancy Serial No

System-generated serial number for the discrepancy record.

Entry Date

Date when the discrepancy record was entered. Defaults to the
current date.

Discovered By

The entity discovering the discrepancy, e.g., Consultant,
Contractor, Department, or Other.

Discrepancy Entered
By

Name of the person entering the discrepancy. Defaults to the
name of the logged on SiteManager user.

Reference to Change
Order Number

Change order number associated with the discrepancy. The
user can search this field.

Discrepancy
Description

Description of the discrepancy. This is a required field.

Discrepancy Correction

Description of the correction of the discrepancy. This field is
optional.

Discrepancy Type

Transportation agency-defined type of the discrepancy. This is
a required field.

Discovery Date

Discovery date of the discrepancy. The discovery date cannot
be after the current date or before the Daily date. This field is
required.

Correction Date

Correction date of the discrepancy. This field is optional and
cannot be after the current date.

Plan Page Number

Page number of the design plan associated with the
discrepancy. This field is optional.

Reference to Dispute

ID of the dispute associated with the discrepancy. The user
can search this field. This field is optional.

Reference to DWR

Date and user ID on the Daily Work Report associated with the
discrepancy. The user can search this field. This field is
optional.

Designer Information

Information about the designer associated with the
discrepancy. This field is optional.

Table 6-8. The Plan Discrepancies Window Fields Table

6-19



AASHTOWare Project SiteManager
6. Contract Administration - Maintenance 6.4 Plan Discrepancy

To add a plan discrepancy to the contract:

1.

> w

10.
11.
12.
13.
14.
15.
16.
17.
18.
19.

20.
21.
22.

6-20

On the Contract Records panel, double-click the Plan Discrepancy icon.

Click the Services menu and click the Choose Keys choice. The Select Contract list opens.
In the Select Contract list box, scroll to and click the contract.

Click OK.

In the Discovered By drop-down list, click the expand arrow and click the entity that found
the discrepancy.

Press the Tab key.

In the Discovery Date field, click in front of the current entry and type the date the
discrepancy was discovered.

In the Discrepancy Type drop-down list, click the expand arrow and click the discrepancy
type.

Press the Tab key.

To enter a reference to the design plan, in the Plan Page field, type the page number.
Press the Tab key.

In the Discrepancy Description field, type a description of the discrepancy.

Press the Tab key.

In the Correction Date field, type the date the discrepancy was corrected.

Press the Tab key.

In the Discrepancy Correction field, type a description of the discrepancy correction.
In the Designer Information field, type desired data.

Press the Tab key.

To add a reference to a change order, in the Change Order Number field, perform a
Search.

Press the Tab key.
To add a reference to a Daily Work Report, in the DWR field, perform a Search.
Press the Tab key.
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23. To add a reference to a dispute, in the Dispute field, perform a Search.

24. Click the Save button.

To modify a plan discrepancy record:

1. On the Contract Records panel, double-click the Plan Discrepancy icon.

2. Click the Open button. The Discrepancy Select window opens. The Select Contract list is

displayed.

3. Inthe Select Contract list box, scroll to and double-click the contract ID. The window

displays a list of discrepancies.

4. Inthe Plan Discrepancy list box, scroll to and double-click the record. The Plan
Discrepancy Select window closes and the Plan Discrepancy window is displayed.

5. Modify data on the window.

6. Click the Save button.

6.5 Dispute/Claim

The Dispute/Claim window lets the user add, modify, and delete dispute and claim records. The

Dispute/Claim window contains the following folder tabs:

Tab Name Description
Description Displays the basic dispute or claim description data that can be
added, deleted, updated, or viewed.
Recipients Displays the dispute or claim recipient’s data that can be added,

deleted, updated, or viewed. This folder tab records data on
people who have been assigned to respond to the dispute or
claim. In addition, the system notifies each recipient of his
pending assignment with an In-Box message.

Related Records

Displays a list of SiteManager records related to the selected
dispute or claim. This lets the user navigate automatically to
the related record’s window (e.g., Plan Discrepancies, Change
Order, Correspondence Log).

Table 6-9. The Dispute/Claim Folder Tabs Table
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6.5.1 Dispute/Claim Descriptions

6.5 Dispute/Claim

The Description folder tab lets the user add, modify, or delete the contract disputes and claims.

..... p =10f x|
Description Recipients: i Palated Recards
Eontract 1D: iC‘I an2g
Dispute ID:; Type Ind: | i Status: | ] Subcontr |D: | |
Categomy Type: | ~| Estmate Nbr: i Requested Days: ;-w
Requested Amt:; $.00 Settled Days: ; Settled Amt: | $.00
Received Dale:i 00/00/00 Logged Date: i 0641102 Diary Start Date: ; 00/00400
Diary End Dale:; 00/00/00 Contractor Accepted Date: ; 00/00/00 Dept.Resolved Dale:i 00,0000
R FHWA Concumence Date: ; 0070000 Helease/Payment Dale:; 000000

Heason Type: [Spaces

Remarks:

[
=
=

Project Mumber

Line [tem Item Code Short Description Seq Mbr

Figure 6-9. The Dispute/Claim Description Folder Tab

Field Name

Description

Contract ID

Transportation agency-defined 1D for the contract.

Dispute ID System-generated ID for the dispute or claim.

Type Ind Identifies whether this is a dispute or a claim. This is a required
field.

Status Status of the dispute or claim (e.g., Received, Logged, Open,

Rescinded, Resolved, Denied, Closed). This is a required field.

Subcontr ID

Transportation agency-defined ID for the subcontractor
associated with the dispute or claim.

Category Transportation agency-defined category of the dispute or claim.
Type Categories are defined for reporting, inquiry, and analysis
purposes. Normally based on the nature of the dispute or claim
(e.g., material, utility, time). This is a required field.
Requested Dollar amount requested by the contractor in the dispute or
Amt claim. Either Requested Amt or Requested Days is required.
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Field Name Description
Requested Number of days requested by the contractor in the dispute or
Days claim. Either Requested Amt or Requested Days is required.
Settled Amt | Amount settled for the dispute or claim.

Settled Days

Days settled for the dispute or claim.

Estimate Nbr

System-generated number assigned to the estimate during the
estimate generation process. The user can search this field.

Received
Date

Date the dispute or claim was received by the department. This
IS a required field.

Logged Date

Date the dispute or claim was entered into SiteManager.
Assigned by the system.

Contractor Date the resolution was accepted by the contractor. Cannot be
Accepted after the current date or equal to the Dept Resolved Date.

Date

FHWA Date the FHWA concurred with the resolution. Cannot be after
Concurrence | the current date.

Date

Diary Start Start date of a range of diaries that document the dispute or
Date claim. Cannot be after the current date.

Diary End End date of a range of diaries that document the dispute or
Date claim. Must be greater than or equal to the Diary Start Date.

Release/Paym

Date the payment was released for the dispute or claim. Cannot

ent Date be after the current date.

Dept Date the dispute or claim was resolved or overridden by the
Resolved department. Cannot be after the current date.

Date

Resolution Resolution reason type that identifies how the dispute or claim

Reason Type

was resolved (e.g., Change Order issued).

Remark Remarks about the dispute or claim.
Project Transportation agency-defined ID for the project related to the
Number dispute or claim.
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Field Name Description
Line Item Line item number of an item associated with the dispute or

claim. The user can search this field. An item can be in
multiple disputes (e.g., a paving item can be disputed one day
because of density controversy and the next day because of an
aggregate mix). This field is protected in update mode.

Seq Nbr System-generated sequence number that identifies the project
and line item associated with the dispute or claim.

Item Code Transportation agency-defined code for the item associated with
the dispute or claim.

Short Short description of the item associated with the dispute or
Description claim.

Table 6-10. The Dispute/Claim Description Folder Tab Fields Table
To add a dispute or claim record to a contract:
1. On the Contract Records panel, double-click the Dispute/Claim icon.
2. Click the Services menu and click the Choose Keys choice. The Select Contract list opens.
3. Inthe Select Contract list box, scroll to and click the contract.
4. Click OK.
5. Inthe Type Ind drop-down list, click the expand arrow and click either Dispute or Claim.

6. Inthe Status drop-down list, click the expand arrow and click the status of the dispute or
claim.

7. Inthe Subcontractor ID drop-down list, click the expand arrow and click the ID of the
subcontractor who started the dispute or claim.

8. In the Category Type drop-down list, click the expand arrow and click the category of the
dispute or claim.

9. Press the Tab key.
10. In the Estimate Nbr field, type an estimate number or perform a Search.
11. Press the Tab key.

12. In the Requested Days field, type the number of days requested by the contractor, or tab to
the Requested Amt field and type the dollar amount requested by the contractor.
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13

14.
15.
16.

17.
18.

19.
20.

21.
22,

23.
24,

25.
26.
217.
28.

29.

30.
31.
32.

. Press the Tab key.
In the Settled Amt field, type the amount for which the dispute or claim was settled.
Press the Tab key.

In the Received Date field, type the date the dispute or claim was received by the
transportation agency.

Press the Tab key.

In the Diary Start Date field, type the start date of a range of diaries that captured
information about the dispute or claim.

Press the Tab key.

In the Diary End Date field, type the end date of a range of diaries that captured information
about the dispute or claim.

Press the Tab key.

In the Contractor Accepted Date field, type the date the resolution was accepted by the
contractor.

Press the Tab key.

In the Dept Resolved Date field, type the date that the dispute or claim was resolved by the
transportation agency.

Press the Tab key.
In the FHWA Concurrence field, type the date the FHWA concurred with the resolution.
Press the Tab key.

In the Release/Payment Date field, type the date the payment was released for this dispute
or claim.

In the Resolution Reason Type drop-down list, click the expand arrow and click the reason
that identifies how the dispute or claim was resolved.

Press the Tab key.
In the Remarks field, type remarks about the dispute or claim.

Click the Save button.
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To add an Item to a dispute or claim record:
1. On the Contract Records panel, double-click the Dispute/Claim icon.

2. Click the Open button. The Dispute/Claim Select window opens. The Select Contract list is
displayed.

3. Inthe Select Contract list box, scroll to and double-click the contract. The window displays
a list of disputes.

4. In the Dispute/Claim list box, scroll to and click the dispute.
5. Click OK.
6. Click the bottom datawindow and click the New button.

7. Inthe Project Number drop-down list, click the expand arrow and click the number of the
project that includes the item.

8. Inthe Line Item field, type the line item number or perform a Search.
9. Click the Save button.

To view a line item related to a dispute or claim:
1. On the Contract Records panel, double-click the Dispute/Claim icon.

2. Click the Open button. The Dispute/Claim Select window opens. The Select Contract list is
displayed.

3. Inthe Select Contract list box, scroll to and double-click the contract. The window displays
a list of disputes.

4. In the Dispute/Claim list box, scroll to and click the dispute.
5. Click OK.
6. Inthe Line Item list box, scroll to and click the line item.
7. Click the Services menu and click the View Item choice.
8. Click the Close button to return to the Dispute/Claim window.
To view an estimate related to a dispute or claim:
1. On the Contract Records panel, double-click the Dispute/Claim icon.

2. Click the Open button. The Dispute/Claim Select window opens. The Select Contract list is
displayed.
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3. Inthe Select Contract list box, scroll to and double-click the contract. The window displays

a list of disputes.

4. In the Dispute/Claim list box, scroll to and click the dispute.

5. Click OK.

6. Look at the Estimate Nbr field to make sure the selected dispute or claim has a valid

estimate number.

7. Click the Services menu and click the View Estimate choice.

8. Click the Close button to return to the Dispute/Claim window.

If the View Estimate menu option is not available, make sure that focus is on the top datawindow
and there is a valid number in the Estimate Nbr field.

6.5.2 Dispute/Claim

Recipients

The Dispute/Claim Recipients folder tab lets the user add, modify, and delete the recipients of the
dispute and claim records. This folder tab lets the user maintain tracking and deposition information
on personnel assigned to respond to the dispute. This includes assigning the personnel, documenting
when the dispute or claim documentation was sent and received and recording the recipient’s
comments or deposition. Each newly assigned recipient is notified of the assignment by an In-Box

message.

E Disputes / Claims

Description Recipients Related Records
Contract 1D: ISITEMGF!_EH Dispute ID: |1_
Recipient Due Date|Doc Sent| Doc Received Recipient 1=l
Date Date Response Date _
00/00/00 00400400 00/00400 00/00/00
o | _vl_I
Recipient:: Due Date:| 00/00/00
Doc Sent Date:| 00/00/00 Doc Received Date:| 00/00/00 Hecipient Response Date:| 00/00/00
Remarks: ;I

Figure 6-10. The Dispute/Claim Recipient Folder Tab
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Field Name Description
Recipient User ID of a person assigned to receive dispute or claim

documents (e.g., Project Engineer). The user can search this
field. This is arequired field. Should be unique within the
dispute or claim.

Due Date Date the dispute or claim document is due to be received by the
recipient. This is a required field. Cannot be before the current
date.

Doc Sent Date | Date the dispute or claim document was sent to the recipient.
Cannot be after the current date.

Doc Received | Date the recipient received the dispute or claim document.
Date Should be greater than or equal to the Doc Sent Date. Cannot
be after the current date.

Remark Remarks received from the recipient of dispute or claim
documents.

Recipient Date the recipient responded to the dispute or claim document.

Response Should be greater than or equal to the Doc Sent Date. Cannot

Date be after the current date.

Table 6-11. The Dispute/Claim Recipients Folder Tab Fields Table
To add a recipient:
1. On the Contract Records panel, double-click the Dispute/Claim icon.

2. Click the Open button. The Dispute/Claim Select window opens. The Select Contract list is
displayed.

3. Inthe Select Contract list box, scroll to and double-click the contract. The window displays
a list of disputes.

4. In the Dispute/Claim list box, scroll to and click the dispute or claim.
5. Click OK.

6. On the Dispute/Claim window, click the Recipients folder tab.

7. Click the New button.

8. In the Recipient field, type the title of the person who has been assigned to respond to the
dispute or perform a Search.
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9.

10.
11.
12.
13.
14.
15.
16.

17.
18.
19.

Press the Tab key.

In the Due Date field, type the date the document is due to be received by the recipient.
Press the Tab key.

In the Doc Sent Date field, type the date the document was sent to the recipient.

Press the Tab key.

In the Doc Received Date field, type the date the recipient received the document.
Press the Tab key.

In the Recipient Response Date field, type the date the recipient responded to the dispute or
claim.

Press the Tab key.
In the Remarks field, type the recipient’s remarks.

Click the Save button.

When a new recipient is added to the list and the record is saved, the system notifies the recipient by
In-Box message.

6.5.3

Dispute/Claim Related Records

The Dispute/Claim Related Records folder tab lets the user view and navigate to the plan
discrepancies, change orders, and correspondence logs related to the dispute or claim.

5 Disputes / Claims _ O]

Description Recipients Related Records

Contract ID: ISIT EMGR_30 Dispute ID: |‘I_

Entered Date Related Records

I

05/07/33  |Plan Discrepancies

04/15/99  |Plan Dizcrepancies 2

03/239/33  |Plan Discrepancies 1

o By

Figure 6-11. The Dispute/Claim Related Records Folder Tab
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Field Name Description

Entered Date | Date the record related to the dispute or claim was entered.

Related Records that are related to the dispute or claim (i.e.,
Records correspondence log, plan discrepancy, Change Order).
Key System-generated sequence number that identifies the record

associated with the dispute or claim.

Table 6-12. The Dispute/Claim Related Records Folder Tab Fields Table

To navigate to a related record:

1.
2.

On the Contract Records panel, double-click the Dispute/Claim icon.
Click the Open button. The Select Contract list is displayed.

In the Select Contract list box, scroll to and double-click the contract. The window displays
a list of disputes.

In the Dispute/Claim list box, scroll to and click the dispute or claim.
Click OK.
Click the Related Records folder tab.

Click the Related Record and click an option on the Services menu, depending on the type
of record selected as follows:

= To view a Plan Discrepancy record, click View Plan Discrepancies.
= To view a Change Order record, click View Change Orders.
= To view a Correspondence Log record, click View Correspondence Log.

To return to the Dispute/Claim window, close the open window.

6.6 Contractor Payrolls

The Contractor Payrolls window lets the user add and modify contractor payroll data and related
employee information. The user can enter the payroll data manually or upload the payroll data
electronically (refer to the Contractor Payroll Load topic). The employee information is used
primarily for civil rights and government reporting functions. The payroll data can be used to track
on-the-job training commitments and training reimbursements to the contractor.

6-30



AASHTOWare Project SiteManager

6.6 Contractor Payrolls 6. Contract Administration - Maintenance

Certain factors must be considered for payroll entry:

SiteManager accepts payroll data only if the Prime Contractor folder tab on the contract
indicates that payrolls are required.

The Work Begin Date on the contract’s Critical Dates tab must be populated.

The payroll frequency is determined by the Frequency In Weeks field on the contract’s Prime
Contractor folder tab. This value determines the ending date for the payrolls.

A payroll for the prime contractor must be entered before a subcontractor payroll may be
entered and saved.

The payroll information for the prime contractor is present from the beginning of the contract
until the end allowing for no gaps.

The payroll frequency cycle for subcontractors must be the same as that of the prime
contractor, but it does not have to be continuous.

Tab Name Description
Payroll The Payroll Information folder tab displays the payroll
Information dates, the payroll’s certified status, and whether the payroll
includes employee hours.
Employee The Employee Information folder tab displays a list of
Information employees for the selected payroll and details for the

employee selected on the list.

Employee Daily The Employee Daily Information folder tab displays the
Information daily records for each employee during a payroll period.

Table 6-13. The Contractor Payrolls Window Folder Tabs Table

To access the Contractor Payrolls window:

1.
2.

On the Contractor Management panel, double-click the Contractor Payrolls icon.

Click the Services menu and click the Choose Keys choice. The Select Payroll for Vendor
window opens.

In the Select Contract list box, scroll to and double-click the contract.
In the Vendor list box, scroll to and click the prime contractor.
Click OK.
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6.6.1 Payroll Information

The Payroll Information folder tab lets the user add and modify payroll data. This information is
submitted to the transportation agency by prime contractors and subcontractors who employ at least
one non-supervisory employee. The user may enter payrolls manually on this window or the
payrolls may be uploaded electronically. (See the Contractor Payroll Load topic for details.)

If there is no employee data, the No Employees for Period indicator is selected. If a payroll with
employee hours is selected, the user can access all three folder tabs.

When the payroll has been processed via the Payroll Exceptions batch process, the Payroll Exception
Process indicator is selected automatically by the system. This indicates that the employee wage
rates have been checked against the contract’s wage decision and trainee hours have been processed
for on-the-job training reimbursement.

Once a payroll has been included in an estimate — meaning its trainee hours have been processed for
on-the-job training reimbursement — the On Estimate field displays the corresponding estimate
number. The estimate number are removed if the estimate is deleted.

Note: Once a payroll has been processed and included on a paid estimate, the payroll
can later be decertified and modified manually or reloaded electronically into the system.
However, any employee hour modifications will not be processed by the next Payroll
Exceptions batch job. Therefore, any changes to a trainee's work hours will not be
reflected on the trainee record and an on-the-job training reimbursement adjustment will
not be calculated on the next estimate. If the DOT hours accrued for a trainee must be
modified, then the changes must be manually made on the Trainee window.

B9 Contractor Pagrolls | hEmE
( Payroll Information | Employee Information | Employee Daily Information |
19

Contract ID: |E1 0785 Vendor ID: 0654 |CONCRETE WORKS OF COLDRADD |
Payroll Received: [06/13/01 v Certified

For Period Ending: |11.-"2El.»"DU [T Mo Employee Hours for period

On Estimate: | [¥ Payroll Exception Processed

| | »

Figure 6-12. The Payroll Information Folder Tab

Field Name Description

Contract ID Transportation agency-defined ID of the contract. This field is
also displayed on the Employee Information and the Daily
Employee Information tabs.

Vendor ID Vendor ID of the prime contractor or subcontractor. This field is
also displayed on the Employee Information and the Daily
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Field Name Description
Employee Information tabs.

Payroll Received | This is the payroll received date. Defaults to the current date.
Cannot be after the current date.

For Period The end of the payroll period. Defaults to a date based on the
Ending payroll frequency of the prime contractor. If a prime contractor
is selected, this field cannot be modified. This date is also
displayed on the Employee Information and the Daily Employee
Information tabs in the Payroll Ending Date field.

Certified Indicates that the payroll is certified.

No Employee Indicates that no employees worked in the payroll period.
Hours for period

Payroll Exception | Indicates that the payroll has been processed via the Payroll
Processed Exceptions batch process.

On Estimate Displays the number of the estimate that included the payroll.

Table 6-14. The Payroll Information Folder Tab Fields Table

To manually add the first payroll:

1.

2.
3.

On the Payroll Information tab, in the Payroll Received field, type the date the payroll was
received.

In the For Period Ending field, type the ending date of the payroll period.

Click the Save button.

To manually add a payroll with no employee hours:

1.

On the Payroll Information tab, in the Payroll Received field, type the date the payroll was
received.

In the For Period Ending field, type the ending date of the payroll period.
Click the No Employees for Period indicator.

Click the Save button.

Note: After the system verifies that the period ending date corresponds to the prime
contractor’s payroll period, the record is saved.

6-33



AASHTOWare Project SiteManager
6. Contract Administration - Maintenance 6.6 Contractor Payrolls

6.6.2 Employee Information

The Employee Information folder tab displays a list of employees for the selected payroll and details
for the employee selected on the list. To add payroll employee information, the user can search the
Vendor’s personnel list by name or SSN/SIN and select the employees who worked on the payroll.
The user can also enter employee information manually. If the selected payroll is not certified, the
user can modify the data.

If the employee is a trainee, the data on this record (Class Type, Class Group, Program Type, etc.)
should match exactly the information on the trainee record.

=l e = =l +)

Payroll Information Employee Information ! Employee Daily Information

ContractiD:  |051333 YendorlD: EDDZB Payroll Ending Date: |1 2/14/39
Name SSN/SIN  |Employee Employee
Class Type |Class Group
Employee 1 999-99-9939 Powe
Name: [Employee 1 SSN/SIN: [935-95-9399
Ethnicity: | Native American = Gender Type: |Male -
Class Type: IPDWSI Equipment Operatc  Class Group: Program Type: ISpaces 'l
Deductions: |$10.00 Met Pay: I?D.DD
Total Hrs: |8.DD Gross Amt:  [0.000
Deduction Type Deduction Amt
— ]
| Federal Withholding - 10.000

Figure 6-13. The Employee Information Folder Tab

Field Name Description
Contract ID Transportation agency-defined ID of the contract.
Vendor ID Vendor ID of the prime contractor or subcontractor.

Payroll Ending End of the payroll period for the selected payroll.

Date

Name Name of a non-supervisory employee. The user can
search this field.

SSN/SIN Social Security Number or Social Insurance Number of
the employee. The user can search this field.

Ethnicity Transportation agency-defined ethnic background of the
employee.

Gender Gender of the employee.
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Field Name Description

Class Group Class Group of the employee.

Class Type Class Type of the employee.

Program Type Program type in which the employee is enrolled.

Deductions Deductions to the employee’s payroll for the payroll
period.

Net Pay Gross Pay minus Deductions for the payroll period.

Deduction Type A drop-down list from which the user can select a
deduction type, such as FICA, State, Federal, Local or
other deductions.

Deduction The amount to be withheld from the employee’s gross

Amount pay for the specified Deduction Type.

Table 6-15. The Employee Information Folder Tab Fields Table

To add an employee payroll record:

1.
2.

8.
9.

On the Employee Information folder tab, click the New button.

In the Name field, type the name or, using the right mouse button, click the field and
perform a Search . The system automatically enters existing data for the employee. The user
can modify this data as needed.

In the SSN/SIN field, type the number or perform a Search.

In the Ethnicity drop-down list, click the expand arrow and select the ethnic group.

In the Gender Type drop-down list, click the expand arrow and select the gender.

In the Class Type drop-down list, click the expand arrow and select the work class type.
In the Class Group field, type a new work class group or perform a Search.

In the Program Type drop-down list, click the expand arrow and select the program type.

In the Deductions field, type the deduction value.

10. In the Total Hours field, type the total hours worked for the pay period.

11. In the Gross Amount field, type the gross pay amount for the pay period.

12. Click the Save button.
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Or
13. In the Total Hours field, type the total hours worked for the pay period.

14.
15.
16.
17.
18.

19.
20.
21.
22,
23.

In the Gross Amount field, type the gross pay amount for the pay period.
Click the Save button.

Click in the bottom data window.

Click the New button.

In the Deduction Type drop-down list, click the expand arrow and select the desired
deduction type.

In the Deduction Amount field, type the amount for the selected deduction type.
To enter additional deductions, repeat Steps 11 through 13.

Click in the Total Hours field and type the total hours worked for the pay period.
In the Gross Amount field, type the gross pay amount for the pay period.

Click the Save button.

Note: The user should not manually enter a value in the Deductions field if the employee
has more than one type of deduction.

To modify employee payroll information for a selected pay period:

1.
2.

9.

10.
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On the Contractor Management panel, double-click the Contractor Payrolls icon.
Click the Open button. The Select Payroll for Vendor window opens.

In the Select Contract list box, scroll to and double-click the contract ID.

In the Vendor list box, scroll to and double-click the prime contractor or subcontractor.
In the Payroll list box, scroll to and click the payroll.

Click OK. The Payroll Information folder tab displays data for the selected payroll.
Click the Employee Information folder tab.

In the Employee list box, scroll to and click the employee name. The window displays data
for the selected employee below the list.

In the Name field, type the name or perform a Search.

In the SSN/SIN field, type the number or perform a Search.
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11

12.
13.
14.
15.
16.
17.
18.

Or

19.
20.
21.
22,
23.
24,

25.

26

. In the Ethnicity drop-down list, click the expand arrow and click the ethnic group.

In the Gender drop-down list, click the expand arrow and click the gender.

In the Class Type drop-down list, click the expand arrow and click the work class type.
In the Class Group field, type a new work class group or perform a Search.

In the Deductions field, type the deduction value.

In the Total Hours field, type the total hours worked for the pay period.

In the Gross Amount field, type the gross pay amount for the pay period.

Click the Save button.

In the Total Hours field, type the total hours worked for the pay period.
In the Gross Amount field, type the gross pay amount for the pay period.
Click the Save button.

Click in the bottom data window.

Click the New button.

In the Deduction Type drop-down list, click the expand arrow and select the desired
deduction type.

In the Deduction Amount field, type the amount for the selected deduction type.

. To enter additional deductions, repeat Steps 11 through 13.

If the selected payroll is certified, the employee data cannot be modified or deleted.

6.6.3

Employee Daily Information

The Employee Daily Information folder tab shows the daily record for each employee during a

payrol

| period. This includes the dates worked on this payroll, the number of hours worked per day,

and the hourly rates paid to the employee. The work dates entered must fall within the payroll

period

. Once the user enters and saves the data on this tab, the application calculates and displays

the total hours worked and gross pay on the Employee Information tab in the Total Hours and Gross

Amou

nt fields. The application then displays these fields in read-only mode.
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Payroll Information

Employee Information " Empl Daily Infi

ContractiD:  [051333 VendorlD:

[NJEI2-B Payroll Ending Date: |1 2/14/93

SSN/SIN Employee Employee

Class Type Class Group

(993939333 [Pawc

Work Date Wage Rate |Fringe

Overtime
Hours

Overtime Regular

Benefit Rate Hours

Rate

12/14/33  |$10.00

$5.00 $15.00  |8.00 2.00

Figure 6-14. The Employee Daily Information Folder Tab

Field Name

Description

Contract ID

Transportation agency-defined ID of the contract.

Vendor ID

Vendor ID of the prime contractor or subcontractor.

Payroll Ending Date

End of the payroll period for the selected payroll.

Name

Name of a non-supervisory employee on the payroll.

SSN/SIN

Social Security Number or Social Insurance Number of the
employee on the payroll.

Employee Class Type

Class Type of the employee on the payroll.

Employee Class Group

Class Group of the employee on the payroll.

Work Date

Date on which the employee worked in the payroll period.

Wage Rate

Hourly wage rate for the employee on this date in the payroll
period.

Fringe Benefit Rate

Hourly fringe benefit rate for the employee on this date in
the payroll period.

Overtime Rate

Hourly overtime rate for the employee on this date in the
payroll period.

Regular Hours

Regular hours worked by the employee on this date in the
payroll period.

6.6 Contractor Payrolls
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Field Name Description
Overtime Hours Overtime hours worked by the employee on this date in the
payroll period.

Table 6-16. The Employee Daily Information Folder Tab Fields Tab

To modify employee daily information:

1.
2.

> w

10.
11.
12.
13.
14.
15.

16.

Click the Employee Daily Information folder tab.

In the Employee list box, scroll to and click the employee name. The window displays data
for the selected employee below the list.

Click the New button. An empty row is added.

Click in front of the current Work Date and type the date.
Press the Tab key.

In the Wage Rate field, type the wage rate.

Press the Tab key.

In the Fringe Benefit Rate field, type the fringe benefit rate.
Press the Tab key.

In the Overtime Rate field, type the overtime rate.

Press the Tab key.

In the Regular Hours field, type the number of regular hours.
Press the Tab key.

In the Overtime Hours field, type the number of overtime hours.

To record hours worked by this employee on another date, repeat Steps 3 through 14. To
record hours worked by another employee, repeat Steps 1 through 15.

Click the Save button.

The prime contractor’s payrolls must be recorded before the subcontractor’s payrolls.

To delete a payroll:

1.

2.

On the Contractor Management panel, double-click the Contractor Payrolls icon.

Click the Open button. The Select Payroll for Vendor window opens.
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w

In the Select Contract list box, scroll to and double-click the contract.

>

In the Vendor list box, scroll to and double-click the prime contractor or subcontractor.
In the Payroll list box, scroll to and click the payroll.
6. Click OK. The Payroll Information folder tab displays data for the selected payroll.

7. If the payroll is certified, click the Certified check box (OFF). SiteManager displays the
message that uncertifying the payroll permits changes to this payroll and associated data.

8. Click OK.
9. Click the Employee Daily Information folder tab.

10. In the Employee list box, click the Employee name. The window displays data for the
selected employee below the list.

11. Select a row of daily data and click the Delete button. SiteManager displays the message, Do
you want to delete Employee’s Daily Information?

12. Click Yes.

13. Repeat Steps 10 and 11 until all employee daily information is deleted for every employee
payroll record.

14. Click the Save button.
15. Click the Employee Information folder tab.
16. In the Employee list box, click the Employee name.

17. Click the Delete button. SiteManager displays the message, Do you want to delete
Employee’s Information?

18. Click Yes. Delete each employee listed.

19. Click the Payroll Information folder tab.

20. Click the Delete button. A delete confirmation message displays.
21. Click Yes.

22. Click the Save button.

If the selected payroll has Employee Information and/or Employee Daily Information, all records
must be deleted before the payroll may be deleted.
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6.7 Contractor Payroll Load

Contractor Payroll Load is a two-step process which loads payroll data electronically received from
the contractor from the server to the database. (To enter payroll data manually, refer to the
Contractor Payrolls topic.) The first step is accomplished by the user selecting payroll files to be
loaded via the Contractor Payroll Load window. The files must be correctly formatted and contain
valid data. When the user selects payroll files to be loaded, the system performs preprocessing
validation of the following:

= Correct file format.
= Valid contract ID, vendor ID, and payroll ending date.
= Payroll data for only one payroll period per file.
= Multiple files must be entered in increasing order by payroll ending date.
A payroll must be loaded for the prime contractor before a subcontractor payroll can be loaded.

After the file selection is saved, the system copies the files that passed validation to a specific
directory on the server. The system also generates a Payroll Preprocessing report and sends the
report name to the user who selected the files. This report gives the preprocessing results.

The second step involves a batch process which loads data from the files queued on the server to the
database. The loaded payroll data can be viewed and modified on the Contractor Payrolls window.
If a payroll has no employee data, the No Employees for Period indicator is selected (ON)
automatically. If a payroll is certified, the Certified indicator must be selected (ON) manually. If
any files fail to load, the batch process generates a Payroll Batch report and notifies the contract’s
primary personnel. This report lists the files that failed and the reasons for failure. Possible load
failure reasons include:

= Missing data, e.g., if non-supervisory employees are on the payroll, specific employee data is
required.

= Invalid data, e.g., regular hours not between zero and 24.
= Invalid data format, e.g., numeric vs. non-numeric.

= |f one payroll fails, all subsequent payrolls fail because the payroll ending dates are out of
sequence.

6.7.1 Contractor Payrolls Text File Format

Payroll files to be uploaded must have the text file format described below with required fields and
delimited by semi-colons (;). An example is provided.
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Rec Type Field Ord Req Type/Length Notes/Issues
Contract ID: Contract ID | 1 Y Char 15 Must be a valid contract ID in
the SiteManager database
Vendor ID: Vendor ID |1 Y Char 14 Must be a valid Vendor ID in
the SiteManager database for
the above listed contract ID
Payroll Ending | Payroll 1 Y Num 8 Must be a date greater than
Date: Ending the last Payroll Ending Date
Date
EMPLOYEE: SSN 1 Y Char 9
EMPLOYEE: Name 2 Y VarChar 50
EMPLOYEE: Gender 3 Y Char 1 Must be F or M
EMPLOYEE: Ethnicity 4 Y Char 4 Must be a valid code in the
SiteManager Ethnicity code
table
EMPLOYEE: Class 5 Y Char 2 Spaces or valid code in the
Group SiteManager Job Class code
table
EMPLOYEE: Class Type |6 Y Char 4 Must be a valid code in the
SiteManager Class Type code
table
EMPLOYEE: Program 7 Y Char 4 Must be either a space or a
Type valid code in the SiteManager
Program Type code table
EMPLOYEE: Deductions | 8 Y Dec 14.3 Spaces or valid sum if
itemized deductions exist.
Otherwise value must be >= 0
EMPLOYEE: Tot Hrs 9 Y Dec 7.2 Spaces or valid sum if
employee details exist.
Otherwise value must be >=0
EMPLOYEE: Gross 10 Y Dec 14.3 Spaces or valid sum if
amount employee details exist.

Otherwise value must be >=0
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Rec Type Field Ord Req Type/Length Notes/Issues
REMARK: Employee |1 N 0to Not required
remark 2,147483,647
PB String
length 32 bit.
60,000 for 16
bit
ADDRESS: Employee |1 Y Char 40 Spaces or value
address
Line 1
ADDRESS: Line 2 2 Y Char 40 Spaces or value
ADDRESS: Line 3 3 Y Char 40 Spaces or value
ADDRESS: City 4 Y Char 40 Spaces or value
ADDRESS: State/prov |5 Y Char 2 Spaces or value
ADDRESS: Zip 6 Y Char 10 Spaces or value
ADDRESS: Country 7 Y Char 14 Spaces or value
ADDRESS: Phone 8 Y Char 13 Spaces or value
ADDRESS: Ext 9 Y Char 6 Spaces or value
ADDRESS: Fax 10 Y Char 13 Spaces or value
DEDUCTION | TYPE 1 N Char 4 Must be a valid code in the
SiteManager Deduction Type
code table
DEDUCTION Deductions | 2 N Dec 14.3 Must be >=0.00
Amount
EMPLOYEE Date 1 Y Num 8 No duplicates allowed and
DAILY: should lie within the Payroll
Frequency Cycle
EMPLOYEE Reg Hours | 2 Y Dec 5.2 Valid range of 0.00 to 24.00
DAILY:
EMPLOYEE Overtime 3 Y Dec 5.2 Valid range of 0.00 to 24.00
DAILY: Hours
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Rec Type Field Ord Req Type/Length Notes/Issues

EMPLOYEE Wage Rate | 4 Y Dec 5.2 Valid range of 0.00 to 999.99.

DAILY: If Reg Hours field from above
is > 0.00, then it must be >
0.00.

EMPLOYEE Fringe Rate | 5 Y Dec 5.2 Valid range of 0.00 to 999.99.

DAILY:

EMPLOYEE Overtime 6 Y Dec 5.2 Valid range of 0.00 to 999.99.

DAILY: Rate If Overtime Hours field from
above is > 0.00, then it must
be > 0.00.

Example of a Payroll Text File

Contract ID:TESTCONTRACT

Vendor ID:G022

Payroll Ending Date:12/17/99

EMPLOYEE:250992222;SHIRLEY M. SMITH;F;01;IlI;ELEC;UNN;150;40;480
REMARK:NEW EMPLOYEE AND FIRST WEEK ON SITE;

ADDRESS:88 BAKER ST.;SECOND FLOOR;SUITE 200;COLUMBIA;SC;29170;USA;803-123-
4567,,803-222-1111

DEDUCTION:FEDL;100

DEDUCTION:STAT;50

EMPLOYEE DAILY:12/13/99;8.00;0.00;12;0.00;0.00

EMPLOYEE DAILY:12/14/99;8.00;0.00;12;0.00;0.00

EMPLOYEE DAILY:12/15/99;8.00;0.00;12;0.00;0.00

EMPLOYEE DAILY:12/16/99;8.00;0.00;12;0.00;0.00

EMPLOYEE DAILY:12/17/99;8.00;0.00;12;0.00;0.00
EMPLOYEE:250136184;FRANK G. MOORE;M;02;II;PLUM;UNN;200;50;750

REMARK:ADDRESS NOT KNOWN
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EMPLOYEE DAILY:12/13/99;10.00;0.00;15;0.00;0.00

EMPLOYEE DAILY:12/14/99;10.00;0.00;15;0.00;0.00

EMPLOYEE DAILY:12/15/99;10.00;0.00;15;0.00;0.00

EMPLOYEE DAILY:12/16/99;10.00;0.00;15;0.00;0.00

EMPLOYEE DAILY:12/17/99;10.00;0.00;15;0.00;0.00
EMPLOYEE:248116767,TERRY CRANE;F;01;;POWD;UNN;25;40;500
DEDUCTION:EDUC;25

EMPLOYEE:248558812;CHRIS SULLIVAN;M;02;;POWC;UNN;;40;425

The Employee and Employee Daily Rec Types are not required to store a payroll, but if they are
supplied, all the associated fields must be completed.

The user may leave the Total Hours and Gross Amount records empty or enter a valid sum.
Otherwise, the user may enter values that are greater than or equal to zero for the Total Hours and
Gross Amount.

The user may leave the Deduction records empty or enter the sum of the itemized deductions (if
applicable). Otherwise, the user may enter a value that is greater than or equal to zero for the
Deductions Amount.

Note: Address, Remarks and Deductions are not required. Only one address may be
entered for each Employee Name/SSN combination. When adding an existing employee
and new address, SiteManager updates the employee’s old address.

B Contoctor Payol Load
ContractiD: II:'I 0veEs

Yendor ID |Vendul Mame Payroll Ending Dal

0 | »

[~ Prompt for Messages

Figure 6-15. The Contractor Payroll Load Window
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Field Name Description
Vendor ID The transportation agency-assigned ID of the vendor
Vendor Name Full name of the vendor

Payroll Ending Date The end of the payroll period

Files to be Uploaded The name of the electronic payroll file which needs to be
uploaded

Prompt for Messages | A check box that is selected if the user wants to be prompted
for informational and warning messages

To select payroll files to upload:

1.

> W

8.
9.

On the Contractor Management panel, double-click the Contractor Payroll Load icon.
The Payroll Load window opens.

In the Select Contract list box, scroll to and double-click the contract.
Select the Prompt for Messages check box (ON).
Click the Services menu and click the Select Another choice.

In the Select File for Payroll window, select a payroll file and click OK. The preprocessing
validation results are displayed.

Click OK.
To select another payroll file, repeat Steps 4 through 6.
Click the Save button. A message says Mail sent.

Click OK.

The preprocessing validation messages are displayed only when the Prompt for Messages check box
is selected (ON).

6.8 Document Submission

The Document Submission window lets the user track documents that have been submitted for
approval or resolution. Examples include drawings, catalog cuts, changes to traffic control plans,
EEO reports, and complaints from the public. The user can enter or view the document type, the
document category, the submission date, the submitter’s name, and a document description. The
user can modify or delete a record only if there are no reviewers assigned to the document.
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To begin the review process, the user selects one or more reviewers. The reviewer receives an In-
Box notification that the document is ready for review. After reviewing the document, the reviewer
records his recommendation on the Review Submitted Document window. A recommendation
cannot be modified after it is saved, but a reviewer can add another recommendation. A new
tracking record is created for every new recommendation. The user can track the document reviews
in the bottom datawindow of the Document Submission window.

6.8.1 Checklist Event Documents

Some documents are entered in the system as Checklist Scheduled Events with projected due dates.
A daily process, Monitor Contract Status, looks for Checklist Event documents that are due from
external sources. The process creates document submission records to track the date the document is
received. When the user records the submission of such a document on the Document Submission
window, the date is also added to the Checklist Event Dates window for the corresponding event
date. For more information, refer to the Checklist Scheduled Event topic.

¥ Document Submission M=l E3
Contract ID: [SITEMGR_30 Document Serial No: |‘I -
Submitted By: [DOT On: [05/31/33
Document Type: Ilnspeclion Feport Document Category: |
Description: =
- -
Reviewer Review  Recommendation Hemarks ﬂ
Date
Project Manager 1 00700400 Pending

Figure 6-16. The Document Submission Window

Field Name Description

Contract ID Transportation agency-defined ID of the contract
associated with the submitted document.

Document Serial No | Serial number assigned to the submitted document by the
system.

Submitted By Name of the person submitting the document.
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Field Name Description
On Date on which the document was submitted. Cannot be
after the current date. Cannot be changed after the record
is saved.
Document Type Transportation agency-defined code for the type of the

submitted document.

Document Category | Transportation agency-defined category of
correspondence for the submitted document (used for
retrieval and analysis).

Description Description of the submitted document.

Reviewer Name of the reviewer of the submitted document. This
field is display only.

Review Date Date of review of the submitted document. This field is
display only.

Recommendation Recommendation given by the person who reviewed the
submitted document (Approved or Denied). This field is
display only.

Remarks Remarks given by the person who reviewed the

submitted document. This field is display only.

Table 6-17. The Document Submission Window Fields Table

To add a document submission record:

> w
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On the Contractor Management panel, double-click the Document Submission icon.
Click the Services menu and click the Choose Key choice. The Select Contract list opens.
In the Select Contract list box, scroll to and click the contract ID.

Click OK.

In the Submitted By field, type the name of the person submitting the document.

Press the Tab key.

In the On field, type the date on which the document was submitted.

In the Document Type drop-down list, click the expand arrow and click the document type.
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9.

10.
11.
12.

In the Document Category drop-down list, click the expand arrow and click the document
category.

Press the Tab key.
In the Description field, type a description of the document.

Click the Save button.

To assign a document reviewer:

1.
2.

10.
11.
12.
13.

On the Contractor Management panel, double-click the Document Submission icon.

Click the Open button. The Document Submission Select window opens. The Select
Contract list is displayed.

In the Select Contract list box, scroll to and double-click the contract ID.
In the Submitted Document list box, scroll to and click the document.

Click OK. The Document Submission window displays information about the submitted
document.

Click the Services menu and click the Forward to choice.

In the Forward to Selected Users list box, scroll to and click the reviewer.
Click OK.

Click the Save button.

A message says Mail sent.

Click OK.

To select another reviewer, repeat Steps 6 through 9.

Each reviewer is listed in the bottom datawindow with a Pending recommendation.

After reviewers are assigned, the record cannot be deleted.

To modify a document submission record:

1.
2.

On the Contractor Management panel, double-click the Document Submission icon.

Click the Open button. The Document Submission Select window opens. The Select
Contract list is displayed.

In the Select Contract list box, scroll to and double-click the contract ID.
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4.
S.

In the Submitted Document list box, scroll to and click the document.

Click OK. The Document Submission window displays information about the submitted
document.

Modify data as needed.

Click the Save button.

6.9 Document Submission Review

The Document Submission Review window lets the user enter recommendations for a submitted
document. To access this window, the user must be one of the reviewers assigned to review the
document. When a submitted document is forwarded for review, the system notifies all reviewers by

In-Box message that the document is ready for review.

The top datawindow displays the document type, document category, submission date, name of the
submitter, and document description. The reviewer adds a recommendation in the bottom
datawindow. The three valid choices are Approved, Approved as Noted, and Denied. The reviewer
can add comments in the Remarks field. A recommendation cannot be changed or deleted after it is
saved, but the reviewer can add another recommendation. A new record is created for each new

recommendation.
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Contract ID: |SITEMGR_30 Document Senal No: |1 ﬂ
Submitted By: [DOT On: [05/31/99

Document Type: ||nspection Report Document Category:

Description: -

=

Name: [Project Manager 1 Date: [05/31/33 =

Recommendation: Remarks: ZI

™ Approved As Moted
i~ Approved

Figure 6-17. The Document Submission Review Window

Field Name Description

Contract ID Transportation agency-defined ID of the contract

associated with the submitted document.

6.9 Document Submission Review
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Field Name Description

Document Serial No | Serial number assigned to the submitted document by the

system.

Submitted By Name of the person submitting the document. This field
is display only.

On Date on which the document was submitted. This field is
display only.

Document Type Transportation agency-defined code for the type of the

submitted document. This field is display only.

Document Category | Transportation agency-defined category of
correspondence for the submitted document. This field is

display only.

Description Description of the submitted document. This field is
display only.

Name Name of the reviewer of the submitted document. This

field is display only.

Date Date of the review of the submitted document. Cannot be
after the current date. This field is display only.

Recommendation Recommendation given by the person who is reviewing
the submitted document. Can be Approved, Approved as
Noted, or Denied.

Remarks Comments that the reviewer adds to the recommendation
for the submitted document.

Table 6-18. The Document Submission Review Window Fields Table

To add a review record for a submitted document:

1.
2.

Receive notification by In-Box message that the document is ready for review.
Review the document, which could be either hard copy or soft copy.

On the Contractor Management panel, double-click the Document Submission Review
icon. The Documents Submitted Select window opens.

In the Select Contract list box, scroll to and double-click the contract ID.

In the Submitted Document list box, scroll to and click the document.
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6. Click OK. The Document Submission Review window displays information about the
submitted document.

7. In the Recommendation area, click the Approved, Approved As Noted, or Denied radio
button.

8. Inthe Remarks field, type comments to add to the review.
9. Click the Save button.
10. To add another review, click the New button and repeat Steps 7 through 9.

The reviews are displayed as view only on the Document Submission window.

6.10 Contractor Evaluation

The Contractor Evaluation window lets the user rate the contract’s prime contractor and
subcontractors. The user can add, modify, or delete a contractor evaluation. The user can specify
the period of time for which the contractor is being evaluated or give a final rating for the entire
contract. The window lists all contractors for the selected contract, with the prime contractor listed
first. Evaluation data for the selected contractor is displayed below the list.

[ Coniracton Evabantion 1SS o |
Contract ID:  |C10735

Vendor ID Contractor Rating | Evaluation Date Evaluator
Ad CONSTRUCTION CO. en 06/13/01 System Administrator 1

< | i
Evaluation Date: |06/13/01 Contractor: [44 CONSTRUCTION CO. Rating: |
Evaluator: [System Administrator 1
ion Periodl
’—‘ Beagin Date: [01/01/01 End Date: [01/02/01 | [Cortract Evaluated Ind: [V

Work Description: [111

Figure 6-18. The Contractor Evaluation Window

Field Name Description
Vendor ID Transportation agency-defined VVendor ID of the
contractor.
Contractor Short name of the contractor. Selected from a list of
Vendors approved to work on the contract. Thisisa
required field.
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Field Name Description
Rating Numeric rating assigned to the contractor evaluation.

This is a required field.

Documents External reference documents attached to the evaluation
record.
Evaluation Date Date of the contractor evaluation. Defaults to the current

date. This is a required field.

Evaluator User ID of the person entering the contractor evaluation.
Defaults to the current User ID.

Evaluation Period Beginning date of the evaluation period of the contractor
Begin Date evaluation. This is a required field.

Evaluation Period End date of the evaluation period of the contractor
End Date evaluation. This is a required field.

Contract Evaluated | Indicates that the evaluation is for the entire contract
Ind period.

Work Description Description of the work for which the contractor is
evaluated.

Table 6-19. The Contractor Evaluation Window Fields Table

To add a contractor evaluation:

1.

On the Contractor Management panel, double-click the Contractor Evaluation icon. The
Contract Select window opens.

In the Contract ID list box, scroll to and double-click the contract.
Click the New button. An empty row is added to the list of evaluations.
In the Evaluation Date field, type the date of the evaluation.

In the Contractor drop-down list, click the expand arrow and click the name of the evaluated
contractor or subcontractor.

Press the Tab key.
In the Rating field, select the current entry and type a numerical rating of the contractor.
Press the Tab key.

In the Evaluation Period Begin Date field, type the beginning date of the evaluation period.
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10. Press the Tab key.
11. In the Evaluation Period End Date field, type the ending date of the evaluation period.

12. To indicate that this evaluation applies to the entire contract, select the Contract Evaluated
Ind check box (ON).

13. Press the Tab key.

14. In the Work Description field, type a description of the work for which this contractor is
being evaluated.

15. Click the Save button.

6.11 Contract Completion

The contract completion procedure includes any activity related to changing the contract status from
active to complete. The general procedure described here can be adapted to the specific needs of the
transportation agency.

The procedure typically begins after the physical work is done and the Item final quantities have
been approved. When the user enters the Contract Items Complete Date, the system notifies contract
personnel that it is time to complete the contract. At this point, the user looks for any contract data
that would prevent final estimate generation or approval. After all required data is entered and all
discrepancies are resolved, the final estimate can be generated and approved. After the final
estimate is approved, the contract status can be changed to complete.

There are several SiteManager reports that can be used to track data during the completion
procedure. The user can run these reports to make sure that all required data has been entered, or to
find data that causes a discrepancy. The following reports are particularly helpful:

= Contract Status Report

= |tem Quantity Report

= Change Order Report

= Required Documents Report

= Dispute/Claim Report

6.11.1 Contract Items Complete Date Requirements

Entering the Contract Items Complete Date begins the contract completion procedure. Before
entering this date, the user should verify the following:
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= Final quantities have been approved for any Items that need a Final Quantity Change Order.
Otherwise, the system enters the Item final quantities.

= All Change Orders are either approved or not approved. If there are any pending or draft
Change Orders, the date cannot be saved.

Final quantities are normally determined at the end of the contract. Before completion, the user can
generate Final Quantity Change Orders to approve final quantities. When the Contract Items
Complete Date is entered, any Item that has not had a final quantity approved on a Change Order is
automatically assigned a final quantity by the system. The user can run an Item Quantity report to
find out which contract items have approved final quantities and which Items do not. If the
contractor must agree on the final quantities, the report can be sent to the contractor.

Some contract items include Stockpiled Materials. During completion, any Stockpiled Materials
with a balance remaining on the contract must have the balance closed (i.e., changed to zero).

The remaining quantity of the Stockpiled Material can be transferred to another contract.
After the Contract Items Complete date is saved, the system does the following:
= Notifies all Level 1 personnel

= Notifies the Project Manager and Project Engineer that Contract Authority should be end-
dated for personnel no longer working on the contract.

= Automatically assigns final quantities and changes status to Final for any Item that does not
have a final quantity approved on a Change Order.

6.11.2 Final Estimate Requirements

Typically, the final estimate is generated after the Contract Items Complete Date is entered. To
generate the final estimate, the following criteria must be met:

= All progress estimates must be approved

The transportation agency defines the requirements for final estimate approval. Discrepancies
cannot be overridden during the processing of the final estimate. This means that all discrepancies
must be resolved before the final estimate is approved. As a part of the completion process, the user
can search for contract data that the estimate process would identify as a discrepancy. Discrepancies
can include:

= Contractor payrolls missing or not certified (if payrolls are required)
= Material sampling incomplete
= Checklist Events incomplete

= DBE compliance criteria not met
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= Item overruns
= Contract Completion date missed

= Milestone Completion date missed

Required Documents

Required documents are the documents that have been identified on the Checklist Event schedule as
Required to Finalize. SiteManager provides a Required Documents report that lists a contract’s
current document requirements. As a part of the completion process, the user can run a Required
Documents report on external document requirements and send it to the contractor who submits the
documents. This reminds the contractor to submit any documents that are required for completion.
The user can also run a Required Documents report on internal documents, which are produced by
the transportation agency.

Required Actual Dates

The transportation agency identifies some Critical Dates and Key Dates as requirements for the
completion of the contract. This begins with the Contract Items Complete Date and generally
includes audit dates, review dates, the final Federal voucher date (for Federal jobs), and the date the
final estimate is paid. SiteManager performs a daily batch process that monitors contract status and
notifies the Project Manager when specific dates have not been entered as required. This tells the
Project Manager which dates need to be entered before the contract can be completed. To track the
status of the required dates, the Project Manager can view the following contract Records panels:

= Contract Critical Dates folder tab
= Key Dates window

= Checklist Event Dates window

6.11.3 Complete Status Requirements

After the final estimate is approved, the user can change the contract’s status from active to
complete. To save this status change, the following criteria must be met:

= Critical Dates, Key Dates, and Checklist Event Dates marked Required to Finalize must be
entered

= Items must have approved final quantities
= Change Orders must be approved or not approved (none pending or draft)
= Disputes, and claims must be resolved

= Stockpiled Material balances must be zero
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= The final estimate must be approved

Most of these requirements are already met in preparation for the final estimate. If the system does
not accept the status change, it displays error messages that identify the type of data that did not
meet the validation criteria (e.g., Change Order). The user can run reports or look at the appropriate
SiteManager windows to pinpoint the data that prevented the status change.

When the contract status is changed to complete, the system performs the following tasks:

= Automatically end-dates Contract Authority for all users except for the Project Manager and
Project Engineer and personnel with Global Contract Access and Update rights.

= Marks the contract To Be Sent to DSS. Any contract that is marked To Be Sent to DSS is
sent automatically by a daily batch process.

6.12 DSS Contracts

The DSS Contracts window lets the user select or deselect a contract to be sent to the Decision
Support System (DSS). A batch process creates flat files for all contracts marked To Be Sent to DSS
and loads the contract data to the flat files. The system enters the date the contract is loaded to a flat
file as the contract’s DSS Last Sent Date. When a contract’s status is changed to complete, the
system selects it to be sent to DSS automatically.

Contract ID |Send| SentDt | Vend Id Yend Name Fed, ~

Y |00/00/0000(0074 A4 CONSTRUCTION CO
C13255 N 1000040000/ 0054 A %5 CONSTRUCTION CO. AND AFFILIATED COMPANIES |NH 2
13298 N 10040040000/ 0054 A %S CONSTRUCTION CO. AND AFFILIATED COMPANIES |C 66E
C13330 M 004000000/ 0054 A %S CONSTRUCTION CO. AND AFFILIATED COMPANIES |MC 3
C13437 N |00/00/0000| 0054 A %S CONSTRUCTION CO. AND AFFILIATED COMPANIES |STA -
C12270 N |00/00/0000|0714 AMES CONSTRUCTION INCORPORATED NHB
test M |00/00/0000|0114 AMES CONSTRUCTION INCORPORATED 0o
C1203 M |00/00/0000|0174 ASPHALT PAVING CO. MNH 4
13211 N |00/00/0000|0174 ASPHALT PAVING CO. STA”
C13350 00/00/0000/0228 AGGREGATE INDUSTRIES -WCR, INC. STA I
C10028 M |08/27/1396|0324 BRANMAN SAND AND GRAVEL COMPANY CCC
4 »

Send to DSS: [
DSS Last Sent Date: lm

Figure 6-19. The DSS Contracts Window

Field Name Description
Lv2 Ofc Contract’s Level 2 office.
Lv3 Ofc Contract’s Level 3 office.
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Field Name

Description

Lv4 Ofc

Contract’s Level 4 office.

Contract ID

Transportation agency-defined ID for the contract.

Vend ID Transportation agency-defined Vendor ID for the
contract’s prime contractor.
Vend Name Full name of the Vendor.

Fed St/Prov Prj Nbr

Federal, state, or province Project Number that identifies
the contract.

Status Current status of the contract (e.g., Pending, Active,
Finalization, Complete, Archived).
Cnty Contract’s primary county. The county in which most of

the work will be performed.

Location Description

Description of the contract’s work location. Describes
where the work in being done.

Send Indicates whether (Y or N) a contract is to be sent to
DSS.

Sent Dt Date the contract was last loaded to DSS.

Send to DSS Indicates whether a contract is to be sent to DSS.

DSS Last Sent Date

Date the contract was last loaded to DSS.

Table 6-20. The DSS Contracts Window Fields Table

To select a contract to be sent to DSS:

1.

4.

On the Contract Records panel, double-click the DSS Contracts icon. The DSS Contracts

window opens.

In the Contract list box, scroll to and click the contract ID.

Select the Send to DSS check box (ON). The value in the Send column changes from N to

Y.

Click the Save button.

When a contract’s status is changed to complete, the system selects it to be sent to DSS
automatically.
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To deselect a contract to be sent to DSS:

1.

6.13 Reports (Contract Administration)

AASHTOWare Project SiteManager
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On the Contract Records panel, double-click the DSS Contracts icon. The DSS Contracts

window opens.

In the Contract list box, scroll to and click the contract ID.

Click the Send to DSS check box (OFF). The value in the Send column changes from Y to

N.

Click the Save button.

The Contract Administration Reports panel generates commonly used contract reports. The

following report topics are available on this panel:

Contract Status

Required Documents

Item Quantity

Item Work

Contract Dispute/Claim
Subcontract Value

Contractor Current Status
Contractor Behind Schedule
Past History - Work Completion
Past History - Claims

View Saved Reports (PSR)

6-59



AASHTOWare Project SiteManager
6. Contract Administration - Maintenance

E SiteM anager Panel

6.13 Reports (Contract Administration)

Schedule

=
REPORTS

Main Panel T Contract Administration(+] T Reports [CA+]
4] 7
i~ | =
Contract Status ISR Item Quantity Item Work. Dispute/Claim  Subcontract Contractor
Documents Report Summary Value Current Status

Contractor

Past

Past

Yiew Saved

Behind
Schedule

Historp-\work
Completion

History-Claims ~ Reports [FSR)

Figure 6-20. The Reports (CA) Panel
To access Contract Administration Reports:
1. On the Contract Administration panel, double-click the Reports (CA) icon.
2. Double-click the icon for the report.

For more report details, please see the Reports section in Chapter 3.

6.13.1 Contract Status Report

The Contract Status Report window lets the user generate a contract status report consisting of a
report header, the contract critical dates, the percentage of work complete by time and dollars, the
current contract amounts, and a Project breakdown. The current contract amounts include values
from approved estimates; pending estimates are not included.

The Contract Status Report displays information on contracts with a status of Active or Pending,
unless the user specifically selects an Archived or Complete contract through the contract ID field on
the report criteria window. In all other instances, a filter is applied to the report so that only Active
and Pending contracts are displayed.
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[Econtactstates | [ L

Zoom: [{00 -l Copies: |1 - |

RPT ID : RCACONST
USER ID : 5Y51

Contract ID: C10736
Vendor ID: 4174

Region: 4

Bid Days: 130
Adjusted Days: 25.0

<

By Contract

VYendor Name: PCL ClVIL CONSTRUCTORS, INC.
Location : WEST OF JULESBURG
County: SEDGEWICK

Work Type: BRIDGE REPLACEMENT

Schedule Type: Percent Complete for a Time Period

Date:  06/22/2001
Page: 1af1

State of Testing
Department of Transportation

CONTRACT STATUS REPORT

Fed State Project Number: C 1324-006

Current Status:  Active

Residency: 340
Time Charges Type: Available Work Days
Retainage Pct: 0

Current Days: 205
Charged Days: 1338

Remaining Days: 17
Pct Cmplt(Time): 31.71

Figure 6-21. The Contract Status Report Window

Field Name Description
Rpt ID Report ID number.
Date Date the report was run.
User ID Transportation agency-defined 1D of the user running

the report.

Contract ID

Transportation agency-defined ID for the contact.

Fed/State Project
Nbr

The federal or state Project number for the contract.

Vendor ID

Transportation agency-defined Vendor ID of the
contract’s prime contractor.

Current Status

Current status of the contract.

Location

Text describing the physical location of the work.

County

Primary county where most of the contract work is
done.

Level 2 Office
(user-defined label)

Office number for the Level 2 office responsible for
administering the contract.

6. Contract Administration - Maintenance
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Field Name

Description

Level 3 Office

(user-defined label)

Office number for the Level 3 office responsible for
administering the contract. If there are only two office
levels, this field will not report.

Level 4 Office

(user-defined label)

Office number for the Level 4 office responsible for
administering the contract. If there are only two or three
office levels, this field will not report.

Work Type

Transportation agency-defined code to identify the
major type of work being done on the contract.

Time Charges Type

How time charges are assessed for the contract. Can be
Work Days, Calendar Days, or Fixed Completion Date.

Schedule Type

The type of progress schedule used for the contract.
Can be Percent Complete for a Time Period, Percent of
Critical Items Complete for a Time Period, or Critical
Path Method. If Critical Path Method, no schedule is
held on SiteManager.

Retainage Pct

Current percentage required to be retained for the
contract.

Bid Days

Original number of work days or calendar days of the
awarded contract.

Current Days

Total current number of work days or calendar days of
the contract. Calculated: bid days + adjusted days

Remaining Days

Total current number of work days or calendar days
available for construction. Calculated: current days -
charged days

Adjusted Days

Total positive or negative number of work days or
calendar days added or removed from the contract by
Change Orders. Sum of adjusted days on all approved
contract time extension Change Orders.

Charged Days

Total number of days worked recorded on the daily
work reports. Sum total of days worked recorded on the
daily work reports.

6.13 Reports (Contract Administration)




6.13 Reports (Contract Administration)

AASHTOWare Project SiteManager

Field Name

Description

Pct Cmpl (Time)

Work completion percentage by time. For Work Days
and Calendar Days: (charged days / current days) * 100.
For Fixed Date: (current date - notice to proceed date) /
(current estimated date - notice to proceed date) * 100.

Date Let

Date the proposal for the contract was let.

Open to Traffic

Date the road construction area was open to traffic.

Original Completion

Contract’s original (bid) estimated completion date.

Notice to Proceed

Date the contractor was given notice to proceed with the
work.

Work Complete

Date the contract’s physical work was completed.

Extension Date

Date the contract’s current completion date is extended
to.

Work Began

Date the contractor actually began work on the contract.

Substantial Cmplete

Date the contract’s physical work was substantially
completed.

Current Completion

The current estimated date the contract’s physical work
is/was expected to be completed. For completed
contract this is the last estimated completion date.

Current Contract Amounts

Bid

Sum of all the contract’s Item dollar amounts. ltem
dollar amount is the contract item’s bid quantity times
the unit price. Calculated once at contract activation
time and then stored.

Approved CO

Contract’s net CO amount. The amount of the
contract’s approved Change Orders.

Current Total current amount for the contract. Bid amount +
approved CO amount.

Pend CO Contract’s pending CO amount. The amount of the
contract’s unapproved Change Orders.

Anticipated Anticipated or expected amount for the contract.

Current amount + pending CO amount.

6. Contract Administration - Maintenance

6-63



AASHTOWare Project SiteManager

6. Contract Administration - Maintenance 6.13 Reports (Contract Administration)
Field Name Description
Pos Adjmnt Total of the contract’s positive contract and line Item

adjustments. The sum of the contract’s positive contract
adjustments and line Item adjustments amounts.

Installed Total dollar amount for all contract items installed to
date. Calculated sum of all the contract items’ installed
amounts.

Over/Under Total current amount of contract over/under runs.

Installed amount minus current amount for contracts
with complete status.

Paid to Date Total amount paid to date for the contract. If latest
contract estimate status = paid, then paid to date =
previous amount paid + current amount paid, else paid
to date = previous amount paid

Pend Paid Amount allocated for payment but not actually paid to
the contractor. Does not include amounts for estimates
which do not meet the minimum amount required for
payment.

Remaining Amount of work remaining on the contract. Current
amount - installed amount.

Neg Adjmnt Total of the contract’s negative contract and line Item
adjustments. The sum of the contract’s negative
contract adjustments and line Item adjustments amounts.

Lig Damages Total liquidated damages assessed to the prime
contractor. If latest contract estimate status = paid, then
total liquidated damages = (previous Project liquidated
damages + current Project liquidated damages) summed
for all Projects, else total liquidated damages = sum of
all the Project previous liquidated damages

Subcontract Total amount of all contract’s Subcontracts. Sum of all
the contract’s Subcontract amounts.
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Field Name

Description

Total Retainage

Total of all retainage for the contract. If latest contract
estimate status = paid, then total retainage = (previous
partic retainage + current partic retainage + previous
non-partic retainage + current non-partic retainage)
summed for all Projects + contract (previous total
escrow amt + current escrow amt + previous total
securities used amt + current securities used amt), else
total retainage = (previous partic retainage + previous
non-partic retainage) summed for all Projects + contract
(previous total escrow amt + previous total securities
used amt)

Paymnt Retain

Total of all payment (cash) retainage for the contract. If
latest contract estimate status = paid, then total cash
retainage = (previous partic retainage + current partic
retainage + previous non-partic retainage + current non-
partic retainage) summed for all Projects, else total cash
retainage = (previous partic retainage + previous non-
partic retainage) summed for all Projects

Securities Ret

Total of all securities encumbered for the contract. If
latest contract estimate status = paid, then total
securities retained = contract (previous total securities
used amt + current securities used amt), else total
securities retained = contract previous total securities
used amt

Escrow Retain

Total of all escrow retainage for the contract. If latest
contract estimate status = paid, then total escrow
retained = contract (previous total escrow amt + current
escrow amt), else total escrow retained = contract
previous total escrow amt

Current Project Breakdown

Project ID

Project number for a contract Project.

Bid Amount

Sum of the Project’s Item dollar amounts. Item dollar
amount is the item’s bid quantity times the unit price.
This value is calculated when the contract is activated.

Approved CO Amt

Sum of the Project’s approved Change Order dollar
amounts.

6. Contract Administration - Maintenance
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Field Name Description
Installed Amount Total dollar amount for all Project Items installed to
date.
Pct Cmplt($) The Project’s percent completion calculated from dollar
amounts. Installed Amount/(Bid Amount + Approved
CO Amt).

Table 6-21. The Contract Status Report Window Fields Table

6.13.2 Contract Dispute/Claim Report

The Contract Dispute/Claim report lists all of the disputes and claims that are found in the database
based on user-selected criteria. This report can be generated for a contract, prime contractor, dispute
category, or for all disputes.

=4 Dispute / Claim Summary _m
Zoom: |1l]l] -l Copies: |1 - |

RPT-ID: RCADISFR State of Testing j
USER : 5YS1 Department of Transportation

Prime 7 Subcontractor 1D Dispute/Claim Summary Report

Contract ID Dispute ID Type/ Requested/Settled Resolution Received Log Diary Diary A
Subcontractor Name /Category Status  Amount and Days Heason Date Date Start Dt End Dt

0BG 1 D $1.000.00 0 0z2/01/01  05/08/01  00/00400  00/00/00
10735 03 A $0.00 0

CONCRETE W0ORES OF COLORADD INCORPORATED

1| LA

Figure 6-22. The Contract Dispute/Claim Report Window

Field Name Description

Report Criteria

Generate Report By | Report selection criteria (i.e., Contract, Prime Contractor,
Dispute Category, All Disputes). This is a required field.

Contract ID Transportation agency-defined ID for the contract. The
user can search this field.

Prime Contractor Transportation agency-defined VVendor ID for the prime
ID contractor. This is the prime contractor who filed the
dispute or claim. The user can search this field.
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Field Name Description

Dispute Category Transportation agency-defined category of disputes or
claims based on the nature of the dispute or claim (e.g.,
material, utility, time).

Dispute/Claim Report

Contract ID Transportation agency-defined ID for the contract.

Prime Contractor Transportation agency-defined Vendor ID for a prime
ID contractor. This is the prime contractor who filed the
dispute or claim.

Subcontractor ID Transportation agency-defined Vendor ID for the
subcontractor. This is the subcontractor where the
dispute or claim possibly originated.

Dispute ID System-generated ID for a specific dispute or claim
within a contract.

Dispute Category Transportation agency-defined category of disputes or
claims based on the nature of the dispute or claim (e.g.,
material, utility, time).

Type Identifies whether this is a Dispute (D) or a Claim (C).

Status Identifies the current status of this dispute or claim
record (i.e., Received, Logged, Open, Denied, Rescinded,
Resolved, Closed).

Requested Amount | The dollar amount requested by the contractor.

Settled Amount Amount settled for the dispute or claim.
Requested Days Number of days requested by the contractor.
Settled Days Number of days settled for the dispute or claim.
Received Date Date the dispute or claim was received by the

transportation agency.

Log Date Date the dispute or claim was entered into SiteManager.
Accepted Date Date the resolution was accepted by the contractor.
FHWA Con. Dt Date the FHWA concurred with the resolution.
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Field Name Description
Diary Start Dt Starting date of a range of diaries pertaining to the
dispute or claim.
Diary End Dt Ending date of a range of diaries pertaining to the dispute
or claim.
Payment Date Date the payment was released for this dispute or claim.
Resolved Date System date the discrepancy was resolved or overridden,

or the date a final resolution was reached by the
transportation agency.

Resolution Reason Resolution reason type that identifies how the dispute or
claim was resolved. Both the type and the description
are printed on the report.

Table 6-22. The Contract Dispute/Claim Report Fields Table

6.13.3 Item Quantity Report

The Item Quantity Report lists all contract item quantities that are found in the database based on
user-selected criteria. This report can be generated on all contract items (i.e., Original, Change
Order, Current, Installed, Paid, Final). The Items are grouped by Item Code and Project Number.
An Item cost summary is displayed for each group.

ﬂltem Quantity : _)Q
Zoom: ;1l]l] ﬁ! Copies: 11 ‘-:-é !
4
RPT-ID: RCAITQTY State of Testing DATE: 671172002
USER: 5Y51 Dep of T p PAGE: 1 of 24
Contract ID: C10785 ITEM QUANTITY REPORT
Line  Status Bid Unit Original NetC O  Qty Instl  Qty Paid Final Final
Nbr  Type Quantity Price Amt Aty ToDate ToDate Quantity Amount
Project Number: -~ 10785-BI0
Itm Cd: 163-0010 Description - TEMPORARY GRASS - Unit Type: M
Supp Descl
Supp Desc2
1 Active 000 - 40000000 0.00 1.000 0.000 0.000 0.000 0.000
Project Totals Original Amount: 0.00 Final Amount: 0.oa0
Itm Cd: 202-00240 Description : Remaval of Asphalt Mat [Planing) Unit Type: E
Supp Descl: supplemental description added by Sonya Dooley in March 2002
Supp Desc2 line 2 suppl description added by Sonwa Dacley in March 2002 =
4 | v 4

Figure 6-23. The Item Quantity Report Window
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Field Name Description

Report Criteria

Contract ID Transportation agency-defined ID for the contract. The
user can search this field.

Status Identifies the current status of the contract item (i.e.,
Audit, Final, Complete, Pending, None).

All Item Status Indicates that all Items will be printed on the report
regardless of status.

Item Quantity Report

Line Item The Contract Line Item number that identifies each Item
as it appears on the contract. For all bid Items, the Line
Item number is assigned by the Pre-construction
function. For all Items added to the contract after
construction begins, the Line Item number is user-

entered.

Item Code Transportation agency-defined code that identifies the
Item.

Description Short description of the Item.

Unit The unit of measure for the Item (e.g., cubic foot, gallon,
sguare yards, acre).

Unit Price Unit price of the Item from the invoice.

Status Type Identifies the current status of the Item (i.e., Audit, Final,
Complete, Pending, None).

Bid Qty The bid quantity on the selected line item.

Original Qty Quantity of the Item as indicated on the proposal or
contract.

Original Amt Original Qty multiplied by Unit Price.

Project Nbr Transportation agency-defined 1D for a Project within the
contract.

CO Qty The net change to the Item quantity from all approved
Change Orders.
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Field Name Description

Current Qty Sum of Original Qty plus CO Qty.

Installed Qty Total of all quantities installed for this Item prior to the
last paid estimate.

Over/under Installed Qty minus Current Qty.

Paid Qty Total of all quantities paid for this Item prior to the last
paid estimate.

Final Qty The final quantity for the Item in the contract.

Final Amt Final Qty multiplied by Unit Price.

Supp Description 1

This field contains a textual description that is
supplemental to the item's description and may be
required by the transportation agency.

Supp Description 2

This field contains a secondary textual description that is
supplemental to the item's description and may be
required by the transportation agency.

Qty Reported to
Date

The total of all reported quantities on DWRs, regardless
of whether the quantities are authorized or unauthorized
and regardless of whether they are included on an
estimate.

Qty Authorized to
Date

The total of all reported quantities on DWRs that are
authorized.

Qty Installed to
Date

The total of all reported authorized reported quantities
included on estimates (of all statuses).

Qty Paid to Date

The total of all authorized reported quantities included on
estimates (of all statuses). This value is always the same
as Qty Installed to Date unless the quantity to pay has
been adjusted on the Estimate Item Detail window. This
window includes a Pay This Est field which can be
modified when an estimate is pending. If the quantity in
this field is adjusted, the Qty Paid to Date field reflects
the modification, which causes the value to differ from
the Qty Installed to Date.

Table 6-23. The Item Quantity Report Fields Table
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6.13.4 Item Work Report

The Item Work Report lists all of the contract item work records found in the database based on
user-selected criteria. This report displays the original bid quantity, current quantity, and installed
quantity of the selected Item. The data is grouped according to the Item Code and Project Number.
The bid quantity, current quantity, and installed quantity of Items is summarized for each group.

B3 1tem Work Report x|
Zoom: ;h 11} ‘-3-11 i Copies: ;1 -s-i i
RPT-ID: RCAITWRE State of Testing DATE: 06/11/2002
USER: 551 Department of Transportation PAGE: 10of1
CONTRACT ITEM WORK REPORT
Contract ID: C10028 Federal/5tate Project Mbr: CC C100-002
Location: “&RI0OUS LOCATIONS
‘Work Type: MaJOR SURFACE TREATMENT Route Mbr:
Contractor: 0324 BRANNAN SAND AMD GRAVEL COMPAI
Project Humber: 10028-EI1D Bid Qty: 0.00 Current Gty: 7.00
Qty Reported: 7.00 Authorized Oty: 7.00 Installed Qty: 7.00
DWH . .
Line Number DWR Date Inspector DWR Qty  Appr. From Station To Station
Item Code: 408-01000 - Item Description: Hot Joint-Crack Sealant Unit: E
Supp Desc 1: MCR 01-2 HOT POURED JOIMNT-CRACK SEALANT
Supp Desc 2: [wAS REF MO 0095 IM CAS]
003e 08/03/41993 - CASCONW ooy 1] 1} 1] 0
Nt Banntad Ta MNata: 700 Nia Avbhorizad To Nata- 700 Nt Inetallad Ta Nata- 700 i
3| | bl

Figure 6-24. The Item Work Report Window

Field Name Description

Report Criteria

Contract ID Transportation agency-defined ID for the contract. The

user can search this field.

Project Nbr Transportation agency-defined ID for a Project within the
contract.
Item Code Transportation agency-defined code that identifies the

Item.

Item Work Report

Contract ID Transportation agency-defined ID for the contract.

Fed/State Project
Nbr

The federal or state Project number for the contract.
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Field Name Description
Location Description of the physical location of the contract work.
Work Type Transportation agency-defined code that identifies the

major type of work (e.g., road, bridge work,
beautification).

Route Nbr The route number of the affected road.

Contractor Transportation agency-defined Vendor ID for the
contractor.

Item Code Transportation agency-defined code that identifies the
Item.

Item Description Short description of the Item.

Supp Description 1 | This field contains a textual description that is
supplemental to the item's description and may be
required by the transportation agency.

Supp Description 2 | This field contains a secondary textual description that is
supplemental to the item's description and may be
required by the transportation agency.

Unit Unit of measure for the Item (e.g., cubic foot, gallon,
square yards, acre).

Project Nbr Transportation agency-defined ID for a Project within the
contract.

Bid Qty Quantity of the Item as indicated on the proposal or
contract.

Current Qty Sum of the net approved change order plus the bid
quantity

Installed Qty Total of all quantities installed for this Item prior to the

last paid estimate.

Line Item Nbr Contract Line Item number that uniquely identifies each
Item as it appears on the contract. For all bid Items, the
number is assigned by the Pre-construction function. For
all Items added to the contract after construction begins,
the number is user-entered.

DWR Date Date the Daily Work Report was created.
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Field Name Description
Inspector The user who wrote the Daily Work Report.
DWR Approved Flag indicating if the DWR or Diary has been approved
by the Project Manager.
DWR Qty The quantity installed on the Daily Work Report date.

This quantity should represent what the inspector
estimates as being eligible for payment.

From Station

The From Station distance, offset distance, and offset
type.

To Station

The To Station distance, offset distance, and offset type.

Reported Qty

The total of all reported quantities on DWRs, regardless
of whether the quantities are authorized or unauthorized
and regardless of whether they are included on an
estimate.

Authorized Qty

The total of all reported quantities on DWRs that are
authorized.

Qty Paid to Date

The total of all authorized reported quantities included on
estimates (of all statuses). This value is always the same
as Qty Installed to Date unless the quantity to pay has
been adjusted on the Estimate Item Detail window. This
window includes a Pay This Est field which can be
modified when an estimate is pending. If the quantity in
this field is adjusted, the Qty Paid to Date field reflects
the modification, which causes the value to differ from
the Qty Installed to Date.

Table 6-24. The Item Work Report Fields Table

6.13.5 Required Documents Report

The Required Documents report lists the required documents for a contract. This report can be
generated to list the documents that are External (produced by the contractor), Internal (produced by
the transportation agency), or Both (internal and external).

6. Contract Administration - Maintenance
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Zoom: IBI] -l Copies: |1 - |

-
RPT-ID: RCARQDOC DATE: 042311
USER: 5Y51 Transportation and Highway Department PAGE: 1cf1

Required Documents Report [External Only)

Contract ID: SITEMGR_03 FediState/Prov Project Nbr: STP-633-1[001)/0633037284
Work Description: Grade, Drain and Est. Pave

Location: FROM:.0.5E8MIE.INT. RTE. 632

Prime Contractor: R374 ROMAND COMCRETE COMSTRUCTR Status: Active
Document Description: EED Event Description: DEE Commitment Verified
Frequency: wWeekly Hext Projected Date: 08/31/93
Ezxternal Indicator: ¥ Hbr Cf Cce: 0 PReqd To Activate Contract: N Cause Payment Dis:

Due Date Received Date
06422193
06#23/93 =

KI ol

Figure 6-25. The Required Documents Report Window

Field Name Description

Report Criteria

Prime Contractor Documents required from the prime contractor (External

(External) documents).

Department of Documents required from the transportation agency

Transportation (Internal documents).

(Internal)

Both (Internal and | Documents required from both the transportation agency

External) (Internal documents) and the prime contractor (External
documents).

Required Documents Report

Contract ID Transportation agency-defined 1D for the contract.
Fed/State/Prov Federal, State or Province Project Number for the
Project Nbr contract, project or category.

Status Identifies the current status of the contract item record.

Values can be none, Audit, Final, or Complete.

Description Description of the contract.

Location Description of the physical location of the contract work.
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Field Name Description
Contractor Short name of the contractor.
Document Description of the document.
Description
Due Date Due date for submission of the document.

Event Description Description of the event that is documented.

Frequency How often the document is required.

Next Projected Date | When the document is due next.

Number of How many times the document has been submitted.
Occurrences

External Indicator | Indicates whether the document is External (produced by
the contractor).

Table 6-25. The Required Document Report Fields Table

6.13.6 Contractor Behind Schedule Report

The Contractor Behind Schedule report lists all contracts that are behind schedule relative to a user-
selected percentage. The report can be generated for all contractors or one contractor. The system

generates the report by reading the Contract Progress Schedule table in descending order by Progress

Schedule Day. Only the most recent values are reported.

I3 Conuoctor Btind Schedule e
Zoom: Iil 00 -l Copies: |1 - |

RPT-ID: RCACTRES State of Testing Date : 6/25/01

USER : 5%S1 Department of Transportation Page: 1 of 1
Contractor Behind Schedule Report [>=0.01%)

Contractor ID Contractor Name Contract ID Percentage Work Complete  Actual Percent

Scheduled Actual Behind  Time Complel

4 | 4

Figure 6-26. The Contractor Behind Schedule Report Window

Field Name Description

Contractor ID Transportation agency-defined Vendor ID of a
contractor.
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Field Name Description
Contract ID Transportation agency-defined ID of a Contact.

Percent Work Complete

Scheduled Anticipated completion percentage of the contract's dollar
amount by the end of the contract month/year.

Actual Actual completion percentage of the contract's dollar
amount by the end of the contract month/year.

Behind Difference between the Scheduled and Actual percentage
of work completed.

Percent Time Actual completion percentage of the contract's scheduled
Complete time by the end of the contract month/year.

Table 6-26. The Contractor Behind Schedule Report Fields Table

6.13.7 Past History Reports

The Past History - Work Completion report lists the completed contracts for a selected contractor. It
also reports the percentage that the contracts were ahead of or behind schedule at the time of
completion. For each contract ID, the system reads the Contract Critical Date table for the following
Critical Date types:

= Estimated Completion Date
=  Work Begin Date
= Physical Work Complete Date

If the Physical Work Complete Date has a value, the system lists the contract and calculates the
following values:

= Scheduled days = Number of days between the Estimated Completion Date and the Work
Begin Date

= Difference days = Number of days between the Estimated Completion Date and the Physical
Work Complete Date

= Percent Ahead/Behind Schedule = (Difference days / Scheduled days) * 100%
= If the percentage is positive, the contract was ahead of schedule

= |f the percentage is negative, the contract was behind schedule
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= If the percentage is zero, the contract was on schedule

The Past History - Claims report lists the completed contracts for a selected contractor that resulted
in a claim. It also reports the percentage of contracts per resolution reason. To generate this report,
the system reads the contract, Contract Critical Date, Contract Dispute, and Contract Vendor tables
for records that match the report criteria.

84 Past History-Work Completion [ %]
Zoom: IBU - Copies: |1 - |
3
RPT-ID: RCAPHWEKC
USER: 5Y51 Transportation and Highway Department
Past History Work Completion Status Report for SHIRLEY CONTRACTING CORP. [5018)
Contract ID Description Final Amount Completion *a
Date
SITEMGR_13 REMOVAL AND REPLACEMENT OF RIGHT OF wAY FENCE $.00 112097
110692-CAL manhaole repair $.00 03407433
110698-FI% Guardrail repair $.00 11405438
330308WINP Diane's WINF Contract .00 01401439
Number of contracts completed : 4
Number of contracts completed ahead of schedule : 1
Number of contracts completed behind schedule : 2
hd
4 I I ay

Figure 6-27. The Past History - Work Completion Report Window

Field Name Description

Contractor The transportation agency-defined Vendor ID of a
contractor.

(Contractor Name) | Short name of the contractor.

Contract ID Transportation agency-defined ID for the contract.
Description Description of the contract.
Final Amount The sum of the final amounts for all contract items plus

any net adjustments.

Completion Date Physical Work Completion Date for the contract.

Pct Schedule

Ahead The percentage the contract was completed ahead of
schedule.
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Field Name Description

Behind The percentage the contract was completed behind
schedule.

Summary
(Number of Number of contracts that were completed within the
Contracts report’s time period.
completed)
(Number of Number of contracts that were completed within the
Contracts report’s time period and were completed ahead of the
completed ahead of | original schedule.
schedule)
(Number of Number of contracts that were completed within the
Contracts report’s time period and were completed behind the
completed behind original schedule.
schedule)

Table 6-27. The Past History - Work Completion Report Fields Table

5 Past History-Claims [x]
Zoom: IBU -I Copies: |1 - |

S

RPT-ID: RCAPHCLR
USER: 5Y3S1

Prime Contractor S013

Contract ID

Contract Description

Transportation and Highway Department
Past History-Claims
SHIRLEY COMTRACTING CORP.

Completion Date

Resolution Reason Description

Number of contracts Completed : 4
Number of contracts resulting in Claim : 0

KNI ol
Figure 6-28. The Past History - Claims Report Window
Field Name Description
Contractor Transportation agency-defined Vendor ID of the
contractor
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Field Name

Description

(Contractor Name)

Short name of the contractor.

Contract ID

Transportation agency-defined ID for the contract.

Description

Description of the contract.

Contract Completion
Date

Physical Work Complete Date for the contract.

Resolution Reason
Type

The reason for the resolution of a dispute.

Claim Date

For disputes, the date the dispute or claim was received
by the transportation agency.

Claim Amount

The dollar amount requested by the contractor.

Claim Time

Number of days requested by the contractor.

Resolution Date

Date a final resolution of a dispute was reached by the
transportation agency.

Resolution Amount

Amount of the resolution.

Resolution Time

Number of days granted.

Number of Contracts
completed

Number of contracts that were completed within the
report’s time period.

Number of Contracts
resulting in a claim

Number of contracts that were completed within the
report’s time period and resulted in a claim.

Resolution Reason

Description of the resolution reason.

Percentage

The percentage of contracts that resulted in a claim for
each resolution reason.

Table 6-28.

The Past History - Claims Report Window Fields Table

6.13.8 Contractor Current Status Report

The Contractor Current Status report lists all contractors, their contracts, and contract status. Status
is defined as the progress of the contract relative to both time and amount. If an office ID is
indicated, the contractors and contracts in the selected office are listed. If no office ID is indicated,
all contractors and contracts are listed. The system generates the report by reading the Contract,
Contract Vendor, and Contract Progress Schedule tables.
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B Contoctor Comont St
Zoom: Ihﬂﬂ -l Copies: |1 - |
RPT ID: RCACSTAT State of Testing Date: 6/25/01 15:E j
USER: 5v51 Department of Transportation Page: 10f1

CONTRACTOR CURRENT STATUS REPORT

Office Contractor Contract Contractor Type Current Contract Amt Percent Complete
1D D Amount Time
Mame Location
4| | M 4

Figure 6-29. The Contractor Current Status Report Window

Field Name Description

Report Criteria

Level 2 Office Transportation agency-defined 1D of a Level 2 office.
(user-defined label)

Level 3 Office Transportation agency-defined ID of a Level 3 office.
(user-defined label)

Level 4 Office Transportation agency-defined ID of a Level 4 office.
(user-defined label)

Contractor Current Status Report

Contractor ID Transportation agency-defined Vendor ID of the
contractor.

Contractor Type Identifies which type of company the contractor is.

Contract ID Transportation agency-defined ID for the contract.

Current Contract The sum of Bid Amount and Net Change Order

Amount Amount.

Percent Complete Actual completion percentage of the contract's dollar

Amount amount by the end of the contract month/year.

Percent Complete Actual completion percentage of the contract's

Time scheduled time by the end of the contract month/year.
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Field Name Description
Location Description of the physical location of the contract work
(two lines).

Table 6-29. The Contractor Current Status Report Fields Table

6.13.9 Subcontract Value Report

The Subcontract Value report lists the value of Subcontracts for a specific contract or administrative
office. When a contract is specified, the Contract Line Item data is included in the report.

ﬂSuhcontract Yalue : : x|

Zoom: 1100‘%{1 Copies: {1 -4 1

B

Report ID: RCASUBYL State of Testing 04/16/2002

User ID-  §YS1 Depart tof T p ( Page 1 of 206

Subcontract ¥alue Report by Contract

Office ID: B

Contract 1D: C10028 Fed/State/Proy Mbr CC C100-002
Subcontract Nbr: 01 Subcontractor: 0164 ARVADA EXCAVATING CO. Subcontract Type: FE

Project Hbr  Ln Itm Hbr Item Code Description Unit Price Quantity
10028-BID 0065 B27-00001 “Pavement Marking Paint 20 425
Subcontract Totals: - Subcontract A b 118839.75
Subcontract Mbr: 02 Subcontractor: 0254 TOMYJ. BELTRAMO & S0NS, INC. Subcontract Type: ELEC

Project Nbr  Ln Itm Nbr Item Code Description Unit Price Quantity
10028-B1D 0070 B30-00000 *Flagging 165 500
10028-BID 0075 §30-00002 “Traffic Control Supervizor 290 40
10028-BID 0080 - §30-80342 “Congtruction Traffic Sign [Panel Size B] 100 12
1002810 0085 B30-80380 *Traffic Cone 1 100
Subcontract Totals:  Subcontract A b 142,22

Contract Totals: Contract Amount: 1733361 Subcontract Amount: 124331, % Subcontracted: £3.43

il . . . . . . . . . i i

Figure 6-30. The Subcontract Value Report Window

Field Name Description

Report Criteria

By Contract When selected, the office fields are protected. If By Contract is
checked, a contract ID is required.
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Field Name Description
By Office When selected, the contract ID field is protected. If By Office

is checked, one of the following must be entered:
State/Province-wide indicator selected (ON)
Level 2 office

Level 3 office

Level 4 office

Contract ID Transportation agency-defined ID for the contract. The user
can search this field. Required if By Contract is checked.

State/Province- Indicates that the report is to be generated for all active
Wide contracts within the state or province.

Level 2 Office Level 2 office responsible for administering the contract.
(user-defined

label)

Level 3 Office Level 3 office responsible for administering the contract. If
(user-defined there are only two office levels, this field will not report.
label)

Level 4 Office Level 4 office responsible for administering the contract. If
(user-defined there are only two or three office levels, this field will not
label) report.

Subcontractor ID | Transportation agency-defined Vendor ID for a subcontractor.
If not entered, all subcontractors will be included in the report.

Generate Off Indicates that the report is to be generated off line.
Line File

Generate Off Indicates that the report is to be printed off line.
Line Print

Subcontract Value Report

Date Date the status report was run.

User ID User ID of the person running the status report.
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Field Name Description
Office ID Office number for the Level 2, Level 3, or Level 4 office
responsible for the contract. If there are only two or three
office levels, only the applicable fields are displayed.
Contract ID Transportation agency-defined ID for the Contact.

Fed/State Project
Nbr

The federal or state project number for the contract.

Subcontract Nbr

user-entered number associated with each Subcontract.

Subcontractor The subcontractor’s Vendor ID and short name.
Subcontract Type | Identifies the type of Subcontract.

Subcontract Current value (Bid Amt plus Approved CO Amt) of the
Amount Subcontract.

Project Number

Transportation agency-defined ID for a Project within the
contract.

Line Item Nbr Contract Line Item number that uniquely identifies each Item
as it appears on the contract.
Item Code Transportation agency-defined code that identifies the Item.

Item Description

Short description of the Item.

Supplemental

This field contains a textual description that is supplemental to

Description the item's description and may be required by the transportation
agency.

Unit Unit of measure for the Item (e.g., cubic foot, gallon, square
yards, acre).

Unit Price Price for this Subcontract line Item per unit.

Quantity The quantity of the line Item Subcontracted to this Subcontract.

Totals

Contract Amount | Total current value (Bid Amt plus Approved CO Amt) of the
contract, office, or state/province.

Subcontract Total current value (Bid Amt plus Approved CO Amt) of the

Amount contract, office, or state/province Subcontract amounts

6. Contract Administration - Maintenance
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Field Name Description

% Subcontracted | Subcontract Amount divided by the contract Amount.

Table 6-30. The Subcontract Value Report Fields Table

6.14 Process List (Contract Administration)

The Process List window lists processes that are available to the authorized user. Available
processes depend upon the functional area of the process list, for example, Contractor Payment
processes are available by clicking the Process List icon located on the Contractor Payments panel.
Processes appearing in Process Lists also depend upon the user security assigned to the individual
process.

The Contract Administration Process List contains the following standard process:
= Monitor Contract Status (BMONCONT)
= Pre-Construction Reference Load (BREFLOAD)
= Payroll Upload (BCRPAYRL)
= Payroll Exceptions Batch Job (BCVTPEXP)
= Pre-Construction Contract Load (BPRELOAD)
= Load DSS Data (BCALDSSD)

Processes may be RTF reports, or batch processes. From this window, authorized users may submit
processes for batch and background execution.

A process is run from the Process List window by clicking on the named process, and choosing Run
Process from the Services menu, or by clicking the named process and clicking the Run Process
button or double-clicking the process.
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Key Dates and Checklist Events are the SiteManager components that let the user establish and
monitor a series of key dates and scheduled events. Key Dates and Checklist Events, although
similar in functionality, are independent events.

= Key Dates are dates that are important when they occur. Personnel are notified when a
Key Date is accomplished. They are also notified when a Key Date is not accomplished
by the projected date. A Key Date can be set up to be required either when the contract is
activated or when it is finalized. The user creates the Key Date schedule and records the
actual occurrences of Key Dates on the Key Dates window.

= Checklist Events are actions that are important when they do not occur. Personnel are
notified when a Checklist Event is not accomplished by the projected date. For Checklist
Events that occur more than once or at regular intervals (e.g., monthly or weekly), the
system tracks each occurrence. A Checklist Event can be set up to be required when the
contract is activated, or to cause a discrepancy when the estimates are generated. The
user creates the Checklist Event schedule on the Checklist Scheduled Events window.

= The Checklist Event Dates window lets the user view the Checklist Event schedule,
including multiple occurrences of each event, and provides a chronological history of the
events. The user records the actual occurrences of the Checklist Events on this window
or, if the event is a document submitted by an external source, on the Document
Submission window.

7.1 Contract and Civil Rights Applicability

Key Dates and Checklist Events enhance your ability to administer the contract and comply with
civil rights provisions. Every contract includes a default set of Key Dates and Checklist Events,
which are defined by the transportation agency. You can modify these defaults and add other
agency-defined Key Date types and Checklist Event types to the contract schedule.

The date and event types are defined by the transportation agency in the system code tables.

Messaging is an important function of Key Dates and Checklist Events. For each Key Date and
Checklist Event, you select either a distribution list or a recipient to be notified as required. Note
that when Default Key Dates and Default Checklist Events are created, a distribution list and
recipient ID are not required. However, once the defaults are added to contracts, a distribution list or
recipient ID is required on the Key Dates and Checklist Scheduled Events windows.

7.1.1 Key Dates

Key Dates can be used to schedule and track key contract dates which need to be reported to contract
personnel when the activity is done, such as testing, final inspection, and dates where roads are
closed to traffic. To schedule Key Dates and record the actual dates of Key Dates that have
occurred, users access the Key Dates window. SiteManager sends In-Box messages related to Key
Dates as follows:
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* When a Key Date’s actual date is recorded, its distribution list or recipient is notified.

=  When a Key Date’s projected date expires before the actual date is recorded, the Project
Manager is notified.

7.1.2 Checklist Events

Checklist Events are useful for scheduling events that occur more than once or depend on an action
or response by external sources and may be difficult to track. This includes the documents required
for civil rights compliance, such as DBE and EEO reports, and documents required by the contract,
such as material certification. Checklist Events can be associated with contract milestones.

To schedule the Checklist Events, access the Checklist Scheduled Event window. To view the
scheduled Checklist Events and record the actual dates of Checklist Events, access the Checklist
Event Dates window and the Document Submission window.

SiteManager sends In-Box messages to its distribution list or notifies its recipient when a Checklist
Event’s projected date expires before the actual date is recorded.

In addition, Checklist Events can cause discrepancies when they do not occur. You define which
Checklist Events will cause discrepancies. If any of these Checklist Events have not occurred when
an estimate is generated, a discrepancy is reported. The estimate process identifies a Checklist Event
as a discrepancy if the projected date has expired and the actual date is not recorded. Estimate
discrepancies are reported on the Estimate Summary window, and the details are given on the
Estimate Discrepancy window.

Every contract schedule also includes a default set of contract Critical Dates. For more information,
refer to the Contract Critical Dates topic.

7.2 Key Dates

The Key Dates window lists the Key Dates for the selected contract in the top datawindow. The data
for the selected Key Date is displayed in the bottom datawindow. The Key Date Types are pre-
defined in the system code tables. SiteManager adds a set of default Key Dates automatically to
each new contract. The user creates the Key Date schedule and records the actual occurrence of Key
Dates on this window. The user can add, modify, and delete the Key Dates.

When a Key Date is logged, an In-Box Message is sent to the distribution list or recipient specified,
including the specified text and the details of the key date. A recipient ID or distribution list is
required for each Key Date. When a Key Date is missed, an In-Box Message with the details is sent
to the Project Manager.
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®3Key Dates [_[O]
Contract ID: |SITEMGFI_3EI
Key Date Type Projected Actual Required | Required ﬂ
Date Date to Activate | to Finali
an/00/00 00/00/00 M N

i o

Key Date Type: [H——— - |

Projected Date: IUEI.-’UU.-"EIU [T Required to Activate
Actual Date: |IJDHDDJDIJ [~ Required to Finalize
Distribution List: | Recipient: |

Message Text: |

Figure 7-1. The Key Dates Window

Field Name Description

Contract ID | The transportation agency-defined ID for the contract.

Key Date Transportation agency-defined type of key date (e.g., Closed to
Type Traffic Date, State Final Inspection Date, Open to Traffic Date).
The key date type is a required field and should be unique
within the contract. After the record is saved, this field is
protected.

Projected The date the event is targeted to occur.
Date

Actual Date The date the event actually occurs. When entered, the date must
be current or in the past. The Recipient or Distribution List is
notified when this date is entered.

Required to Indicates that a key date must occur before the contract status
Activate can be changed from Pending to Active (e.g., Letting Date,
Award Date, Execution Date). A Key Date cannot be both
Required to Activate and Required to Finalize.

Required to | Indicates that a key date is part of the contract finalization
Finalize process. A Key Date cannot be both Required to Activate and
Required to Finalize.

Distribution | Group to be notified that the event has occurred. Either a
List Distribution List or Recipient field must be entered. After a
valid entry in either field, the other field is protected.
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Field Name Description
Recipient User ID of a person to be notified that the event has occurred.

Either a Distribution List or Recipient must be entered. After a
valid entry in either field, the other field is protected.

Message Text | Standard message to be sent to the recipient(s).

Table 7-1. The Key Dates Window Fields Table

To schedule a Key Date:

1.
2.

10.
1.
12.

13.

14.

Select Reference Tables from the Contract Administration panel.
Select Default Key Dates.
In the Key Dates list box, scroll to and click the Key Date.

In the Projected Date field, with the cursor in the first space, type the date the Key Date
event is expected to be completed.

Press the Tab key.

If this Key Date must occur before the contract status can be changed to Active, select the
Required to Activate check box (ON).

If this Key Date is to be part of the contract finalization process, select the Required to
Finalize check box (ON).

Press the Tab key.

In the Distribution List field, perform a Search and select a Group ID.
OR

In the Recipient field, perform a Search and select a User ID.

Press the Tab key.

In the Message field, type a short notice that will be sent to the Distribution List or Recipient
when the Actual Date is entered.

Click the Save button.

The Key Date Type field cannot be modified on a saved record. To change the Key Date Type,
delete the old record and add a new one.

To enter the Actual Date of a Key Date:

1.

In the Key Dates list box, scroll to and click the Key Date.
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2.

3.

In the Actual Date field, with the cursor in the first space, type the date that the event
occurred.

Click the Save button.

To delete a Key Date:

1.
2.
3.
4.

In the Key Dates list box, scroll to and click the Key Date to delete.
Click the Delete button.
Click the Yes button to confirm the deletion.

Click the Save button.

To add a Key Date:

1.

2.

10.

1.
12.

13.

14.

On the Key Dates window, click any row in the top datawindow.
Click the New button to insert a blank row in the top datawindow for the new Key Date.

In the Key Date Type drop-down list, click the expand arrow to the right of the current
selection and click the Key Date Type.

Press the Tab key.

In the Projected Date field, with the cursor in the first space, type the date the key date event
is expected to be completed.

Press the Tab key.

If this Key Date must occur before the contract status can be changed to Active, select the
Required to Activate check box (ON).

If this Key Date is to be part of the contract finalization process, select the Required to
Finalize check box (ON).

Press the Tab key.

In the Distribution List field, perform a Search and select a Group ID.
OR

In the Recipient field, perform a Search and select a User ID.

Press the Tab key.

In the Message field, type a short notice that will be sent to the Distribution List or Recipient
when the Actual Date is entered.

Click the Save button.
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7.3 Checklist Scheduled Events

The Checklist Scheduled Events window lists the scheduled events for the selected contract. The
data for the event selected in the top datawindow is displayed in the bottom datawindow. The Event
Types are pre-defined in the system code tables. SiteManager adds a set of default Checklist Events
automatically to each new contract. You create the Checklist Event schedule on this window. You
can add, modify, and delete the Checklist Events. A recipient ID or distribution list is required for
each Checklist Scheduled Event.

When an event is scheduled on this window, the Monitor Contract Status process creates records for
the projected dates so you may record the actual dates of occurrence. These records appear on the
Checklist Event Dates window. You can record the Actual Date of each occurrence of an event on
either the Checklist Event Dates window or the Document Submission window, depending on the
event. If the Checklist Event is a document supplied by an external source, the Actual Date is
recorded on the Document Submission window. The Monitor Contract Status process notifies the
recipient(s) when a Checklist Event is overdue.

When an Event Date is missed, an In-Box Message is sent to the distribution list or recipient
specified and includes the specified text and the details of the event date. When and Event Date is
logged, no notification is sent.

E Checklist Scheduled Events [_[O]
Contract 1D: |SITEMGH_3U

Event
Type

Event Group |Mext Proj| Nbr of | Required Discr| Required

to Activate Ind

Frequency
Type

i o

Event Type: |w v| Event Group Type: | =1
F Type: | [=] EventDay:[ Milestone No:[__ [~
Next Proj Date: | 00/00/00 [T Required to Activate
Mbr of Dccurrences: I_ [T Discrepancy
Required Doc Type: | [x] I Extemal Indicator
Distribution List: | Recipient: I—
Message Text: |

Figure 7-2. The Checklist Scheduled Events Window

Field Name Description

Contract ID | The transportation agency-defined ID for the contract.
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Field Name Description

Event Type Transportation agency-defined type of event (e.g., bonding
verified DBE commitment verified, Final Inspection
Completed). The Event Type is a required field and should be
unique within the contract. After the record is saved, this field
is protected.

Event Group | A grouping of associated event types (e.g., EEO, Training, or

Type Certification). This is a required field.

Frequency For repetitive events, the frequency with which those events

Type occur (i.e., Daily, Weekly, Biweekly, Monthly, Quarterly, Semi-
Annually, or Annually). One Time Only is for non-repetitive
events. This is a required field.

Event Day For weekly and bi-weekly events, the day of the week (01-07)
the events are to occur. For monthly events, the day of the
month (01-30) they are to occur. This field is protected for all
other frequency types.

Milestone No. | Identifies a milestone number within the contract.

Next Proj Next target date for the repetitive event to occur. For a new

Date checklist event, it is the first occurrence date. This is a required
field.

Required to Indicates that the event must occur before the contract status can

Activate be changed from Pending to Active. Only events with a
frequency of One Time Only can be Required to Activate. An
event type cannot be both Required to Activate and associated
with a Discrepancy. If one of these fields is selected, the other
field is protected. This field is protected if the contract is
already active.

Number of Number of times the event is scheduled to occur in the specified

occurrences | frequency type. This is a required field. If the frequency type is

One Time Only, this field defaults to 1.

Discrepancy

Indicates that if the event has not occurred by the time of
estimate generation, it is noted as a Discrepancy. An event type
cannot be both Required to Activate and associated with a
Discrepancy. If one of these fields is selected, the other field is
protected.

7.3 Checklist Scheduled Events




AASHTOWare Project SitteManager
7.3 Checklist Scheduled Events 7. Key Dates and Checklist Events

Field Name Description

Required Doc | Transportation agency-defined codes identifying the type of
Type document when an external document is expected (e.g., Trainee
report, EEO report, Material Certification). This is a required
field when the External Indicator is selected.

External Indicates that a document is expected to be received from an
Indicator external source. A valid Document Type must be entered when
this field is selected.

Distribution | Group to be notified when the Checklist Event’s projected date
List expires and the actual date is not entered. Either a Distribution
List or Recipient field must be entered. After a valid entry in
either field, the other field is protected.

Recipient User ID of a person to be notified when the Checklist Event’s
projected date expires and the actual date is not entered. Either
a Distribution List or Recipient field must be entered. After a
valid entry in either field, the other field is protected.

Message Text | Standard message to be sent to recipient(s).

Table 7-2. The Checklist Scheduled Events Window Fields Table
To schedule a Checklist Event:
1. On the Checklist Scheduled Events window, scroll to and click the scheduled event.

2. Inthe Event Group Type drop-down list, click the expand arrow to the right of the current
selection and click the event group type.

3. Press the Tab key.

4. In the Frequency Type drop-down list, click the expand arrow to the right of the current
selection and click the frequency type. If the frequency type is either monthly or weekly, the
Event Day field is enabled.

5. Press the Tab key.

6. If the Event Day field is enabled, type the corresponding day of the week (2-6) or day of the
month (1-30).

7. Press the Tab key.

8. In the Milestone No. drop-down list, click the expand arrow to the right of the current
selection and click the milestone to associate with this scheduled event.

9. Press the Tab key.
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10. In the Next Proj Date field, with the cursor in the first space, type the next date this
scheduled event is expected to occur.

11. Press the Tab key.

12. If the event must occur before the contract status can be changed to Active, select the
Required to Activate check box (ON).

13. Press the Tab key.

14. In the Number of Occurrences field, type number of times this scheduled event will occur.

15. Press the Tab key.

16. To generate a discrepancy if the event has not occurred by the time of estimate generation,
select the Discrepancy check box (ON).

17. Press the Tab key.

18. If the event is a document, in the Required Doc Type drop-down list, click the expand arrow
to the right of the current selection and click the required document type.

19. Press the Tab key.

20. If the required document is expected from an external source, select the External Indicator
check box (ON).

21. In the Distribution List field, perform a Search and select a Group ID to be notified when
the Actual Date is overdue.
OR

22. In the Recipient field, perform a Search and select a user ID to be notified when the Actual
Date is overdue.

23. Press the Tab key.

24. In the Message field, type a short message that is sent to the Distribution List or Recipient
when the scheduled event Actual Date is not completed by the Next Projected Date.

25. Click the Save button.

To delete a Checklist Scheduled Event:

1.
2.
3.
4.

7-10

On the Checklist Scheduled Events window, scroll to and click the scheduled event.
Click the Delete button.
Click the Yes button to confirm the deletion.

Click the Save button.
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Deleting a Checklist Scheduled Event also deletes:

= Any corresponding Document Submission records, and

= Checklist Event Date records.

To add a Checklist Event:

1.

10.
11.

12.
13.

14.

15.

16.

17.

On the Checklist Scheduled Events window, click any row in the top datawindow to return
focus to that datawindow.

Click the New button to insert a blank row for the new scheduled event entry.

In the Event Type drop-down list, click the expand arrow to the right of the current selection
and click the event type.

Press the Tab key.

In the Event Group Type drop-down list, click the expand arrow to the right of the current
selection and click the event group type.

Press the Tab key.

In the Frequency Type drop-down list, click the expand arrow to the right of the current
selection and click the frequency type. If the frequency type is either monthly or weekly, the
Event Day field is enabled.

Press the Tab key.

If the Event Day field is enabled, type the corresponding day of the week (2-6) or day of the
month (1-30).

Press the Tab key.

In the Milestone No. drop-down list, click the expand arrow to the right of the current
selection and click the milestone to associate with this scheduled event.

Press the Tab key.

In the Next Proj Date field, with the cursor in the first space, type the next date this
scheduled event is expected to occur.

Press the Tab key.

If the event must occur before the contract status can be changed to Active, select the
Required to Activate check box (ON).

Press the Tab key.

In the Number of Occurrences field, type number of times this scheduled event will occur.
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18. Press the Tab key.

19. To generate a discrepancy if the event has not occurred by the time of estimate generation,
select the Discrepancy check box (ON).

20. Press the Tab key.

21. If the event is a document, in the Required Doc Type drop-down list, click the expand arrow
to the right of the current selection and click the required document type.

22. Press the Tab key.

23. If the required document is expected from an external source, select the External Indicator
check box (ON).

24. In the Distribution List field, perform a Search and select a Group ID to be notified when
the Actual Date is overdue.

OR

25. In the Recipient field, perform a Search and select a user ID to be notified when the Actual
Date is overdue.

26. Press the Tab key.

27. In the Message field, type a short message that is sent to the Distribution List or Recipient
when the scheduled event Actual Date is not completed by the Next Projected Date.

28. Click the Save button.

7.4 Checklist Event Dates

The Checklist Event Dates window lists the scheduled events for the selected contract. The data for
the event selected in the top datawindow is displayed in the bottom datawindow. The data shows a
chronological history of each occurrence of a repetitive scheduled event and the Actual Date
recorded by the user for each occurrence. This window lets you record the actual dates of the
Checklist Scheduled Events and add or delete Checklist Event Date records.

One day prior to a scheduled event, the Monitor Contract Status process automatically writes the
projected date for the checklist event to this window (if the projected event has not already been
added). If the Checklist Event is a document supplied by an external source, the Monitor Contract
Status process also creates a corresponding Document Submission record for the event. When the
date is recorded on the Document Submission window, the Actual Date field on the Checklist Event
Dates window is automatically populated with this date.
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Note: If the Checklist Event is an external document and the projected date for the event
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is entered manually, the system automatically creates a corresponding Document

Submission record when the row is entered by the user. This document record should be

used to record the actual date of occurrence.

You cannot modify the Checklist Event schedule (in the top datawindow) on this window. The

schedule can only be modified on the Checklist Scheduled Events window.

5 Checklist Event Dates |- (O] x|
Contract I1D: ISITEMGH_SEI

Event
Type
Bonding Yerified

Frequency | Event Group |Next Proj| Nbr of | Required Discr| Required |Ext| =
Type Type Date |Occrncjto Activate Ind Doc Type |Ind

One Time OnlyEED 06/30/99

Projected Date | Actual Date Comments o
PE/30/99 00700400
[« | »

Figure 7-3. The Checklist Event Dates Window

Field Name Description
Contract ID The transportation agency-defined ID for the contract.
Event Type Transportation agency-defined code representing a type of
event (e.g., bonding verified, DBE commitment verified, Final
Inspection Completed).
Frequency For repetitive events, the frequency with which those events
Type occur (i.e., Daily, Weekly, Biweekly, Monthly, Quarterly,

Semi-Annually, or Annually). One Time Only is for non-
repetitive events.

Event Group
Type

A grouping of associated event types (e.g., EEO, Training,
Certification).

Next Proj Date

Next Projected Date field. The next targeted date for the
event.

Nbr of
Occurnc

Number of times the event is expected to occur.
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Field Name Description
Required to Indicates that an event must occur before the contract status
Activate can be changed from Pending to Active.
Discr Ind Discrepancy indicator that indicates if an event has not

occurred by the time of the estimate generation, this event
needs to be noted on a discrepancy.

Required Doc | Required Document Type field. Agency-defined codes
Type identifying each type of document (e.g., Trainee report, EEO
report, Material Certification document).

Ext Ind The external indicator that indicates a document is expected to
be received from an external source.

Projected Date | The date the event is targeted to occur. This field is protected
after the record is saved. When entered, the date must be in
the future and cannot be greater than next projected date. For a
new row default to Next Proj Date.

Actual Date The date the event actually occurs, protected when external
indicator is selected. When entered, the date must be current
or in the past.

Comments Comments about this record.

Table 7-3. The Checklist Event Dates Window Fields Table
To record the Actual Date of a Checklist Scheduled Event:
1. On the Checklist Event Dates window, scroll to and click the Checklist Event.

2. Inthe Actual Date field, with the cursor in the first space, type the date that the event
occurred.

3. Press the Tab key.
4. Inthe Comments field, type comments to add to the record.
5. Click the Save button.

If the Checklist Event is a document supplied by an external source, enter the Actual Date on the
Document Submission window.

To delete a Checklist Event Date record:

1. On the Checklist Event Dates window, scroll to and click the scheduled event.
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3.

4,

5.

In the bottom datawindow of the Checklist Event Dates window, scroll to and click the
record to be deleted.

Click the Delete button.
Click the Yes button (to confirm deletion).

Click the Save button.

If the Checklist Event is a document supplied by an external source, deleting the date record also
deletes the associated document submission record.

To add an unscheduled Checklist Event Date record:

1.

8.
9.

On the Checklist Event Dates window, click any row in the top datawindow to return focus
to that datawindow.

Click the New button to insert a blank row for the new scheduled event entry.

In the Projected Date field, with the cursor in the first space, type the date for the next
occurrence of the scheduled event.

Press the Tab key.

In the Actual Date field, with the cursor in the first space, type the date the scheduled event
occurred.

In the field, type the actual date.
Press the Tab key.
In the Comments field, type any comments that apply to this event date occurrence.

Click the Save button.

An unscheduled event does not have to occur at the scheduled frequency.
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8.1 General Concepts

Daily Work reports and Diaries are created to document the work that is done daily on the contract.
The data recorded in a Daily Work report or Diary is the contract activity data rather than the
contract plan. The documentation of contract activity includes daily information about the weather,
the personnel who worked at the construction site, the hours worked, and the equipment used. This
data is collected in the field by the project manager, project engineer, and the inspectors working on
the contract. The project manager uploads the Diaries and authorized Daily Work reports to the
SiteManager Server database. This method is used to enter most of the contract activity data in
SiteManager. This information is essential for the administration of the contract.

The Installed Work report, located in the Contractor Payments functional area, compiles all placed
quantities for a contract that have not yet been included in an estimate. See Section 10.3.5 for more
details.

The inspectors record daily information in Daily Work reports. Typically, for each contract, each
inspector submits one Daily Work report per day to the project manager. The project manager either
authorizes a Daily Work report or sends it back to the inspector to be modified and resubmitted. The
project manager creates daily Diaries. Each Diary is a collection of the Daily Work reports
submitted by all inspectors working on the contract. Typically, for each contract, the project
manager submits one daily Diary per day. In the daily Diary, the project manager authorizes the
Daily Work reports and enters the charge information for the day.

Following the general rule that only one Daily Work report (DWR) per day per inspector per
contract can be created:

= A message appears if an inspector attempts to create a second DWR for a contract. A
second DWR cannot be created for a contract.

= A message appears that the DWR can be opened as Read Only (no changes can be made)
if the DWR:

= Has been transferred to the project manager.
o Has been authorized by the project manager.
o The current user is not the DWR author.

= A DWR cannot be deleted. It can be amended the next day or data can be deleted on the
Contractor or Contractors Equipment Tabs.

You can access the Daily Work Report and Diary functions on the Daily Work Reports panel. This
panel has three icons that represent the following functions:

= Daily Work Reports
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= History

Figure 8-1. The Daily Work Reports Panel

8.1.1 Pipeline

Project managers and inspectors use pipeline to transfer contract data and Daily Work reports.
Throughout the life of a contract, the project manager uses the pipeline process to download contract
plan data from the server to the field. Only the project manager can download data from the server.
This data is not modified in the field; it is used as a basis for recording contract activity data.

First, the project manager downloads basic contract data to the workstation using the pipeline
process. Basic contract data includes any force accounts or change orders for the contract. The
project manager then pipes specific contract data to the inspector. After the inspector receives the
data, the inspector can begin recording contract activity data in the form of Daily Work reports.

The inspector pipes all Daily Work reports and transfers them to the project manager for
authorization. The project manager authorizes the Daily Work reports and uploads them to the
server using the pipeline process. Unauthorized Daily Work reports can be piped back to the
inspector for modification. The project manager also uploads the Diaries to the server. If necessary,
the project manager can download Daily Work reports and Diaries from the server for modification.
For more information, refer to the Daily Work Report Applicability topic in the Pipeline section of
this manual.
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8.1.2 Accessing SDMS

You can access the Survey Data Management System (SDMS) application from the Daily Work
Report panels by selecting the SDMS menu option on the Services menu.

8.1.3 Stockpiled Materials Information

The stockpiled materials data is entered on the server and downloaded to the inspector using
pipeline. You can view stockpiled materials data from the Daily Work Report panels by selecting
the Stockpiles menu option on the Services menu. The data includes the invoiced quantities and
amounts of a stockpiled material, and their usage.

8.1.4 Installed Work Reports

After the Daily Work reports have been submitted, you can run a report of work items that have
installed amounts but are not included on an estimate. The inspector and project manager can run
this report in either environment—Server or Standalone. The report lists only the data in the current
system’s database. For more information, see the Installed Work Report topic under Contractor
Payments in this manual.

8.1.5 Pen-enabled Data Entry

Daily Work reports support the use of a pen on pen-enabled workstations. To enter data with a
workstation pen, double-click the data entry field.

8.2 Data Collection

8.2.1 Daily Work Reports

The inspector creates daily records of construction activity in Daily Work reports. SiteManager lets
the inspector create DWRs on the workstation in the field. Before the inspector can create the first
DWR for a contract, the project manager must download the contract plan data from the
SiteManager Server database to the inspector’s workstation. After the inspector loads the contract
plan data onto the workstation’s local database, the inspector can begin creating reports. Typically,
for each contract, each inspector submits one Daily Work report per day to the project manager. The
project manager either authorizes a Daily Work report or sends it back to the inspector to be
modified and resubmitted.

To create or modify a Daily Work report, the inspector double-clicks the DWR icon on the Daily
Work Reports panel. This opens the DWR Info folder tab. To access the other Daily Work Report
folder tabs, the inspector must either create or open a DWR. After the inspector saves each tab in a
DWR, he can modify it until it is transferred to the project manager. A Daily Work report cannot be
modified if it has been transferred to the project manager (checked in and locked on the
workstation), authorized by the project manager, or opened by a user who is not the author. The
Daily Work Reports panel contains the following folder tabs:
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Tab Name

Description

DWR Info

The DWR Info folder tab lets you create a new Daily Work
report and collect information about the day for which the
report was created.

Contractors

The Contractors folder tab lets you enter daily data on the
contractor, supervisor(s), and variable labor (by personnel

type).

Contractors
Equip

The Contractor Equip folder tab lets you document the daily
presence and use of equipment on the job site for the selected
contractor.

Daily Staff

The Daily Staff folder tab lets you enter daily information on
state employees and consultants. Each entry shows how many
hours the staff member worked, the type of work performed,
and data on state vehicle usage.

Work Items

The Work Items folder tab lets you view and add daily usage
data for installed work items.

Force Accounts

The Force Accounts folder tab in Daily Work reports lets you
view or add daily information on a force account. The force
accounts are created and maintained in Contract
Administration. However, the daily force account data is
collected by the inspector in Daily Work reports.

Table 8-1. The Daily Work Reports Folder Tab Table
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ADaily Work Reports

Accident

Figure 8-2. The DWR Info Folder Tab

To access the DWR folder tab:
1. On the SiteManager main panel, double-click the Daily Work Reports icon.

2. On the Daily Work Reports panel, double-click the Daily Work Reports icon.

Selecting a Daily Work Report

The Daily Work Report Select panel lets you open a Daily Work report. The panel lists all of the
DWRs stored on the workstation for the selected contract and the selected User ID. You can only
access the DWRs stored in the local database. You can open any DWR in the database, but cannot
modify a report you did not create. The DWR opens as view-only if the system finds one of the
following:

= Daily Work report has been transferred to the project manager.
= Daily Work report has been authorized.

= The current user is not the author of the Daily Work report.
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Figure 8-3. The Daily Work Reports Select Panel

To access the Daily Work Report Select panel:
1. On the SiteManager main panel, double-click the DWRs icon.

2. On the DWRs panel, double-click the DWRs icon. The DWR Info folder tab opens.
3. Click the Open button.

The fields on the DWR Select panel are defined in the following table:

Field Name Description

DWR Date Date the DWR was created. This date represents both the
DWR date and the Diary date.

Locked Indicates whether or not the DWR has been transferred to the
project manager (Yes or No).

Auth Ind Indicates whether or not the DWR has been authorized by the
project manager (Yes or No).

Table 8-2. The Daily Work Report Select Panel Fields Table
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To select a Daily Work report:

You can open any DWR in the database, but cannot modify a report you did not create, a report that

1.
2.

6.
7.

On the SiteManager main panel, double-click the Daily Work Reports icon.

On the DWRs panel, double-click the DWRs icon. The DWR Info folder tab opens.
Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.

In the User list box, scroll to and double-click the User ID of the report’s author.

In the DWR list box, scroll to and click the DWR Date of the report.

Click OK.

has been authorized, or a report that has been sent to the project manager.
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Creating a New Daily Work Report
Daily Work reports are created as follows:
= When the DWR Info folder tab opens, the system enters the current date and user.
= When creating a new Daily Work Report, you select a Contract ID.
You can click the New button, enter a date, and select a Contract ID.

You can open a Daily Work report and change the date, allowing the copy function to
copy the contractor and daily staff data recorded on the DWR.

In any case, the system verifies that the DWR is new. If the database already contains a DWR with
the selected date, User ID, and Contract 1D, the existing DWR will open. When a new DWR is
created from an existing DWR, choose whether or not to copy the contractor information from the
existing DWR to the new DWR. (Data must exist for the copy capability to be used.) If you choose
Yes, the information copied includes the contractor, contractor equipment, contractor supervisors,
contractor personnel, daily staff, and all associated data.

In DWRs, you can enter a date by selecting it from a calendar. If you double-click the DWR Date
field, a calendar displays where you can select the date.

Select Date

April 2002
S oM OTW T FE 3
R . s
OB BoD AR s
14 1a}16 17 13 19 20
Z1 22 23 14 25 36 07
iz ]

Figure 8-4. The Calendar

You cannot enter a date that is after the current system data.
To create a new Daily Work report:
1. On the SiteManager main panel, double-click the Daily Work Reports icon.

2. On the DWRs panel, double-click the DWRs icon. The DWR Info folder tab opens by
default.



AASHTOWare Project SiteManager™
8. Daily Work Reports 8.2 Data Collection

3. Click the Services menu and click the Choose Keys choice. The Contract Select panel
opens.

4. In the Contract ID list box, scroll to and click the desired contract.

5. To change the date, double-click the DWR Date field. This opens a calendar on which a
date prior to the current date can be selected. To select a prior month, click the left
arrow. To enter the selected date on the DWR Info panel, click OK.

6. Click the Save button.
To create a new Daily Work report from an existing Daily Work report:
1. On the SiteManager main panel, double-click the Daily Work Reports icon.

2. On the DWRs panel, double-click the DWRs icon. The DWR Info folder tab opens by
default.

3. Click the Open button. The DWR Select panel opens.
4. Scroll to and click the desired DWR to copy. The DWR appears.

Double-click the DWR Date field. This opens a calendar on which a new DWR date can be
selected. To enter the selected date on the DWR Info panel, click OK.

A message box asks if contractor information should be copied. To copy the contractor information
from the last DWR for this contract, click Yes. Otherwise, click No.

8.2.2 DWR Information Tab in Daily Work Reports

The DWR Info folder tab lets you create a new DWR and collect information about the day for
which the DWR was created. For example, you would enter information regarding the weather
conditions and high and low temperatures for the day on this tab. The name of the author of this
report is displayed in the Inspector field. The date covered by this report is displayed in the DWR
Date field. The Locked and Authorized fields indicate the state of the DWR. If either the Locked or
Authorized field displays Yes, you cannot modify the DWR.

This folder tab has three check boxes — No Contractors On Site, No Daily Staff On Site, and No
Work Items Installed — that indicate there is no data for the subject. These boxes are checked by
default. When you enter data for the subject on another folder tab, the corresponding check box is
cleared automatically.

General remarks are also recorded on this folder tab. To record a remark, you must first select a
remark type. If a remark has already been entered for the selected type, as indicated by a check
mark next to the type, the remark appears in the Remarks field. A remark does not have a size limit,
and can be pasted to and from a word processor. You can maintain these types of remarks in the
transportation agency’s code tables. If work is suspended during the day, record the time in the
Suspended Time field. Additional suspended times for that day can be recorded in the Remarks
field.
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A Spell Check button is available in the Remarks area. The Spell Check option will be visible if the
following are true:

= “Enable Spell Check Remarks” system operational parameter is set to Yes.
= Microsoft Office is installed.

The Spell Check button will be enabled if the current window rights are set to ‘Update’ and the
Daily Work Report is not locked, protected or authorized.

Once the Spell Check button has been clicked, the Microsoft Spell Checker will be called using the
text entered in the Remarks field. The spell check uses the dictionary that is utilized by Microsoft
Office applications, in addition to the custom dictionary, ‘custom.dic.” The Spell Check function
allows for the addition of new words not in the current dictionary.

The standard attachment functionality is also available on this tab.

On the Work Items tab, attachments are associated with individual work items.

L | The Attachment icon will appear without a paperclip if there are no attachments associated
with the record in the currently opened window.

i The Attachment icon will appear with a paperclip if attachments are associated with the record
in the currently opened window.

File Edit Services ‘Window Help
D2 DecHEE|

DWH Info. Contractors " Contractar Equip. Daily Staff i Wwiork [tems ¥ Force Accounts
Contract 1D: IT RalM_01 Inspector: ITrainer 1
DWR Dale:l 04,/01/07
Locked: ﬁo Temperature Weather Conditions
Authorized: Fln:- High: 0 i.' AM.: IH':'t & Hurnid |

Autharized Date: [00/00/00 Low:| 0 = P AL VTN ~ |

Mo Work Items Installed: [v Work Suspended: [
Mo Contractors On Site: ¥ Suspended Time: I 0000 ﬁ
No Daily Staff On Site: v Resumed Time: 0000 ill

Remarks:

=] [This is a test | Spell Check |
EED Issues
General _I _I

Figure 8-5. The DWR Info Folder Tab
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Spelling: English {U.5.} ll EI

Mot in Dictionary:
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Ignore All |

Add ko Dickionary |
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Change |
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bectars = AutoCarrect |
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Figure 8-6. The DWR Info Tab — Spell Checker
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The DWR Info folder tab fields are defined in the following table:

Field Name Description

Locked Indicates if the DWR has been sent to the project manager for
authorization (Yes), if the project manager has sent the DWR
back to the inspector for modification (No), or if neither has
occurred (the field is blank).

Authorized Indicates if the DWR has been authorized by the project
manager (Yes), if the project manager did not authorize the
DWR (No), or if neither has occurred (the field is blank).

Authorized Date on which the project manager authorized the DWR.

Date

Temperature The high temperature recorded for the workday. The high

High temperature must be higher than the low temperature, and is
required.

Temperature The low temperature recorded for the workday. The low

Low temperature must be lower than the high temperature, and is
required.

Weather A user-defined drop-down list from which you select the

Conditions significant weather condition for the morning (i.e. Rain, Snow,

AM. Cloudy, Sunny, etc.). This field is required.

Weather A user-defined drop-down list from which you select the

Conditions significant weather condition for the afternoon. This field is

P.M. required.

No Work Items | A check in this box indicates that no work items were installed.

Installed

No Contractors | A check in this box indicates that no contractors were present

On Site on the work site.

No Daily Staff | A check in this box indicates that no daily staff was present on

On Site the work site.

Work A check in this box indicates that work was suspended during

Suspended the day. Payrolls are not required for any payroll period when
work is suspended; no workdays are charged to the contract.

Work The inspector enters the time of day when work was

Suspended suspended.

Time
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Field Name Description

Work Resumed | The inspector enters the time of day when work was resumed.

Time Work cannot be resumed unless it has previously been
suspended.

Remark Type Denotes the types of remarks entered in the Remarks field, and
lets you select a remark type to enter or view.

Remarks General remarks for the current DWR. Each remark is
associated with a remark type. The inspector can enter only
one remark for each remark type, but you can enter multiple
remark types on each DWR. Remarks are optional.

Spell Check The Spell Check function will be available if the “Enable Spell

Check Remarks” system operational parameter is set to yes and
if the current window rights are set to ‘Update’ and the Daily
Work report is not locked, protected or authorized.

Microsoft Office must be installed for the spell check feature to
function.

Default value is ‘N.’

Table 0-3 The DWR Info Panel Fields Table
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To enter data on the DWR Info folder tab:

1.
2.

10.

11.

12.

13.

14.
15.
16.
17.

On the SiteManager main panel, double-click the Daily Work Reports icon.

On the DWRs panel, double-click the DWRs icon. The DWR Info folder tab opens by
default.

To create a new DWR, click the Services menu and click the Choose Keys choice. The
Contract Select panel opens.

In the Contract ID list box, scroll to and click the desired contract.
Click OK. A message box asks if contractor information should be copied.

To copy the contractor information from the last DWR for this contract, click Yes.
Otherwise, click No.

To change the date, double-click the DWR Date field. This opens a calendar on which a
date prior to the current date can be selected. To select a prior month, click the left
arrow. To enter the selected date on the DWR Info panel, click OK.

To enter the high temperature for the day, in the High field, click the up (or down) spin
button until the high temperature appears.

To enter the low temperature for the day, in the Low field, click the up (or down) spin
button until the low temperature appears.

To enter the A.M. weather conditions, in the Weather Conditions A.M. drop-down list,
click the expand arrow and select the prevailing weather condition for the A.M. hours of
the work period.

To enter the P.M. weather conditions, in the Weather Conditions P.M. drop-down list,
click the expand arrow and select the prevailing weather condition for the P.M. hours of
the work period.

If work was suspended during the day, in the Suspended Time field, click the up (or
down) spin button until the time appears. (If work was resumed, enter the time in the
Resumed Time field.)

To enter a remark, in the Remark Type list box, scroll to and click the remark type. Then
type the remark in the Remarks field.

Click on the Spell Check button.
Close the Spell Check window.
Click the Save button.

Click OK.
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Every time a temperature value is changed, the values are compared. If the high temperature
becomes lower than the low temperature, the system adjusts the values.
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8.2.3 Contractors Tab in Daily Work Reports

The Contractors folder tab in Daily Work reports lets you enter daily data on the contractor,
supervisor(s), and variable labor (by personnel type). Equipment usage is recorded on the
Contractors Equipment folder tab. When you create a Daily Work report, you can copy the
contractor information from the last opened or saved DWR for the contract. This includes any
recent modifications of the contractor information. If you choose not to copy the contractor
information, you can select the contractor from a drop-down list of contractors and subcontractors
who are authorized to work on the contract. The subcontractor is not available to a DWR prior to
that subcontractor’s approval date for the contract. In addition, the associated subcontractor is not
available to a DWR prior to that subcontractor’s Effective Date. The associated subcontractor is also
not available to a DWR after that subcontractor’s Expiration Date has passed The prime contractor is
always at the top of the drop-down list. You may also enter remarks for each contractor.

You must select a contractor before entering information related to the contractor or before recording
work items. After selecting a contractor, you can select supervisors and personnel types associated
with the selected contractor from the drop-down lists in these fields. The records that appear on the
drop-down lists are stored on the Master List. To add a record (supervisor, equipment, etc.) that
does not appear on a drop-down list, the record must first be added to the Master List.

The Supervisor list on the Contractors folder tab displays all of the supervisors who worked for the
selected contractor on this date. After selecting a supervisor, you can record the number of hours
worked by the supervisor. You may also enter remarks for each supervisor. The Personnel Type list
displays all of the non-supervisory personnel types who worked for the selected contractor on this
date. This listis also referred to as the variable labor list. You can record the number of workers
present for each personnel type. For example, you can record the number of painters present for the
prime contractor. After selecting a Personnel Type and number, you can enter the number of hours
worked by each person. You may also enter remarks for each personnel type used.

When you enter Supervisors and Personnel Types, the system updates the Number of Supervisors,
Number of Workers, and the Contractor Hours Worked fields.

8-17



AASHTOWare Project SiteManager™

8. Daily Work Reports 8.2 Data Collection
5 Daily Work Reports =] E3
D'WR Info. Contractors Contractor Equip. Dhaily Staff Wwork ltems Force Accounts
Contract ID: ISITEMGH_H Inspector: |System Administrator 1 Date: |02.-"I391'99

Contractor
Hrs Worked

I

DO04 DAY CONSTRUCTION COMPANY == PRIME **

|4

| Hours
Supervisor/Foreman Name Worked

Nbr of
Persons

Total
Hours

Hours
Worked

Personnel Type

Figure 8-7. The Daily Contractors Panel

To access the Contractors folder tab:
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1.
2.
3.

On the SiteManager main panel, double-click the Daily Work Reports icon.

On the DWRs panel, double-click the DWRs icon. The DWR Info folder tab opens.
Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.

In the User list box, scroll to and double-click the User ID of the report’s author.

In the DWR list box, scroll to and click the DWR Date of the report.

Click OK.

Click the Contractors folder tab.
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The fields on the Contractors folder tab are defined in the following table:

Field Name

Description

Contractor

Drop down list containing the short name for the contractor
who worked on the contract on this date.

. Note: Subcontractors associated with the
contract will not appear in this drop-down list
unless an approval date for the subcontract
has been entered on the Subcontracts
window. In addition, the associated
Subcontractors must have an Effective Date
prior to or equal to the DWR Date. If an
Expiration Date was entered, the Expiration
Date must be the same as or after the DWR
Date.

Nbr of
Supervisors

Number of supervisors present on this date. This field is
calculated every time you record a supervisor as present.

The calculation is the total of all the present supervisors. You
can change the value manually.

Nbr of Workers

Number of non-supervisory personnel present on this date.
This field is calculated every time you record a personnel
type as present. The calculation is the total of all the present
non-supervisory personnel. You can manually change the
value.

Contractor Hrs
Worked

Hours worked by the contractor on this date. This is the
system-calculated sum of the Hours Worked fields for
Supervisors and Personnel Types. This value must be greater
than zero.

Supervisor Name

The Contractor's supervisors who worked on this date.

Supervisor Hours
Worked

The number of hours worked by this supervisor. The number
of hours worked must be greater than zero.

Personnel Type

The personnel type of non-supervisory workers who worked
for the selected contractor. Personnel types can be added
from the drop-down list.

Nbr of Persons

The number of persons of each personnel type who worked
on this date for the selected contractor. The number of
persons must be greater than zero.
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Field Name Description
Hours Worked Hours worked by this personnel type. Hours cannot be
recorded until the number of persons is greater than zero.
Total Hours System-generated total hours worked by this personnel type
on this date.

Table 8-4. The Daily Contractors Folder Tab Fields Table

To add a supervisor to a Daily Work report:

1.

o >~ w

10.
11.

12.

13.

On the SiteManager main panel, double-click the Daily Work Reports icon.

On the DWRs panel, double-click the DWRs icon. The DWR Info folder tab opens.
Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.

In the User list box, scroll to and double-click the User ID of the report’s author.

In the DWR list box, scroll to and click the DWR Date of the report.

Click OK.

Click the Contractors folder tab.

If there is more than one Contractor listed, click the Contractor who employs the
supervisor.

Click the Supervisor field and click the New button. An empty row is added to the list.

In the Supervisor drop-down list, click the expand arrow and click the desired
supervisor.

In the Hours Worked field, type the number of hours worked by this supervisor on this
date.

Click the Save button.

To add a personnel type to a Daily Work report:
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1.
2.

On the SiteManager main panel, double-click the Daily Work Reports icon.
On the DWRs panel, double-click the DWRs icon. The DWR Info folder tab opens.
Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.
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5. Inthe User list box, scroll to and double-click the User ID of the report’s author.

6. Inthe DWR list box, scroll to and click the DWR Date of the report.

7. Click OK.

8. Click the Contractors folder tab.

9. |If there is more than one Contractor listed, click the Contractor who employs the
worker.

10. Click the Personnel Type field and click the New button. An empty row is added to the
list.

11. In the Personnel Type drop-down list, click the expand arrow and click the desired
personnel type.

12. In the Nbr of Persons field, type the number of workers of this Personnel Type who
worked on this date.

13. In the Hours Worked field, type the number of hours worked by this personnel type on
this date. The system calculates the value in the Total Hours field.

14. Click the Save button.

8.2.4 Contractor Equipment Tab in Daily Work Reports

The Contractor Equipment folder tab lets you document the presence and use of equipment on the
job site for the selected contractor. Enter the number of pieces of each equipment-type on the site on
this date, the number of pieces used, and the number of hours each equipment-type was used. You
may also enter remarks for each piece of equipment used. You must select a contractor before
entering equipment information for the contractor.

After you select a contractor, you can select Equipment IDs from the drop-down list in the
Equipment ID field. The records that appear on the drop-down list are stored in the Master List.
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Figure 8-8. The Daily Contractor Equipment Folder Tab

To access the Contractor Equipment folder tab:

1. On the SiteManager main panel, double-click the Daily Work Reports icon.
2.

3.

7.
8.

On the DWRs panel, double-click the DWRs icon. The DWR Info fold
Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.

In the User list box, scroll to and double-click the User ID of the report’s author.

In the DWR list box, scroll to and click the DWR Date of the report.
Click OK.

Click the Contractor Equipment folder tab.

The Remarks function is available for each piece of equipment recorded.
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The fields on the Contractor Equipment folder tab are defined in the following table:

Field Name Description
Contractor Short name for the contractor who worked on the contract on
this date.
Nbr of Number of supervisors present on this date. This field is

Supervisors

calculated every time you record a supervisor as present. The
calculation is the total of all the present supervisors. You can
change the value manually.

Nbr of Workers

Number of non-supervisory personnel present on this date.
This field is calculated every time you record personnel as
present. The calculation is the total of all the present non-
supervisory personnel. You can change the value manually.

Contractor Hrs

Hours worked by the Contractor on this date. This is the

Worked system-calculated sum of the Hours Worked fields for
supervisors and personnel types. This value must be greater
than zero.

Equipment ID - | Text description of the piece of equipment. Can be used to

Description describe a type of equipment.

Nbr of Pieces

This field is used to record the quantity of an equipment type.
The equipment quantity must be greater than zero, before
quantity used can be recorded.

Nbr Used Identifies how many pieces of the equipment type were used
that day. The equipment quantity must be greater than zero,
before the quantity used can be recorded. The quantity used
cannot be greater than the equipment quantity.

Hours Used Number of hours the vehicle or equipment was used on that

day. The equipment quantity used must be greater than zero,
before equipment hours can be recorded.

Table 8-5. The Daily Contractor Equipment Folder Tab Fields Table
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To add equipment to a Daily Work report:

1.
2.

10.

11.

12.

13.
14.
15.

On the SiteManager main panel, double-click the Daily Work Reports icon.

On the Daily Work Reports panel, double-click the Daily Work Reports icon. The
DWR Info folder tab opens.

Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.

In the User list box, scroll to and double-click the User ID of the report’s author.
In the DWR list box, scroll to and click the DWR Date of the report.

Click OK.

Click the Contractor Equipment folder tab.

If there is more than one contractor listed, click the Contractor who supplied the
equipment.

Click the Equipment ID field and click the New button. An empty row is added to the
list.

In the Equipment ID drop-down list, click the expand arrow and click the desired
Equipment ID.

In the Nbr of Pieces field, type the number of pieces of this equipment present on this
date.

In the Nbr Used field, type the number of pieces of this equipment used on this date.
In the Hours Used field, type the number of hours this equipment was used on this date.

Click the Save button.

8.2.5 Daily Staff Tab in Daily Work Reports

The Daily Staff folder tab lets you enter daily information on state employees and consultants. A
staff member can be entered more than once per DWR with a different work code. Each entry shows
how many hours the staff member worked, the type of work performed, and if a state vehicle was
used. If a state vehicle was used, its identification number must be recorded along with its starting
and ending miles. Select staff members from the drop-down list in the Staff Member field. You may
also enter remarks for each line of Daily Staff recorded. The records that appear on the drop-down
list are stored in the Master List. Records that do not appear on the drop-down list must first be
added the Master List.
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5 Daily Work Reports [_ O] ]
D'WwR Info. Contractors Contractor Equip. Daily Staff ‘work ltems Force Accounts
Contract ID: ISITEMGF!_H Inspector: |S_l,lstem Administrator 1 Date: |02.-"08£99
Staff Member S/C Work Reg. oT Starting | Ending
Code | Hours | Hours |¥ehicle ID | Mileage | Mileage
ohn Higgins [ 0l 0 a
Rhonda Wilson 5 0 0l a 0

Figure 8-9. The Daily Staff Folder Tab

To access the Daily Staff folder tab:

1.
2.

On the SiteManager main panel, double-click the Daily Work Reports icon.

On the DWRs panel, double-click the DWRs icon. The DWR Info folder tab opens.
Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.

In the User list box, scroll to and double-click the User ID of the report’s author.

In the DWR list box, scroll to and click the DWR Date of the report.

Click OK.

Click the Daily Staff folder tab.
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The Daily Staff folder tab fields are defined in the following table:

Field Name Description

Staff Member The name of a state employee or a consultant who worked on

the contract on this date. In the list portion of the screen, this
value is display only. Staff members must be added to the
Master List before they can be added to the DWR.

Work Code Transportation agency-defined code that identifies work

activities, including sick time and vacation. This field is
required if there is more than one entry for the same
individual.

SIC Indicates if the staff member is a consultant or state employee

(C=Consultant, S=State Employee).

Reg Hours The number of regular pay hours worked by the staff member

for the time period. This field is required.

OT Hours The number of overtime pay hours worked by the staff

member for the time period. This field is optional.

Vehicle ID The license number or other ID for a state vehicle used by the

staff member. Required if a vehicle was used.

Starting Mileage | The beginning mileage for the vehicle used by this staff

member for the day. Required if a vehicle was used. The
Starting Mileage should be less than the Ending Mileage.

Ending Mileage | The ending mileage for the vehicle used by this staff member

for the day. Required if a vehicle was used. The Ending
Mileage should be greater than the Starting Mileage.

Table 8-6. The Daily Staff Folder Tab Fields Table

To add a staff member to a Daily Work report:

8-26

1.
2.

On the SiteManager main panel, double-click the Daily Work Reports icon.

On the Daily Work Reports panel, double-click the Daily Work Reports icon. The
DWR Info folder tab opens.

Click the Open button.
In the Contract list box, scroll to and double-click the desired contract.

In the User list box, scroll to and double-click the User ID of the report’s author.
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6. Inthe DWR list box, scroll to and click the DWR Date of the report.

7. Click OK.

8. Click the Daily Staff folder tab.

9. Click the Staff Member field and click the New button. An empty row is added to the
list.

10. In the Staff Member drop-down list, click the expand arrow and click the staff member
name.

11. In the Work Code field, type the code that describes the work done on this date.

12. In the Reg Hours field, type the number of hours worked by this staff member on this
date.

13. In the OT Hours field, type the number of overtime hours worked by this staff member
on this date.

14. In the Vehicle ID field, type the ID of the state vehicle used by this staff member on this
date.

15. In the Starting Mileage field, type the starting mileage of the state vehicle used by this
staff member on this date.

16. In the Ending Mileage field, type the ending mileage of the state vehicle used by this
staff member on this date.

17. Click the Save button.

The Social Security Number(or SIN) is not displayed on the Daily Staff folder tab.

8.2.6 Work Items Tab in Daily Work Reports

The Work Items folder tab lets you view and add daily usage data for installed work items. Before
entering Work ltem data, the Contractor responsible for the Work Item must be entered on the
Contractors folder tab. When you first select the Work Items folder tab, the Select Work Item list
appears. The Record Work Item and Select Work Item buttons let you toggle between two different
versions of the Work Items folder tab. To enter usage data, first select the Work Item and then select
the Record Work Item button (or the Record Work Item option on the Edit menu). This displays the
Record Work Items folder tab on which you can view and add daily usage data.

o=

Figure 8-10. The Record Work Item and Select Work Item Buttons
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For a multi-project contract, you must generate the items for each project separately.
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Associating DWR Templates with Items

Adding DWR Templates to Items

After a DWR Template has been created, it must be associated with an item on the Master List and
with a contract item in order to record data to it for the Daily Work report. The DWR Template must
first be associated with an item in the Master List before it can be associated to a contract item. This
is done on the Item - DWR Template Association panel from the Daily Work Reports panel. This
panel displays all of the items on the Master List at the top and all of the templates that have been
created and are active on the bottom left in the Templates List window. Templates that are
associated to items are moved to the Associated Templates window on the bottom right of the panel.

Mdltem - DWR Template Association

Item code Item Master Short Description Spec Unt Sys |Last Chng =
Year |Ind Year
10416-25595 LIGUID ASPHALT 1993 M 1993
10417 TACK COAT 1390 M 1990
10417 TACK COAT 1991 |E 1991
10417 TACK COAT 1394 |E 1994
TACK COAT
10418-26843 LIQUID ASPHALT 1993 M 1993
10418-26863 LIQUID ASPHALT 1994 M 1994 | =
Templates List: Associated Templates:
Template ID Template Description_~ Template ID Template Description
4248-261M Asphalt Mutti Haul j Add > Asphathd Asphalt - Metric
4248-261 Aszphalt Single Haul e
. . Add All ->>
2525-254, Landscape turfgrass installstion ———
ss8 Test Template 1 <- Remove
PAKS Pam's third test <<- Rem All
PAK2 Pam's Test -
PAK4 Quick test
ATST ATEST ALDOT
< | _Dl—l | | |

Figure 8-11. Associating a DEW Template to a Master List Item

To associate a DWR template with a Master Item:

1. On the Daily Work Reports panel double-click the Item - DWR Template icon. It will
take a few minutes for the Master Item list to load.

2. Select the appropriate item to associate templates with.

3. From the Templates List data window select the template or templates (use the CTRL or
SHIFT keys to select multiple templates) to associate with the item.

4. Click the Add button, or click the Add All button to associate all of the templates to the
item. The selected templates will move to the Associated Templates window.

5. Click the Save button or select Save from the File menu.

8-29



AASHTOWare Project SiteManager™
8. Daily Work Reports 8.2 Data Collection

Removing DWR Templates From ltems

A template may become unnecessary, outdated or obsolete and need to be made unavailable for use
with future contracts. Templates can be removed or disassociated from the items in the Master List
by removing them from the Associated Templates window. The templates will maintain any existing
contract item associations, but will not be available to associate to future contract items. If the
template becomes valid again later, the template can be added back to the Associated Templates
window.

If the DWR template will no longer be used with any items or contracts, it can be made inactive in
the DWR Template panel accessible through the System Administration panel. See the section on
Creating DWR Templates for more information on this option.

To remove a DWR Template from an item:

1. On the Daily Work Reports panel double-click the Item - DWR Template icon. It will
take a few minutes for the Master Item list to load.

2. Select the appropriate item to associate templates to.

3. From the Associated Templates data window select the template or templates (use the
CTRL or SHIFT keys to select multiple templates) to disassociate or remove from the
item.

4. Click the Remove button, or click the Rem All button to remove all of the templates
from the item. The selected templates will move back to the Templates List window.

5. Click the Save button or select Save from the File menu.
Associating DWR Templates with Contract Items

Adding DWR Templates to Contract Items

After templates are associated with items in the master list they can be associated with items used in
a contract. There are several ways to associate templates to the contract items. The system
administrator can globally associate all of the templates associated to all items in the contract, or
templates can be associated for each item, either individually or in small groups. This is done on the
Contract Item - DWR Template Association panel from the Daily Work Reports panel. Select a
contract and Project ID from the list. All of the items available for the selected contract and project
will appear in the top portion of the panel. The templates associated with the items will appear on the
bottom left portion of the panel in the Templates List window. Templates that are associated with
contract items are moved to the Associated Templates window on the bottom right of the panel.
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Etunlracl Item - DWR Template Association O] x|
ContractiD:  |BID-L-2-F-0007 Project:  |1712275010000
tem Code Itemn Short Description Category | Line tem Last Chg| Unit Sys |Spec Bid Unit
Hum Hum Year |Indicator| Year | Quantity

22674 GATE FE-CL L=0.9 M 0170 1540 1993 E 1993 25965 0.3¢

22675 GATE FE-CL L=3.0 M 0170 1545 1993 E 1993 1 902

22663 CORNER BRACE UNIT FE-CL * 070 1530 1993 E 1993 204 373

00212 MIMNOR STRUCTURE EXCAY. BOX CULYED150 9939 1991 E 1991 |25 25

27001 SEEDING & FERTILIZING 0040 1550 1993 1 1993 [1 200

hd

scx con T 0.

Templates List: Aszsociated Templates:
T 1] Templt Desc
Add >
Add Al =>>
<- Hemove
<<= Bem All
< | | < | i

Figure 8-12. Associating a DWR Template to a Contract Item

To globally associate DWR templates to all contract items:

1.

On the Daily Work Reports panel double-click the Contract Item - DWR Template
icon.

Double-click on a Contract in the Contract ID window.
Select a Project from the Project Nbr window and click OK.

Choose Generate from the Services menu or click the Generate button on the Toolbar.
All templates associated to all items used by the contract will be moved to the Associated
Templates list and marked as Active.

Click the Save button or select Save from the File menu.
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To associate individual DWR templates with a contract item:

1. On the Daily Work Reports panel double-click the Contract Item - DWR Template
icon.

2. Double-click on a Contract in the Contract ID window.

Select a Project from the Project Nbr window and click OK.

W

Select the appropriate contract item with which to associate templates.

5. From the Templates List data window select the template or templates (use the CTRL
or SHIFT keys to select multiple templates) to associate with the contract item.

6. Click the Add button, or click the Add All button to associate all of the templates to the
contract item. The selected templates will move to the Associated Templates window.

7. Click the Save button or select Save from the File menu.

Removing DWR Templates From Contract Items

A template may become unnecessary, outdated or obsolete and need to be made unavailable for
further use. Templates can be removed, or disassociated, from the contract items if no data has been
recorded to the template by removing them from the Associated Templates window. If data has been
associated with a template that has become outdated, the template can still be made inactive for the
contract by deselecting (unchecking) the Active check box. This way, the template can no longer be
used in the contract, but the historical data associated with the template in the contract remains
intact. If the template becomes valid again later it can be added back to the Associated Templates
window.

If the DWR template will no longer be used with any items or contracts, it can be made inactive in
the DWR Template panel accessible through the System Administration panel. See the section on
Creating DWR Templates for more information on this option.

To remove a DWR template from a contract item:

1. On the Daily Work Reports panel double-click the Contract Item - DWR Template
icon.

2. Double-click on a Contract in the Contract 1D window.
3. Select a Project from the Project Nbr window and click OK.
4. Select the appropriate Contract Item from which to remove templates.

5. To remove templates from the Contract Item, from the Associated Templates data
window select the template or templates (use the CTRL or SHIFT keys to select multiple
templates) to disassociate or remove from the item.
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6. Click the Remove button, or click the Rem All button to remove all of the templates
from the item. The selected templates will move back to the Templates List window.

OR

1. To make a template inactive within a contract item, deselect the Active box next to the
appropriate Template in the Associated Templates data window.

2. Click the Save button or select Save from the File menu.

Selecting a Work Item

You can toggle between two different versions of the Work Items folder tab. When you first select
the Work Items folder tab, or when the Select Work Item button is selected, the Select Work Items
folder tab lists work items for the selected contract. The work items are listed in ascending order by
item code. You can find, filter, and sort the list. If an item has installed quantities for the selected
DWR, the Installed check box is checked (ON).

= Daily Work Reporis
DR Irfo. Contractors “ Conhractor Equip. Draily Staff Work Items “ Force Accounts
Contract ID:  |030330 Inspector:  [System Adminstiator 1 Date: [03/417/08

Project Line Item | Category ~
Instld) Humber Humber Humber Cateqgory Description Item Code  Description
93812 ooz [oioo |IDOD-ROADWAY 202(4) 0183 o WA

[0onz (0100 1000-RDAD N AY 202[C) 0184  MCLASSIFIED BORROW

(o004 o700 [000-ROADWAY 205 4223 [TYPE A-SALVAGED TOPSOIL

(0005 (0100 000-ROAD W AY 222 2301  [TEMPCRARY BALE BARRER

oooe (o100 [000-ROADWAY 223 2801  [TEMPORARY SILT FERCE

[oon7 o100 000-ROADW AT 224 2803 [TEMPCRARY SEDIMEMT FILTER

[0on2 (0100 1000-F DADWAY 226 2805  [TEMPORARY SEDIMEMT REMOWAL

[0oms o700 [000-ROADWAY 227 000 [TEMPORARY SILT DIKE

(001D o100 000-ROADW AT 229 4318 [QITCH LINER PROTECTION

oo (o100 [000-ROADWAY 230(2) 2806  BOLID SLAB SODDING

o012 o100 1000-F OAD WA 230(B) 2807  MULCH SODDING

[om3 [o100 (1000-R DAL AT 230F) 2812 WATERING

o014 o100 [000-ROADWAY 233[8) 2817 WEGETATIVE MULCHING

0015 o100 I000-FDAD /A 234[84) 2824 FERTILIZING (10-20-10)

[0me (0100 1000-RDAD N AY 234(4) 4406 FERTILIZING (0-45-0)

o017 o700 [000-ROADWAY 20 2832 MOWING

e (0100 1000-FDAD W/ AY 243 0450  [PLITEMPORARY IMLET SEDIMENT FILTER 2

Figure 8-13. The Select Work Items Folder Tab

To access the Select Work Items folder tab:
1. On the SiteManager main panel, double-click the Daily Work Reports icon.
2. On the DWRs panel, double-click the DWRs icon. The DWR Info folder tab opens.
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3. Click the Open button.
4. In the Contract list box, scroll to and double-click the desired contract.
5. Inthe User list box, scroll to and double-click the User ID of the report’s author.
6. Inthe DWR list box, scroll to and click the DWR Date of the report.
7. Click OK.
8. Click the Work Items folder tab. The Select Work Items folder tab lists the work items

for the selected contract.

The Select Work Items folder tab fields are defined in the following table:

Field Name Description
Instld Indicator | Indicates whether or not the work item is installed.
Project Number | Project number in which the work item is included.
Line Item Contract line item number of the work item.
Number
Category Category number in which the work item is included.
Number
Category Short description of category defined in the Categories
Description window.
Item Code Transportation agency-defined code that identifies a particular

item.

Description Short description of the work item.
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To view daily work item usage:
1. On the SiteManager main panel, double-click the Daily Work Reports icon.

2. On the Daily Work Reports panel, double-click the Daily Work Reports icon. The
DWR Info folder tab opens.

3. Click the Open button.

4. In the Contract list box, scroll to and double-click the desired contract.

5. Inthe User list box, scroll to and double-click the User ID of the report’s author.
6. Inthe DWR list box, scroll to and click the DWR Date of the report.

7. Click OK.

8. Click the Work Items folder tab.

9. Inthe Work Item list box, scroll to and click the installed work item (note that the
Installed Indicator is checked).

10. Click the Record Work Item button. The daily usage records for the selected Work Item
are displayed on the Record Work Item folder tab.

11. Click the Close button.

To list only the installed (or uninstalled) items, you can filter the list by the Installed check box
entry.

Recording a Work Item

You can toggle between two different versions of the Work Items folder tab. When the Record
Work Item button is selected, the Record Work Items folder tab displays usage information on the
selected item for this DWR. You can enter new usage data on this folder tab. If the item is installed
in multiple locations, you can enter the quantity installed at each location.

The Material Inspection Details at the bottom of the window displays Material Component, Unit,
Expected Quantity, Inspected Quantity, and Installed Quantity. In the case of standalone mode,
however, the material details may not be representative of the entire sample population — if any other
samples have been logged via any other means than the standalone mode on the current machine.
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Il!im;@n > dd O FeTEF A
DR Info. i Contractors " Confractor E quip. D aily Staff Work Items Force Accounts
Contract ID: 050010 Inspector:  [System Adminstrator 1 Date: [03/13/08

Project Mbr: 1339904 Line Itm Mbr: | 0070 Item Code:|5DS[B] 1328

Category Mbr: 02m

Oty Reported to Date: 84700  Qty Authonized to Date: |£9.200
Qty Installed to Date: £9.800 Bid Qty: |63.800

Status: Ective Aty Paid to Date: £9.500 Current Contract Qty: |£9.200

Item Desc: k:LASS A COMCRETE Unit Price: $400.00000
Supp Desc 1:|
Supp Desc 2: |

Units Type: | CY

Pay To Plan Qty: [ ]

Loc Seq Mbr [Location Installed Placed lle Plan Page Humber [Templt Uzed

T T N R

Placed Qty: | 14.900| Plan Page Mbr:| 0" Contractor: |M.). LEE CONSTRUCTION COMPANY = PRI
As Built Qry: 000 Loc Seq Mbr: {1 Location: South wing ' alls Br. B

" Measured Indicator

WE ]
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Station Offzet Distance Station Offset Distance * Interim Oty
From: + | R} | 000 Tae +| Aooa | 000 | ¢ Final Oty
Material Inspection Detail A
Material Component Cont Est Matrl Oty Satisf Repr Matrl Oty Reprt Matrl Gty Matrl Unit

HEC [aML) 19.654 0.000 19.664 TON

HCC-A-AE £9.500 0.000 69.800  Cubic ‘Yard

ADNE (AhL) £9.500 0.000 B9.500 LS

FLY ASH (AL 59.500 0.000 59.500 LS

Figure 8-14. The Record Work Items Window

Field Name

Description

Contract ID

Transportation-defined ID for the contract.

Inspector This field displays the name of the user who is currently logged
into SiteManager and creating the Daily Work report.

Date The date for which the work performed is being recorded.

Project Nbr Project number in which the work item is included.

Line Itm Nbr

Contract line item number of the work item.

Item Code Transportation agency-defined code that identifies a particular
item.

Category Nbr Category number in which the work item is included.

Item Desc Short description of the work item.

Unit Price Unit price of the material.
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Field Name

Description

Supp
Description 1

This field contains a textual description that is supplemental to
the item's description and may be required by the transportation
agency.

Supp
Description 2

This field contains a secondary textual description that is
supplemental to the item's description and may be required by
the transportation agency.

Qty Reported to | The total of all reported quantities on DWRs, regardless of

Date whether the quantities are authorized or unauthorized and
regardless of whether they are included on an estimate.

Qty Authorized | The total of all reported quantities on DWRs that are authorized.

to Date

Units Type The unit of measure associated with the pay item (e.g. inches,
feet, tons).

Pay To Plan Indicates if the line item is paid to plan quantity. If this

Qty indicator is “ON,” an In Box message indicating that the item

has exceeded the bid quantity will be issued to the user
generating an estimate.

Qty Installed to

The total of all reported authorized reported quantities included

Date on estimates (of all statuses).

Bid Qty The bid quantity on the selected line item.

Qty Paid to The total of all authorized reported quantities included on

Date estimates (of all statuses). This value is always the same as Qty
Installed to Date unless the quantity to pay has been adjusted on
the Estimate Item Detail window. This window includes a ‘Pay
This Est’ field which can be modified when an estimate is
pending. If the quantity in this field is adjusted, the Qty Paid to
Date field will reflect the modification, which will cause the
value to differ from the Qty Installed to Date.

Current Current contract quantity of the contract line item including any

Contract Qty change orders. Current Quantity is calculated by the sum of Bid
Quantity and the net Change Order quantity.

Placed Qty Quantity of the work item installed on this date.

As Built Qty This column is a field that will be used to record the As Built

Quantity on the work item record. This field is informational
only and does not affect estimate calculations.
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Field Name Description

Plan Page Plan page number on which the work item is included.

Number

Loc Seq Nbr Sequence number for the installation record for the item.

Contractor Drop-down list containing the name of the contractor
responsible for the work item.

e Note: Subcontractors responsible for a work
item will not appear in this drop-down list unless
an approval date for the subcontract has been
entered on the Subcontracts window.

Location Location where the work item was installed. An item can be
installed at multiple locations. (This description does not need
to be unique for each entry.)

Measured This column identifies the type of measured indicator for the

Indicator quantity on the work item record. The labels for the radio

button can be customized in the System Operational Parameter
window. This column is a two radio button field. Possible
values: “Y” — “Yes”, “N” — No. The default value for this
column is a space. The default can be redefined in the DWR
Work Item Measured Indicator Default system operational
parameter.

From Station

Station ID that identifies where the installation of this work item
starts.

From Station
Offset

Offset from the Station ID that identifies where the installation
of this work item starts.

From Station

Distance of the offset from the Station ID that identifies where

Distance the installation of this work item starts.

To Station Station ID that identifies where the installation of this work item
ends.

To Station Offset from the Station ID that identifies where the installation

Offset of this work item ends.

To Station Distance of the offset from the Station ID that identifies where

Distance the installation of this work item ends.

Material The short material description from the Material Detail window.

Component
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Field Name Description

Contract The Bid Current Quantity (Bid Quantity + change order

Estimated quantity) of Contract Item times the Conversion Factor.

Material

Quantity

Satisfied The total material quantity reported on the Contract tab of

Represented Maintain Sample Window. For the given item from the

Material Contract tab the Total of Represented Quantity on satisfied

Quantity samples for the material. Note that in standalone mode, this
data only includes those samples logged on the current local
database, and therefore may not be representative of the entire
contract item.

Reported The total material installed is calculated based on Installed

Material Quantity of Contract Item times the Conversion Factor.

Quantity

Material Unit The item material unit from the Contract Sampling and Testing

Requirements window.

Table 8-8. The Record Work Items Folder Tab Fields Table
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To access the Record Work Items folder tab:

8-40

1.
2.

On the SiteManager main panel, double-click the Daily Work Reports icon.

On the Daily Work Reports panel, double-click the Daily Work Reports icon. The
DWR Info folder tab opens.

Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.

In the User list box, scroll to and double-click the User ID of the report’s author.
In the DWR list box, scroll to and click the DWR Date of the report.

Click OK.

Click the Work Items folder tab. The Work Item list is displayed.

Click a Work Item and click the Record Work Item button. The folder tab fields
change to allow usage data entry.
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To enter new work item usage data:

1.
2.

10.

11.
12.
13.
14.
15.

16.
17.
18.
19.

20.
21.

On the SiteManager main panel, double-click the Daily Work Reports icon.

On the Daily Work Reports panel, double-click the Daily Work Reports icon. The
DWR Info folder tab opens.

Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.

In the User list box, scroll to and double-click the User ID of the report’s author.
In the DWR list box, scroll to and click the DWR Date of the report.

Click OK.

Click the Work Items folder tab. The Work Item list is displayed.

Click a Work Item and click the Record Work Item button. The folder tab fields
change to allow usage data entry.

Click the Location Installed field and click the New button. An empty row is inserted on
the Record Work Item List.

In the Placed Qty field, type the quantity of the item installed at this location.

Press the Tab key.

In the Plan Page Nbr field, type the page number of a reference to the installed item.
To enter another location where this item was installed, repeat steps 9 through 12.

In the Contractor drop-down list, click the expand arrow and click the name of the
contractor responsible for the installed item.

Press the Tab key.
In the Location field, type the location where the item was installed.
If the installed item was measured, click the Measured Indicator check box (ON).

In the From Station field, type the Station ID that identifies where the installation of this
work item starts.

Press the Tab key.

In the From Station Offset field, type the offset from the Station ID that identifies where
the installation of this work item starts.
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22. Press the Tab key.

23. In the From Station Distance field, type the offset distance from the Station ID that
identifies where the installation of this work item starts.

24. Press the Tab key.

25. In the To Station field, type the Station ID that identifies where the installation of this
work item ends.

26. Press the Tab key.

27. In the To Station Offset field, type the offset from the Station ID that identifies where
the installation of this work item ends.

28. Press the Tab key.

29. In the To Station Distance field, type the offset distance from the Station ID that
identifies where the installation of this work item ends.

30. Click on the Remarks button. Add a remark then click the Remarks button again to save
the remarks.

31. Click on the Remarks button again. The remarks entered in the previous step will open.
32. Click on the Spell Check button. Check spelling and close the Spell Check window.
33. Click the Save button.

To associate an external document with a work item usage record, click the External Document
option on the Services menu (referenced in the General Concepts section).

Material Inspection Detail
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ﬂ Material Inspection Detail

Contract ID: (050010 Ingpector:  |Syztem Adminstrator 1 DWR Date: |03/13/08

Project Hbr: | 1333904 Line Itm Nbr: Iﬁ Item Code: |509[B] 1328 Category Nbr: | 0201
Item Desc: CLASS & CONCRETE Unit Price:|  $400.00000
Supp Desc 1:|
Supp Desc 2- |
Oty Reported to Date: ’w Oty Authonzed to Date: ’W Units Typpe: W
Aty Installed to Date: ’w Bid Qty: W Payp To Plan Qty: [ ]
Status: [sctive Qty Paid to Date: | G3.800 Current Contract Qty: [F3800
M aterial Component Cont Est Matrl Satisf Repr  Reprt Matrl Matrl Unit Conversion Contract DWR ~
Aty Matrl Qty Aty Factor S&T Sample
1) e o @ | @ ||
AGGR-HC COMC-57-C £3.944 0.000 E3.944 TOM 0916 v [
AGGR-HC COMC-F-H 43639 0.000 43639 TOM 0.625 v [
FLY A5H [AML) £3.800 0.000 £5.800 uc 1.0 v [
HE [AkL) 19654 0.000 19654 TOM 0282 v [
-
Test Method Sampling Rate Sampling Frequency Acceptance method Sample Type P/S
AMB00 -Acceptance of Pre-Approve 1.0 100000 CRES-CRES Construction Resider DOC -DOC Document
< >

Figure 8-15. The Material Inspection Detail Window

The Material Inspection Detail window is accessible from the Record Work Item folder tab
displaying daily usage records for a selected work item. The Material Inspection Detail window can
be accessed from the Services menu option or from the Open Material Inspection Detail icon located
on the toolbar. The Material Inspection Detail window is only accessible from the Record Work
Item window.

The Material Inspection Detail window has the following panels:
= Contract Item Info
= Associated Materials
= Sampling & Testing Requirements

The Material Inspection Detail window will display contract item information from the DWR
Record Work Item folder tab in the top panel. The middle panel will display all contract materials
associated with the item code. If the material has contract sampling and testing requirements
defined, the Contract S&T column will be checked. If samples were previously created for the
selected material from the DWR window, the DWR Sample field will be checked. Users can select a
material by clicking on a material component, displaying associated test methods in the lower (third)
panel.

The third panel will display contract sampling and testing requirement information for the selected
material in the middle panel. If contract sampling and testing requirements have not been defined for
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the material, this panel will be blank. The data displayed in this panel is information only and no
data from this panel is carried over to the sample window to create samples.

Create Sample for Selected Material

From the Material Inspection Detail window, you can click on the Services - Create Sample menu
option or the tool bar icon. SiteManager will open the Maintain Sample Information window for the
selected material. Fields in the Maintain Sample Information window will be populated from
information available in the Material Inspection Detail window. This option will only be available if
your group has been given authority in the Group Security window. If your group has inquiry rights,
you will be able to open existing DWR samples, but will not be able to create new samples from the
Material Inspection Detail window. A user with no rights will not be able to create or open samples
from the Material Inspection Detail window.

You can view information in the Maintain Sample Information window by clicking on the Services
- Open Sample window menu option or the tool bar icon. If more than one sample was created for
the DWRs material, a window will be populated listing all the samples created for the material. Pick
a sample and click OK to open the selected sample.

If LIMS is enabled and the sample has been progressed to LIMS for testing, the Sample Status,
Sample Type, and Acceptance Method cannot be modified. Sample Status and Acceptance Method
can only be modified in LIMS. The Authorize option on the Services Menu is also disabled.
Samples that are being processed in LIMS cannot be authorized from SiteManager, and
authorization (or approval only) may only occur as a last step in LIMS Sample processing.

When a sample is approved but not authorized in LIMS (i.e., Approve Only check box selected),
sample processing will have completed in LIMS yet the sample will not be authorized. When the
sample is opened in SiteManager, the system will now allow sample authorization from SiteManager
if the current user has update rights to the window and has rights to authorize samples (i.e., the
Authorize option under Services menu is enabled).

Samples that have been authorized in LIMS can be unauthorized in SiteManager because sample
processing will have completed in LIMS.

Recording Data to DWR Templates

You can toggle between two different windows of the Work Items folder tab - the Select Work Item
list window and the Record Work Items window. When you first select the Work Items folder tab,
or when the Select Work Item button is selected, the Select Work Items window lists work items for
the selected contract. The work items are listed in ascending order by Item Code. You can find,
filter and sort the list. If an item has installed quantities for the selected DWR the Installed check
box is checked (ON).
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M Daily Work Reports

D'w/A Infa. g Contractors | Contractor Equip, 'l Daily Staff i ‘Work Items Force Accounts

Contract ID: 030330 Inspector:  Matthews, Dyton B. Date: [01/01/05

Line ltem
Number

Project
Number

Category
Number

Category Description Item Code _ Description

(TSR ooz o100 1000-ROADWAY 202(8) 0183 UNCLASSIFIED EXCAVATION
I 1easeiz [ooo3 o700 lon0-ROADWAY 202(0) N84 1INCLASSIFIED BORROW
I~ eassiz  [oond [o7on [lo00 ROADwWAY 305 4223 [TYPE A-SALVAGED TOPSOIL
I~ Teageiz [ooos {0700 [lo00-ROADwAY 222 2801  TEMPORARY BIALE BARRER
I esssiz  [ooos [o7on [lo00 ROADwWAY 373 2801 [TEMPORARY SILT FENCE
I~ 1gageiz [ooor {0700 [lo00-ROADwAY 224 2803 TEMPORARY SEDIMENT FILTER
1000 ROADWAY

|ooos 226 2805  (TEMPORARY SEDIMENT REMOWAL

1000-ROAD WA

230(E) 2807  MULCH SODDING

|Io00-ROADWEY 230(F) 2812 WATERING
[ID00-ROADWAY 23314) 2817 WEGETATIVE MULCHNG
1I000-ROADWAT 234j4] 2824 FERTILIZNG (10-20-10)
[ID00-ROADWAY 234[8) 4406 FERTILIZING (0-96-0)
1000-ROAD AT 241 283 MOAING

I000-ROAD WY 243 0480 (PLOTEMPORARY INLET SEDIMENT FILTER

Figure 8-16. The Select Work Items Window

When the Record Work Item button is selected, the Record Work Items window displays usage
information on the selected Item for this DWR. The Record Work Items window allows you to view
existing data for the work item or add new usage data. Any DWR Templates associated with the
selected item are also available from this window for viewing or entering data.

To record data to the Work Items tab:

1.

From the Daily Work Reports panel, click the Work Items folder tab. The Select Work
Item list window appears.

Select a Work Item and click the Record Work Item button or choose Record Work
Item from the Services menu. The Record Work Item window appears.

Click the Location Installed field and click the New button. An empty row is inserted
on the Record Work Item list and the cursor moves to the bottom portion of the Record
Work Item window for data entry.

If the DWR Template Usage Ind function was set to Yes by the System Administrator
and the item has an associated template with the mandatory return value flag set to Yes,
then the Placed Qty field will not be available for manual data entry and will be
populated by the return value in the DWR Template. If the return value is optional or the
DWR Template Usage Ind function was set to No, DWR templates will return values to
the Placed Qty field, but the Placed Qty field can be modified or overwritten by manual
entries. If the value returned from the template is different than the value in the Placed
Qty field, a text message will appear next to the Templt Used checkbox. The actual text
message will be determined by a Sys Op Parm. If an associated template has no return
value, or no template is associated to the item, then you must enter the quantity of the
item installed at this location in the Placed Qty field.

In the Contractor drop-down list, click the expand arrow and click the name of the
Contractor responsible for the installed item.
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6. Click the Tab key.

7. Inthe Plan Page Nbr field, type the page number of a reference to the installed item.

8. Click the Tab key.

9. Click the Tab key.

10. In the Location field type the location where the item was installed.

11. If the installed item was measured, click the Measured Indicator check box (ON).

12. In the From Station field type the Station ID that identifies where the installation of this
work item starts.

13. Click the Tab key.

14. In the From Station Offset field, type the offset from the Station ID that identifies where
the installation of this work item starts.

15. Click the Tab key.

16. In the From Station Distance field, type the offset distance from the Station ID that
identifies where the installation of this work item starts.

17. Click the Tab key.

18. In the To Station field type the Station ID that identifies where the installation of this
work item ends.

19. Click the Tab key.

20. In the To Station Offset field, type the offset from the Station ID that identifies where
the installation of this work item ends.

21. Click the Tab key.

22. In the To Station Distance field type the offset distance from the Station ID that
identifies where the installation of this work item ends.

23. Click the Save button. A message will display indicating that the Quantity field cannot be

0 and that data must be entered in the template. Click OK to continue.

The DWR Templates panel opens and displays a list of the DWR templates available for use with
this work item. Choose which DWR template associated with the selected item to view or on which
to record data.
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ElowR Template L1 1] [ ][ [ [ FE 10 i S = £

Contract: |BID-L-2-F-0007 Inspector: |System Administrator 1 DWR Date: |DB.«‘1 3400

Project Nbr: [1712275010000 Line Itm Nbr: [1530 Loc Seq No: |1_

Item Code & Desc: |1 0417 |TACK COAT

Template ID Description Used |Detail/  |Returns

LI

Asphalt - Metric

Figure 8-17. The DWR Templates Panel, Template ID Window

The list of associated DWR templates available for use with this work item contains the information
shown in the following table. Once the DWR template has been chosen, you can enter data into the

template.
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Field Description
Template ID The unique, user-defined identifier defined for the
template at its creation.
Description The template name or title.

Used

Check box indicating whether the template has been
used with the selected work item and DWR. If the box
is checked (On), the template has been used. If the box
is unchecked (Off), the template has not been used.

Detail/Multi Line

This check box specifies whether the template is a
detail/multi line template or a header (single line)
template. The default is a header template with the box
unchecked. If this box is checked, the Detail/Multi
Line portion of the template must have at least one row
containing alphanumeric or numeric data. A header
template is also required to contain alphanumeric or
numeric data.

Returns Value

Check box indicating whether the template returns a
value to the Placed Qty field of the DWR. If the box is
checked (On), the template does return a value. If the
box is unchecked (Off), the template does not return a
value.

Table 8-9. The DWR Template ID Window Fields Table

FIowR Tomplte -asohany | e

Contract: [BID-L-2-F-0007 Inspector: [System Administrator 1 DWR Date: [05/13/00 j
Project Nbr: [1712275010000 Line Itm Nbr: | 1590 Loc Seq No: l‘l_
Item Code & Desc: [10417 [TACK COAT
Square Meters 0.000 Rate (kg/sq. Meter) j
Metric Tons 0.000 Temperature I 0.0 CELSIUS
]
Begin Station End Station Lane Lenght [m) ‘Width (m) Square Meters  Remarks
1 | | [ mooo [ oood | [
Total Square Meters 0.000
=

Figure 8-18. The DWR Template

To record work item data to DWR templates:
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1. To invoke the DWR Template window, click on the DWR Template button or select
Edit/View Work Item Template Data from the Services menu.

2. The DWR Template ID window displays the Templates available for use with the
selected work item. Choose a DWR template to record data to and click the Record
Template Data button or choose Record Template Data from the Services menu. The
DWR template appears.

3. Enter the appropriate data into the fields of the DWR template.

4. Click the Save button or select Save from the File menu when the data is fully entered
into the template.

5. Click the Close button or select Close from the File menu to return to the Record Work
Item window. The Placed Qty field is now populated with the value from the DWR
template and the Templt Used box is checked.

8.2.7 Daily Force Accounts Tab in Daily Work Reports

The Force Accounts folder tab in DWRs lets you view or add daily information on a force account.
The force accounts are created and maintained in Contract Administration, and downloaded to the
project manager and inspector. However, the daily force account data is collected by the inspector in
DWRs. The daily force account data can be viewed in Contract Administration after the project
manager authorizes the DWRs.

When you first select the Force Accounts folder tab in DWRs, the folder tab lists the force accounts
for the selected contract. Selects a force account on this list, select the Record button on the toolbar,
and then toggle to one of the following three folder tabs:

= Daily Force Account Equipment
= Daily Force Account Labor
= Daily Force Account Materials

You can add daily force account data on these folder tabs. For example, to add equipment data
related to a force account, first select the force account. Then select the Record button and the
Equipment button. This opens the Daily Force Account Equipment folder tab.
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FEEIrRE

Figure 8-19. The Daily Force Account Toolbar Buttons

Selecting a Daily Force Account

The Force Account Select folder tab lets you select a force account. The folder tab lists all force

accounts created for the selected contract. If no force accounts have been created, the selection list
IS empty.

E Daily Work Reports =] B3
D'WH Info. Contractors Contractor Equip. Daily Staff Wwork [tems

Contract 1D: |SITEMGH_11 Inspector: |System Administrator 1 Date: |DZ!DB!99

Force
Account ID

Force Accounts

Force Account Description Purpose ﬁ

Additional maintenance on culverts

(e} repair damage ta 3

—
Figure 8-20. The Force Accounts Select Folder Tab
To access the Force Accounts Select folder tab:

1. On the SiteManager main panel, double-click the Daily Work Reports icon.

2. On the Daily Work Reports panel, double-click the Daily Work Reports icon. The
DWR Info folder tab opens.

3. Click the Open button.

4. In the Contract list box, scroll to and double-click the desired contract.

5. In the User list box, scroll to and double-click the User ID of the report’s author.
6. Inthe DWR list box, scroll to and click the DWR Date of the report.

7. Click OK.
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8. Click the Force Accounts folder tab. The Force Accounts Select folder tab is displayed.

The Force Accounts Select list has three columns as defined in the following table:

Field Name Description

Force Account Force Account ID number.

ID
Description Description of the work the force account is intended to cover.
Purpose Description of the reason for the force account.

Table 8-10. The Force Accounts Select Panel Fields Table

To view a daily force account:
1. On the SiteManager main panel, double-click the Daily Work Reports icon.

2. On the Daily Work Reports panel, double-click the Daily Work Reports icon. The
DWR Info folder tab opens.

.

Click the Open button.

&

In the Contract list box, scroll to and double-click the desired contract.

In the User list box, scroll to and double-click the User ID of the report’s author.
6. Inthe DWR list box, scroll to and click the DWR Date of the report.

7. Click OK.

8. Click the Force Accounts folder tab. The Force Accounts Select list is displayed.
9. Inthe Force Account list box, scroll to and click the force account.

10. Click the Record button and click either the Equipment, Labor, or Materials button, to
view the corresponding daily Force Account data.

Changes to the force account, such as available equipment, must be entered on the server and
downloaded to the project manager and inspector through pipeline.

Force Account Tab, Equipment Window

The Force Account tab, Equipment window lists all of the equipment authorized for the selected
force account. It also includes the ownership information, the used rate, and the idle rate for each
piece of equipment. You can add the number of hours each piece of equipment was used and the
number of hours it was idle.

8-51



AASHTOWare Project SiteManager™

8. Daily Work Reports 8.2 Data Collection
E Daily Work Reports H[=1E3
D'WwWh Infa. Contractors Contractor Equip. Daily Staff ‘work [tems Force Accounts
Contract ID: ISITEMGH_‘I‘I Inspector: ISystem Administrator 1 Date: IEIZIEIS.-"SS

||—Force Account Description:] [4ddtional maintenance on culverts

Purpose Text: |t|:| repair damage to bridge

Force Account Egp Description Hrs Used Used Rate|Hrs Idle | Idle Rate Ownership -
bulldozer 7 $150.00 1 $50.00|R ented and Erought To Sit

-
4 »

Figure 8-21. The DWR Force Account Folder Tab - Equipment Window

To access the daily Force Account Equipment folder tab:
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1.
2.

8.
9.

On the SiteManager main panel, double-click the Daily Work Reports icon.

On the DWRs panel, double-click the Daily Work Reports icon. The DWR Info folder
tab opens.

Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.

In the User list box, scroll to and double-click the User ID of the report’s author.
In the Daily Work Report list box, scroll to and click the DWR Date of the report.
Click OK.

Click the Force Accounts folder tab. The Force Accounts Select list is displayed.

In the Force Account list box, scroll to and click the Force Account.

10. Click the Record button and click the Equipment button.



AASHTOWare Project SiteManager™

8.2 Data Collection 8. Daily Work Reports

The fields on the daily Force Account Equipment folder tab are defined in the following table:

Field Name Description

Force Account Header

Description Description of the work the force account is intended to cover.

Purpose Description of the reason for the force account.

Force Account Equipment

Description Description of the piece of equipment or a type of equipment.

Hrs Used Number of hours the equipment was used on the force account
on this date. The field should be numeric and must not exceed
24 hours. The total of this field and Hrs Idle must not exceed

24 hours.
Used Rate Used rate for the piece of equipment.
Hrs Idle Number of hours the equipment was idle on this date. The field

should be numeric and must not exceed 24 hours. The total of
this field and Hrs Used must not exceed 24 hours.

Idle Rate Idle rate for the piece of equipment.

Ownership Description to indicate whether the piece of equipment is
owned by the Contractor and was already on the project site,
whether it is owned by the Contractor and brought to the site
for the Force Account work, or whether it is rented.

Table 8-11. The DWR Force Account Folder Tab - Equipment Fields Table

To record daily force account equipment data:

1.
2.

W

On the SiteManager main panel, double-click the Daily Work Reports icon.

On the Daily Work Reports panel, double-click the Daily Work Reports icon. The
DWR Info folder tab opens.

Click the Open button.
In the Contract list box, scroll to and double-click the desired contract.
In the User list box, scroll to and double-click the User ID of the report’s author.

In the Daily Work Report list box, scroll to and click the DWR Date of the report.
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7. Click OK.

8. Click the Force Accounts folder tab. The Force Accounts Select list is displayed.

9. Inthe Force Account list box, scroll to and click the force account that was worked on.
10. Click the Record button and click the Equipment button.

11. In the Equipment list box, scroll to the equipment record that needs data added.

12. In the Hrs Used field, type the number of hours the equipment was used on the force
account on this date.

13. Press the Tab key.
14. In the Hrs Idle field, type the number of hours the equipment was idle on this date.
15. To record data for other equipment, repeat steps 10 through 13.

16. Click the Save button.

Force Account Tab, Labor Window

The Force Account tab, Labor window lists all the workers authorized for the selected force account.
It also includes the regular, overtime, and fringe rates for each worker. You can add the number of
regular and overtime hours worked by each worker.

5 Daily Work Reports _ O] <]
D'WR Info. Contractors Contractor Equip. Draily Staff Work [tems Force Accounts
Contract 1D: IS ITEMGR_11 Inspector: IS ystem Administrator 1 Date: |DS!EI4."99

[Force Account Description:] [Pipe Repair

Purpose Text| |'o complete project

Worker Hame Class |Regular Hrs |Hegu|al Rate| Fringe Rate OT Hrs OT Rate =
park Lee Ironworkers E1$'I 2.00 2.00 21$13.00

o
< | »

Figure 8-22. The DWR Force Account Tab - Labor Window

To access the daily Force Account Labor folder tab:
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8.
9.

On the SiteManager main panel, double-click the Daily Work Reports icon.

On the Daily Work Reports panel, double-click the Daily Work Reports icon. The
DWR Info folder tab opens.

Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.

In the User list box, scroll to and double-click the User ID of the report’s author.
In the Daily Work Report list box, scroll to and click the DWR Date of the report.
Click OK.

Click the Force Accounts folder tab. The Force Accounts Select list is displayed.

In the Force Account list box, scroll to and click the force account.

10. Click the Record button and click the Labor button.
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The fields on the daily Force Account Labor folder tab are defined in the following table:

Field Name

Description

Force Account Header

Description

Description of the work the force account is intended to cover.

Purpose

Description of the reason for the force account.

Force Account Labor

Worker Name

Name of a worker authorized to work on the force account.

Class

Job classification of the worker.

Regular Hours

Regular hours worked on the force account on this date. The
field should be numeric and must not exceed 24 hours. The
total of this field and Overtime Hours must not exceed 24
hours.

Regular Wage

Regular hourly rate for the worker.

Regular Fringe

The fringe rate that should be applied to the regular hours
worked when determining total cost.

Overtime Hours

Overtime hours worked on the force account on this date. The
field should be numeric and must not exceed 24 hours. The
total of this field and Regular Hours must not exceed 24
hours.

Overtime Wage

The overtime hourly rate for the worker.

Table 8-12. The DWR Force Accounts Folder Tab - Labor Fields Table

To add daily force account labor data:
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1.
2.

On the SiteManager main panel, double-click the Daily Work Reports icon.

On the Daily Work Reports panel, double-click the Daily Work Reports icon. The
DWR Info folder tab opens.

Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.

In the User list box, scroll to and double-click the User ID of the report’s author.

In the Daily Work Report list box, scroll to and click the DWR Date of the report.
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7. Click OK.

8. Click the Force Accounts folder tab. The Force Accounts Select list is displayed.
9. Inthe Force Account list box, scroll to and click the force account.

10. Click the Record button and click the Labor button.

11. In the Worker Name list box, scroll to the name of the worker who worked on the force
account on this date.

12. In the Regular Hrs field, type the number of regular hours worked on the force account
on this date.

13. Press the Tab key.

14. In the OT Hrs field, type the number of overtime hours worked on the force account on
this date.

15. To record hours for other workers, repeat steps 10 through 13.

16. Click the Save button.

Force Account Tab, Materials Window

The DWR Force Account folder tab, Materials window lists all of the materials authorized for the
selected force account. It also includes the Invoice ID, the unit price, and the unit of measurement
for each material. You can add the quantity of each material that was used.

E Daily Work Reports M=] B3
D'Wh Info. Contractors Contractor Equip. Daily Staff ‘whork Items Force Accounts

Contract I1D: |SITEMGF!_11 Inspector: |S_l,lstem Administrator 1 Date: |05.-’U4a"99

i|Force A t Description:| llE'ipe Repair

Purpose Text:| |to complete project

Invoice ID Cont FA Matl Description Quantity Unit Price | Unit of Measure | «
IEEISB 36" pipe 6.000]  $20.00000f LF

Figure 8-23. The DWR Force Account Tab - Materials Window

To access the daily Force Account Materials folder tab:
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1.
2.

8.
9.

On the SiteManager main panel, double-click the Daily Work Reports icon.

On the Daily Work Reports panel, double-click the Daily Work Reports icon. The
DWR Info folder tab opens.

Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.

In the User list box, scroll to and double-click the User ID of the report’s author.
In the Daily Work Report list box, scroll to and click the DWR Date of the report.
Click OK.

Click the Force Accounts folder tab. The Force Accounts Select list is displayed.

In the Force Account list box, scroll to and click the force account.

10. Click the Record button and click the Materials button.
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The fields on the daily Force Account Materials folder tab are defined in the following table:

Field Name Description

Force Account Header

Description Description of the work the force account is intended to cover.

Purpose Description of the reason for the force account.

Force Account Labor

Invoice ID ID of the invoice for the material.

Cont FA Mtl Contract force account material description. Describes the

Description material specified for use on the force account.

Quantity Quantity of the material used on the force account on this
date.

Unit Price Unit price of the material.

Unit of Measure | Unit in which the material is measured.

Table 8-13. The DWR Force Account Folder Tab - Materials Table

To add daily force account materials data:

1.
2.

8.
9.

On the SiteManager main panel, double-click the Daily Work Reports icon.

On the Daily Work Reports panel, double-click the Daily Work Reports icon. The
DWR Info folder tab opens.

Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.

In the User list box, scroll to and double-click the User ID of the report’s author.
In the Daily Work Report list box, scroll to and click the DWR Date of the report.
Click OK.

Click the Force Accounts folder tab. The Force Accounts Select list is displayed.

In the Force Account list box, scroll to and click the force account.

10. Click the Record button and click the Materials button.

11. In the Materials list box, scroll to the material used on the force account on this date.
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12. In the Quantity field, type the amount of the material used on the force account on this
date.

13. To add quantities for other materials, repeat steps 10 through 11.

14. Click the Save button.

8.3 DWR Template Reports

There are two reports that provide information regarding DWR templates. The DWR Template
Usage Report lists information about the data recorded to a template for a DWR. The DWR
Template Item Master Report provides a list of the items that have associated DWR templates and
the associated templates titles.

8.3.1 DWR Template Usage Report

The DWR Template Usage Report lists detailed information about the data recorded to a template
for a selected DWR. This report is available either from the Daily Work Reports panel or from the
DWR Template panel. Selects from various criteria to specify how the report is to be generated. The
report can be created on and printed from your computer or offline. If the report is generated off-line
it can be accessed from the Accessories folder tab, Process Status Monitor icon.

The DWR Template Usage Report contains information for the selected Contract, DWR Date,
Project Number, Line Item Number, Location Sequence Number and Template ID. The contents of
the DWR Template Header are listed, showing the value entered in each field. Then, if itis a
Detail/Multi Line template, each line of the Detail/Multi Line portion of the template is listed along
with the values entered in each field.

Y Tompiste Repon Citeria |
Contact Id I Ln Itm Nbr |
User ID I Loc Seq Mbr I
DWR Date | Template ID |
Project Nbr |
[" Generate Dff-line File ITI = | =
[~ Generate Off-line Print ance et

Figure 8-24. The DWR Template Usage Report Criteria Window

To generate a DWR Template Usage report from the Daily Work Reports panel:
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1. On the SiteManager main panel double-click the Daily Work Reports icon.

2. On the Daily Work Reports panel double-click the DWR Template Usage Report
icon. The Template Report Criteria window will display.

3. Position the cursor over the Contract ID field, click the right mouse button and click on
Search. The Contract ID search window displays all of the contracts.

4. Scroll to and select the appropriate Contract ID and click OK.

5. From the User ID drop-down list select the appropriate User ID for the Daily Work
report’s author.

6. From the DWR Date drop-down list select the date of the desired Daily Work report.

7. From the Project Nbr drop-down list select the Project Number for which the DWR was
created.

8. Select the appropriate Line Item number from the Ln Itm Nbr drop-down list.

9. From the Loc Seq Nbr drop-down list select the location of the installed work item on
which to report.

10. Select the Template 1D from the drop-down list that was used in the selected DWR at the
selected location.

11. To generate the report on-line click OK.

12. To print the report click the Print button on the toolbar.

Or
13. To generate the report off-line to a file click the Generate Off-line File check box (ON).
14. Click OK.
Or
15. To generate and print the report offline, click the Generate Off-line Print check box
(ON).
16. Click OK.

To generate a DWR Template Usage report from the DWR Template panel:

1. From the Daily Work Reports panel, follow the steps listed under the section Recording
Data to DWR Templates to navigate to the DWR Template panel.

2. From the Template ID list highlight the desired DWR template.
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Or

Or
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3.

10.

11.

12.
13.

14.
15.

16.

17.

Click on the DWR Template Report button or select DWR Template Report from the
Services menu. The Template Report Criteria window will display.

Position the cursor over the Contract ID field, click the right mouse button and click
Search. The Contract 1D search window displays all of the contracts.

Scroll to and select the appropriate Contract ID and click OK.

From the User 1D drop-down list select the appropriate User ID for the Daily Work
report’s author.

From the DWR Date drop-down list select the date of the desired Daily Work report.

From the Project Nbr drop-down list select the Project Number for which the DWR was
created.

Select the appropriate Line Item number from the Ln Itm Nbr drop-down list.

From the Loc Seq Nbr drop-down list select the location of the installed work item on
which to report.

Select the Template ID from the drop-down list that was used in the selected DWR at the
selected location.

To generate the report online, click OK.

To print the report, click the Print button on the toolbar.

To generate the report offline to a file, click the Generate Off-line File check box (ON).
Click OK.

To generate and print the report offline, click the Generate Off-line Print check box
(ON).

Click OK.
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RPT-ID: RDWTUSG
User: System Administrator

Contract ID: BID-L-2F-0007
Line Item Number: 1530

ncy Name
DWR Template Usage Report

DWR Date:  03/23/2000
Loc Seq Nbr: 1

Date: 06/13/2000
Page 1 of 1

Project No: 1712275010000
Template ID: Asphalid

Header
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Detail/ Multi Line
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Figure 8-25. The DWR Template Usage Report Panel

8.3.2 DWR Template Item Master Report

The DWR Template Item Master report provides a list of the selected items that have associated
DWR templates along with a list of their associated templates. This report is available from the Iltem
- DWR Template Association panel. Select from various criteria to specify how the report is to be
generated. The report is created on and printed from your computer.

The DWR Template Item Master report is simply a listing of all of the Master Items within the
selected items and specifications that have DWR Templates associated to them. The report also lists
some template identification data for all of the templates associated to the selected Items, such as
Template ID and description and whether the template is active or not.

Y empiote Repont Citeris

Fromltem Code: [  Toltem Code: I—
Unit Sys Ind: I—L,
Spec Yr: |—
Last Chng Yr: I—

" | Zenerate Off-line Eile ITI = | =
" | Generate Wi-line Print ance e

Figure 8-26. The DWR Template Item Master Report Criteria Window

To generate a DWR Template Item Master report:
1. On the SiteManager main panel, double-click the Daily Work Reports icon.

2. On the Daily Work Reports panel, double-click the Item - DWR Template icon.
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3. Onthe Item - DWR Template Association panel click on the DWR Template Item
Report button or select DWR Template Item Report from the Services menu.

4. The Template Report Criteria window will display.

5. Position the cursor over the From Item Code field, click the right mouse button, and
click Search. The From Item Code search window displays all items that have associated
templates.

6. Scroll to and select the appropriate From Item Code and click OK.

7. Position the cursor over the To Item Code field, click the right mouse button, and click
Search. The To Item Code search window displays all items that have associated
templates.

8. Scroll to and select the appropriate To Item Code and click OK.

9. From the Unit Sys Ind drop-down list select the appropriate unit system indicator/spec
year/last change year selection. The Spec Yr and Last Chng Y fields will automatically
be populated.

10. To generate the report online, click OK.

11. To print the report, click the Print button on the toolbar.

EDWR Template Contract Item Report x|

Zoom: ;100 “3‘111 Copies: 11 =i i

RPT-ID: RDWTCITM State of Testing Date: D4/1672002
Uszer: System Administrator Department of Transportation Page 1 of 1
DWRH Template Contract Item Report

ltem Code tem Short Description Line kem Last Chng Unit Sys Spec Category Templt Id Templt Desc Ac
Supplemental Description Humber Year Indicator Year Humber

Supplemental Description2
Contract ID C10735 oo
Project Humber 10755-BID
202-00240 Rem Asphatt Mat (Planing) 0005 1939 E 1933 0200 ASPHALT  Asphatt Single Haul [

supplemental description added by Sonya Dooley in March 200
line 2 suppl description added by Sonya Doaley in March 2002

202-00240 Rem Asphatt Mat (Planing) 4567 1930 E 1930 0400 ASPHALT Asphatt Single Haul I
202-01000° Rem Fence aoio 19839 E 1955 0200 CLRGRE  Clearing and Grubbing I
ling 1
line 2
205-00100° Sedimert Removal and Disposal o025 1983 E 14955 0200 CLRGRE  Clearing and Grubbing i
-
1] | Moz

Figure 8-27. The DWR Template Contract Item Report Panel
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8.4 Daily Diary

The project manager creates Daily Diaries. Each Diary is a daily collection of the authorized Daily
Work reports submitted by all inspectors working on the contract. The project manager usually
submits one Diary per day per contract. Diaries can also be created for days when no Daily Work
reports are collected. The Diary panel has two folder tabs:

8.4.1 Diary Authorize

The Diary Authorize folder tab lets the project manager create a Diary, authorize or unauthorize
Daily Work reports, and add remarks to the Diary. The project manager can also view and print
Daily Work report previews.

8.4.2 Diary Charge

On the Diary Charge folder tab, the project manager reports the charge for the contract work for the
day—Full Day, Half Day, or No Charge.

igix

" Authotize *  Charge

Contract ID:

Diary Date: | 02/23/15  Last Modified User 1D: Creator User ID:[SYS1
Inspectar [ Authorized [ Authorized Date | Authorized By _[DWR Template

=] Spell Check
-

Figure 8-28. The Diary Authorize Folder Tab
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8.4.3 Selecting a Diary

The Diary Select window lets an authorized user open a Diary.

Contract 1D %]

—Selech

8.4 Daily Diary

Contract D | 011589
= Date I

Find |
—Date

Diary Date | Diary Locked Indicator

10/04/1398 Mo
10/05/1338 Mo

Figure 8-29. The Diary Select Panel

To access the Diary Select panel:
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1. On the Daily Work Reports panel, double-click the Diaries icon. The Diary Authorize
folder tab opens.

2. Click the Open button.
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The fields on the Diary Select panel are defined in the following table:

Field Name

Description

DWR Date

The date of the Diary. This date represents both the Diary and
the Daily Work reports that comprise the Diary.

Diary Locked
Indicator

Indicates whether or not the Diary has been uploaded to the
SiteManager Server (checked in).

To select a Diary:

Table 8-14. The Diary Select Panel Fields Table

1. On the Daily Work Reports panel, double-click the Diaries icon. The Diary Authorize
folder tab opens.

2. Click the Open button.

3. Inthe Contract list box, scroll to and double-click the desired contract.

4. Inthe Diary list box, scroll to and click the DWR Date of the Diary. (The DWR Date
represents both the Diary and the Daily Work reports that comprise the Diary.)

5. Click OK.

8.4.4 Creating a New Diary

The Diary Authorize folder tab lets you create a Diary. You can create a Diary with or without
Daily Work reports. Typically, the project manager creates a Diary from the Daily Work reports that
have been submitted by the inspectors. To create a Diary, select a contract first, and then enter the
Diary’s date on the Diary Authorize panel. By entering the date, you are selecting the Daily Work
Reports with this date and creating a Diary with this date. You can enter a date by selecting it from a
calendar. If you double-click the Diary Date field, a calendar is displayed on which you can select

the date.
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Select Date

March 1999
S M TWTF §

1z 2 4 55

T2 9 1011 12 13
14 15 16 17 123 19 20
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23 3 20 3

<|m]|>]

LCancel |

Figure 8-30. The Calendar

You cannot enter a date that is after the current system date.

After you select a date, the Diary Authorize folder tab lists the Daily Work reports submitted for the
selected date. The reports are listed alphabetically by the name of the inspector who submitted the
report. If a Diary has not already been saved for the selected date, a new Diary is created.

Il

“Authorize ©  Chaige

Contract ID:  [12345678

Diary Date: | 03/18/14 = Last Modified User 1D: [SYS51 Creator User ID:|SYS51
nspector Authorized | Authorized Date | Authorized By _[DWR Template
I T

System Admiristiator

Remarks:
Accidents | Spell Check

Delays
General Remarks Iz

I5]

El

Figure 8-31. The Diary Authorize Folder Tab
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The fields on the Diary Authorize folder tab are defined in the following table:

Field Name Description

Inspector The name of the inspector who created the Daily Work report.
The author of a Daily Work report is the only person who can
modify the Daily Work report.

Authorized Indicates whether or not the Daily Work report has been
authorized by the project manager. A check indicates that the
Daily Work report is authorized. Authorization can be
removed.

Authorized Date | The date the Daily Work report was authorized. When the
project manager marks the Daily Work report as authorized, the
system enters the current date. If the project manager removes
authorization, the date is removed.

Preview The Preview button on the toolbar displays a summary report
of the selected Daily Work report.

Authorized By | The User ID who authorized the DWR.

Table 8-15. The Diary Authorize Folder Tab Fields Table

A Spell Check button is available in the Remarks area. The Spell Check option will be visible if the
following are true:

=  “Enable Spell Check Remarks” system operational parameter is set to yes.
= Microsoft Office is installed.

The Spell Check button will be enabled if the current window rights are set to ‘Update’ and the
Diary is not locked or protected.

Microsoft Office must be installed for the spell check feature to be functional.

Once the Spell Check button has been clicked, the Microsoft Spell Checker will be called using the
text entered in the Remarks field. The spell check will use the dictionary that is utilized by
Microsoft Office applications, in addition to the custom dictionary, ‘custom.dic’. The Spell Check
function will allow for the addition of new words not in the current dictionary.
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" Authorize Chaige

Conbract ID:  |TRAIN_28

Diary Date: | 0/29/37  Last Modified User ID: [trainl Creator User 1D:|trainl

Inspector Authorized | Authotized Date ([DWR Template
& wwo [ @ ] |
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Remarks:
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Figure 8-32. The Diary Authorize Folder Tab- Remarks Spell Check

Mok in Dictionary:
Iatest Ignore Once I
Ignore all |
Add to Dictionary |
Suggestions:
Change |
attests Change Al |
=l AuUtoCorrect |
Dictionary language: IEninsh s j
Qptions.. . | Unda Last | Cancel |

Figure 8-33. The Diary Authorize Folder Tab- Remarks Spell Checker

To create a new Diary:

1.
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On the Daily Work Reports panel, double-click the Diaries icon. The Diary Authorize
folder tab opens.

Click the Services menu and click the Choose Keys choice.
In the Contract list box, scroll to and click the desired contract.

Click OK. The Diary Authorize folder tab lists the Daily Work Reports submitted for the
current date.

To change the date, double-click the Diary Date field. This opens a calendar on which a
date prior to the current date can be selected. To select a prior month, click the left
arrow. To enter the selected date, click OK.
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6. To enter a remark, in the Remark Type list box, scroll to and click the remark type.
Then, type the remark in the Remarks field.

7. Click on the Remarks button again. The remarks enter in previous step will open.
8. Click on the Spell Check button. Check spelling and close the Spell Check window.
9. Click the Save button.

10. Click OK.

8.4.5 Authorizing Daily Work Reports

The Diary Authorize folder tab lets the project manager authorize or unauthorize Daily Work
reports. A Daily Work report with a check in the Authorized check box is considered authorized.
When a Daily Work Report is marked as authorized, the system enters the current date in the
Authorized Date field. You can remove authorization (and the authorized date) by removing the
check from the Authorized check box. However, if the DWR has been sent to the server previously,
the DWR cannot be unauthorized.

If the project manager chooses not to authorize a Daily Work report, you can transfer the report back
to the inspector for modification using pipeline. Only the author of the Daily Work report (the
inspector) can modify the Daily Work report. The Daily Work reports must be authorized before
they can be uploaded (checked in) to the SiteManager Server database.

To authorize a Daily Work report:

1. On the Daily Work Reports panel, double-click the Diaries icon. The Diary Authorize
folder tab opens.

2. Click the Open button.
3. Inthe Contract list box, scroll to and double-click the desired contract.

4. In the Diary list box, scroll to and click the DWR Date of the Diary. (The DWR Date
represents both the Daily Work Report Date and the Diary Date.)

5. Click OK. The Diary Authorize folder tab displays the Daily Work Reports submitted for
this date.

6. In the Inspector list box, scroll to the inspector who submitted the Daily Work report to
be authorized.

7. Click the Authorized check box (ON). The system date is inserted into the Authorized
Date field.

8. Click the Save button.
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You can unauthorize a Daily Work report by clicking the Authorized check box (OFF). When a
Daily Work report becomes unauthorized, the system removes the authorized date.

8.4.6 Previewing Daily Work Reports and Diaries

The Preview option on the Diary panel lets you view and print a summary of a Daily Work report
without leaving the Diary panel. Diaries may be printed with either all or with selected Daily Work
reports. The Preview Diary, Preview Diary and All DWR, and Preview Diary and Selected DWR
selections appear on the Services menu.

Previewing Daily Work Reports
To preview a Daily Work report:

1. On the Daily Work Reports panel, double-click the Diaries icon. The Diary Authorize
folder tab opens.

2. Click the Open button.
3. Inthe Contract list box, scroll to and double-click the desired contract.

4. Inthe Diary list box, scroll to and click the DWR Date of the Diary. (The DWR Date
represents both the Daily Work Report Date and the Diary Date.)

5. Click OK. The Diary Authorize folder tab displays the Daily Work reports submitted for
this date.

6. Inthe Inspector list box, scroll to and click the inspector who submitted the Daily Work
report to be previewed.

7. Click the Preview button. A summary report of the selected Daily Work report is
displayed in a print preview window. You can either review the information on-line or
print it.

8. To close the print preview window, click the Close button.

Figure 8-34. The Daily Work Report Preview Button

The Daily Work Report Preview capability is also available under the Services menu by choosing
the Preview DWR choice or the key strokes, Cntrl+Shift+P.
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Figure 8-35. The Daily Work Report Preview

The fields on the Daily Work Report Preview are defined in the following table:

Field Name Description

Contract ID Transportation agency-defined ID of the contract.

Authorized Indicates if the Daily Work report has been authorized by the
project manager. Displays Yes if the Daily Work report has
been authorized, No if it has not been authorized, or remains
blank if no response has been entered.

Locked Indicates if the Daily Work report is currently uploaded
(checked in) to the project manager. Displays Yes if the Daily
Work report has been checked in, No if the Daily Work report
has been sent back to the inspector for correction, or remains
blank if neither has occurred.

Paid Indicates if the work reported on the Daily Work report has
been paid for (Yes or No).

Inspector ID ID of the user who created the Daily Work report.

High Temp. The high temperature recorded for the work day.
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Field Name Description

Low Temp. The low temperature recorded for the work day.

AM. The significant weather condition for the morning.

Condition

P.M. The significant weather condition for the afternoon.

Condition

Work Items Tells if no work was completed (no work items installed) for

Installed this Daily Work report (Yes or No).

Contractors Tells if contractors were reported present on this Daily Work

On Site report (Yes or No).

Daily Staff On | Tells if daily staff were reported present on this Daily Work

Site report (Yes or No).

Work The Daily Work report date is captured when the project

Suspended manager indicates that work is suspended on that day. Payrolls

Time are not required for any payroll period when work is suspended;
no work days are charged to the contract. The Work Suspended
Date is added to the Contract Key Dates.

Work The Daily Work report date is captured when the project

Resumed Time

manager indicates that work has been resumed on that day.
Work cannot be resumed unless it has previously been
suspended. The Work Resumed Date is added to the Contract
Key Dates.

Remark Type

Denotes the type of remark and also doubles as a search field.

Remarks

Remarks entered on the Daily Work report. Each remark must
have a remark type. A remark type can exist only once per
Daily Work report, but multiple remark types can be recorded
on each Daily Work report.

Contractor ID

Transportation agency-defined Vendor ID for the contractor.

Nbr. Of
Supervisors

Number of supervisors reported present on the Daily Work
report.

Nbr. Of Number of non-supervisory personnel reported present on the
Workers Daily Work report.
Hours Worked | Hours worked by the contractor reported on the Daily Work

report.
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Field Name

Description

Supervisors

Names of the contractor's supervisors reported on the Daily

Name Work report.
Supervisor Number of hours worked by the supervisor reported on the
Hrs Worked Daily Work report.

Personnel Title

Title of workers reported as variable labor on the Daily Work
report.

Variable The number of workers of each title reported as variable labor
Labor Qty on the Daily Work report.

Variable Number of hours worked by each title reported as variable labor
Labor Hrs on the Daily Work report.

Worked

Equipment Text description of the piece of equipment or a type of
Description equipment reported on the Daily Work report.

Equipment Quantity of the equipment reported present on the Daily Work
Qty report.

Equipment Quantity of the equipment reported used on the Daily Work
Qty Used report.

Equipment Number of hours the equipment was reported used on the Daily
Hrs Used Work report.

Remarks Remarks entered about the contractor.

Staff Member

The name of the staff member reported present on the Daily
Work report.

Work Code Transportation agency-defined code that identifies work
activities, including sick time and vacation.

S/IC Indicates if the staff member is a consultant or an employee
(C=Consultant or S=State Employee).

Reg Hrs The number of regular pay hours worked for the time period.

OT Hrs The number of overtime pay hours worked for the time period.

Vehicle ID The license number or other identifying number for a state
vehicle used by a staff member.

Start M/km The beginning mileage for the vehicle for the day.
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Field Name Description
End M/km The ending mileage for the vehicle for the day.
Line Item Nbr | The Contract Line Item number that identifies each item as it
appears on the contract.
Description A short description of the selected work item.

Supplemental

This field contains a textual description that is supplemental to

Description the item's description and may be required by the transportation
agency.
Item Code An agency-defined code used to identify a particular item.

Project Nbr

The unique identifier for the project.

Category A grouping of items assigned during pre-construction.

Location The location on the job where the item was installed.

Placed Qty The quantity installed on the Daily Work report date. This
quantity should represent what the inspector estimates as being
eligible for payment.

Plan Pg Nbr A reference to a specific plan page.

Measured Indicates if a work item has been measured or not (Yes or No).

Table 8-16. The Daily Work Report Preview Fields Table

The Diary Preview DWR report optionally includes the remarks recorded for DWR contractor
equipment, personnel, supervisors, and the daily staff.

Previewing Diaries

To preview a Diary:

1.
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On the Daily Work Reports panel, double-click the Diaries icon. The Diary Authorize
folder tab opens.

Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.

In the Diary list box, scroll to and click the DWR Date of the Diary. (The DWR Date

represents both the Daily Work Report Date and the Diary Date.)
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5. Click OK. The Diary Authorize folder tab displays the Daily Work reports submitted for

this date.

6. On the Services menu, choose Preview Diary. The Preview Diary print preview panel
opens. The Diary report appears in a Print Preview window. You can either review the

information online or print it.

7. To close the print preview window, click the Close button.

The Diary capability is also available with all DWRs or selected DWRs included under the Services
menu by choosing the Preview Diary and DWR choice or the Preview Diary and Selected DWR

choice.
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|.|.|.I.|.|.|.I.|.|.|.I.|.|.|.I.|.|.|.I.|.|.|.I.|.|.|.I.|

Diary Charge Type: Full Day
Diary Charge Reason:

Figure 8-36. The Diary Report Window

8.4.7 Charge Days and No Charge Days

The Diary Charge folder tab lets you record charge or credit information for the day and enter
remarks. Review the Daily Work reports in the Diary to determine if work was performed on the
contract. If work was performed, a Full Day or Half Day charge can be applied to the contract end
date. A No Charge (credit) day is a day on which no work was performed on the contract. For No
Charge days, no time is applied towards the contract end date. For Half Days and No Charge days,
you must enter a credit reason to explain why work was not done. You can also apply charge or
credit information to milestones for the contract. For Half Days and No Charge days applied to a
milestone, you must also enter a credit reason
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8.4 Daily Diary
Boioy | 1L L LT =

Autharize Charge
Contract ID:  {IHOOT2

Date: |04/01/00

Charge Type

Total Number of Diaries: 17

' Full Day
" Half Day
" No Charge

Total Diary Charge Days: 16,00
) Total Diary No Charge Days: ~ 1.00
(B Adj Total Diary Charge Days: 000
~]  Adj Total Diary No Charge Dags: 1500

Mistn
Nbr

Charge Credit
Milestone Description Amount Reason

Figure 8-37. The Diary Charge Folder Tab

To access the Diary Charge folder tab:

1.

6.

On the Daily Work Reports panel, double-click the Diaries icon. The Diary Authorize

folder tab opens.

Click the Open button.

In the Contract list box, scroll to and double-click the desired contract.

In the Diary list box,

scroll to and click the DWR Date of the Diary. (The DWR Date

represents both the Diary and the Daily Work Reports that comprise the Diary.)

Click OK. The Diary Authorize folder tab lists the Daily Work reports submitted for the

selected date.

Click the Dairy Charge folder tab.

The fields are defined in the following table:

Field Name

Description

Charge Type Full
Day

Full day charge indicator for the Diary. When checked,
a Full Day charge will be applied to the Diary.

Charge Type Half
Day

Half day charge indicator for the Diary. When checked,
a Half Day charge will be applied to the Diary. If this
charge type is selected, a credit reason must be given.

Charge Type No
Charge

No Charge day indicator for the Diary. When checked, a
No Charge day will be applied to the Diary. If this
charge type is selected, a credit reason must be given.

Diary Credit Reason

Transportation agency-defined reason for granting a
credit day. A credit reason is only required if a charge
type other than Full Day is used.
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Field Name

Description

Total Number of
Diaries

Total number of Diaries that exist for the contract.

Total Diary Charge
Days

The Total Diary Charge Days field is the sum of all
records that have Charge Type as Full Day or Half Day
for the Diary.

Total Diary No
Charge Days

The Total Diary No Charge Days field is the sum of all
records that have Charge Type as No Charge or Half
Day for the Diary.

Adj Total Diary
Charge Days

The Adj Total Diary Charge Days field is the sum of
previous total charge days and current total charge days
for the contract.

Adj Total Diary No
Charge Days

The Adj Total Diary No Charge Days field is the sum of
previous total suspended days and current total
suspended days for the contract.

Mistn Nbr Identifies the number of a milestone for the selected
Contract.

Milestone Description of a milestone for the selected Contract.

Description

Milestone Charge
Amount

Type of day credited (Full Day, Half Day, No Charge).

Milestone Credit
Reason

Transportation agency-defined reason for granting a
credit day for the milestone. It is only required if a
charge type other than Full Day is used.

Table 8-17. The Diary Charge Folder Tab Fields Table
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To enter charge data in a Diary:

1.

10.

11.

12.

13.

14.

On the Daily Work Reports panel, double-click the Diaries icon. The Diary Authorize
folder tab opens.

Click the Open button.
In the Contract list box, scroll to and double-click the desired contract.

In the Diary list box, scroll to and click the DWR Date of the Diary. (The DWR Date
represents both the Diary and the Daily Work reports that comprise the Diary.)

Click OK. The Diary Authorize folder tab lists the Daily Work reports submitted for the
selected date.

To review a Daily Work Report, in the Inspector list box, scroll to and click a Daily
Work report, then click the Preview button.

To enter charge data, click the Dairy Charge folder tab.

In the Charge Type field, click the radio button of the charge type to apply to the day for
the contract.

If the charge type is Half Day or No Charge, in the Credit Reason drop-down list, click
the expand arrow and click the reason for not charging all or part of the day.

To apply all or part of the charge or credit to a milestone, click the Milestone field and
click the New button. An empty row is inserted.

In the Milestone drop-down list, click the expand arrow and click the milestone to apply
the charge or credit to.

In the Charge Amount drop-down list, click the expand arrow and click Full Day, Half
Day, or No Charge.

If Half Day or No Charge is entered as the Charge Amount for the milestone, in the
Credit Reason drop-down list, click the expand arrow and click the reason for a credit.

Click the Save button.

8.5 Diary Adjustment Window

The Diary Adjustment window allows charge day adjustments to be applied for a day that has
incorrect charge information recorded and applied by an approved estimate. The window is only
available on the server. The window is comprised of two tabs. The first tab allows you to adjust the
charge information for a Diary’s day charge. The second tab allows you to adjust the charge
information for Diary Milestones.
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A Diary must be selected that has been recorded and included on a paid estimate. An existing
adjustment cannot be deleted or updated. A new adjustment must be created. Since multiple
adjustments can be made for a Diary and a Diary Milestone, a sequence number will automatically
be assigned to each new adjustment. The Diary Adjustment window tracks sequence number, User
ID, Charge Type, Credit Reason, Remarks, Update Date, and Estimate number.

Once an adjustment has been saved, it is ready to be processed by the next estimate which gets
generated. If multiple adjustments are made that have not been included on a previous estimate, the
last adjustment will be applied to the Diary or milestone only on the next estimate. The estimate
process will update the Total Charge and the Total No Charge days on the contract, then update the
adjustment records with the associated estimate number. Milestone Adjustments will be similarly
posted against the Diary Milestone Information that has been recorded for that Diary.

8.5.1 Diary Adjustment Window Diary and Milestone Tab

Creating a Diary Adjustment

The Diary Adjustment Window Diary tab allows adjustments to charge days on a Diary associated
with a paid estimate. The top of the window displays the current Diary charge information. The
lower window displays the adjustments that have been made.

EDiaw Adjustments |_ [ x|

[ Diary Milestones

ContractiD:  |SDContractd Diary Date: |U3/DS.!I]IJ Charge: |FuIIDay

Seq Nbr Estimate

User Id Charge Credit Reason Update Date
551 00/00/00

Chalge:l j Credit Reason: I

User Id: [SY51 Update Date: 00/00/00  Seq Nbr: 1
Remarks: -

Figure 8-38. The Diary Adjustment Window

The fields are defined in the following table:
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Field Name Description
Contract ID Transportation agency-defined ID for the contract
associated with the Diary Adjustment.
Diary Date Date of the Diary being adjusted.
Charge Type of charge associated with the Diary. If work was

performed, a Full day or Half day charge can be applied
to the contract end date. If No Charge (credit) days is
selected, no time is applied to the contract end date.

Seq Nbr The system-entered sequence number that identifies the
Diary Adjustment.

User Id System-entered User ID of the user who entered the
Diary adjustment.

Credit Reason Transportation agency-defined reason for granting a
Credit day. A credit reason is only required if a charge
type other than Full Day is used.

Update Date The system-entered date the Diary Adjustment was last
updated.

Estimate The system-entered estimate number on which the Diary
Adjustment appears.

Remarks User-entered information about the Diary Adjustment.

Text can copied to this field using standard Windows
copy and paste functionality. The copy and paste
function is also available from the Edit option located on
the SiteManager toolbar.

Table 8-18. The Diary Adjustment Window Fields Table

To create a new Diary adjustment:
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1.
2.

On the Main Panel, double click the Daily Work Reports icon.
Double-click the Diary Adjustment icon.

In the Contract list box, scroll to and click the desired contract.
In the Diary list box, scroll and click the desired Diary.

Click the New button. A sequence number and User ID will display in the new row.
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6. Inthe Charge drop-down list, click the expand arrow to the right of the current selection
and click the desired choice.

7. If you select Half Day or No Charge from the drop-down list, the Reason Code must be
entered. Click the expand arrow to the right of the current selection and click the desired
choice.

8. Fill inthe Remark field as appropriate and click Save.

e Note: The Charge drop down list will not display the current Diary charge value as a
selection.

When the new adjustment is saved, the Charge, Credit Reason and Update Date will be updated. The
Estimate field will remain blank until the next estimate gets generated. The estimate process will
populate the adjustment records with the associated estimate number.

ﬂ Diary Adjustments | _ (O x|

Diary Milestones

Contract Diary Date Mistn Nbr| Charge Credit Reason

02/15/3301

Seq Nbr User Id Charge Credit Reason | Update Date | Estimate
15v52 Half Day  Adjustment Period 06/03/00

Charge : I Half Day  Credit Reason: [Adjustment Period
User Id: [5Y52 Update Date: | 06/08/00 Seq Nbr: | 1
Remarks: g

]

Figure 8-39. The Diary Adjustment Milestone Tab

Field Name Description
Contract The transportation agency defined ID of the contract.
Diary Date Date of the Diary.
Charge Type of charge associated with the Diary. If work was

performed, a Full day or Half day charge can be applied
to the contract end date. If No Charge (credit) days is
selected, no time is applied towards the contract end

date.
User ID Identifies the person who created the adjustment.
Credit Reason Transportation agency-defined reason for granting a

credit day. A credit reason is only required if charge
type is half day or no charge.
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Update Date The date upon which the adjustment has been made.
Estimate This field shows the associated estimate that updated the

total charge and total no charge days on the contract.

Table 8-19. The Diary Adjustment Milestone Tab Fields Table

To create a new adjustment for Milestone on a Diary:

1.

W

On the Main-Panel, double click on the Daily Work Reports icon.
Double-click the Diary Adjustment icon.

In the Contract list box, scroll to and click the desired contact.

In the Diary list box, scroll to and click the desired Diary.

Click on the Milestone tab.

Click the New button. A sequence number and User ID appears in the new row.

In the Charge Days drop-down list, click the expand arrow to the right of the current
selection and click the desired choice.

If you select Half Day or No Charge from the drop-down list, the Reason Code must be
entered. Click the expand arrow to the right of the current selection and click the desired
choice.

Fill in the Remark field as appropriate and click Save.

Note: The Charge Days down list will not display the current Charge Reason value as a
selection.

After the new Milestone Adjustment is saved, the Charge Days, Charge Reason, and the Update
Date will be populated. The Estimate field will remain blank until the next estimate gets generated.
The estimate process will populate the adjustment records with the associated estimate number.

8.6 DWR Reference Tables

8.6.1 DWR Master List

During the creation of Daily Work reports, contractor supervisors, and personnel types are selected
from standard drop-down lists on the Contractor folder tab. Contractor equipment is similarly
selected from a standard drop-down list on the Contractor Equipment folder tab. Transportation
agency staff members are selected from a standard drop-down list on the Daily Staff folder tab.
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The entries in these drop-down lists are first created on in the Vendor Master List. The entries in the
Vendors Master List then have to be associated to specific contracts.

Staff members are unusual since they are State Transportation agency employee or consultants.
They are added, modified and deleted to the Vendor Master List in the same way the other Master
List entries are performed.

The DWR Master List is composed of two windows, the Vendor Master List and the Contract
Master List. The Vendor Master List allows a user to maintain a centralized list of equipment,
personnel types, supervisors and agency staff associated to a vendor. The Contract Master List is
used to associate the Vendor Master List to specific contracts. A record on the Vendor Master List
can be associated to multiple contracts.

The Vendor Master List and the Contract Master List are created and maintained on the server. The
Contract Master List is piped down when Basic Contract Data is selected on the Server to PM
pipeline screen. The Contract Master List is read-only in stand-alone mode. If changes need to be
made, the Contract Master List must be corrected on the server and the Basic Contract Data piped
down again to update the list on the stand-alone.

Vendor Master List

The Vendor Master List allows equipment, personnel types, supervisors, and agency staff members
to be associated to a vendor. The top portion of the window displays the VVendor 1D and allows
selection of the lists to modify. The bottom portion of the screen displays the respective data for each
list.

B vendor Master List [_ [O] x|
¥endor ID: |S15?
{* Equipment " Personnel " Supervisor " Staff Member
|| Equipment | Active
E quipment Description 1D Indicator
fltruick 34343434 v
[bulidozer 34333330 v
[harse 30934343 v
arader 339:5000:0 v

Figure 8-40. The Vendor Master List

The fields on the Vendor Master List panel are defined in the following table:

Field Name Description
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Field Name Description
Equipment Description of a piece of equipment or type of equipment.
Equipment ID Identification of the equipment.

Active Indictor

Indicates if the record is active or inactive.

Personnel Type

Personnel type of non-supervisory workers.

Supervisor Name

Name of the supervisor.

Staff Member Name

Name of the state employee or consultant.

SSN/SIN

Social security number of the state employee or consultant.

S/IC

S indicates a state employee. C indicates a consultant.

Figure 8-41. The Vendor Master List Fields Table

If a user deactivates an active record on the Vendor Master List, a warning message will appear. The

message warns you that by deactivating a record on the Vendor Master List, the record will be
deactivated for ALL contracts with which the record is associated.

If a user activates a record that had been deactivated on the Vendor Master List, you will have to go

to each contract individually on the Contract Master List to mark the record as active.

The Equipment Radio button is the active radio button when you first enter the Vendor Master List.

You can add, modify, delete, activate, or deactivate the vendor equipment on the Master Lists.

To add equipment to the Equipment Master List:

1. On the SiteManager main panel, double-click the Daily Work Reports icon.

2. On the Daily Work Reports panel, double-click the Reference Tables icon.

oW

On the Reference Tables panel, double-click the Vendor Master List icon.

On the Vendor list box, scroll to and double-click the desired vendor.

5. Click the Equipment radio button.

6. Click the New button. An empty row is added to the Equipment list.

7. Type the Equipment Description.

8. Press the Tab key.

9. Type the Equipment ID.
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10. Click the Active Indicator check box (ON).
11. Click the Save button.
You can add, modify, delete, activate, or deactivate the Vendor Personnel Types on the Master Lists.
To add a personnel type to the Personnel Type Master List:
1. On the SiteManager main panel, double-click the Daily Work Reports icon.
2. On the Daily Work Reports panel, double-click the Reference Tables icon.
3. On the Reference Tables panel, double-click the Vendor Master List icon.
4. On the Vendor list box, scroll to and double-click the desired vendor.
5. Click the Personnel radio button.
6. Click the New button. An empty row is added to the supervisor list.
7. Type the personnel type.
8. Press the Tab key.
9. Click the Active Indicator check box (ON).
10. Click the Save button.
11. Click the Close button.
You can add, modify, delete, activate, or deactivate the vendor supervisors on the Master Lists.
To add a contractor supervisor to the Master List:
1. On the SiteManager main panel, double-click the Daily Work Reports icon.
2. On the Daily Work Reports panel, double-click the Reference Tables icon.
3. On the Reference